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INTRODUCTION

Course Description

This course covers the concepts and functionality you need to know in order to use the InEight
Estimate software successfully. As a result, you will be able to build cost estimates and bid proposals
with precision and efficiency.

Course Objectives

As a result of this course, you will be able to use the InEight Estimate software to:

l Construct and modify cost estimates

l Calculate profit and finalize bid proposals

How to Use this Manual

This training manual serves as the working guide during the E101 Essentials of Project Modeling and
Estimating instructor-led course. The first seven lessons of this document follow a natural progression
of putting an estimate together, from set up of a project to finalization of a bid. The remaining lessons
cover additional functionality that will help you build and review your project estimate more
effectively.

Lessons

The following lessons are covered in this course:



Course Lessons

Lesson Topic

Lesson 1 Estimating Core Concepts

Lesson 2 General Navigation

Lesson 3 Library Setup

Lesson 4 Project Setup

Lesson 5 Estimate Direct Costs

Lesson 6 Estimate Indirect Costs

Lesson 7 Finalize the Estimate

Lesson Format

This manual is designed to be a “hands on” learning guide. As such, each lesson is organized into
sections:

Section Description

Objectives Specify what you will learn in each lesson.

Topics Organize the subject matter, with explanations of key concepts and terms.

Step by
Steps

Walk you through the “mechanics” of how to perform specific functions in the
software. For each step by step, you will use the Training Job that comes pre-loaded in
the InEight Estimate Estimating software.

Exercises Allow you to practice and reinforce what you learn. For each exercise, you will use the
Training Job that comes pre-loaded in the InEight Estimate Estimating software.

Review Asks you questions to check what you have learned within each lesson.

Call-Outs

Throughout the document, you will also find important call-out banners.

Tips are for important notes and information you want to remember.

Notes are for critical information you need to know.
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Ongoing Use

This manual is also designed to be a comprehensive reference guide you can use outside of the
classroom and revisit as needed. Each lesson is compartmentalized so that you can refer back to each
lesson as needed.
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LESSON 1 — ESTIMATING CORE
CONCEPTS

Lesson Duration: 30 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Explain the estimating process in InEight Estimate

l Explain key terms and concepts

Lesson Topics
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Step 4 – Add Markup, Contingency, & Fees 46
Step 5 – Distribute Cost + Markup to required Structure 47
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1.2.4 Cost Item 50
1.2.5 Pay Item 50
1.2.6 Resource 51
1.2.7 Resource Assembly 52
1.2.8 Cost Item Assembly 52



Lesson 1 Review 53
Lesson 1 Summary 53
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1.1 OVERVIEW OF THE ESTIMATING PROCESS

The estimating process typically progresses through the following five steps. If you are an Owner you
may not take part in all five of these steps, but may instead do a few in an iterative process as you
progress through stage gate approval phases.

1. Enter project details.

2. Enter proposal deliverables.

3. Calculate Direct & Indirect Project Cost.

4. Add Markup, Contingency, & Fees.

5. Distribute Cost + Markup to required structure.

The below table displays how these five steps correspond with specific forms in InEight Estimate:

Note the forms used in InEight Estimate to accomplish the steps above:

l Job Properties

l Pay Item & Proposal

l CBS (Cost Breakdown Structure)

l PBS (Price Breakdown Structure)
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The rest of this section walks you through an overview of each step in the process and its
corresponding form in InEight Estimate.

Step 1 – Enter Project Details

When you decide to estimate a new project, the first step is to create a new estimate and set it up with
the general project details. In InEight Estimate, you’ll enter basic information and project specific
settings in the Job Properties form from the Setup tab.

The Job Properties form is organized into tabs to help you keep track of all the basic information and
settings for the project. It begins with the Overview tab. You will move from left to right entering your
project specific information and adjusting any settings that differ from the default.

Step 2 – Enter Proposal Deliverables

For Contractors who are submitting a proposal to a client, this step enables you to enter the client
provided deliverables clients are requesting pricing for. Most Owners will skip this step unless there is
a need to track various funding sources or prepare for internal or external company billing.

In InEight Estimate this list of items is recorded in the Pay Item & Proposal Register on the Setup tab.
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• Notice that your pay items have no pricing when first entered because you have yet to figure out
costs. You will come back to this form later in the process to distribute your costs and markup.

Step 3 – Calculate Direct & Indirect Project Cost

Once you’ve set up your estimate, you will perform take-offs and cost analysis to determine the total
estimated cost to complete the entire scope of work.

The Cost Breakdown Structure (CBS) Register is the main form where you will do your cost estimating.

l It is the hierarchy of work activities that make up the estimate

l Each row in the CBS represents a work activity and is called a cost item
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Step 4 – Add Markup, Contingency, & Fees

Once you have estimated all project costs, you may need to add markup, contingency or other fees and
define the job’s profit in the Price Breakdown Structure form.
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Step 5 – Distribute Cost + Markup to required Structure

You now have a target price or total estimated value that you can spread to your required project
deliverables, back in the Pay Item & Proposal form. InEight Estimate has tools within this form to help
automatically distribute your cost, overhead and all markups to the listed items.

1.2 KEY CONCEPTS AND TERMS

To help you get started in InEight Estimate, you should know a few key terms:

l Job Folder

l Library

l Form

l Cost Item

l Pay Item

l Resource

l Assembly
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1.2.1 Job Folder

Job folders hold all the information for an individual project estimate. It is possible to import master
data into a job folder, but when you work in a job folder it is independent, meaning any activity
performed in that folder will not affect any other jobs and will not affect the library.

When moving back and forth between jobs, make sure to always double-check that you
are in the right job.

1.2.2 Library

The Library is a storehouse for master data, such as:

• Labor, equipment, and material unit cost rates

• Standard account codes

• Units of measure

When you create a new job from scratch, default data and settings copy from the Library into your new
job folder, except for the resource rates. Multiple list of resource rates can be maintained in the library
so you must select which rates to populate a new estimate with. Four tag fields are available to filter
the resource rates you bring into an estimate from the master library. For example, you may select a
subset of your labor rates based on the geographical location of the project.

1.2.3 Form

Any screen you open in InEight Estimate is considered a Form. There are three types of forms:
Standard, Register, and Record forms.

Standard Forms resemble typical data entry forms with fields available to fill in key project
information. They also may contain radio buttons or checkboxes to define settings for the job.

Page 48 of 962 InEight Inc.  |  Release 19.2

1.2 Key Concepts and Terms Estimate User Guide



InEight Estimate uses tabs to group and organize entry fields and settings in a logical way,
so that the information is easy to access.

Register Forms have a grid format of rows and columns, giving it a spreadsheet look and feel. Register
forms allow you to see information for multiple items at once. The Cost Breakdown Structure (CBS)
Register is an example of a register form.

In a register form, you can open a Record for individual items you want to drill into.

The Tab key is the best way to move among fields in InEight Estimate (instead of the
Enter key).

The below figure displays a Cost Item Record accessed by double clicking on that item on the Cost
Breakdown Structure (CBS) Register.
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1.2.4 Cost Item

Cost items are the individual cost-related activities that make up the project. Cost items are organized
into a hierarchy in the Cost Breakdown Structure (CBS) Register. Each row in the CBS is considered a
cost item.

1.2.5 Pay Item

Pay items typically represent the owner required deliverables a contractor must submit pricing for. Pay
items are used to distribute the cost calculated in the Cost Breakdown Structure, with all markup,
including any fees or contingencies calculated in the Price Breakdown Structure. This allows the total
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estimate value to be distributed to a structure that is different than the CBS. Pay Items are
predominantly used by contractors to prepare a bid sheet. Owners may use pay items to identify
funding sources or for various reporting needs.

1.2.6 Resource

Resources are the building blocks of a detailed cost estimate.

Resources are the people, equipment, material, and supplies needed to complete the project.
Resources are employed to cost items to develop an estimate, and are organized into seven categories
or types:

1. Labor

2. Construction Equipment

3. Rented Construction Equipment

4. Installed Equipment

5. Installed Materials

6. Supplies

7. Unique
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1.2.7 Resource Assembly

A Resource Assembly is a group of resources that are often used together. For example, for civil work,
you may group together an operator foreman, operator, and laborer, along with a loader and
excavator. When estimating, you can employ this assembly which includes all of the pre-selected
resources.

1.2.8 Cost Item Assembly

A Cost Item Assembly is a predefined group of cost items that has cost based on estimator inputs to a
set of questions. Cost item assemblies provide parameter-driven estimating and can also refer to
reference tables. They allow companies to create intelligent construction systems to automatically
estimate various scopes of work, based upon a user providing specification and dimension variables.
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Lesson 1 Review

1. Which InEight Estimate form is used to enter basic information about the job as well as
define our cost basis?

a. Pay Item & Proposal

b. Job Properties

c. Library

d. Job Folder

2. All default data and settings copy from the Library into your new job folder except:

a. Labor rates

b. Equipment rates

c. Material rates

d. All of the above

3. These are considered the “building blocks” of the job – you employ them to cost items to
develop your estimate.

a. Assemblies

b. Pay Items

c. Resources

d. Forms

Lesson 1 Summary

As a result of this lesson, you can:

l Explain the estimating process in InEight Estimate

l Explain key terms and concepts
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LESSON 2 — GENERAL NAVIGATION

Lesson Duration: 45 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Navigate the InEight Estimate system interface

l Navigate system settings

l Manage columns in InEight Estimate registers
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2.1 GENERAL NAVIGATION

This section explores the layout of InEight Estimate.

Step by Step — Launch InEight Estimate

1. From the Windows desktop, locate the InEight Estimate shortcut icon.

2. Double click on the icon, or right click and select Open.

If you can’t find the InEight Estimate shortcut icon, you can also launch InEight
Estimate from the Windows Start menu.

2.1.1 Backstage View

InEight Estimate opens to the Backstage view. You can also get to the Backstage view from other tabs,
by selecting the File tab.

Section Description

Section 1
From the Start page you have the option to create, open or save a project, or close all
jobs that are open.

Section 2 You access the Library or open the Jobs page to go to the Job Register, Compare Jobs,
delete a job, or do a Primavera Batch Sync.

Section 3

l Templates allows you to create Job templates.
l You can create job snapshots or access previously created snapshots in the

Snapshot Register.
l You can also archive or back up and restore job folders.

Section 4 Settings allows you to customize options such as General settings, Account Code
settings, Timesheet Warehouse settings, Licenses and Currency settings.

Section 5 From the Open a recent Job section of the Start page, you can open the Training job or
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Section Description

click More to open your list of jobs.

Section 6 You have the option of creating a new job from scratch, a template, from an existing job,
or using the Bid Wizard.

2.1.2 Overview – Backstage View

2.1.2.1 Archive / Restore

From the Backstage View, you can back up and restore your jobs using the Archive/Restore feature.

Step by Step — Archive and Restore a Job

1. Click File to open the Backstage View.

2. Select Archive / Restore.
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l Several options appear for archiving and restoring your jobs and library

3. Select Archive Job.

l The Job Register appears

4. Select the Training Job, then click OK.

5. When prompted to include attachments, click Yes.

l The Save As window appears

6. Browse to where you want to save the job, then click Save.

7. To restore the job, select Restore Job Archive from the Archive / Restore page of the Backstage
View.

8. Browse to the archived job and select it.

9. Click Open.

l If the job already exists, a prompt will appear asking if you want to overwrite it

l To overwrite it, select Yes

l If you select No, you will be prompted to save it under a new Job Code

2.1.2.2 Settings

From the Settings in the Backstage view, you can adjust some system settings:

l General Settings

l Default Job Start page

l Decimal Precision

l Currency
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l Account Code Settings

2.1.2.3 Prompt to Save

An important setting to visit in the Tools menu is Prompt to Save. InEight Estimate does not
automatically save your work. Instead, it will prompt you to save as often as you specify in the general
settings.

2.1.2.4 Decimal Precision

The Decimal Precision setting is also helpful. This is where you can specify the way your numbers
display in the system. For example, you may want your costs to display to the hundredth decimal place
(2), and your quantities to display as whole numbers with nothing to the right of the decimal (0).

Changing decimal precision does not affect the way your numbers are calculated.
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2.1.3 Open a Job Folder

From the Backstage view, you can open a job folder by selecting Start. This opens the Start page,
where if you see your job, simply click on it to open it. If it’s not showing, click onMore… and select the
job from the Job Register. The Job Register is the form that lists all of your existing job folders so you
can select the one you need.

Step by Step — Open a Job Folder

1. From the Backstage view, under the Open a recent Job section, double click on your job.

2. The job folder opens by default to the Cost Breakdown Structure Register.
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You can change the default form that opens when you start up a job. From the Backstage view,
click on Settings to change the Job Startup > Start Page settings.

2.1.4 Help Bubbles

Help bubbles appear at various times in InEight Estimate, including the first time you open InEight
Estimate. These messages contain important information to clarify key functions in the system.
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You can dismiss the message until the next time by closing it with the X in the corner or dismiss it
permanently by clicking the Never offer this help again link.

2.1.5 Data Map

Found in the Price tab, the Data Map is a great way to view a high level summary of your estimate and
can be accessed at any time during the estimating process. You can see totals of direct costs, indirect
costs, profit, and overall bid price.
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2.1.6 InEight Estimate Layout

The layout of InEight Estimate is workflow based. You will move from left to right on the tabs as you
enter your data for the project and work on developing your estimate.

2.1.7 Overview - Setup Tab

Section Description

1 Initialize

From the initialize section, you can access the following registers. Job Properties
is where you enter the basic project details. Foundation Setup Data is where
you populate all account codes and validated fields. The Pay item & Proposal
Register provides an alternate structure to distribute estimated values. Bid
Wizard helps automate the process of setting up estimates by copying
information that already exists in other jobs.

2 Resources In the Resources section, Resource Rates opens the Resource Rate Register,
where detail costs for labor, equipment and material is stored. The Resource
Assemblies opens the Resource Assembly Register, where you create a
combination of resources as an assembly and reuse it as needed in multiple
cost items.

3 Assemblies
You can create a Cost Item Assembly to automatically estimate different scopes
of work based on input values. Standard tables – allow you to create tables of
reference data that can be accessed in any cost item assembly.

4 Reports The Reports section is available from any tab. Depending on the tab you access
it from will bring you to reports specific to that tabs data. Here you will find
reports on resources such as Resources Changes, Resource Utilization, and
Resource Cost Details.
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2.1.8 Overview – Estimate Tab

Section Description

1
Breakdown
Structures

From the Breakdown Structures section in the Estimate tab you can access the
Cost Breakdown Structure (CBS) Register, Account Code Utilization Register, and
Work Breakdown Structures (WBS) Register.

2 Resources Resource Rate Register is where you create or modify the rate charged for
labor, material and equipment resources. Different views of the Resource Rate
register such as Resource Utilization and Resource Cost Details are available
from the Resources section.

3
Excel
Workbook

InEight Estimate's integration with Microsoft Excel is a two-way integration that
allows you to update register fields in Estimate with data contained in an Excel
workbook, and update Excel cells with data contained in a register field in
Estimate. This is where you open the embed excel workbook which is
maintained as part of the estimate job folder and where you preform the sync
functions to send values back and forth.

4 Schedule From the Schedule icon, you can access bi-directional integration with
Microsoft Project and Oracle Primavera. The Cash Flow graph displays the
projected cash flow of your project, along with the job financing expense,
individual cost category costs and resource utilization.

5
Indirect Cost
Items

Indirect Cost Items filters the CBS register to display cost items that contain
overhead costs that are not directly associated with any particular deliverable
items. Clicking on % Price Add on or Prime Bond opens up these individual
records.

6 Overhead
and Profit

Price Breakdown Structure (PBS) Register is a visual run-down of the costs and
profit that make up your Target Price. You can access the Direct and Indirect
Markup records or see totals of direct costs, indirect costs, profit and overall
bid price summarized in a Data Map.
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Section Description

7 Alternates
Alternates are used to define alternate scenarios in order to assess the impact
of those scenarios.

8 Reports From the Reports section, you can run reports on CBS Summary, CBS Details,
CBS Outline, CBS Estimate Summary, CBS Currency Comparison.

2.1.9 Overview – Quote Tab

Section Description

1 Setup

Quotes are organized using Address book, Quote Group Tags, Minority Setup
and attachments in the Setup section. Address book stores and maintains all
information pertaining to subcontractors, vendors, architects/engineers, etc.
that you work with regularly. The Minority Setup tab within Job Properties
stores information about the agency that authorizes the status of Minority
Enterprises along with their different types. You can use Quote Group Tags
to group together multiple resources or cost items that will be sent in a
single request for quote package to solicited contractors or vendors..

2 Quote
Management

Quote Management allows you to access the Requests for Quote (RFQs)
register and Quotes. Request for Quotes (RFQs) are invitations to sellers,
requesting that they submit pricing to provide services, equipment or
material based on the line items and resources included in your estimate.
The Quote Register stores all of the quote responses you receive for that
job.

3 Quote The Quote Comparison & Award section allows you to perform comparative
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Section Description

Comparison &
Award

analysis across all the quotes you’ve received. You can view a comparison of
submitted pricing by resources or cost items.

4 Reports From the Reports section in Quotes you can run reports on Quote Summary,
Quote Record, Compare & Award, and Minority Participation.

2.1.10 Overview – Price Tab

Section Description

1 Pay Items

From the Pay Items section you can lock Cost items to Pay items and access the
Pay item & Proposal register. Under Pricing in Job Properties, you can set up
how the tool is calculates profit and spreads pricing to your pay items. You can
also access Competitor’s bid information in Job Properties..

2 Overhead
and Profit

The Price Breakdown Structure (PBS) Register is a visual run-down of the costs
and profit that make up your Target Price. You can access the Direct and
Indirect Markup records or see totals of direct costs, indirect costs, profit and
overall bid price summarized in a Data Map.

3 Audit Log
You can access the PBS Changes register (which logs any changes that effect the
Target Price) and turn on/off logging PBS changes..

4 Alternates Alternates are used to define alternate scenarios in order to assess the impact
of those scenarios on the total estimate value.

5 Reports From the Reports section in the Price tab, you can generate reports for
Standard Proposal, DOT Proposal, Pay Item Summary, Pay Item Currency
Comparison, Pay Item Price Breakdown.
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2.1.11 Overview – Execution Tab

The Execution Tab is for Customers who are utilizing the Job Tracking functionality within InEight
Estimate. InEight Control users can disregard this tab.

Section Description

1 Job Tracking

You can customize the titles and colors for
different fields. You can export and import
saved Views, Titles, Colors and Output
Settings. You can customize reports generated
by Estimate using External reports. External
References allows you to open external
programs with Estimate.

2 Overhead & Profit Commitments tracks how much of the
current budget has been committed for
expenditure. Pay Requests and Approvals
automatically calculates earned revenue to
provide the data you need to bill your client,
as well as approve invoices from your
suppliers and subcontractors.

3 Change Management

Budget/Contract Changes is the only way to
change current budget or add a pay item after
the project has been released for execution
and the Original Budget locked. Create
Original & Current Budget sets the original
and current budget for the project. These
should be equal when you initially create it (at
the beginning of project execution). Current
budget is the only thing that can change after
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Section Description

execution. Remove Original & Current Budget
removes original and current budget values.

4 Reports and Exports From the Reports icon, you can run multiple
reports on the project. Exports can export
budget file, schedule, and timesheet to many
different formats.

2.1.12 Overview - System Tab

Section Description

1 Custom

You can customize the titles and colors for different fields. You can export and
import saved Views, Titles, Colors and Output Settings. You can customize reports
generated by Estimate using External reports. External References allows you to
open external programs with Estimate.

2 Help You can access a comprehensive help system from the Help menu. You can get
information about the Estimate Version and all new updates about the different
versions.

2.1.13 Library

Click on the Library icon and the Library opens in its own window.

Users with sufficient security can access master information available in the Library.
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The Library is covered in greater detail in "3.1 Library Overview" on page 85

2.1.14 Open Forms

The following steps assume you already opened the Training Job.

Step by Step — Open Forms

1. Click on the Setup tab.

2. In the Initialize section of the Setup tab, click on the drop-down menu for Job Properties.

3. Select Overview to open the Job Properties form.
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l Notice that each form opens in its own tab within the active job folder

l You can tab between these forms as you are working in InEight Estimate

l Once you are in a register, the Actions and More Actions tabs are available to you. The options
available are contextual to that register
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2.2 SYSTEM SETTINGS

From the Backstage View, you can access system settings. System settings contain options and settings
that effect the entire InEight Estimate system. These settings include:

l General settings (options)

l Network settings

l Attachment settings

l Licensing information and settings

l Currency settings

The following step by step walks you through configuring general settings (options).

Step by Step — Decimal Precision

1. With InEight Estimate open, click on the File tab to go to the Backstage view.

2. Select Settings.

3. Select General under Options in the node tree on the left.

4. To activate Prompt to Save, select the Prompt to Save checkbox.
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5. Select how often you want to be prompted (in minutes).

6. Select Decimal Precision in the tree on the left.

7. Review the default settings.

Units of Measure will default to English, and Currency will default to U.S. Dollar.

2.3 COLUMNS

Within each register, you can move, sort, filter and group your columns to view the information the
way you need to see it.

2.3.1 Move Columns

You can move columns by selecting a column header and using drag-and-drop. If there are columns on
the register that you don’t use, you can hide and unhide them from view, as needed.
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Step by Step — Move Columns

1. In the CBS, click on the Currency column header and drag the column to the left, dropping it to
the right of the Description column.

2. Hide the Optional Code column by dragging the Optional Code column header down until a black
X appears, then let go.

l The Optional Code is now hidden from view

l To unhide a column, right click on any column header and select Column Chooser; a
Customization window appears, which contains all the hidden columns in that register

3. Find the column you want to unhide and drag-and-drop it to the location where you want it to
go.
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l You can also unhide a column using the Go To Column feature

4. Right click on a column header and select Go To Column.

5. Click on the drop-down menu and select the column you want to unhide.
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6. Click OK.

2.3.2 Sort and Filter Columns

You can sort and filter your columns to drill down to specific information.

Step by Step — Sort Columns

You can sort on any column by clicking once on the column header.

1. In the CBS Register, click on the Total Cost (Forecast) column to sort the column in ascending
order (e.g., 1 to 10, A to Z).

2. Click the Total Cost (Forecast) column a second time to sort in descending order (e.g.,10 to 1, Z
to A).

Use Ctrl-click to unsort a column and reset it to its original state.

Step by Step — Filter Columns

1. In the CBS, hover over the Unit of Measure column header for the filter icon to appear.

2. Click on the filter icon in the Unit of Measure column to select a filter value.

l From the filter list, you can select any of the values defined for that column or you can use
one of the predefined values (Custom, Blanks, Non blanks).
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3. Make your selection, then click OK.

4. To clear the filter, click on the red X at the bottom of the form or click on the filter icon on the
header of the column you filtered and select (All), then click OK.

2.3.2.1 Filter Editor Overview

The Filter Editor displays conditions and groups as a tree branching system.

The Filter Editor grouping feature allows you to increase the amount of And/Or statements that
originated from the first selected And statement. When you add a new Group, a new Condition is
automatically added to that Group.

With each additional Condition statement, you will need to select an operator and a value in order for
your customized filter to take effect on your chosen column. Many new operators have been added to
this version as shown in the screenshot below:
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Step by Step — Filter Editor

1. In the CBS, hover over the Unit of Measure column header for the filter icon to appear.

2. Click the filter icon in the Unit of Measure column to select a filter value.

3. Select the Filter Editor button. The Filter Editor data box appears.

l By default, an And statement is created with a Begins with operator and a blank value.

4. Select your preferred operator and then enter in your preferred value.

5. To add additional And/Or statements, select the word And in the top left corner. A drop down
appears.
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6. Choose which And/Or statement to add and then select the preferred operator.

7. Enter in your preferred value to complete your additional statement.

8. Select the X to delete a single statement.

9. Select the And statement in the top left corner to begin clearing all And/Or statements.

10. From the drop down, select the option Clear All.

11. Once done, select Apply and then click OK.

2.3.3 Group Columns

Sometimes you may want to organize your information into groups. Instead of filtering your
information down to one value (e.g., unit of measure = Ton), you can look at your information with a
separate group for each value (e.g., a group for Tons, a group for Cubic Feet, etc.).

Step by Step — Group Columns

1. From the CBS register, group the Unit of Measure column by dragging it into the grouping area
(where it says “Drag columns here to group”).

InEight Inc.  |  Release 19.2 Page 79 of 962

Estimate User Guide 2.3 Columns



l Notice that the cost items in the register are now grouped together by their units of
measure, and each group of cost items is subtotalled by costs, hours, quantities, etc.

2. To ungroup, right click in the grouping area and select Clear Grouping

l The column returns to its original location

You can group by more than one column to have multiple grouping levels.

2.3.4 Saved Views

Once you have set up a view the way you like it, you can save the view so you won’t have to configure
it again later. InEight Estimate also comes with some pre-built views to help you organize the screen
the way you want to see it.

Views are accessed from the Saved Viewsmenu in the top right portion of a register.

The following steps assume you have made changes to your register view and want to save it for future
use.
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Step by Step — Create a Saved View

1. In the CBS register, click on the Saved Views drop-down menu and the Save disc icon appears.

2. Click on the Save disc icon.

l The Save Current View window appears

3. Enter the View Name, then select OK.

l The new view displays in the drop-down menu

Saved views are user-specific; you will only see your own saved views when you are
logged in.
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Lesson 2 Review

1. The _________ is a great way to get a summary view of your bid. You can see totals of
direct costs, indirect costs, profit and the overall bid price.

a. Job Folder

b. Data Map

c. System tab

d. Resource Rate Register

2. You can group by more than one column to have multiple grouping levels.

1. True

2. False

3. Display settings for Units of Measure, Currency, and Colors can be adjusted from the
_______ tab.

a. Setup

b. Estimate

c. System

d. Help

Lesson 2 Summary

As a result of this lesson, you can:

l Navigate the InEight Estimate system interface

l Navigate system settings

l Manage columns in InEight Estimate registers

Page 82 of 962 InEight Inc.  |  Release 19.2

Lesson 2 Review Estimate User Guide



InEight Inc.  |  Release 19.2 Page 83 of 962

LESSON 3 — LIBRARY SETUP
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l Library Job Properties

l Library Foundation Setup Data Register

l Library Resource Rate Register

l Library Assembly Register
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3.1 LIBRARY OVERVIEW

The Library is where you set up and maintain master information that imports into your projects,
including resource rates, tags, units of measure, cost item assemblies, and master breakdown
structures. It is also where security roles and permissions are configured.

You access the Library from the Backstage view in Estimate. Click on the Library link to open.

You can also access the Library by clicking on the Library icon, when on the InEight Estimate landing
page.
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When the Library opens, you see ribbons available under the main menu tabs. Each Menu tab has
unique sections which hold the necessary forms. In this lesson you will learn about each tab and their
components.

3.1.1 Library Tabs

The Library has six tabs which organizes the forms under sections. The tabs are:

l Setup

l Estimate

l Execution

l System

The Actions and More Actions tabs appear when you open a register and contain functions for the
register you have active.

3.1.1.1 Setup Tab

Name Description

1
Job
Properties

The job properties maintained in the library will serve as the default settings
for any new estimate that is created from scratch. When creating a new job it
will inherit all the job properties set in the master library.

2 Foundation
Setup Data

A master set of account codes, tags, and units of measure. When a new folder
is created, the master set is automatically copied from the Library to the new
folder.

3 Address Book
Used to store and maintain all information pertaining to the companies with
whom you work and contact regularly (subcontractors, vendors, architects,
etc.).

4 Trench
Calculator

Stores and maintains common trench configurations that are used from
project to project.

Overview - Setup Tab
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Name Description

5
Shift Rate
Calculator

Allows you to set up shift rate configurations that you can access at the
project level.

6 Resource
Rates

Opens the Library Resource Rate Register where you can create and edit all
resources and resource cost details available for import into your projects.

7
Most Used
Resources

For quick access to the Labor, Equipment and Materials tabs of the Master
Resource Rate Register.

8 Resource
Assemblies

Takes you to the Library Resource Assembly Register where you can set up
resource assemblies to import into individual projects.

9
Cost Item
Assemblies

Cost Item Assemblies are predictive models to quickly and accurately estimate
elements of a job that can be repetitive in nature on the job or from job to
job.

10 Standard
Tables

The Standard Tables are used to create and/or list job-level table data that is
accessible by any of the Cost Item Assemblies that exist in a job. The Standard
Table Record allows the user to create and or modify a Table record. The
Standard Table Register lists all the job level tables created / available in the
project.

11 User Roles

Opens the Register where you assign users to a role which can include the
forms, tabs and menu commands to which each role has access. The user
names that are used when setting up your User Profiles come from Active
Directory, and they are the user names that each user uses when logging onto
his/her personal computer.

12 Access
Control

Allows you to customize your system permissions by restricting destinations
or commands that only designated roles should have access to.

13 Reports
Opens the Reports window, where you can access all system reports and
configure the default report settings.

Overview - Setup Tab (continued)
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3.1.1.2 Estimate Tab

Name Description

1

Cost
Breakdown
Structure
(CBS)

Opens the Library Cost Break Structure register, where you can define the CBS
that will automatically import when a new project is created.

2 Account
Code
Utilization

Used to roll estimate line items into an account code hierarchy and benchmark
against historical projects in a way that is consistent across projects.

3
Work
Breakdown
Structures

Opens the Library Work Break Structure register, where you can define
additional Work Breakdown Structures that will automatically import when a
new project is created.

4 Master
Workbook

Opens the master Microsoft Excel template which will be embed into each new
estimate job folder. The cells in the embed excel workbook can be linked to
send information to or from InEight Estimate Fields.

5
Indirect Cost
Items

Takes you to the Library Cost Breakdown Structure Register where you can edit
and define indirect cost items.

6 Job Finance Takes you to the Library Cost Breakdown Structure Register where you can edit
the Job Financing cost item.

7
Price % Add
On

Takes you to the Price % Add On record, where you can define the price % add
to be included in the Library CBS.

8 Prime Bond Opens to the Library Prime Bond record where you can define the bond tables
that will import automatically when a new project is created. 

9 Reports
Opens the Reports window, where you can access all system reports and
configure their report settings.

Overview - Estimate Tab
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3.1.1.3 Execution Tab

Name Description

1
Timesheet
Warehouse

Used to document for any period of time (day, week, month, etc.) the
employees and machines employed on a cost item (tracked by Account, Phase
or CBS Code), how many hours they are employed and optionally, the quantity
of work they accomplish.

2 Publish Jobs
for
Timesheet
Warehouse

Links to the Job Register to publish jobs from the Timesheet Warehouse.

3

Unpublished
Jobs for
Timesheet
Warehouse

Opens up a list for to view the unpublished jobs from the Timesheet
Warehouse.

4 Published
Jobs

Opens to a Register to show the published jobs from the Timesheet
Warehouse.

4
Employees &
Machines

Opens a register which list all of your company's employees and machines,
including their identification number and other associated codes.

5 Reports Opens the Reports window, where you can access all system reports and
configure their report settings.

Overview - Execution Tab
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3.1.1.4 System Tab

Name Description

1 Customize
Window to customize the field titles that are displayed throughout various
screens in the system, including all cost category titles, user-defined Tags, and
more.

2 Saved
Views

Allows you to save your views onto a disk or load from a disk. 

3 Titles Allows you to save titles onto a disk or load from a disk. 

4 Colors Allows you to save your colors onto a disk or load from a disk.

5
Output
Settings

Allows you to save your output settings onto a disk or load from a disk.

6 External
Reports

Menu to not only generate reports created by Estimate, but also to open
programs, folders, documents, reports, or Internet resources with the
associated program.

7
External
References

Allows you to open programs, folders, documents, reports, or Internet resources
with the associated program.

8 Help
Section

Offers you links to Estimate’s general Help menu, information about Estimate
(i.e., version number, system information, tech support, etc.), What’s New in the
new version, and InEight’s external website.

Overview - System Tab
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Customized Job Folder Tags match the view of the fields in the Job Properties form.

3.2 LIBRARY JOB PROPERTIES

The Library Job Properties form serves as a template for new jobs. Some of the tabs on the Library Job
Properties form hold basic settings that will require a default selection which will apply to all new jobs
created from scratch. Time can be saved when utilizing Library Job Properties, because the data and
settings you fill out will be automatically imported into a new job. Once imported, these settings can
be changed at the job level if necessary.

It may be helpful to complete the following tabs / fields at the Library level:

l Overview Tab Notes Field:  Filling out the Notes section at the Library level would be helpful for
any instructions or reminders that you want to display on all projects’ Job Properties form. For
example, “Always double check currency exchange rates”

l Cost Basis Tab:  Shift arrangements may or may not be standard across all projects, as well as
wage rates and scales. The cost basis default rules should be established within the library.

l Fuel Cost Tab:  Entering a default fuel cost here will factor with the utilization of your equipment
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to be included in your equipment rates

3.3 LIBRARY FOUNDATION SETUP DATA

Foundation Setup Data is where all drop-down options within Estimate fields are stored. These can
serve as category labels, alternate structures or validated tag fields. The different validated fields are
organized into tabs on this form.

You should be aware of these category labels:
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Category Labels

Name Definition

Account
Codes

These codes will be set up on the back end and will help you compare your cost and
production rates to similar cost items in past projects.

Tags
Some tags are already set up for you. Additional tags can be created and used to
group and filter your items.

Work
Breakdown
Structures

Use this format when you need to have multiple variations and summary reports of
an estimate. WBS retains the same relationships between items as in the original
estimate and only changes the view and how items are arranged in hierarchy.

Units of
Measure

These are standardized to relate to one another by a conversion factor. If you need to
create a new unit of measure, you will need to reference it to a base unit of measure
and can include a conversion factor to allow you to convert back and forth between
English and Metric.

Currencies The default currency is set to U.S. Dollar, but you can also enter the exchange rate
for other currencies (such as Canadian) so you can estimate with whatever currency
you need. Multiple currencies can be used in the same project. The system base
currency can be changed from USD in the backstage view settings, but is a global
change for the entire estimate environment.

When you create a new job folder, all category labels defined in the Library Foundation Setup Data
Register will be copied to the new job folder automatically.

3.4 RESOURCES

VIDEO | Create a Unique Resource
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InEight Estimate refers to labor, equipment and material items as Resources. You will use these
resources as the basic building blocks used to detail the costs in your estimates.

InEight Estimate organizes resources into seven types:

Resources

Name Description

Labor The human resources that perform direct or indirect work. Direct labor is typically
classified by trade (e.g., pipefitters, electricians, iron workers) and title (e.g.,
foreman, journeyman, laborer).

Construction
Equipment

Owned construction equipment.

Rented
Construction
Equipment

Construction equipment rented from a third party.

Installed
Materials

Materials that will remain installed on site after the project is completed, (e.g.,
concrete, piping, aggregate).

Installed
Equipment

Equipment that will remain installed on site after the project is completed, (e.g.,
boilers, heat exchangers, vessels, cooling towers).

Supplies
Expendable items that will not be permanently installed (e.g., small tools,
consumables).

Unique Resources that are of a “unique” nature and do not fit well into the other types
(e.g., dump fees, hauling charges and equipment rented by the month).

After creating a new job folder, you can import a filtered set of resources from the Library into the new
project. This is done on the Cost Basis tab of the Job Properties form.

In the following section, you will learn more about the resources stored in your Library in the Library
Resource Rate Register.

3.4.1 Library Resource Rate Register

To open the Library Resource Rate Register, select Labor from the Master Resources ribbon.
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Overview – Library Resource Rate Register

Name Description

1 Tabs
There are tabs along the top of the form for each of the seven resource types, in
addition to an All tab that holds the resources of all types.

l Notice that you are on the Labor Tab

2 Resource
Code

Each record (or row in the register) represents a single resource.

3 Description The Description provides more detail about the resource.

4 Resource
Rate per
Unit

This is the resource cost per unit.

5
Utilization
Count

Tells you how many units of that resource are being used in the job.

6 Unit of
Measure

Each resource is defined with a Unit of Measure.

7 Register
This register includes columns for the resource attribute categories so you can
filter and group your resources.
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Resource rate add and search tips:

l You cannot add new resources on the All tab.

l You can search for resources in the Resource Rate Register using the ‘Find’ field.

Next you will take a look at the different types of resources and how the differ when we drill into
resource rate records from each category.

3.4.2 Labor Resources

Looking at your Labor resources more closely, you will see all the Resource Codes for the Labor
resources begin with an L. This is a best practice for naming and organizing your resources, but you can
also use another organizational method of your choice.

3.4.3 Resource Rate Record

If you need to add cost to a resource, adjust a rate, or just view a more detailed breakdown, you can
open the resource’s rate record. From the Library Resource Rate Register, double click on the row
header for the resource you need to view in greater detail.
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Overview – Resource Rate Record

Name Description

1 Record The record references the resource you are editing.

2 Charge Rate The Charge Rate tab is the tab the record defaults to and is where you define
the cost of the resource.

3 Scale Buttons
The Scale buttons only show up on labor resources. They are used for defining
regular time, overtime and double time rates for the resource.

4 Cost
Category
Breakdown

The Cost Category Breakdown is where you enter the costs for the resource.
The categories will depend on what type of resource it is (e.g., equipment
resources will have equipment cost categories and materials will have material
cost categories).

5

Special
Instructions /
Base Wage
Factors

The right side of the record will have additional options to help you define the
rate. These options change depending on what type of resource it is.
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Name Description

6 Setup
There is also a Setup tab where you can define the resource’s attributes an a few
other settings. These attributes are used for filtering which resource rates to load
into a new estimate.

7 Cost
Driver

Labor resources default Cost Driver is CI Duration which means their costs are
driven by time.

8
Default
Quantity

The Default Quantity is typically set to 1 for most cases if you are bringing in the
resource you are using at least one.
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The following steps walk you through how to create a new labor resource.

Step by Step — Create a Labor Resource

1. From the Library landing page, on the Setup tab, click on Resource Rates from the Master
Resources section.

l The Library Resource Rate Register opens

2. Select the Labor tab.

3. Right click on any row header and select New.

l A new Labor Rate Record displays

4. In the Code field, type L + [your initials].

5. Press the Tab key.

6. Fill in the Description field.

7. Click on the resource’s Setup tab and select Standard Labor Rate File from the Resource File
drop-down list.

8. Select a location for the Geographic Area.

9. SelectWage Zone A for Wage Zone.

10. Select a labor type for the Organizational Category.

11. For Tag 2, select a code.
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12. For Tag 1, select a code.

13. On the Charge Rate tab, enter a dollar value for your Labor Base.

14. Expand Labor Burden and under Labor Fringes, type in a dollar value for Pension and
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Subsistence.

15. Define an overtime and double-time rate for the resource. Select the checkbox for Use Base
Wage Factors for Scales 2 and 3.

16. Set the Scale 2 Factor to 1.50 x Base Wage and Scale 3 Factor to 2.00 x Base Wage.
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17. Click OK, to close the record.

3.4.4 Construction Equipment Resources

l Similar to Labor Resources, Construction Equipment Resources are also duration driven
resources by default

l They contain cost categories for ownership and operation costs

These resources are the fleet of construction equipment that you own.

3.4.5 Rented Equipment Resources

These resources represent the construction equipment that you rent.

l Rented Equipment Resources are also duration driven resources by default

l Contain cost categories for rental and operation cost as well as additional fees

l On the Rental Construction Equipment Record, you will notice a new tab named Quote

l Quotes will be discussed in detail in Lesson 8 – Quote Management

l You will also note the Tax section. You can check the box to Apply Standard Tax, which pulls the
Sales Tax percentage defined on the Cost Basis tab in Job Properties, or you can manually specify
a unique sales tax rate
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Step by Step — Create a Rental Equipment Resource

1. Open the Library Resource Rates Register.

2. Select the Rented Construction Equipment tab.

3. Right click on any row header and choose New; a new Installed Rented Equipment Rate Record
displays.

4. In the Code field, type RECR + [your initials], then press Tab.

5. In the Description field, type Crane 110 Ton.

6. Click on the resource’s Setup tab and select Standard Rental Rate File from the Resource File
drop-down list.

7. Select a resource from the Organizational Category drop-down list.

8. Move back to the Charge Rate tab to follow the step by step on the next page.

3.4.6 Equipment Consumption Rates

The Construction Equipment and Rented Construction Equipment Resource Rate Records include
consumption rates that will factor with the fuel cost you define on the Library Job Properties > Fuel
Cost tab to give a fuel cost for your equipment rate.
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The below figure shows where consumption rates are defined on the Construction Equipment
Resource Rate Record.

3.4.7 Non-Hourly Rate Calculator

For owned and rented construction equipment, the rate entered must be hourly. If your rate is weekly
or monthly, you can use the Non-Hourly Rate Calculator on the Construction Equipment Resource
Record to come up with the hourly rate.

Step by Step — Non-Hourly Rate Calculator

1. Refer back to your last entry's rate amount. Under Non-Hourly Period Charge Rates on the right,
check the Calculate Non-Hourly Period Charge Rates checkbox.

2. On the resulting prompt, click OK.

3. In the Period field, selectWeekly.

4. In the Amount Per Period field, type in a number value.

5. Type in a number of hours in the Hours Per Period field.
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6. Click OK to close the record.

3.4.8 Installed Materials, Installed Equipment & Supplies Resources

l Comparing the Installed Material & Equipment resources to those covered so far, you will note
that the unit of measure is not Hour for materials, but it is specific to the kind of material. It is a
quantity-driven resource, as opposed to duration-driven like your labor and equipment
resources
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l You will also note the tax field can pull your standard tax settings from the Cost Basis tab in Job
Properties, or a unique sales tax rate can be manually entered in each record

l On record for these resource types, you will notice a new tab named Quote. This tab shows up
here because you may have to shop around and get quotes for these resources

l Quotes will be discussed in detail in Lesson 8 – Quote Management

l In the Setup tab you will see a field named Waste % Add-on. Here you can account for
approximate waste percentages

l Cost categories will differ on each type of resource record

Above is an example of the Installed Material tab in the Library Resource Rate Register.

The following steps walk you through how to create a new material resource in InEight Estimate.

Step by Step — Create an Installed Material Resource

1. Select Resource Rates from the Library landing page.

l The Resource Rate Register displays

2. Select the Installed Material tab.

3. Right click on any row header and select New from the drop-down menu.
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l A new Installed Material Rate Record displays

4. In the Code field, typeMGBP + [your initials], then press Tab.

5. In the Description field, type Brick Pavers.

6. Select a unit of measure from the Unit of Measure drop-down list.

7. On the resource’s Setup tab, under Resource File select Standard Material Rate File.

8. On the Charge Rate tab, expand Materials and enter a number value in the Installed Materials
Amount field.

9. Click OK to finish adding this resource.

3.4.9 Unique Resources

The Unique resource type is a catch-all and can be used for anything from dump fees and security to
creating subcontractors as a resource.

l The Unique resources are the only resources that have all cost categories available, as well as all
units of measure

l You will also note the tax field which can pull your standard tax settings from the Cost Basis tab
in Job Properties, or a unique sales tax rate can be manually entered in each record
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l Quotes will be discussed in detail in Lesson 8 – Quote Management

3.5 RESOURCE ASSEMBLIES

A Resource Assembly is a group of resources. You can create an assembly once and then reuse it as
needed in multiple cost items whenever the same combination of resources is needed.

The most common use for an assembly is to group labor resources into crews (e.g., Pipe Crew,
Concrete Crew); however, any resource (equipment, materials, etc.) may be grouped into an assembly.
Utilizing assemblies allows you to estimate faster, since you can add and manage an entire group of
resources at once.

You can create assemblies in the Library and import them into job folders the same way you import
resources.

3.5.1 Library Resource Assembly Register

To open the Library Resource Assembly Register, select the Library icon, then select Resource
Assemblies from the Master Resources section of the Setup tab.

Overview – Library Resource Assembly Register

Section Description

1 Each row in the register represents a single resource assembly and is defined with an
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Section Description

Assembly Code and Assembly Description.

2 Each assembly can be expanded by clicking the plus icon next to its Assembly Code.

3

Expanding an assembly reveals the list of resources that make up that assembly.
l Best practice for creating Assembly codes is to use C for Crew Assemblies, M for

Material Assemblies, etc., however you can have labor, equipment, and materials in
the same assembly

3.5.2 Resource Assembly Record

To open an existing Resource Assembly Record, right click on the row header of an assembly (row) on
the Resource Assembly Register and select Open.

Overview – Resource Assembly Record

Name Description

1
Assembly
Code and
Description

Each assembly is defined with an assembly Code and an assembly Description.

2 Quantity
and Unit of
Measure

Each assembly has a quantity and unit of measure. The default is 1 EA. For crew
assemblies with all hourly duration driven resources, it is a best practice to
change the Qty to Hour, so that when used on a cost item, it will show you the
assembly’s unit cost per hour.
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Name Description

3
Assembly
Details

The rows in the Assembly Details register represent the resources that make up
the resource assembly.

4 Notes An area where the estimators make notes for records related to the resource
assemblies for work orders which is commonly performed by a type of crew.

3.5.2.1 Productivity Rate Indicator in the CBS Register

The Productivity Indicator shows the field that contains the as-entered value and is driving the
estimate for that cost item. This appears as an arrow aligned to the left of the cell as shown below.

Being able to see productivity drivers on the CBS register makes it easier to review and modify the
estimate as a whole while reducing the potential to accidentally overwrite a manually entered data.
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Follow the step by step below to create a Resource Assembly.

Step by Step — Create a Resource Assembly

1. From the Library landing page, under the Master Resources section of the Setup tab, select
Resource Assemblies.

l The Resource Assembly Register is shown.

2. Right click on any row header and select New from the drop-down menu.

l A new Resource Assembly Record is shown.

3. In the Code field, type CEXC + [your initials] as the unique code for the assembly.

4. Add a description in the Description field.

5. In the Assembly Details register at the bottom of the screen, click in the Resource Code column
in the first blank row, and then select the Resource icon that appears in the cell.

6. On the Labor tab of the resulting register, select the resource with the Description: LL2Laborer
and click OK to add this resource to the assembly.

7. Add two additional resources.

You can use the Ctrl and Shift keys to select multiple resources at once.

8. Click OK to save and close the new assembly.
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Exercise 3.1 — Create Resources & Resource Assemblies

In this exercise, you will practice creating resources and assemblies in the InEight Estimate Library. In
the Library Resource Rate Register, create resources with the following variables:

Resource Code LSFA Wage Zone Wage Zone A

Resource Description Field Administrator Organizational Category Supervision

Geographic Area Southwest Scale 1 Labor Base $33.45

Scale 1 Premium 2 percent Scale 1 Subsistence $0.47

Resource File Standard Labor Rate File

Select the checkbox for Use Base Wage Factors for Scales 2 and 3.
Scale 2 Factor: 1.50 x Base Wage. Scale 3 Factor: 2.00 x Base Wage.

Labor Resource

Rented Construction Equipment Resource

Resource Code RPW3000 RE Rental Amount $3.40

Resource
Description

Pressure Washer 3000 PSI
Organizational
Category

Clean & Inspect

Resource File Standard Rental Rate File

Installed Material Resource

Resource Code MCCB Installed Materials Amount $300.00

Resource
Description

Pre-Cast Concrete Catch
Basin

Organizational Category Concrete

Resource File Standard Material Rate File

Unit of Measure Each

Uncheck the box for Apply Standard Tax and enter a Unique Sales Tax Rate: 6%

Rented Construction Equipment Resource

In the Library Resource Assembly Rate Register, create resource
assemblies with the following codes, descriptions, and resources
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Assembly Code CBRIDGE

Assembly Description Bridge Crew

Resource File Standard Assembly File

Unit of Measure Hour

SelectWage Zone A Labor Resources for this Assembly.

Resources on Assembly Resource Description Resource Quantity

LC3 Carpenter Foreman 1

LL2 Laborer 2

LF2 Finisher 1

LC2 Carpenter Journeyman 2

Assembly #1

Assembly Code CRIPRAP

Assembly Description Rip Rap Replacement Crew

Resource File Standard Assembly File

Unite of Measure Hour

SelectWage Zone A Labor Resources for this Assembly.

Resources on Assembly Resource Description Resource Quantity

LT2 Teamster Foreman .5

LO3 Operator Class 3 1

LL2 Laborer 2

EX510 Backhoe JD 510 1

ETPU Pickup 1

EL950 Loader 950 1

Assembly #2

You should end up with the following results
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Congratulations, you have completed this exercise!
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Lesson 3 Review

1. When you create a new job folder, all category labels defined in the Library Foundation Setup
Data Register will be copied to the new job folder automatically.

a. True

b. False

2. This resource type is a catch-all and can be used for anything from dump fees and security to
creating subcontractors as a resource.

a. Installed Materials

b. Unique

c. Labor

d. Construction Equipment

3. The Construction Equipment and Rented Construction Equipment Resource Rate Records include
consumption rates that will factor with the fuel cost you define where?

a. Library Foundation Setup Data

b. Library Resource Rates

c. Job Properties

d. Cost Breakdown Structure

Lesson 3 Summary

As a result of this lesson, you can define, adjust and explain:

l Library Job Properties

l Library Foundation Setup Data Register

l Library Resource Rate Register

l Library Assembly Register
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l Enter Job Properties

l Create pay items in the Pay Item & Proposal Register
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4.1 JOB CREATION

As discussed in Lesson 1, a job folder contains all pertinent information for a single project, and it is
independent from any other job. When you create a new job folder, all your estimating and managing
of the project will be stored in that folder.

First, you will create a new job from scratch.

Step by Step — Create a New Job

1. From the InEight Estimate Backstage view, under the Create a new Job from… section, select
Scratch, or select New > Scratch from the left sidebar menu.

2. On the New Job dialog, name the Code field.

l The Job Code must be unique to differentiate between projects

3. Type in a description in the Description field.
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l It is not required, but best practice is to have a good description to make it easier to find
the job

4. Click OK to create the new project.

4.2 JOB PROPERTIES

When you create a new project, the Job Properties form automatically displays. This is where you can
enter basic information about the project. To open the Job Properties form at any other time, on the
InEight Estimate landing page, select the Setup tab and click Job Properties.

4.2.1 Overview Tab

The Job Properties form opens to the Overview tab.

Name Description

1
Job Code and
Description

Contain the information you entered on the New Job dialog.
l The Description can be changed at any time if necessary
l The Code cannot be changed

2 Status Indicates where in the process this project is (e.g., Bidding, Awarded, etc.)
• When searching for jobs in the Job Folders list, you can filter and sort jobs
by their status

Overview – Overview Tab
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Name Description

• These job statuses can be adjusted to fit your company requirements in the
Jobs Register, Tools Menu, Job Statuses.

3 Notes

Used to document project specifics.
l Information in this field is created in InEight Estimate and it is not

integrated with other programs

4 Job created by Indicates the user or entity that initially created the job.

Overview – Overview Tab (continued)

You can change your Job Code by making a copy of the job with a new code.

4.2.2 Security Tab

When you set up the job, you can secure it so only those working on the estimate will have access. You
can adjust security at the field level or at the job level.

The following steps walk you through how to set up security. For now, you will leave the Security tab as
is without making any specific selections; however, the following steps guide you through making any
security changes when needed in the future.
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Step by Step — Set Up Job Level Security

1. On the Job Properties > Security tab, select the Restrict access to this Job… check box.

l Notice the checkbox to “Allow ALL users with Bid Wizard access to use this job as a source”
is checked by default. Make sure to keep this checked as well

2. Click the Add Users / Groups button to add users.

3. In the Select Users or Groups dialog, type the email addresses for those that need access and
then click OK.

l If you don’t know the email address, you can type the name of the user, and click the
Check Names box to find the appropriate user

l The job can now only be opened by those listed under Users allowed in this job
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4.2.3 Cover Sheet Tab

The Cover Sheet tab is where you can define much of the general information about the project. It
includes fields to identify the job’s location, contacts, and bid details.

The following fields are available:

l Job Location

l City, County, Country, Province/State

l Job Type

l Engineer

l Owner

l Architect

l Forecast Start and Forecast Finish

l Bid Date and Bid Time

l Bid Location

l Estimator

l Opening Type and Proposal Type

l Liquidated Damages (if applicable)

The fields on this tab can be helpful for historical reference and job classification. It is good practice to
complete as many of these fields as possible, so you can reference and find the project later. These
fields can be updated as needed at any time.
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4.2.4 Cost Basis Tab

The Cost Basis tab has some important settings that will affect how costs are calculated in your
estimate. The settings reviewed below are the ones you need to consider.

Name Description

1
Standard Shift
Arrangements

The default standard shift arrangements are set up as 8 hours per shift, 1 shift
per day, and 5 days per week; this can be changed if a project requires a
different standard shift arrangement.

2 Standard
Wage Rate
Composite:

Allows you to indicate what percentage of your labor hours will be regular
time (Scale 1), overtime (Scale 2) or double time (Scale 3). You can enter
these percentages manually, or you can use the Shift Rate Calculator to
obtain a more accurate figure.

3
Lock Cost Items
to Pay Items:

For this sample job, you will check this box. When Cost Items are locked to
Pay Items, your level 1 estimate structure is controlled by your list of pay
items.

4 Default
Currency:

The default will be set to U.S. Dollar, but this can be changed if needed.

5 Sales Tax Rate:
This field is not required but may be used to automatically apply a sales tax to
all your material and rental items. The default is set to zero.

Cost Basis Tab Overview
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4.2.5 Shift Rate Calculator

Take a closer look at calculating your shift rates using the Shift Rate Calculator. For this example, you
will walk through setting up 2 shifts for your project.

Step by Step — Shift Rate Calculator

1. On the Job Properties > Cost Basis tab, select the Shift Rate Calculator button.

2. For Shift 1, type a number value of hours in theMonday through Friday Work Hours fields.

l You can enter up to three shifts for the project

3. For Shift 1, type a number value of hours in the Scale 1 fields.
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l Scale 1 will be your regular time and Scale 2 will be any overtime

4. Enter a number value for hours in the Scale 2 fields (just Monday through Friday).

5. For Shift 2, type a number value for hours as you did above in Step 3.

6. Click OK.

l Now you have a blended shift arrangement, and your labor rates are a blend of 64.18%
straight-time and 35.82% overtime
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4.2.6 Import Filtered Resources

You may have noticed the bottom portion of your Cost Basis tab called the Resource Filter.

The Resource Filter portion of the Cost Basis tab is the most important part of Job Properties. You use
it to import your labor, equipment, and materials from the Library. Until you import filtered resources,
you have no resources (labor, equipment, materials) in your project.

Updated resource rates can be imported into the Library on a regular basis. It is important to update
and have the “Latest & Greatest” rates available to import into your estimates.

You will import the rates you need using a set of four filters called Resource Attributes. Especially for
labor rates, filtering by these attributes allows you to pare down the master list to just the resources
you need.
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Each of the resource filter categories are open for use as determined best by your business. The
following are examples of common uses:

Resource Attribute Filters

Name Description

Resource File
Description

This attribute can be used to designate the rate type or the year to which the rates
pertain.

Geographic
Area

This attribute is used to designate regions, cities, or provinces based on
geographical location of a project.

Wage Zone This attribute is typically used specifically for labor resources. For example, it may
designate the trade and union agreements your labor resources belong to.

Organizational
Category

This attribute can be used to designate what trade or work type your resources
pertain to.

Resource filters become more specific from left to right, so it makes sense to start with Resource File
Description and end with Organizational Category. The geographic area, wage zone and organizational
category attribute titles can be changed to meet your business needs for filtering resources.

You can sort the filter lists by clicking on the filter category titles.

The following steps walk through using the Resource Filter to import resources.

Step by Step — Import Filtered Resources

1. In your job, go to the Job Properties > Cost Basis tab, select the Labor Rate resource type.

2. Under Resource File Description, select Standard Labor Rate File.

3. For Geographic Area, select Southwest.

4. For Wage Zone (Work Center), selectWage Zone A.

5. For Organizational Category, select All.
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6. Select the Construction Equipment resource type.

7. Select the Import Filtered Resources button to bring your selected resources into the job.

You must select “Import Filtered Resources” to import your resources. Clicking OK on the
Job Properties form will not import your resources.

4.2.7 Fuel Cost Tab

On this tab you can enter the cost for fuel (or other energy sources). These unit cost will be multiplied
by the consumption rates entered on each equipment record to define the fuel operating cost of each
piece of equipment. The Cost per UM fields default to $0.00.

Step by Step — Enter Fuel Costs

1. In your job, open the Job Properties > Fuel Cost tab.

2. In Cost Per UM column, enter a dollar amount into the following:

l Diesel

l Gas & Gasoline
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l Off Road Diesel

3. Currency should read U.S. Dollar and UM should read Gallon.

4.2.8 Job Folder Tags Tab

On this tab, you can enter tag fields to label your project, so you can reference it later.
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Many of these fields are validated fields, meaning you can choose from options in a drop-down list.
The names of these tags and the drop-down values are defined at a master level within the Library
Foundation Setup Data. Some job folder tags are setup to be date fields or numerical fields. These tags
are used to sort and filter the job register as well as for selecting which past estimates to utilize for
benchmarking.

4.2.9 Schedule Tab

The Schedule tab is used to define the scheduling options for the integration between InEight Estimate
Primavera or Microsoft Project. The settings you define here determine what information is sent to
your scheduling tool, and how it will be structured.

l At the top of the Schedule tab, the Integrated Schedule can be set to Primavera or Microsoft
Project or Manual

l You will need to confirm the proper settings are defined on each of the Schedule sub-tabs. These
settings are defined in detail in Lesson 12 – Schedule Integration

4.2.10 Other Job Properties Tabs

There are several additional tabs on the Job Properties form. The other tabs will not be discussed here
because they are either used for project controls, or they will be covered at another time.

Other Job Properties Tabs

Name Function

Minority Setup Used to set up minority participation goals (for example, DBE or MBE) and you
want to track minority participation goal attainment status during the bid process,
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Other Job Properties Tabs

Job Tracking

Used to select the code that will be used when tracking job progress, define the
planned production calculation, define the percent complete calculation, define
the forecast methods, and define markup rates for calculating earned revenue on
Time and Expense pay items.

Competitors For an estimate that is being submitted for a competitive bid, this is a place to
track a list of competitors and if available, store competitor price submissions for
reference and trend tracking.

Pricing
Used to define how you want the Balanced Unit Price for each of the job's pay
items to be calculated when using the AutoPrice feature

Cash Flow Defines the cash flow rules (payment terms) that are used in the calculation of
Job Financing and cost/revenue realization to generate the curves that display on
the Cash Flow form.

Equipment
Maintenance

Used to define the calculation of maintenance labor man-hours based on
equipment utilization, to capture the impact on total man-hours when changes are
made that affect the job's total value.

Benchmarking Used to establish the historical data to be used for benchmarking the current job,
and to define the default benchmark graph display and calculations.

Alternates Used to define Alternate Scenarios, to assess the impact of those scenarios.
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Exercise 4.1 — Define Job Properties

In this exercise, you will continue to define your Job Properties from in the E101 training job you
have created. Complete the following steps:
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1. On the Cover Sheet tab, fill out the following fields:

Job Location 90th Street & Shea

City Scottsdale

County Maricopa

Country United States

State Arizona

Type Infrastructure

Engineer Fred Jones

Owner Jerry Slate

Architect Robert Frost

Contract Duration 80

Time Measure Calendar Days

Forecast Start October 15, 2019

Duration (days) 70

Bid Date and Bid Time 10/1/2019 2:00 PM

Estimator Jim Sly

Bid Location 123 Main Street

Owner’s Estimate $500,000.00

Opening Type Public

Proposal Type Unit Price

Plan Holders 10

Liquidated Damages $1000.00 Per Day

RFQ Contact Jim Sly

2. On the Cost Basis tab:
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l Ensure the Shift Arrangement is 8 hours a day, 5 days a week

l Ensure theWage Composite is set to 100% Scale 1

l Ensure the Sales Tax is set to 8%

You should end up with the following results

The following Cover Sheet properties are defined:

The following Cost Basis settings are defined:

InEight Inc.  |  Release 19.2 Page 135 of 962

Estimate User Guide Exercise 4.1 — Define Job Properties



Congratulations, you have completed this exercise!
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4.3 PAY ITEM CREATION

Pay items typically represent the owner required deliverables a contractor must submit pricing for.
Within InEight Estimate, pay items are used to distribute the cost calculated in the Cost Breakdown
Structure and all markup, fees or contingency calculated in the Price Breakdown Structure to a list of
defined items. This allows the total estimate value to be distributed to a structure that is different then
the CBS. Pay Items are predominantly used by Contractors to prepare a bid sheet. Owners may use pay
items to identify funding sources or for various reporting needs.

Many Bid Forms are organized by grouping bid items for related scopes of work. Pay items within the
Pay Item and Proposal screen can be grouped in a hierarchy by utilizing the Position Code column.

You can create pay items in the Pay Item & Proposal Register. Access this form by selecting the Setup
tab > Pay Item & Proposal.

Name Description

1
Proposal and Item
Recaps

Related to pricing during bid close-out. You can disregard them at this
time.

2 Pay Item Number Represents the bid item number from the client (if they give you one)
or can be a number you specify. This field is alpha-numeric

3 Position Code
Controls the way pay items can be grouped, and provide you with an
efficient way to sort.

4 Description You can enter a pay item description.

5
Pay Quantity and
Forecast (T/O)
Quantity

The Pay Quantity is the quantity provided by the client.
The Forecast (T/O) Quantity is your measured quantity for the item.
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4.3.1 Overview – Pay Item & Proposal Register

Step by Step — Create a Pay Item

1. Open your job and select Setup tab >Pay Item & Proposal from the InEight Estimate landing
page.

l The Pay Item & Proposal Register displays

2. In the Pay Item Number column, in the first blank row, type a number value.
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3. Use the Tab key to move to the Description column and type a description.

4. Leave the Pay Quantity at 1.00 and change the Unit of Measure to LS (Lump Sum).

l The Forecast (T/O) Quantity will auto populate to match your pay quantity, but can be
changed later

l You can tab to the next row to create additional pay items if needed

4.3.2 Pay Item Prices by Category

Owners are increasingly requiring more information from contractors as part of their bid submissions.
Many times, this is a further breakdown of a bid price such as separating the price of an item based on
its labor cost, material cost or man-hours. Select columns in the Pay Item & Proposal register enable
users to summarize their pay item prices by up to 10 price categories.

In addition to seeing the price by category, these additional columns also give users better visibility
into how the price is established, including columns for the total cost, total distribution, total markup
and markup percent. These new columns make it easier to verify that the distribution of unassigned
cost and markup are calculated as intended by the estimator.
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Exercise 4.2 — Create Pay Items

In this exercise, you will practice creating pay items in the Pay Item & Proposal Register. Complete
the following steps, using the E101 – Training Job.

Pay Item Number Description Pay Quantity Unit of Measure

2000 Clearing & Grubbing 10.00 Acre

3000 Excavation 50,000.00 CY

4000 10” PVC Pipe 1,000.00 LF

You should end up with the following results

Congratulations, you have completed this exercise!
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Lesson 4 Review

1. This is where you enter basic information about the job as well as define your cost basis.

a. Pay Item & Proposal

b. Job Properties

c. Library

d. Job Folder

2. On the Job Properties form, this tab is where you enter information such as the start
date, bid date, job type and location.

a. Overview

b. Cover Sheet

c. Cost Basis

d. Foundation Setup Data

3. These are the project deliverables; anything the owner agrees to measure and pay for.

a. Cost Items

b. Resources

c. Target Price

d. Pay Items

Lesson 4 Summary

As a result of this lesson, you can:

l Create a new job

l Enter Job Properties

l Create pay items in the Pay Item & Proposal Register
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LESSON 5 — DIRECT COSTS

Lesson Duration: 30 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Explain the estimating process in InEight Estimate

l Explain key terms and concepts
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5.1 COST BREAKDOWN STRUCTURES

The Cost Breakdown Structure (CBS) is the main form where you will do your cost estimating.

l It is the hierarchy of work activities that make up the estimate

l Each row in the CBS represents a work activity or organizing category and is called a cost item

To access the Cost Breakdown Structure, from the InEight Estimate landing page select the Estimate
tab, then under the Breakdown Structure section select Cost Breakdown Structure (CBS).

Name Description

1
Actions
Menu

Shortcut icons allow you to edit cost items and import items from other sources
such as Excel.

2 CBS Tree The CBS tree mirrors your CBS hierarchy and can be used to quickly filter to a
particular section of the CBS by selecting that line on the CBS Tree.

3
Left CBS
register

This side of the register contains all of the estimate activities (cost items) that you
create or import, organized into a parent-child hierarchy.

4 Right CBS
register

This side of the register contains numerous columns for cost detail, production
values, and user-defined tags and fields.

Overview – Cost Breakdown Structure (CBS) Register
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5.1.1 Cost Item Terminology

The CBS contains both direct and indirect costs.

l Direct Cost Items contain costs that pertain directly to the deliverables of the project. Therefore,
direct cost items are typically assigned to pay items

l Indirect Cost Items contain overhead costs that are not directly associated with particular
deliverable items but contribute to the total cost of the project (e.g., supervision, site office,
safety supplies, bid securities). Occasionally an indirect cost item may be assigned to a pay item
(e.g., Mobilization costs that are indirect but assigned to a Mobilization pay item).

InEight Estimate uses various terms to describe the parent-child relationships of the multiple levels in
the CBS:

Terms Description

Superior
A Superior cost item has subordinate (child) items below it that determine hours and
costs.

Subordinate A Subordinate cost item is a child to a Superior cost item.

Terminal
A Terminal cost item has no subordinate items. Resources, costs, and production can
only be added at the terminal cost item level.

A Terminal cost item may or may not be a subordinate.
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The levels of the CBS are referred to as Level 1, Level 2, etc., as you drill down in the structure. As costs
are defined on the terminal items, the sum of the terminal cost items roll up to the superior cost items.

A superior cost item can have no costs of its own; its costs are strictly the rolled-up total
from the subordinate cost items below it.

You can use superior cost items as buckets for organizing your work.

As hours and costs are defined on the terminal items, the sum of the terminal cost items roll up to the
superior cost items.

5.1.2 Work Breakdown Structures

The Work Breakdown Structure (WBS) allows you to reorganize the estimate using different formats
such as Construction Specifications Institute (CSI) MasterFormat or UniFormat. WBS formats are used
when you need multiple variations and summary reports of an estimate. The WBS retains the same
relationships between items as in the original estimate while only changing the view and items
arrangement in the WBS hierarchy.

To view the Work Breakdown Structure View Register, in the Ribbon select the tab Estimate > Work
Breakdown Structures.

Name Description

1
WBS
Tree

Use the WBS Tree to filter to a particular WBS item.

2 WBS
Grid

When a specific WBS item is selected in the WBS Tree,
all subordinate WBS items display in the WBS grid.

3
Cost
Items

The Cost Items associated with the WBS subordinate in
the WBS Grid displays in this data block.

Overview – Work Breakdown Structure (WBS) View
Register
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5.1.3 Locked vs. Unlocked Approach

There are two basic approaches to structuring your cost items and pay items. You can choose to work
in a “locked approach” or an “unlocked approach.”

In a locked approach, level one cost items are automatically created and assigned to pay items. This
locked approach works well when pay items adequately represent the work plan. Subordinate cost
items inherit the pay item assignment of superior cost items.
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If the Lock Cost Items to Pay Item rule is checked in Job Properties, InEight Estimate will
automatically create level 1 cost items in the CBS Register for each of your pay items.

The unlocked approach may work better when the pay items do not adequately represent the work
plan. You can then assign your cost items to your pay items in any arrangement. Companies looking to
standardize the way they estimate and use templates will want to use this approach as it allows you to
dictate the cost breakdown structure. Owners will also typically use the unlocked approach since pay
items are not necessary to their estimating process.

InEight Inc.  |  Release 19.2 Page 149 of 962

Estimate User Guide 5.1 Cost Breakdown Structures



The option of working in a locked approach vs. an unlocked approach is available in the Job Properties
Form, on the Cost Basis tab under the Rules section. By selecting the checkbox for Lock Cost items to
Pay Item, you are choosing to work in a locked approach.

5.1.4 Take-Off Quantities

In the Cost Breakdown Structure, estimated quantities are entered into the Forecast (T/O) Quantity
field with a corresponding unit of measure. The quantity will default to 1 each when you create a new
cost item and should be updated to reflect the work being estimated.
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Forecast (T/O) Quantities are only used for your cost items in the CBS Register.
Pay Quantities are used for final pricing in the PBS and Pay Item & Proposal forms.

Because the training project is a “locked” job, you already have level 1 cost items, and their default
take-off quantities are populated from their corresponding pay item quantities.

The following step by step walks you through adjusting the default take-off quantities on a couple of
your cost items.

Step by Step — Adjust Take-Off Quantities

1. In your job, from the InEight Estimate landing page, on the Estimate tab, select Cost Breakdown
Structure (CBS).

l For each cost item, you can enter the T/O quantity, followed by the unit of measure in the
next column

2. For this example, add a number value per acre and a number value to Excavation with the UoM
to CY.
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5.2 COST ITEM CREATION

During estimate development, you will create new cost items to break down your work into specific
activities. You can create superior and subordinate cost items as needed to organize your work.

5.2.1 Insert Subordinate Cost Item

You can add subordinate cost items in two different ways:

Option 1

Right-click on the row header of the superior cost item and select Insert Subordinate.

The row header is considered the far left edge of the CBS row where the small arrow appear appears
above. It is used to open records and perform actions on items instead of clicking on cells within the
row which will allow you to directly type into the selected cell.

Option 2

Click on the Subordinate Cost Item icon on the Cost Breakdown Structure (CBS) Register toolbar.
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5.2.2 Insert Cost Item

You can add cost items at the same level in two different ways.

Option 1

Right click on the row header of the superior cost item and select Insert.
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Option 2

Click on the Cost Item icon on the Cost Breakdown Structure (CBS) Register toolbar.
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Because the project you are working in is a “locked” job (where cost items are locked to pay items),
your CBS Register will already have level 1 cost items representing each of your pay items, and each
cost item will be assigned to its corresponding pay item.

The following step by step walks you through creating a subordinate (child) cost item for one of your
level-one cost items.

Step by Step — Create a Subordinate Cost Item

1. In your job, from the InEight Estimate landing page, on the Estimate tab, select Cost Breakdown
Structure (CBS).

2. Right click on a cost item and select Insert Subordinate.

l This creates a new, subordinate cost item below your selected cost item

3. For the subordinate cost item, enter a Description.

4. Add a quantity and select your Unit of Measure.

You can create a subordinate at the same level, by right clicking on an equal-level
cost item and selecting Insert.

5.2.3 Move Cost Items

As you develop your estimate, you may need to move cost items around in the Cost Breakdown
Structure. To move a cost item:

InEight Inc.  |  Release 19.2 Page 155 of 962

Estimate User Guide 5.2 Cost Item Creation



1. Select the row header of the cost item you wish to move. If you select a superior cost item, it will
bring the subordinates along with it.

2. Drag and drop the cost item to the right place in your structure. Notice one of two cursor
symbols appears:

The symbol with three equal bars will drop the cost item at the same level as
the cost item you drop it on.

The symbol with a subordinate bar will make the cost item become a
subordinate to the one you drop it on.

Page 156 of 962 InEight Inc.  |  Release 19.2

5.2 Cost Item Creation Estimate User Guide



Exercise 5.1 — Create Cost Items

In this exercise, you will practice creating additional cost items. Create the following cost items,
using your E101 – Training Job:

Code Description Forecast (T/O) Quantity Unit of Measure

2.2 Grading 10 Acre

3.1 Excavate 40,000 CY

3.2 Haul 40,000 CY

4.1 Furnish Pipe Materials 1,000 LF

4.2 Excavate-Install-Backfill Pipe 1,000 LF

You should end up with the following results

Congratulations, you have completed this exercise!
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5.3 COSTS AND PRODUCTION

For the cost items you’ve created, you can now add their costs and production. All information for a
cost item is contained in a Cost Item Record.

5.3.1 Cost Item Record

You can open the Cost Item Record by either double clicking on a cost item row header, or right
clicking and selecting Open.

Cost Item Record Overview

Name Description

1
Cost Item
Header
Information

Provides general information about the cost item. It displays the cost item’s
take-off quantity, Unit of Measure, and Cost. It also indicates what Cost Source
is being used.

The Cost Segment drop-down is used to differentiate estimated costs in the
Direct Costs, Job Overhead or Business overhead categories.

2 Costing Area Section where costs are defined. There are three ways to enter costs: Detail,
Plug, and Quote. The Cost Summary tab summarizes whatever costs are
defined.
Under the Cost Segment drop down, you can choose

3 Data Blocks
Contains a set of tabs for entering additional information including production,
shift arrangements, man-hour factors, notes, and scheduling information.
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5.3.2 Cost Segments

The Direct Costs, Job Overhead, and Business Overhead cost segments helps to classify the scope of
work so you can report on direct vs indirect costs, and accurately control how markup is spread
throughout your bid. This differentiation is necessary to effectively price work based on the risk profile
of each segment of cost.
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5.3.3 Cost Sources

You can define costs on a cost item in one of three ways, called Cost Sources:

Tab Description

Detail
This is the recommended costing method, where labor, equipment, and material resources
are defined, along with productivity, to determine costs.

Plug This method allows you to enter a unit or total cost directly, without needing to enter
resources or production. This should rarely be used, but does have a couple of use cases:

l Place holder value until you get more information (from subcontractors or designers)
l For preliminary estimates when limited information is available
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Tab Description

Quote
The Quote cost source is for contractors, subcontractors or vendor quotes.

l Creating and managing quotes is covered in Lesson - Quote Management

On each Cost Item Record, InEight Estimate gives you the option to define both Plug and Detail values
on each respective tab.

5.3.3.1 Plug Tab

The Plug tab allows user to input unit or total cost to any of the listed cost categories which can be
customized based on company requirements.
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5.3.3.2 Detail Tab

Entering both a detailed and plug cost allows you to define costs at a higher summary level initially
(Plug tab), and then define more detail as the estimating process progresses (Detail tab). You can
review and compare your plug and detail values by toggling between tabs, but your cost item will only
contribute the total cost from one of the tabs based on which cost source is selected.

You control which cost is used by selecting Detail or Plug in the Cost Source field on the Cost Item
Record.
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The Quote Cost Source can only be selected from the Quote Comparison & Award form.
See Lesson 8 – Quote Comparison.

5.3.4 Plug Costs

The following steps walk you through defining a plug cost on a cost item.

Step by Step — Define a Plugged Cost

1. In your job, from the InEight Estimate landing page, on the Estimate tab, select Cost Breakdown
Structure (CBS).

2. Right click on the row header for a cost itemand select Open.

3. In the Cost Source drop-down field select Plug.
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4. In the left section of the Cost Item, select the Plug tab.

l This gives you the list of all cost categories, where you can enter either a Unit or Total Cost

5. Click in the Labor Unit Cost field and enter a numeric value. Click in the Owned Equipment Unit
Cost field and enter a numeric value.
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l The Total Cost for the cost item should now auto-calculate to be $20,000.00

5.3.5 Detail Costs

The Detail cost method is also defined on the Cost Item Record. On the Detail tab, you can add
resources (labor, equipment, and material) and define production.

On the Production tab (right side of screen), define production by entering one of the following:

l A duration, or

l A unit per duration, or

l A duration per unit
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When you enter a production value, all the other production fields will auto-fill based on what you
entered.

The hours defined on the Production tab drive the labor and equipment resources you employ on the
left, multiplying their unit costs by the production hours.

When you employ material resources, their costs are driven by the quantity you enter into the quantity
field.

The Total Cost of each resource is added together to give you the Total Cost for the cost item.

5.3.5.3 Add Cost Detail

The following steps walk you through adding resources and production on a cost item.
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Step by Step — Add Cost Detail

1. Using your job, from the InEight Estimate landing page, on the Estimate tab, select Cost
Breakdown Structure (CBS).

2. Right click on the row header for a cost item and select Open.

3. Select the Detail tab.

l Notice there is no cost on the Detail tab since no cost detail is defined

4. A blank row is available to define your costs. With your cursor in the code field, click the
Resource Selection icon to open the Resource Selection Register.

5. On the Labor tab, select a labor resource.

6. Select OK.
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l The labor resource you selected is now employed on the cost item

7. In the new blank row, click in the Code field and click on the Resource Selection icon to open the
Resource Selection Register.

8. Select the Labor tab, then select a labor resource.

9. Click OK.

10. In the new blank row, click in the Code field and click on the Construction Equipment tab, then
select an equipment resource.

11. Click OK.

12. Because these are duration-based resources, you need to enter a Production value. From the
lower-right section of the form, select the Production tab.
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13. Enter a numeric value in the Days field, then press Tab.

l Notice the red arrow indicating where production was defined

l Notice that the Total Cost of the cost item is defined, based on the resources and
productivity you defined

14. Next, adjust the production by entering a numeric value in the Acre/Day field.

15. Click OK to close the record.
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5.3.5.4 Add Assembly

Step by Step — Define Cost Detail by Adding an Assembly

1. Using your job, from the InEight Estimate landing page, on the Estimate tab, select Cost
Breakdown Structure (CBS).

2. Right click on the row header for a cost item and select Open.

3. Select the Detail tab.

l A blank row is available to define your costs

4. With your cursor in the Resource Assembly field, click the Resource Assembly Selection icon to
open the Resource Assembly Selection Register.

5. Select a labor assembly, then select OK.
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l The assembly you selected is now employed on the cost item

6. Because this crew includes duration-based resources, you need to enter a Production value.
Select the Production tab.

7. Enter a numeric value in the Acre/Day field, then press Tab.
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l Notice the Total Cost of the cost item is defined, based on the resources included in the
assembly and the productivity you defined
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Exercise 5.2 — Define Cost Detail

For cost items you create in InEight Estimate, you need to add resources, assemblies and production
to define their costs. In this exercise, you will practice defining cost details. Complete the following
steps, using your E101 – Training Job:

Code Description Quantity

LO1 Operator Class 1 1

LL2 Laborer 2

LL3 Labor Foreman 1

EX225 Excavator 225 1

CY/Hour 400

Add the following resources to 3.1 Excavate cost item

Code Description Quantity

LO1 Operator Class 1 1

LL2 Laborer 2

LL3 Labor Foreman 1

LT1 Teamster 1

EL950 Loader 950 1

ETDT Dump Truck 1

EX225 Excavator 225 1

Add the following resources to 3.2 Haul cost item

CY/Hour 400

Add the following production value to cost item
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Code Description Quantity

MPP10 Pipe 10” PVC SDR21 1,000 with 5% Waste % Add-on = 1,050 LF

Add the following resources to 4.1 Furnish Pipe Materials cost item

Resource Assembly Description Quantity

CPIPE Pipe Crew 1

Add the following assembly to 4.2 Excavate-Install-Backfill Pipe cost item

Days 3

Add the following production value to cost item

You should end up with the following results

Congratulations, you have completed this exercise!
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5.4 COST ITEM DETAILS

The Cost Item Record contains other tabs (called Data Blocks) in addition to the Production tab, for
storing and calculating information specific to that cost item.

You can add to or adjust the information on these tabs as needed, based on the cost item’s
circumstances. In this section, you will review three of the tabs (in addition to the Production tab) you
will likely use most often: Cost Item Setup, Notes, and Man-Hour Factors.

5.4.1 Cost Item Setup

On the data block where the Production tab was found, there is also a Cost Item Setup tab where you
can adjust wage scale and shift arrangements for a specific cost item.
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The composite wage scale and work and pay hours are used in the calculation of the cost of employed
labor resources. The data reported on the Default Pay Rules tab is, by default, the composite wage
scale and work and pay hours defined on the Job Properties - Cost Basis tab for the current job.

These settings can be modified from the default on a cost item-by-cost item basis.

The Pay Rules for cost items can also be defined or modified on the Cost Breakdown Structure (CBS)
Register in the Scale 1, Scale 2, Scale 3, Work Hours Rules, and/or Pay Hours Rules columns in the row
of the subject cost item.

Step by Step — Adjust Shift Arrangements

1. Using your job, from the InEight Estimate landing page, on the Estimate tab, select Cost
Breakdown Structure (CBS).

2. Right click on the row header for a cost item and select Open.
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3. Select the Cost Item Setup tab in the lower-right portion of the form (the tab name may be
abbreviated).

4. In the Default Pay Rules data block, adjust your wage scale to a numeric value for Scales 1 and 2.

5. Under the Composite Wage Scale, adjust the hours so that for every 10 hours worked, pay 10
hours.

6. In the Default Shift Arrangements data block, change the Work Hours per Shift to 10. Leave
Shifts per Day at 1 and Days per Week at 5.

InEight Inc.  |  Release 19.2 Page 177 of 962

Estimate User Guide 5.4 Cost Item Details



l Notice that your hours did not change on the cost item (they will remain constant)

l However, if you go back to the Production tab, you will also see that it automatically
adjusted your other production values based on the new settings

5.4.2 Notes

On the Cost Item Record, you can enter any cost item-specific instructions, parameters, or general
information on the Notes tab. Below are a few examples of the kinds of notes you might enter:

l For a Hauling cost item:  There should be very little waste. If so, we can spread it out in the right
of way at MP 111

l For a Structural Excavation and Backfill item:  The backfill cannot be the native material. Have
to use clean base rock

l For an Underground Pipe cost item:  The average depth is close to 10 ft.

You can use the Notes tab to reference cost item changes (e.g., changing shift
arrangements, changing a resource rate).
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5.4.3 Man-Hour Factors

For items that have known risks or potential resource concerns, you can apply a Man-Hour Factor to
take those risks into consideration.

Man-Hour factors are applied on the Man-Hour Factors tab on the Cost Item Record. Factors are
applied in relation to 1, where slower production is greater than 1 and faster production is less than 1.

Man-Hour Factors affect both Labor and Equipment Hours.

For example, if you predict production to be 20% slower due to weather concerns, you would type 1.2
in the weather factor field.

Even after defining a Man-Hour Factor, the Production tab will still display the original Production
values.

l To see the factored Production values, click the Customize Display link on the Production tab
and select Show Man-Hour Factors

l Both original and factored production are then displayed on the Production tab

InEight Inc.  |  Release 19.2 Page 179 of 962

Estimate User Guide 5.4 Cost Item Details



You can apply Man-Hour Factors to multiple cost items at once by Multi-Editing selected
cost items on the CBS Register.

5.4.4 Unique Identifier

You may have noticed when you made changes on the Cost Item Setup tab, that the fields you changed
and the Cost Item Setup tab became highlighted, indicating they were altered from their original state.
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On the CBS Register, the cost item you edited now has a Unique Identifier in the row header indicating
the cost item was altered from the default values set in the project job properties or in the project
library of resources rates.

If you hover over the identifier, a pop-up menu appears indicating what data points were changed.
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This same identifier will show up for resources as well, if you make changes to the employed resource’s
cost to be different than the original resource rate imported from the Resource Rate Register.

5.4.4.1 Highlight Unique (Delta) Toggle

You can turn the highlighting of unique resource and cost item fields off and on from the Actions menu
of the Cost Item Record, under the View section.
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5.4.5 Cost Drivers

Each type of resource has a default cost driver. For example, Labor resources are duration driven so
the cost driver is CI Duration, meaning their costs are driven by the duration of the cost item. If you
want an Operator to only be assigned to a specific cost item or work activity for half the time, you can
change its quantity to .5 and it will be driven by half of the cost item’s hours.

To enter work hours manually for the employed resource, you can change the Cost Driver option to CI
Quantity or Fixed.
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With CI Quantity as your cost driver for the Operator, you can adjust the Work Hours manually, where
previously that column was read-only.

Let’s say you want your Operator to work specifically 80 hours.

However, since the resource is now quantity driven, if you change the Forecast (T/O) Quantity to 50
you will see that the work hours will still adjust from 12 to 40.

If you want it set at 80 hours no matter what changes you make to your quantity, you can change the
cost driver to Fixed. Then when you change the Forecast Quantity to 500, the work hours for the
Operator will not change and will remain at 80 hours as shown below.

If you followed along and made any adjustments to cost item 2.1 Clearing, change the Cost Driver for
the Operator resource back to CI Duration and the Work Hours back to 100.
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5.4.5.2 Split by Cost Type

It is common for an estimate to progress through multiple levels of detail. Often a high-level estimate
for a particular scope of work consists of a single cost item inclusive of the entire cost of that work in a
single line item. As the estimate is further refined, more detail is added and at times it can become
necessary to split a cost item by the four main types of costs that make it up, such as separating the
material cost from the installation cost.

The Split by Cost Type feature gives you the ability to select a cost item or a collection of cost items,
and then separate any of the labor, equipment, material, or subcontract costs into separate cost items.

l Right click on a new Cost Item under Guardrail Type 2, and select Split by Cost Item. You can use
this option if there at least two types. If not, you will get this pop-up:

Alternatively, click on Split.
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l Enter the number of parts to split and click OK

l You will be asked if you want to proceed.  If so, click Yes

The end-result will automatically add subordinate rows which you can now edit.

5.4.6 Suspend Cost Items

The Suspend feature allows you to turn cost items on and off in order to perform “what-if?” analysis or
evaluate alternative approaches to the work.

A cost item can be suspended in InEight Estimate for various reasons including the following:
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l Manually suspended cost items

l Suspended parent

l Parent with cost source that is not Detail (plugged or quoted)

l Parent cost item with a zero quantity

l Pay item is suspended

l Allocated cost items

l Alternate scenarios:

l Overridden by another alternate

l Alternative is not active

Suspended cost items do not contribute any cost to the job's total value. Suspended items can be un-
suspended at anytime in order to be included in the total project value.

Step by Step — Suspend a Cost Item

1. On the Cost Breakdown Structure (CBS) Register, select a cost item.

2. Right click on the selection and select Toggle Suspended from the menu.

l You can also select Toggle Suspended under the Edit section of the Actions tab up above

l You can also suspend cost items by checking the Suspend checkbox on the Cost Item Setup
tab of a cost item record

l If a superior cost item is suspended, its subordinate cost items are automatically
suspended as well
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l The costs associated with these cost items will no longer contribute to the estimate

5.4.6.3 Editable Man-Hour Factors in Suspended Cost Items

You can edit Man-Hour Factors for a suspended cost item by creating and maintaining cost items,
including Man-Hour Factors. This can be accomplished in a suspended state while having the scope of
work included in your estimate. The cost to contribute is excluded from the scope of work until you are
ready to make it part of your estimate.

5.4.6.4 Unsuspend a Cost Item

Follow the step by step below to unsuspend a cost item.

Step by Step — Unsuspend a Cost Item

1. On the Cost Breakdown Structure (CBS) Register, select a cost item.

2. Right click on the selection and choose Toggle Suspended.
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l You can also select Toggle Suspended from the Edit section of the Actions tab

l You can also unsuspend cost items by unchecking the Suspend checkbox on the Cost Item
Setup tab of a cost item record

5.4.6.5 Suspend Column

Within the CBS Register, the Suspend column indicates which cost items are suspended.

l Hover over the checkmarks to see why the cost item is suspended

l You can suspend and unsuspend cost items by checking and unchecking the checkboxes in the
Suspend column as well

5.4.7 Adding Cost Adjustments

Total Cost and Billing Adjustments can now be made in the CBS register which can be viewed either
from the Standard view of the CBS register, or a saved view affiliated with change.
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Adjustment fields have been added to the CBS to view and modify the adjustment amount and
adjustment percent without going into each individual cost item.

Any adjustment made to the Adjustment Amount fields on the CBS register will then have the
Adjustment Percent field automatically calculated. Changes made to those fields will be highlighted in
yellow signifying an adjustment has been made.

Other adjustments fields in the CBS register include the many adjustments fields that have been added
to the Billing Rates View.

A new Saved view called Cost Item Adjustment View has been added to the Cost Breakdown
Structure.
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Exercise 5.3 — Manage Cost Item Details

In this exercise, you will practice making adjustments to your cost item details. Complete the
following steps, using your E101 – Training Job:

1. Open the Cost Item Record for cost item 2.2 Grading.

2. From the Cost Item Setup tab, change the Composite Wage Scale to 80% Scale 1, 20%
Scale 2.

3. Change the Default Shift Arrangements to 10Work Hours per Shift, 1 Shift per Day, 5
Days per Week. Also adjust for every 10 hours worked, pay 10 hours.

4. From theMan-Hour Factors tab, apply a Man-Hour Factor of 1.1 to the same cost item.

5. On the Notes tab, type Added man-hour factor due to hard soil conditions.

You should end up with the following results for 2.2 Grading

Congratulations, you have completed this exercise!
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Lesson 5 Review

1. Resources, costs, and production can only be added to what type of cost item?

a. Superior

b. Terminal

c. Parent

2. What Cost Source is used for defining resources and production?

a. Plug

b. Detail

c. Quote

3. On the Cost Item Record, what tab is used for changing the cost item’s Default Shift
Arrangements?

a. Cost Item Setup

b. Production

c. Man-Hour Factors

d. Notes

Lesson 5 Summary

As a result of this lesson, you can:

l Explain the Cost Breakdown Structure and its purpose

l Create cost items

l Add costs and production

l Manage cost item details
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6.1 INDIRECT COSTS OVERVIEW

Indirect costs such as the cost of prime bond, mobilization, or site supplies are typically overhead costs
that are not directly associated with a particular project deliverable but contribute to the total cost of
the project. However, indirect costs can be assigned to a pay items. This gives you the flexibility to
more accurately control the cost basis of bid items and strategically price the work to maximize cost
recovery and profit.

Once your direct costs are defined, you can add indirect project costs. Estimate provides two ways you
can create indirect costs:

1. Default Indirect Cost Items:  These are pre-built cost items created by InEight Estimate, located
at the top of the CBS Register.

2. User-Defined Indirect Cost Items:  Any cost item you create in the CBS Register that is not
assigned to a pay item is considered indirect cost.
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The Cost Breakdown Structure (CBS) located in the Library under the Estimate tab,
Master Breakdown Structures section, controls which of the default indirect cost
items to copy into new job folders.

6.1.1 Navigation to Indirect Costs

From the Estimate tab of the InEight Estimate landing page, you can quickly access indirect costs from
the Indirect Cost section.

l Select Indirect Cost Items to open the Cost Breakdown Structure Register filtered to only your
indirect costs

l You can select Prime Bond, Price % Add On, and Job Financing to access those indirects

The following section takes a closer look at the default indirect cost items.

6.2 DEFAULT INDIRECT COST ITEMS

InEight Estimate contains various default cost items to help you calculate your indirect costs.

6.2.1 Independent Indirect Cost Items

Independent indirect cost items function very much like the direct cost items you defined previously:

l Job Management & Equipment

l General Expense

6.2.1.1 Job Management & Equipment

The sample Job Management & Equipment Record below shows that you can add resources and
production just like in your direct cost items. Supervisory staff resources were added, and the
production duration is set to 100 days.
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The following Step by Step walks you through defining resources and costs for your Job Management &
Equipment indirect cost item.

Step by Step — Add Job Management & Equipment Costs

1. In your job, from the InEight Estimate landing page, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS).

3. Double click on the Job Management & Equipment row header.

l You can see that this record looks like the direct cost item records that you have been
working with thus far in the CBS

4. Here you will add a labor resource by clicking in the Code column and selecting the icon.
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5. Select the Production tab.

6. Enter a numeric value in the Days field.

l This represents the length of the job

7. Click OK to close the record.

Step by Step — Add General Expense Costs

1. In your job, from the InEight Estimate landing page, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS).

3. Right click on the General Expense row header and select Open.

l The General Expense cost item record also looks identical to a direct cost item record

l You could add existing resources here, but in this case, you will create an ad hoc resource

4. Type in a description the Description column.
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5. Enter a number in the Quantity field.

6. For the Unit of Measure field, select a Unit of Measure from the drop down.

7. Click on (highlight) that row, and then click the Resource Employment Breakdown tab.

8. Enter a number in the Undefined Supplies cost category.

l The amount entered automatically fills into the unit and total cost columns

You are only allowed to enter information in the Resource Cost Breakdown if
the resource row is selected, otherwise fields will not display.

9. Click OK to close the record.

6.2.2 Dependent Indirect Cost Items

The other default indirect cost items are dependent indirect cost items, meaning their costs depend
on other costs, prices or hours. They include:

l Direct and Indirect Cost Add-On

l Direct and Indirect Cost Escalation

l Prime Bond
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l Price % Add-On

l Job Financing

l Man-Hour Add-On

It’s possible to assign any assigned or dependent cost Item to any of the 3 cost segments and provides
greater control over where costs exist in the Price Breakdown Structure (PBS).

6.2.2.2 Default Dependent Cost Item Deletion

If you need to use additional dependent cost items, you can create your own, but you
must delete all the existing default dependent cost items first.

The following steps walk you through deleting your existing default indirect costs so you can create
your own.
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Step by Step — Delete Existing Default Dependent Cost Items

1. In your job, from the InEight Estimate landing page, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS).

3. Select an indirect cost item by clicking on its row header.

4. Press and hold the Shift key while selecting another indirect cost item.

l All your dependent indirect cost items are now selected

5. Right click on the selection and select Delete.

6. Select Yes to confirm you want to delete the selected cost items.

l Your indirect cost items are now deleted

6.2.2.3 Prime Bond

The following steps walk you through adding and defining your prime bond for the job.

Step by Step — Define Prime Bond

1. In your job, from the InEight Estimate landing page, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS).

3. Right click on the row header for any cost item and select Insert Dependent Cost Item.
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4. On the resulting Attention prompt, select Based on Bond Table.

5. Click OK.

l The Prime Bond indirect cost item now displays at the top of your CBS

6. Right click on the Prime Bond row header and select Open.

l Prime Bond represents the insurance for the job

l This is an irregular form and uses bond rate tables

l The form’s Bond Table Name defaults to No Bond Required until a saved Bond Table
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Name is chosen

7. Use the Table Name drop-down to choose EXAMPLE: GENERAL CONSTRUCTION

8. Click OK to close the record.

l The Prime Bond indirect cost item is now added to your CBS

Page 202 of 962 InEight Inc.  |  Release 19.2

6.2 Default Indirect Cost Items Estimate User Guide



Multiple bond rate dependent items

For certain projects, it may be desirable to calculate costs for bond or insurance premiums based upon
multiple different rate tables. It is now possible to add multiple bond/rate table based dependent
items in the CBS.

For example, in addition to having a prime bond, the job may also require insurance coverage where
the premium is calculated using a rate table-based approach. This can now be accomplished by adding
another Bond/Rate-table based dependent cost item to the job.

Deleting Bond Tables

Delete bond tables that are not applicable to your estimate by selecting them and then clicking the
Delete button. You can customize the Bond Table window to only view the tables that are relevant to
your estimate from the Table Name drop-down list.
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6.2.2.4 Price % Add-On

The following steps walk you through defining the Price % Add-On.

Step by Step — Define a Price % Add-On

1. From the Cost Breakdown Structure (CBS) Register, right click on the row header for any cost
item and select Insert Dependent Cost Item.

2. On the resulting Attention prompt, select Based on Job’s Price.
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3. Click OK.

4. Double click on the Price % Add On row header to open the record.

5. The Price % Add-on Record opens to the Description tab. Type a description in the Description
field and enter a numeric value for rate.
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6. Click OK to close the record.

6.2.2.5 Direct Cost Add-On

The following steps walk you through creating a Direct Cost Add-On dependent cost item.

Step by Step — Define a Direct Cost Add-On

1. From the Cost Breakdown Structure (CBS) Register, right click on the row header for any cost
item and select Insert Dependent Cost Item.

2. On the resulting Attention prompt, select Based on Direct Costs.

3. Click OK.

4. Double click on the Direct Cost Add-On row header.

5. On the Description tab, type a description in the Description column.
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6. Press the Tab key (you can define additional rows for other add-on costs as needed).

l The Dependency Cost Breakdown appears on the right

l The Subject Cost is the cost that the cost item depends on, based on what is defined on
the cost item’s Dependency tab

7. Click on the Dependency tab to see what contributes to your subject cost.
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l These are the cost items on which this Direct Cost Add-On depends

l There are a couple of options at the bottom to control how dependency items are
selected. By default, the bottom radio button is selected

l The bottom radio button allows you to use column filtering to control what items
are included

l The top button allows you to manually select the cost items you would like to
include

8. For this activity, leave the default (lower) button selected.

9. Click on the Description tab, where you can define an add-on Rate (percentage) or Cost at any of
the cost category levels in the Dependency Cost Breakdown on the right side of the record.

l You can also add a rate at the Total level to have it apply to all your cost categories

10. Enter a numeric value in the Rate field at the Labor cost category level, then press Tab.
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11. Click OK to close the record.

6.2.2.6 Repositioning Dependent Cost Items

Repositioning dependent cost items creates a simpler way to manage the hierarchy of your project by
placing items of more importance ahead of other line items.

Since dependent cost items can now be repositioned, a Position Code field has been added with the
functionality similar to column remaining the same. The below listed dependent cost item fields are
now exposed in the CBS register so you can more easily see the various percentages used in dependent
items.

• Subject Cost

• Subject Cost Rate

• Subject Billing Amount

• Subject Billing Rate

These columns can also be found in the new saved view Bid Review.
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6.3 USER-DEFINED INDIRECT COST ITEMS

You may prefer to create your own indirect cost items. You create user-defined indirect cost items the
same way you create direct cost items. The only difference is that your indirect cost items will not be
assigned to pay items. One advantage of creating your own indirect cost items is the ability to create a
parent-child structure for your indirect costs.

Here is an example of user-defined indirect cost items, expanded to show their employed resources:
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Step by Step — Add User-Defined Indirect Cost Items

1. At the bottom of your CBS, create an indirect cost item with a Forecast (T/O) Quantity of 1 and a
Unit of Measure of Each.

2. Add two subordinates under the new cost item and name both. For the first subordinate cost
item, set it to 1 Each. Set the second to 1 Lump Sum.

3. Open the first subordinate cost item by double clicking on the row header.

l Assuming there is nothing for this subordinate indirect cost item in your Resource Rate
Register, you will create this resource “on the fly”

4. In the Detail grid, click on the Resource Register icon in the Code field as if you were going to
select from the Resource Rate Register.
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5. On the Resource Rate Register, click the Rented Construction Equipment tab.

6. Right click on one of the line items and select New to add a new resource.

7. Enter a Resource Code of RJT for the Rented Construction Equipment Resource.

8. In the Description field, type in a description.
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l You do not need to enter Fuel, but the Job Trailer’s cost is given to you at a charge per
week, so you will use the Non-Hourly Period Charge Rates to figure out the hourly cost

9. Select the Calculate Non-Hourly Period Charge Rates for RE Rental checkbox; this will allow you
to edit the fields below the checkbox. A pop-up box will appear.

10. Click OK on the resulting prompt.
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You may need to expand the resource record to see all of the fields to fill out.

11. SelectWeekly as the Period, and type 1,000 as the Amount Per Period.

12. Since the Period is Weekly, type 40 in the Hours Per Period field.

13. Press the Tab key so the change takes effect on your Cost Category Breakdown (on the left).

l Now you can see that Estimate auto-filled the Rented Equipment category, as well as your
Standard Sales Tax under Fees in the Cost Category Breakdown, to equal a total amount
per hour

14. Click OK to close the Resource Rate Record.
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15. Select the new resource you created, then click OK to return to the Cost Item Record.

16. On the Cost Item Record, adjust the quantity of first subordinate cost item you created,
assuming you will have multiples of this item on site.

17. Finally, adjust your production by entering the duration of the job.

18. Click OK to close the record.

19. On the CBS register, select the Utilities cost item by double clicking on the row header.

20. Create another ad hoc resource on this cost item which will be 1Lump Sum.

21. Finally, go to the Resource Employment Breakdown tab and enter your forecasted cost for the
duration of the jobin the Custom Category1 row.

22. Click OK to close the record.
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l Your user-defined indirect cost items now contain production and costs
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Exercise 6.1 — Define Indirect Costs

In this exercise, you will practice entering Indirect Costs. Complete the following steps, using the
E101 – Training Job:

1. Double click on the Price % Add On row header.

2. You already have Office Overhead as your first line item. In the next blank row type
Corporate Insurance in the Description field and enter a rate of .10.

3. Click OK to close the record.

4. Double click on the Direct Cost Add-On row header.

5. You already have Small Tools as your first line item. On the Description tab, type Safety &
Training in the next blank row’s Description field, then press Tab.

6. The Dependency Cost Breakdown appears on the right. Enter a rate of 5 for Labor Costs
only.

7. Click OK to close the record.

You should end up with the following results
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Congratulations, you have completed this exercise!
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Lesson 6 Review

1. Default direct costs are pre-built _____ ______ created by InEight Estimate, located
within the CBS Register.

a. billing rates

b. cost items

c. pay items

2. Any cost item you create in the CBS Register that is not assigned to a pay item is
considered indirect cost.

a. True

b. False

3. You create user-defined indirect cost items the same way you create direct cost items.
The only difference is that your indirect cost items will not be assigned to ___________.

a. Resources

b. Pay Items

c. Assemblies

Lesson 6 Summary

As a result of this lesson, you can:

l Explain how indirect costs are defined in InEight Estimate

l Estimate default indirect cost items

l Estimate user-defined indirect cost items
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LESSON 7 — FINALIZE THE ESTIMATE

This lesson is primarily suited towards contractors who must add profit or markup to their total
estimated cost, which will be submitted in the form of a bid or proposal. Most owners can divert from
this lesson as it's more geared towards adding profit and markup. There are a few use cases in which
an owner may wish to use the price breakdown structure. For example: to add risk, contingency, or
reserves if it is preferred, these are not shown directly in the budget line items. The price breakdown
structure also provides a summary level review of the total estimate and is a great reference during
estimate reviews.

Lesson Duration: 45 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Add job markup (profit)

l Use tools on the PBS form to review your estimate

l Spread Target Price over pay items

l Make bid adjustments
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7.1 JOB MARKUP (PROFIT)

On the Data Map  notice how the different segments within the pyramid coincide with the
percentage amounts that make up Direct Costs, Indirect Costs and Target Profit. Illustrations below
show how the Data Map values correspond to the values that make up the cost and profit.

To open the Data Map, select the Price tab, then Data Map from the Overhead and Profit section.

7.1.1 Target Price

For contractors building the price of your project is like building a pyramid. The foundation of your
price consists of the direct costs of the job.

The images below represent a default examples.
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On top of your direct costs, you can decide if costs with a cost segment of business overhead should be
indirect costs or markup. You estimate your direct and indirect costs in the CBS Register.
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At the top of the pyramid you add an amount for profit. You add profit in the Price Breakdown
Structure (PBS) form. There is a very small block at the top of the Data Map, which comprises 0.22% of
Indirect Cost Markup.
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The total of the direct cost, indirect cost, and profit in the project is referred to in InEight Estimate as
the Target Price. This is the final price that you want to submit as your proposal.
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7.1.2 Price Breakdown Structure

As you already practiced, your direct and indirect costs are estimated in the CBS. Your project’s profit
needs to be defined in the Price Breakdown Structure (PBS) form.

The main purpose of the Price Breakdown Structure (PBS) is to add markup (profit) to the estimate.
The Price Breakdown Structure is a visual run-down of the costs and profit that make up your Target
Price. It helps you analyze how your costs contribute to the price you are targeting, including the
amount of profit you would like to include.

You can open the PBS from the InEight Estimate landing page by selecting the Price tab, then Price
Breakdown Structure (PBS) from the Overhead and Profit section.
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Name Definition

1
PBS
Description

The left side of the screen displays several cost classifications:
l Target Profit
l Business Overhead
l Job Overhead
l Direct Cost

2 Various
Columns

The Assigned and Unassigned columns show which costs are either assigned or
not assigned to pay items. Unassigned costs are spread back to pay items based
on the distribution logic set in Job Properties > Pricing. The Total columns
represents a summation of both columns.
Each layer displays with an amount, and the percentage of the Target Price that
this amount represents.

3 PBS Menu
The right side of the screen holds several tabbed pages of information. This
information is useful in analyzing the job at a summary level.

4 Refresh
Data

To ensure that you are always reviewing the most up-to-date factors and ratios,
click the Refresh Summary Data button whenever you are reviewing the data.

Overview – Price Breakdown Structure
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All costs in the Price Breakdown Structure are based on pay quantities (not forecast take-
off quantities).

7.1.3 Markup vs. Margin

Let’s look at the difference between Markup and Margin.

l Markup is a function of cost, while margin is a function of price

l Markup indicates how much you are marking up the cost

l Margin indicates what percentage of your price the markup represents

The percentages on the main PBS screen are margin, so you can see what percentage each category in
the PBS represents compared to the total price. If you enter 10% in the Target Profit field, your profit
will be 10% margin of your total price.
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When you open the Direct or Indirect Markup Records, the Rate percentage there indicates markup of
the cost. If you enter 10% markup on $100, the markup will be $10.

Within Job Properties, you can choose if costs with a cost segment of business overhead should be
indirect costs or markup. If selecting markup, then Business Overhead will be spread within the
Markup category of the Price Breakdown Structure. The Total Markup will be the sum of Target Profit
and all Items categorized as Business Overhead.
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This lets you see the true total cost of the job, including the total markup inclusive of the business
overhead. You can also create cost items and categorize them as business overhead, then possibly
include overhead costs such as estimating or home office expenses. This provides you with added
flexibility in marking up your job.

7.1.4 Define Profit

Before you define profit, review the PBS. You estimated your direct cost items, and you also estimated
some indirect cost items in the CBS. You can view your direct and indirect cost totals on the Price
Breakdown Structure. Notice you have not defined profit yet.

You can define profit by entering a profit percentage directly on the PBS, or by modifying the Direct or
Indirect Cost Markup Records.

The following steps walk you through plugging a Target Profit percentage directly on the PBS form.
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7.1.4.1 Profit as a Percentage of Target Price

Step by Step — Add Profit as a Percentage of Target Price

1. Open your job in InEight Estimate.

2. From the InEight Estimate landing page, select the Price tab.

3. Select Price Breakdown Structure (PBS) from the Overhead and Profit section.

4. On the Target Profit row, enter a numeric value in the % of Target Price column, then press Tab.

Notice that entering that Target Profit has the following effects, once you tab off the field:

l Your Target Price increases

l Indirect and Direct Cost Markup values automatically have amounts pushed down to them

l The amounts for both Prime Bond and Price % Add-On increase, as they are based on a
percentage of the Target Price

l Direct Cost and Job Overhead amounts don’t change, but their % of Target Price changes

7.1.4.2 Profit Through Direct Cost Markup Record

The following steps walk you through how to add profit as markup on the Direct Cost Markup record.

Step by Step — Modify the Direct Cost Markup Record

1. On the Price Breakdown Structure (PBS) form, double click on the Direct Cost Markup row.
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2. In the Markup Cost Item Record, override the Default entry with Direct Cost Markup in the
Description field.

3. In the Rate column on the Dependency Cost Breakdown, a numeric value for your rates in the
Labor Cost , Owned Equipment, Materials, and Fees categories. Reset the other categories back
to 0.

l Notice the average rate rolls up at the Total cost category level

4. Click OK to save your changes and return to the PBS.

l The Direct Cost Markup now is a different percentage of the Target Price, and the Target
Profit and Target Price have changed
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5. Click the Refresh Summary Data button on the PBS to see the changes reflected.

7.2 COST ESTIMATE AUDIT/REVIEW

InEight Estimate offers built-in reports to double check your estimate and review different aspects of
your project, including material costs, quotes, man-hours and production.

7.2.1 Price Breakdown Structure Tabs

The purpose of the tabs on the Price Breakdown Structure is to assist with estimate reviews.

7.2.1.1 Markup Analysis

On this tab, you can compare your profit to your costs for labor, subcontract and other cost groupings.
By seeing the ratios of your markup compared to your different cost categories, you can gauge if you
have the right balance of costs in your estimate.

For example, if your markup is more than 100% of your Labor cost, it may indicate that you don’t have
enough labor cost in your estimate to cover the work, which could indicate labor cost overruns during
execution that would eat into your profit margin.
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7.2.1.2 Cost Source

The Cost Source tab shows the breakdown of Detail, Plug and Quote cost sources, as well as the
amounts and percentages of each that are attributable to Direct and Indirect cost. Your Plug cost
source should be the lowest percentage.

7.2.1.3 Resource Utilization

The Resource Utilization tab shows a breakdown of the man-hours and equipment hours utilized on
the job, based on take-off quantities.
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7.2.1.4 Subcontract Status

The Subcontract Status tab displays a breakdown of subcontractor amounts, costs, and percentages for
quoted cost items. This is a good place to review how much of your estimate is subcontracted.

7.2.1.5 Vendor Status

The Vendor Status tab displays a breakdown of vendor information, including amounts and
percentages of the Target Price represented by vendors. This is a good place to review how much of
your estimate costs come from vendor quotes.

7.3 SPREAD TARGET PRICE OVER PAY ITEMS

In the Cost Breakdown Structure you generated your direct and indirect costs, and in the Price
Breakdown Structure you added profit to come up with a Target Price for the bid, but you still haven’t
decided how to spread the Target Price over your pay items.

In Lesson 4 you created pay items for the project in the Pay Item & Proposal Register. You can now go
back to the Pay Item & Proposal Register to distribute your Target Price over those pay items.

7.3.1 Current Price vs. Target Price

In InEight Estimate, Current Price means the total price that is currently assigned on your pay items.
Open the Pay Item & Proposal Register to see what the Current Price is for your pay items (Price > Pay
Item & Proposal).
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At this point there is no pricing on your pay items, so your Current Price is $0.00. This is because you
have not yet spread your Target Price (the total of your cost and profit) over your pay items.

7.3.2 Proposal Recap

On the Pay Item & Proposal Register, there is a Proposal Recap table where you can compare your
Current Price to your Target Price to see if there is any variance.

Ideally, you want to add pricing to your pay items until your Current Price equals your Target Price, so
that your Variance equals zero. That way you know you are covering all your costs and getting the
profit you want.

Notice the Variance column will indicate if you need to ADD or CUT pricing on your pay items to hit
your Target Price.

7.3.3 Spread the Target Price

For lump sum contracts, spreading the Target Price may be as simple as spreading it to a single pay
item that represents the entire project. However, most jobs will have at least a few pay items defined
by the owner, and Unit Price contracts will have many pay items.

There are two main ways to distribute pricing onto your pay items:
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1. Define pay item prices manually, by entering a unit or total price, or a margin percentage.

2. Use InEight Estimate’s AutoPrice feature to distribute pricing automatically.

7.3.4 Define Pricing for Pay Items Manually

First, you will walk through the process of defining pricing manually. This method requires filling in
each item’s price based solely on your own judgment.

Step by Step — Define Pricing Manually

1. From the InEight Estimate landing page, select the Price tab.

2. Select Pay Item & Proposal from the Pay Items section.

l Review the Proposal Recap and determine where adds or cuts are needed. If your Current
Price is $0.00, you need to add the entire Target Price to your pay items

3. Select a pay item.

l Notice at the top-right of your register you have an Item Recap to tell you what the direct
cost, overhead and profit would be for the Civil Work pay item if it was balanced
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4. First, define pricing manually. In the Total Price (current) field for your selected pay item, enter
a dollar amount.

5. Use Go to Column (<Ctrl> - G) to find the % Margin column, bring it in next to the Total Price
(current) column, and adjust your % Margin amount as needed.

7.3.5 Use AutoPrice to Balance and Hit the Target Total

Perhaps you want to get a head start and have InEight Estimate spread your Target Price
proportionately over your pay items for you. This can be done using the InEight Estimate AutoPrice

InEight Inc.  |  Release 19.2 Page 239 of 962

Estimate User Guide 7.3 Spread Target Price Over Pay Items



feature.

Once distributed, you will still have the ability to adjust your pricing on pay items
manually as needed.

Look at how you can use the AutoPrice feature.

Step by Step — Use AutoPrice to Balance and Hit the Target Total

1. Open the your job in InEight Estimate.

2. From the InEight Estimate landing page, select the Price tab.

3. Click on Pay Item & Proposal to open the Pay Item & Proposal Register.

4. On the Pay Item & Proposal Register menu, choose Actions > Balanced Bid > Hit Target Total.

5. Review the Proposal Recap and see that the Variance is now $0.00. Now that the job is balanced,
you can see that the Current Price and the Target Price are the same, indicating that the costs
and profit are spread proportionately over your pay items.

7.3.6 Use AutoPrice to Unbalance and Hit the Target Total

The Autoprice to Unbalance feature in InEight Estimate can automatically distribute profit to account
for your over- and underrun items.

InEight Estimate will take profit from your underrun and put it on your overrun by using the Actions >
Unbalanced > Hit Target Total feature. The purpose is to maximize your profit by spreading it
strategically between these items.

Step by Step — Unbalance Hit Target Total

1. You may encounter overrun and/or underrun items in the Pay Item & Proposal Register of your
job.
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2. If you do, highlight the row for each item to view it’s current balanced item recap.

3. On the Pay Item & Proposal Register menu, choose Actions > Unbalanced Bid.

l You will see the changes reflected and how the profit was spread to your overrun and
underrun items
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l In the example shown, highlighting each item will show that all your overhead and profit
from Excavation was put onto Clearing & Grubbing.
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Exercise 7.1 — Manually Price Pay Items

To finalize your bid proposal, you will apply final pricing (costs and profit) to your pay items either
manually or using the AutoPrice tool. In this exercise, you will practice entering prices manually for
your pay items. Complete the following steps, using your E101 – Training Job.

1. Continue manually pricing items in the Pay Item & Proposal Register.

2. Type 2.75 in the Unit Price (current) column for pay item Unclassified Excavation.

3. Type 2 in the % Margin field for pay item 4000 – 10” PVC Pipe.

4. Check your variance to see if you need to add or cut your current pricing to hit your
Target Price.

You should end up with the following results

According to the Proposal Recap, you need to add $21,611.42 to reach your Target Price.

Congratulations, you have completed this exercise!

InEight Inc.  |  Release 19.2 Page 243 of 962

Estimate User Guide Exercise 7.1 — Manually Price Pay Items



7.4 BID ADJUSTMENTS

Often you will want to continue adjusting certain pay items and then rebalance to hit the target total.

7.4.1 Lock Price

You can lock down a pay item price and it will not factor in future rebalancing.

Step by Step — Lock Price

1. Select the Lock Price checkbox on an item's row.

2. After making further adjustments in the next step by step, you will return to the Pay Item &
Proposal to rebalance.

l You can continue to adjust at previous levels aside from solely in the Pay Item & Proposal
Register

l For example, you could make a last-minute adjustment in the PBS or CBS. You can make
adjustments anywhere, but for this example an adjustment will be made in the Direct Cost
Add-On record at the CBS level

Step by Step — Make Last Minute Bid Adjustments

1. With your job open, select the Estimate tab.

2. Click on Cost Breakdown Structure to open the CBS.

3. Double click on the row header to open the Direct Cost Add-On dependent cost item record.
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4. Under the Description tab on the left, click in the blank row under the Description column.

5. Type in a description.

6. Make the adjustment by typing a numeric value in the Cost column of the Materials Cost
category under the Cost Breakdown section on the right.

l To make a cut, enter a negative value, i.e. -1000

7. Press the Tab key, and your adjustment will be reflected on the left-hand side.

8. Finally, return to the Pay Item & Proposal.

9. On the Actionsmenu, select Balanced Bid > Hit Target Total.

10. An Auto Price Warning may display, informing you of rounding variances. After reading the
details, click the Close button.
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l Note on the proposal recap that a variance may still exists because there are limited
number of pay items to spread the rounding error over

l Note that the locked item did not adjust, but the other pay items were updated

l Note that you can overwrite locked items for spreading your price by checking the
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Overwrite Locked Pay Items option on the Actions menu

7.4.2 Suspend Pay Items

Like suspending cost items in the CBS Register, you can suspend pay items in the Pay Item & Proposal
Register. Suspending a pay item causes it to no longer contribute quantities and pricing to the
estimate.

This can be helpful when considering alternate items on a bid submission. Should the client decide to
not require a pay item, you can suspend it, causing the pay item and any of its assigned cost items to
no longer contribute any cost or price. It will no longer show up on your bid and no longer contribute
to the overall total price.

You can suspend/unsuspend pay items in one of three ways:

l Right click on the pay item and select Toggle Suspended
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l Select the pay item and click Toggle Suspended under the Edit section of the Actions Tab

l Open the pay item record and checking/unchecking the Suspend box
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Lesson 7 Review

1. Markup is a function of cost, while margin is a function of _________.

a. billing

b. price

c. job overhead

d. indirect costs

2. When adding profit, it must be the same amount for direct and indirect costs.

a. True

b. False

3. What options do you have to enter profit on the PBS?

a. % Mark-Up, % Margin, and Fixed Dollar Amount

b. % Mark-Up or % Margin

c. Fixed Dollar Amount Only

4. Once distributed, you still can adjust your pricing on pay items manually as needed.

a. True

b. False

Lesson 7 Summary

As a result of this lesson, you can:

l Add job markup (profit)

l Use tools on the PBS form to review your estimate

l Spread Target Price over pay items

l Make bid adjustments
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LESSON 8 — QUOTE MANAGEMENT

Lesson Duration: 60 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Create and publish RFQs

l Define quote pricing

l Compare and award quotes

l Create and analyze scope items
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8.1 QUOTE MANAGEMENT OVERVIEW

8.1.1 Quote Management Workflow

When you make the decision to send out RFQs (Requests for Quote), as the estimator you will outline
the specifications for the request, select the vendors you wish to contact, and issue the request for
quotes.

When you receive quotes back from vendors, you can enter their pricing into InEight Estimate, where
you can compare them, award them, and update your CBS costs in one fluid process without the need
to re-enter data in multiple locations. InEight Estimate lets you enter multiple vendor quotes to enable
price comparison.

Awarding a quote in InEight Estimate does not mean the vendor is awarded the contract,
but rather that their price is selected as the carrying cost in the bid.

InEight Estimate provides a built-in workflow for managing your quotes, consisting of three steps:

1. Creating and publishing Requests for Quote (RFQs)

2. Updating quotes with vendor/subcontractor pricing

3. Comparing and awarding quotes

InEight Estimate has a separate form to manage each step:

1. Request for Quote (RFQ) Register

2. Quote Register

3. Quote Comparison & Award

8.1.2 Quotes and Quote Groups

Typically, an estimate contains two types of quotes:
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1. Quotes for resources (materials, equipment) purchased or rented from suppliers.

2. Quotes for subcontracted work.

In InEight Estimate, quotes from suppliers are managed at the resource level. In other words, you can
use material resources to represent the items purchased from the supplier.

For the cost items in your project that you plan to subcontract, you can manage quotes at the cost
item level, using the cost items themselves as the descriptions on the quote request.

You can use Quote Groups to group together multiple resources or cost items that will be sent in an
RFQ package. Using quote group tags can save a great deal of time generating packages of items to
request quotes for.

8.1.2.1 Resource Level Quote Groups

When sending out quotes, you may want to organize your resources into groups based on the type of
material, such as pipe, aggregate, or concrete. When creating Requests for Quote, you will be able to
select your pre-defined quote group and it will bring all the related resources along with it. You can
assign quote groups using a pre-defined tag called a Quote Group in the Resource Rate Register.

Below is an example of resources with a quote group assigned:

8.1.2.2 CBS Level Quote Groups

For your subcontracted items, you can assign quote groups at the cost item level to group together
subcontractor work, such as Commercial Work or Landscaping Work. These labels are assigned using a
pre-defined tag called Quote Group in the Cost Breakdown Structure register.
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8.2 REQUESTS FOR QUOTE

Requests for Quote (RFQs) are invitations to sellers that include a requested list of items or
services/pricing and terms. When you create an RFQ in InEight Estimate, you are able to indicate the
line items you want to include in the quote, and the vendor(s) to whom you want to send it.

8.2.1 Request for Quote (RFQ) Register Overview

To access the Request for Quote (RFQ) Register, from the InEight Estimate landing page, select the
Quote tab, then click on Request for Quote (RFQ).

l The RFQ register lists all of the RFQs you’ve created, with a Description, a Status, and a Response
Deadline Date
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8.2.2 Request for Quote (RFQ) Record

You can double click on the row header, or right-click on any request for quote in the Request for
Quote Register and choose Open to access an existing Request for Quote (RFQ) Record.

Name Definition

1
RFQ
Description

Each record contains a Description, Deadline Date and Deadline Time fields to
identify the RFQ and indicate when a response is due.

2 RFQ Tabs The record is organized into tabs where you can define the items for the quote,
terms & conditions, and the seller companies to receive the RFQ.

3
Status and
Published
Data

The Status and Published Date let you know if it is new or published (sent out),
and when it was published.

Overview – Request for Quote (RFQ) Record
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8.2.3 Create an RFQ

When putting together your RFQs, you will be able to select the appropriate material resources and
cost items for which you need quotes in your estimate. To create a new RFQ, you have a few options:

l Create RFQ from scratch:  This creates an empty RFQ Record for you to define

l Create RFQ from Quote Group Tag(s):  This option lets you create an RFQ from a quote group so
you can add multiple materials or subcontract items at once

l Create RFQ using Default Seller data:  In your address book you can store vendors with a list of
their default materials. This option lets you select the vendor and have it automatically find their
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materials in the job

The rest of this section walks through each tab on the RFQ Record in more detail.

8.2.3.1 Line Items

The Line Items tab lists the resources or cost items selected for the RFQ, including the Description,
Quantity, Quote Group, Currency and other user-defined tags.
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8.2.3.2 Terms & Conditions

This tab provides ample space for you to enter terms, conditions and instructions that need to be
included on the RFQ.

8.2.3.3 Seller Companies

You will use the Seller Companies tab to select the suppliers or subcontractors that will be receiving
the RFQ. This is done by selecting them from the InEight Estimate Library Address Book. This tab will
store all of the pertinent contact information for each seller, including their fax number and/or email
address so that you can send them the RFQ.
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The following options are particularly noteworthy:

l Publish Item Quantities:  If you want the RFQ to specify your take-off quantities, select this
checkbox. If you want to keep that information to yourself and let the vendors or contractors
determine their own quantities, deselect this checkbox

l Publish by Fax:  If you choose to publish by fax, InEight Estimate creates a Word document with
a template filled out. It is ready to print and send, but you have the opportunity to double-check
the information before emailing the RFQ

When RFQs are generated for multiple vendors using the Publish by Fax option, be
sure to separate the MS Word document pages and send only the correct pages to
each vendor.

l Publish by Email:  If you choose to publish by email, the Word document is created, the
template is filled out, it is attached to an email, and automatically sent to the email address
listed for that vendor in the Address Book

When using the Publish by Email option, the process is automatic and it does not
give you the opportunity to double check your information before the RFQ is
emailed. For this reason, it is recommended to Publish by Fax, review the
information, and then email the RFQ manually.

8.2.4 Attachments

This tab allows you to specify any electronic files that need to be attached to the RFQ, such as drawings
or specifications for the work.
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8.2.5 Setup

The Setup tab lets you indicate what information will display on the published RFQ template, including
custom tags. In addition to selecting tags and adding notes on the Setup tab, you can also specify your
RFQ Publication Settings and can choose whether you want to include the instructions, special terms
and conditions, notes and attachments.

8.2.6 Publish an RFQ

Once created, InEight Estimate allows you to generate a Microsoft Word RFQ template that can be
faxed or manually sent via email to the supplier or subcontractor.
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When you complete all of the fields that are required for this RFQ, you are ready to publish the RFQ, To
do so, select all of the vendors that you want to receive the RFQ and click Actions > Publish on the RFQ
Record ribbon.

Step by Step — Create and Publish an RFQ

1. Open your job.

2. From the InEight Estimate landing page, select the Quote tab.

3. Select Request for Quote (RFQ).

4. From the Actions tab, click on the New icon to create a new RFQ.

5. Select Create RFQ from Quote Group Tag(s), leaving the checkboxes checked to only show
quote groups and resources that are being used.

6. Select a description from the panel.
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7. Click OK.

l The Request for Quote (RFQ) Record is created with two aggregate line items

l The Description field is automatically filled with the name of the quote group
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8. In the Response Deadline Date field, select a date two weeks from today, and for the Response
Deadline Time, type a time stamp (e.g. 2:00 pm).

9. Select the Terms & Conditions tab.

10. Create and type in any special conditions in the Buyer’s Special Terms & Conditions field.

11. Type in instructions in the RFQ Instructions field.
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12. Select the Seller Companies tab and click in the first blank row in the Company Name column.

13. Click on the Address book icon, and then select vendors.

14. Click OK.

15. Make sure Publish by Fax is checked for all sellers, and that they all have Fax numbers.

l Also make sure Publish by Email in unchecked for each vendor

16. Select the sellers to whom you want to send the RFQ.

17. Under the Actions tab of the record, select Publish to create your RFQ document.

l MSWord opens the file automatically for you to review; and from here you can either
print it or send it in an email as an attachment
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18. Click OK to save the RFQ Record.

8.2.7 RFQ Email Draft

When sending out Requests for Quotes (RFQ) on a bid, it is essential to be able to effectively
communicate the project requirements to potential subs or suppliers to ensure you have good quote
coverage within your estimate. Email RFQs open as a draft email message, giving you, the sender, the
opportunity to control specifically what is sent and customize the message before sending it out to
subs and suppliers.
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8.3 QUOTES

When you receive responses to your RFQ, the next step is to enter their pricing in the Quote Register.
The Quote Register stores all of the quotes you have for that job. Each quote has a Description and a
Quote Status, and each quote displays seller contact information.

In this case, an estimator in charge of receiving quotes would need to determine how best to input
these quotes within the Quote register.
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8.3.1 Sample Received Quote Scope Sheet

Name Description

1 Section one

Scope item one includes 4 items the subcontractor has considered as work to
be done onsite. You may want to consider adding all 4 items as individual
quotes. Then creating a package identifying these quotes as on-site work,
totaling $203,000.

2 Section two Scope item two includes 3 items the subcontractor has considered as work
to be done offsite. You may want to consider adding all 3 items as individual
quotes. Then creating a package identifying these quotes as offsite work,
totaling $24,650.

3 Exclusions
The subcontractor is showing 9 items they excluded from their scope of
responsibility.

4 Qualifications The subcontractor has included 3 stipulations pertaining to this bid. If
selected all 3 are considered accepted terms.

Overview – Received Quote Scope Sheet
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8.3.2 Quote Register Overview

To access the Quote Register, choose Quote > Quotes on the main InEight Estimate menu or click the
Quotes icon on the toolbar.
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8.3.3 Quote Record Overview

The Quote Record establishes who the vendor is, along with quoted prices and all terms and
conditions. Once a requested quote returns, you can either create the quote in InEight Estimate from
scratch or convert the original RFQ to a quote and enter the supplier or subcontractor pricing. Each
Quote Record contains additional fields and options for managing the quote.

Quote Records utilize data blocks allowing you to reposition tabs, detach tabs into individual windows,
and redock tabs in new locations. Using the data blocks layout, you can input and maintain important
quote data like Vendor Qualifications and Special Terms & Conditions.

Right click on any existing quote in the Quote Register and choose Open to access the Quote Record.

Name Description

1
Header
block

You can include detailed contact information about the supplier or subcontractor.
This automatically fills when you select the seller from the Address Book. The
External Ref field can be used to access information specific to the bid/quote.

2 Price
block

The Price data block contains a breakdown of pricing information for the quote,
including taxes, item conditions, and special conditions.

3
Quote
tabs

The tabs at the bottom of the screen hold detailed information regarding the
quote.

4 Default
Data
Blocks

Data blocks include Special Terms & Conditions, Qualifications, Packages, Taxes,
Seller’s Profile, Setup, and Minority.

Overview – Quote Record
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8.3.4 Header Block

The Header block portion of the screen is where you enter in description information pertaining to the
quote, along with vendor/contractor information.

There is an External Ref field you can use as a hyperlink for attaching any supporting bid quote
attachments from the vendor/contractor.

On the right portion of the header block is where you enter optional information related to:

l Optional Code – a code used to reference the received quote.

l Date – date the quote is received.

l Source – this is the method by which the quote was received. The options are email, fax, hard
copy, phone, and other.

l Currency – system of money in general use for a particular country..

l Ignore – by ignoring the quote, and providing a reason, the quote will turn grey in the Quote
Comparison & Award screen.

8.3.5 Price Block

The Price block includes the quotes extended price, along with any additional taxes, bonds, item
conditions, and special conditions.
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8.3.6 Quote Record Tabs

8.3.6.1 Resources & Cost Items

The Resources & Cost Items tab displays the resources or cost items quoted, along with their estimated
quantities and units of measure.

l A Unit Price column is included on this tab for entering the quoted pricing from the seller, either
manually or by pasting from an electronic format

l If a Package code is entered, the Unit Price field is greyed out, and the Package code amount is
used

l Additional columns are provided for making conditional amount or percentage adjustments to
the quote to manage last-minute changes

l A note field is included for explanation changes

l A No Split option indicates that the seller will only provide the quoted goods or services if they
are selected to provide all listed items. They will not provide one quoted item without you
procuring all others from them as well.

l You can check an item as Free for circumstances where the vendor will include the price of one
item with another. Marking the included item(s) as free reminds you there is no quoted price for
that item

8.3.7 Data Blocks

The Quote Record utilizes data blocks that allows you to customize the layout and focus on data block
tabs that matter most to you. You can select the default data block action in the ribbon to revert back
to the default setting, which shows all six data blocks.

Data Block tabs include:

l Special Terms & Conditions

l Qualifications

l Packages
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l Taxes

l Seller’s Profile

l Setup

l Minority

The six data blocks appear at the bottom right of the screen.

It’s possible to move the entire data block, or individual data blocks to other parts of the screen. For
example, select the Special Terms & Conditions header row, and drag to the desired part of the screen.
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Drop the data block on top of an arrow where you wish to land the data block.

The data block will now reside on the left side of the screen.
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You can also close a specific tab if it’s not commonly used. In this example, you can right click on a tab
(like Special Terms & Conditions) and select close.

8.3.8 Data Block Tabs

8.3.8.2 Special Terms & Conditions

Special Terms & Conditions is where you can include buyers and sellers special terms, add fixed cost to
the quote, and include/exclude scope items.
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8.3.8.3 Qualifications

This tab allows you to include bond. You can enter the bond rate and the system will calculate the total
Bond Cost or vise versa. This tab also allows you to enter insurance contact information and seller
license information. If the vendor in the address book already had this information, then this
information will get pre-filled when the seller is assigned to the Quote.
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8.3.8.4 Packages

Using the Packages feature allows you a way to arrange quotes into a collection which makes sense for
packaging your quotes. You can determine how to intake quotes from subcontractors and classify them
into a package grouping.

By creating a Package code within the Packages block, and giving it a dollar value, you can then assign
that package code to one or many quote records. In this case, the subcontractor provided quotes for
both on site and off-site concrete work. You can then determine which individual quotes go with the
on site or off-site package. The Package Amount field carries over to the Extended Price field under the
Cost Items tab.
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You can also create a package by selecting multiple items and selecting Add to new Package.

8.3.8.5 Taxes

Item Tax and Quote Tax have been combined to display on a single data block called Taxes. Using the
taxes feature allows you to add item taxes to each item's price. You can also add taxes to the quote.

8.3.8.6 Seller’s Profile

The Seller’s Profile tab populates with address book notes and alternate contact information.
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8.3.8.7 Setup

This tab provides extra space for any additional notes and tags to be assigned to the quote.
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8.3.8.8 Minority

This tab allows you to determine if the seller qualifies for any type of minority business, and the ability
to apply a certification number.
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If any of your Data Blocks become deleted on a Quote Record, simply click the Default
Data Block icon.

8.3.9 Create a Quote from RFQ

Walk through the steps of creating a quote from an RFQ.

To create a quote from scratch, click the New icon on the Quote Register and fill in the
quote details and seller fields manually.
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Step by Step — Create a Quote from RFQ

1. Open your job.

2. From the InEight Estimate landing page, select the Quote tab.

3. Select Request for Quote (RFQ).

4. Open the RFQ record for which you’ve received quotes (e.g. Aggregates RFQ).

5. Select the Seller Companies tab and select the sellers for whom you need to create quotes.

6. From the Actions menu, select Create Quote.

l InEight Estimate will create quotes for each of the sellers you selected
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l A prompt indicates how many quotes were created, then click OK

7. Close the RFQ Record and the RFQ Register.

8. To open the Quote Register, select Quote from the InEight Estimate landing page.

9. Select Quotes from the Quote Management section.

l The quotes that you created from RFQ are now listed on the Quote Register

8.3.10 Enter Quote Details

Now that you have quotes created, you can enter pricing.

Step by Step — Enter Quote Details

1. Open the Quote Record for a seller.

2. On the Resources tab, make sure No Split is unchecked for all items.
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3. Also on the Item Resources & Cost Items tab, now enter the following unit prices for the
resources:

Resource Code Description Unit Price

MBR Aggregate Base Rock $8.00

MDIRTB Dirt Class B $6.00

4. Click OK to close the Quote Record.

Step by Step — Create a Multi-packages Quote

1. From the InEight Estimate landing page, select the Quote tab.

2. Click on the Quotes icon under Quote Management.

3. Double click on an item (e.g. Pipe Materials).

4. In the Description field, type in or replace the description.

5. In the Contact field, select a contact.
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6. Click OK

7. Select the Cost Items tab on the left side of the screen.

8. Add a cost item under Cost Items.

9. Then, add another cost item under Cost Items.

10. On the Packages tab, enter the following 2 new records:

1. Code: P1

2. Description: On Site

3. Amount: $200,000

4. Code: P2

5. Description: Off Site
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6. Amount: $300,000

11. Type in P1 under Package for cost item 7.

12. Type in P2 under Package for cost item 8.

13. Select OK.

14. Under the Quote Comparison and Award ribbon, select Cost Items.

15. Under Quote Groups, select Pipe Materials.

l Quote Comparison and Award shows the newly created quote with the associated package
quotes.
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l The Package Price can quickly be modified in the Quote Comparison and Award form by
selecting the Edit Package action in the Actions tab or by using the right click context
menu.
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8.3.11 Use Unit Price or Extended Price on Quote Record Item

It's possible to enter the Extended Price for a Quote Item, and the Unit Price is then calculated, which
makes entering quotes more efficient and results in less errors.

8.3.12 Duplicating an Existing Quote

You can create a new quote by duplicating an existing quote from the Quote Compare & Award form.
Duplicate Quotes will contain the same scope as the quote that you previously copied.

Step by Step — Duplicate an existing Quote

1. From the InEight Estimate landing page, select the Quote tab.

2. Select the Resources icon under Quote Comparison & Award.

3. Highlight any row under the Quote column you want to duplicate.
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4. Select the Actions tab.

5. Under the Quotes section, select the Duplicate Quote icon.

l The resources and prices from the quote you previously selected have been copied into a
new Quote Record.

6. From the Header block, enter in any missing information.

l The information listed in the Header block will not copy over to the duplicated quote.

7. Enter additional Cost Items in the Quote tabs data block.

l Check the default data blocks for any information you want to add to your duplicate
quote.
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8. Once done, click OK.
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Exercise 8.1 — Quote Management

When you receive quotes from vendors, you will need to record their pricing and conditions in their
InEight Estimate quote records. In this exercise, you will practice entering quote details. Enter the
following Quote Record details, using the Training Job:

Quote Name:
Aggregates

Seller Name: Example Vendor 2 - Stan Mark

Resource
Code

Description Unit Price

MBR Aggregate Base Rock $7.45

MDIRTB Dirt Class B Not Quoted (delete)

Special Instructions Seller is NOT willing to split items.

Quote
Name:
Aggregates

Seller Name: Example Vendor 4 - Lester Slim

Resource
Code

Description Unit Price

MBR Aggregate Base Rock $8.15

MDIRTB Dirt Class B FREE

Special Instructions Seller is NOT willing to split items.

Resource Code Description Unit Price

Quote Name: Aggregates Seller Name: Example Vendor 4 - Lester Slim

Resource Code Description Unit Price

MBR Aggregate Base Rock $8.15

MDIRTB Dirt Class B FREE

Special Instructions Seller is NOT willing to split items.

You should end up with the following results
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Congratulations, you have completed this exercise!
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8.4 QUOTE COMPARISON & AWARD

Now that you’ve received quotes and entered pricing information, you will compare them to
determine which is the preferred vendor or contractor to carry their pricing in your estimate. The
Quote Comparison & Award forms improve visibility into comparative analytics, while increasing
efficiencies in populating the estimate with quoted values.

The Quote Comparison & Award screen is designed to closely match the layout of a vendor comparison
sheet. It’s designed to show all scope items with prices provided by multiple vendors and substitute
pricing where items have been excluded.

Now that you’ve entered contextual quote information in the Quote Register, the Quote Comparison &
Award screen provides you with the ability to make better, and more efficient determinations for
awarding the quote.

8.4.1 Quote Comparison & Award Overview

To open the Quote Comparison & Award form, select Quote > Quote Comparison & Award.

Name Definition

1
Resource and
Cost Item Filter

You can show either your quoted resources or cost items.

2 Quote Group
Filter

This section provides checkboxes to further filter your items. The Quote
Group Filter allows you to mark the quotes as reviewed.

3
Quote
Description and
Vendor

Your quotes display with the vendor name plus the quote description.
l Awarded items have an award symbol

If an item is designated as No Split, it has a chain link icon
l Awarded and Locked items have a lock symbol next to the award

symbol

4 Cost Source
Type

The cost source can either be a Plug or Detail type.

Overview – Quote Comparison and Award Form
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8.4.2 Edit Mode

You can make last minute modifications to the quote price directly in the Quote Comparison and
Award form.

When in Edit mode, the quote item's price, unmodified by the quote's bond cost or special conditions,
can be updated. You can modify the Unit price or the Extended price for each of the quote items that
are not part of the package or marked as Free.

The updates made to quote items in Quote Compare and Award will update the estimate in real time
allowing you to see the impact of the changes in the estimate.

8.4.3 Substitute Values

You can display a substitute value by selecting Actions > Substitute Values.

Notice the entered quotes. One of the vendors did not give pricing for three of the CBS items.
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When you compare this quote to the others, it can be difficult to see if the total cost of the quote is
high or low because it is missing some of the pricing. InEight Estimate can help you make an “apples to
apples” comparison by filling in a substitute price for items that are missing.

You can tell when it’s a substitute value because the price displays in italics.

InEight Estimate grabs the substitute value from one of four places:

1. Awarded splittable quote

2. Lowest splittable quote you’ve received

3. Detail (this only applies to quoting cost items)

4. Plug cost (the rate defined for that resource in InEight Estimate)

You can set the order for a substitute value by selecting Actions > Set Substitute Ranking.

On the resulting Substitute Ranking window, you can use the up and down arrows to change the
selection order. It will look from the top to the bottom of the list. The plug being in red represents the
most risk, while the Awarded Splittable Quote is the least risk. Users can modify the color coding of
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these Substitute values by navigating to System Customize dialog and then selecting Substitute Quote
Ranking in the colors sections.

Note that the substitute values are color-coded so that back on the Quote Comparison & Award form
you can see the source that your substitute value comes from. When you hover- over a substitute
value it displays the vendor whose substitute value has been used.

When you use a substitute value, it is included in your Comparable Total so you can have a more
realistic comparison of your quotes.
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8.4.4 Display Ignored Quotes

You can view ignored quotes by selecting Actions > Ignored Quotes.

You can ignore a quote by right clicking on the subcontractor header, then selecting Edit Quote.

From the Quote Record screen, select the Ignore check box and also a Reason, then select OK.
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If the quote record is already awarded, you will not be able to select the Ignore option.

If the Ignored Quotes button is pressed, the ignored quote will display in grey. An ignored Quote
cannot be awarded. The ignored quotes get appended to the right end of the QC&A form.
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8.4.5 Additional Quote Comparison and Award functions

The Quote Comparison and Award form contains other notable functions which improves the process
of selecting the quote that brings the greatest value to the estimate.

Name Definition

1
Asterisk next to
Quote Item

An Asterisk (*) is displayed on a quote to indicate when that quote includes
quote items appearing in other Quote groups.

2 Zero value
Plug/Detail

Award quotes to Plug or Detail when its value is zero.

3
Updated Quote
Items Tool tip

Quote Item Tool tip displays details including:
l Unit Price
l Extended Price
l Bond
l Taxes
l Special Conditions
l an indicator for a delta quote item

Overview – Additional Quote Comparison and Award Functions

8.4.6 Configure Totals

You can display and sort additional Summary Totals, Special Conditions, and Last Updated fields by
selecting Actions > Configure Tools.
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The Options radio button give you better control for viewing totals at the tops of the screen or after
the quotes.

After selecting additional captions, the new fields appear at the bottom of the Quote Comparison &
Award screen. Notice that the caret symbol next to the Comparable totals in the below screenshot
indicates that the Quotes are sorted based on Comparable totals in an ascending order.
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8.4.7 Adding Notes to Quote Comparison & Award

The Notes feature within the Configure Totals tool, allows you to quickly add, edit, and view notes for a
quote in the Quote Comparison & Award form. Having visibility into the notes such as phone
conversations with vendor/supplier, quotes that need clarification, or notes on other attributes will
help you in making better decisions on who to consider when awarding a particular quote.

Step by Step — Add the Notes section to Quote Comparison & Award form

1. From the InEight Estimate landing page, select the Quote tab.

2. Select the Resources icon under Quote Comparison & Award.

l Notice the absence of the Notes section. This is the default option until you follow the next
steps.
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3. Select the Actions tab.

4. From the View section, select the Configure Totals icon.

5. Select the check box in the Visible column for the Notes caption.

6. Select OK.
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l The Notes section displays on the Quote Comparison & Award form.

8.4.8 All Quote Groups Layout

The All Quote Group icon, located within the Quote Comparison and Award ribbon, allows you to see
all the quote groups at the same time.

You can make appropriate quote group selections based on understanding how choosing a quote
group impacts the entire estimate. In addition, the quote groups layout provides you with the visibility
and flexibility in aligning scopes, and being able to perform an efficient comparison of various quotes.

Features of this layout include:

Name Definition

1
Totals per Quote
Group

Ability to see the Awarded Total Plug, Detail and Quote amount per
Quote Group

2 Total Awarded
Amount

Visibility into the Total Awarded Amount per Quote Group

Overview – Quote Groups Layout
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Name Definition

3 Comparable totals Better visibility into the Comparable totals per Quote Group

4 Expand/Collapse Expand/Collapse individual or All Quote Groups to display the quote
items

Overview – Quote Groups Layout (continued)

You can scan through all the quote groups in the estimate and see if you are carrying the most
appropriate quote. You can also review the Totals per Quote Group and better analyze the risks in the
estimate based on whether the cost is a plug number, detailed estimate or a quoted value.

8.4.9 Compare and Award Quotes

To award an item, right click on that item and select Award.
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The Award icon displays next to the awarded item(s).

Once you award a quote in InEight Estimate, you can see it adds the Awarded Total on the comparison
screen, and the pricing updates automatically in the Cost Breakdown Structure.
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You can award multiple Quote items by selecting all the items and then using the right
click context menu to award.

8.4.9.1 Open Status

If a quote is yellow, this indicates that the quote record is open in another screen. Closing out of the
quote record, will turn the record back to gray.

8.4.9.2 Award Status

The Award Status indicates whether or not all quotes are awarded within a quote group.
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8.4.9.3 Review

You can keep track of what quote groups have been reviewed by checking the Reviewed check box.

This can be helpful when there are many quotes to track and several users managing them. If any
changes are made to quotes within a quote group after the quote group is marked as Reviewed, the
quote group will be highlighted in yellow to indicate something changed since the last review.

Once reviewed again after the changes, you can uncheck and check the Reviewed checkbox again to
indicate it is up to date, and the yellow highlighting disappears.

The following steps walk you through comparing and awarding the Aggregate quotes.

Step by Step — Compare and Award Quotes

1. Open the Training job, and from the main InEight Estimate landing page select Quote>Quote
Comparison & Award.

2. Select Resources on the Quote Comparison & Award ribbon.
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3. Under Description, select Asphalt Materials.

4. Review the quotes to determine the lowest bidder:

l Select the Configure Total icon in the tool ribbon to view additional captions

l Both vendors have no split items for both resources.
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5. Example Vendor 1 has the lowest comparable amount, so award all to Vendor 1 by right clicking
on the Example Vendor 1 Asphalt Materials and selecting Award All.

l By awarding Example Vendor 1 both resources, the award ribbon icon displays next to the
unit price.
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l You could also change your mind and award Example Vendor 2 one of the resources. In
this case, award resource code MAFA to Example Vendor 2.

6. Right click on $7.35 under Example Vendor 2, and select Award.

l You now have awarded resource code MAFA to Example Vendor 2.

8.4.10 Package Entire Quote

The Package Entire Quote function allows you to mark an entire quote as a package. This is beneficial if
you are attempting to quickly update an existing detailed quote to a lump sum quote from the Quote
Record or Quote Compare and Award form.
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8.4.11 Incomplete Quotes

The Incomplete quotes status indicates if a quote includes quote items that do not yet have a price.
This is often the case when vendors respond to an RFQ expressing interest in bidding but do not
provide their prices until right before the bid is due. These quotes display in gray in the Quote Compare
and Award form.

Incomplete Quotes that are Scope Only can be viewed in the Quote Compare and Award form using
the Zero Items toggle. These are quotes that have none of the Items priced. These quotes are
displayed to the right of all the Comparable Quotes.
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8.5 SCOPE ITEMS

During the bidding process, it’s common for subcontractors and suppliers to provide a quote(s) for
work during the tail end of the bidding process. These last-minute offers make it extremely difficult for
you to evaluate and compare the various quotes and your ability to award them. With scope items,
you can create and evaluate checklists and quote group exclusions, and account for them within the
Quote Comparison and Award form.

You can view scope items as a checklist of items that break down the quote’s scope of work into
individual tasks to aid in the process of evaluating subcontractor and supplier quotes in greater detail.
This can be used to ensure that certain items of work are included or excluded. If excluded, the scope
items need to be properly accounted for by contractor awarding the quote.

Section Description

Seller’s
Special
Terms &
Conditions

By default, all scope items are considered included in the quote, and the Special
Conditions amount is $0.00. On the quote record, by selecting the checkbox, you can
indicate scope items and uncheck items that are not included. The amount associated
with these items will then total up in the Special Conditions subtotal. The person
responsible for awarding quotes needs to update the Inclusions field to correspond
with what the subcontractor has agreed to include in the quote.

Overview – Quote Record – Scope Items

Page 312 of 962 InEight Inc.  |  Release 19.2

8.5 Scope Items Estimate User Guide



Section Description

1 Scope Items

Quote Comparison and Award checklist items for your quote that help with
evaluating subcontractor and supplier quotes in greater detail. This is used to
ensure certain items are either included (inclusion) or excluded (exclusion) in
the quote and accounted for by the entity awarding the quote.

2 Scope Item
Inclusions

Maintained in Quote Record form. These are the Seller’s Special Terms &
Conditions scope items that the subcontractor is including in their quote price.
When the scope item contains a value, the subcontractor is agreeing to perform
the work. 

3
Scope Item
Exclusions

Maintained in Quote record form. These are the Seller’s Special Terms &
Conditions scope items price. If the Inclusions checkbox is blank, the
subcontractor is NOT agreeing to perform the scope items.

Overview – Quote Comparison and Award – Scope Items
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Section Description

4 Scope Item
value

An entered value means that the subcontractor is excluding this scope of work.
However, you may add an amount because this scope could incur a cost. Once
the bid is awarded, you may find another subcontractor to perform the work.
You are simply accounting for a cost for this scope of work. In the example
below, HD Engineering is not going to paint the electrical equipment, but you
know the cost is $150.00. You are showing this cost to account the cost for this
scope of work that needs to happen.

5

Seller’s
Special
Terms &
Conditions

By default, all scope items are considered included in the quote, and the Special
Conditions amount is $0.00. On the quote record, by selecting this checkbox,
you can indicate scope items and uncheck items that are not included. The
amount associated with these items will then total up in the Special Conditions
subtotal. The person responsible for awarding quotes needs to update the
Inclusions field to correspond with what the subcontractor has agreed to include
in the quote.

Overview – Quote Comparison and Award – Scope Items (continued)

The example below in the Quote Register form shows quotes from two subcontractors, both with
different quote prices. It is important to understand all scope of work the subs are quoting. By just
viewing these quotes alone, it’s difficult to understand which quote will provide you with the best
value. In other words, just because Example Sub #3 is the lowest priced quote, does not mean it is the
best quote to go with.
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The example below in Quote Comparison and Award shows that HD Engineering Group is excluding 3
scope items in their quote that totals $950. This provides a more granular picture for what is being
included within each subcontractor’s scope of work. It also displays how much each scope of work
costs, so you have the option to find another subcontractor to perform this scope work.

Utilizing Scope Items enables you to more effectively compare quotes from subcontractors and
suppliers by providing a deeper comparison of quotes. Moreover, it provides clearer visibility of what a
proposal may or may not be including at the time you are attempting to make an award.

You can make a more informed decision on whom to award the quote to, now that the vendor quotes
and associated scope items are all visible on one screen.

8.5.1 Scope Item Setup

Scope items are stored within each quote group tag in the Foundation Setup Data form. On each
Quote Group Tag Record, you can list out scope items that break down the work into smaller scopes of
work, along with the estimated cost amount associated with each scope item.
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8.5.2 Scope Item Creation and Award

The following Step by Step assumes you are putting out an advertisement for bids for some electrical
work on a project. You will add scope items with some fixed costs as a special condition, then will
compare quotes in order to decide which vendor quote is the best deal.

Step by Step — Create and Award Scope Items

1. Open the Training Job.

2. Select the Setup tab.

3. Click on Foundation Data Setup in the Initialize section.

4. Select the Quote Group Tags tab to setup Scope Items within a Quote Group.

5. Create a new Quote Group Tag called Electrical Work and click OK.
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6. Open Electrical Work and add the following Scope Items:

l Permits

l Surveying and Layout

l Temporary Traffic Control Devices

l Trench and Backfill for Electrical Work

l Painting Electrical Equipment

l Temporary Power and Lighting

7. Enter 500 in the Amount field for Survey and Layout, and 300 for Temporary Power and Lighting.

l If any of these default columns are missing, click on one of the headers, and right click.
Select Column Chooser and drag the item(s)over tto the header bar, then click OK
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8. Click OK.

9. Select the Estimate tab.

10. Click on Cost Breakdown Structure (CBS).

11. Change your Saved Views to Quote Group Setup View.

12. Create a cost item Entry Gate with a subordinate Electrical Work.

13. Assign Quote Group Electrical Work to the Electrical Work cost item.

14. Select the Quote tab.

15. Click Request For Quote (RFQ) to open the RFQ Register.

16. Create an RFQ for the Electrical Work cost item by selecting the New icon on the Actions tab.

17. Select Create RFQ from Quote Group Tag(s) and select Electrical Work.
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18. Click OK.

19. Click on the Seller Companies tab and select the following Company Names:
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l Architectural Designs

l HD Engineering Group

20. Highlight both companies and select Publish.

l Make sure the appropriate boxes are checked and fields filled out for publishing either by
fax or by email prior to publishing

21. Assuming that you’ve already received quotes back from both companies, create a Quote from
this RFQ for both companies by selecting the companies and selecting Create Quote.
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22. Click OK to close the RFQ record.

23. Select the Quote >Quotes tab to open the Quote Register.

l Note the 2 quotes that were just created for Electric Work

24. Open the Quote Record for HD Engineering Group and enter a Unit Price of 3,500, which is based
on the quote you received.

25. Select the Special Terms & Conditions tab and select the Seller’s Special Terms & Conditions
radio button.
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l You now have visibility for all of scope items for this quote

26. Assuming HD Engineering is excluding certain scope items from this quote, click on the Included
checkbox to exclude (uncheck) the following scope items:

l Surveying and Layout

l Painting Electrical Equipment

l Temporary Power and Lighting

27. Type 150 in the Amount field for Painting Electrical Equipment.

l Notice how the 3 scope items you just excluded are now added to the Special Conditions
total for the quote
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28. Click NEXT to move to the other Quote Record for Architectural Designs.

29. Enter a Unit Price of 3,700.

30. Press Tab to move to the Special Terms & Conditions tab and select the Seller’s Special terms &
Conditions (at right) radio button.

31. Uncheck the Inclusions checkbox for Surveying and Layout

32. Add the amount 500.

33. Click OK.

34. Select the Quote tab.

35. Open the Quote Comparison and Award form, and select the Cost Items tab.

36. Under Quote Groups, select Electrical Work.
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l You will notice that scope items with inclusions and exclusions on the quotes are now
displayed in the Scope Items section. The Scope Items button needs to be pressed in the
View section of the screen

l The total of all exclusions are now added to the Special Conditions section for each
subcontractor

If your Special Conditions row is missing, click the Substitute Values icon on
the Action tab. You can also rearrange the sequence as desired.
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l Most importantly, this comparison including scope items makes it clear HD
Engineering Group has provided a quote of $4,450, while Architectural Design’s
quote is $4,200

37. Right click on the quoted amount for Architectural Design and select Award to award the work
to Architectural Design.

38. Click Yes, on the resulting prompt to mark the quote group as reviewed.
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l The Architectural Design’s quote is now awarded

8.6 QUOTE ITEM ADJUSTMENT

Quote items can be adjusted even after a quote has been awarded. This could happen on closing day
when a vendor sends in a last minute discount. For example, vendor 3 has sent in a 10% discount on
piping materials. This percentage discount is applied to the vendor 3 quote by entering the 10% in the
Condition Adjustment column.

Step by Step — Quote Item Adjustment

1. From the Ribbon, select the Quote tab.

2. Under the Quote Comparison and Award section, select Resources.
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3. Locate the Example Vendor 3 column.

4. Select the quote you want to edit under the Example Vendor 3 column. In the Ribbon, select the
Actions tab.

5. Under the Quotes section, select Edit Quote. You can also right-click and select Edit Quote. This
launches the Quote Record.

6. You can make Condition Adjustments by a percentage or an amount. Select the field to adjust
the percentage or amount of the Condition Adjustments.

If you enter a percentage, the amount is populated based on that calculation. This
is the same for entering a Condition Adjustment Amount.
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7. Items adjustments can be applied individually or by using the multi-edit function. Select multiple
resources in the Quote Record, then right-click and select Open. This opens the Quote Resource
Item Record.

8. As you populate the 10% discount adjustment to all of the items selected using the multi-edit
tool, the amount value changes to Varies. This is because of the variance in the unit rates for
each selected item.
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9. Select OK to save the changes to the line items in the Quote record and to save the Quote.
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Lesson 8 Review

1. When you receive responses to your RFQ, the next step is to enter their pricing in the
__________________.

a. CBS Register

b. PBS

c. Quote Register

d. RFQ Register

2. On a Quote Record, No Split means

a. The quote must be combined with other quotes from the same vendor

b. All items on the quote must be purchased from that seller

c. You can’t split the quote into multiple quotes

3. When a quote group is highlighted in yellow on the Quote Comparison & Award form, it
signifies that

a. The quote group has changed since it was last marked as Reviewed

b. No quotes have been awarded for that quote group

c. There are some quotes in the quote group that contain substitute values

Lesson 8 Summary

As a result of this lesson, you can:

l Create and publish RFQs

l Define quote pricing

l Compare and award quotes

l Create and analyze scope items
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Lesson Objectives

After completing this lesson, you will be able to:

l Run reports from the Reports menu

l Create and run reports from register forms
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9.1 REPORTS MENU

InEight Estimate provides a lot of out of the box reports, referred to as “canned” or “system” reports,
that can help you review and analyze your estimate.

9.1.1 Non-Modal Report dialog box

The Reports dialog is docked along with the other forms and registers. You can continue to work with
your estimate without being forced to close the Reports dialog box.

If the report becomes undocked, the job code shows in the reports dialog box header.
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9.1.2 Adjustable Reports

Most of the reports within InEight Estimate can be adjusted to output the specific data and reporting
format you need. Each report has its own set of output settings for configuring and formatting the
report.

All InEight Estimate adjustable reports are accessed from the Reports menu. You may even run the
same report multiple times and choose different output settings based on what you want to see or
who the intended audience is.

For example, you may choose to run the CBS Details Report several times to satisfy different needs or
for different audiences, and include or exclude specific data depending on what you or the report
recipients want to see.

l For a group of estimators, you may want to run a CBS Details Report that shows all cost and
productivity data for a job

l For field personnel, you may want to run a CBS Details Report that shows no cost data, but all
production and resource data

l Finally, for executive management, you may want to run a CBS Details Report that shows
summary level information only

The following steps take you through a brief overview of the Reports menu and how you can access it.

Step by Step — Get to Know the Reports Menu

1. Open the Training Job, and select Setup tab.

l You access the Reports menu by clicking on the Reports icon

You can access the Reports menu from the Setup, Estimate, Quote, Price,
and Execution tabs.

2. Select Reports.
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3. Here you select the Report of your choice. For this example, select the first option, Job
Properties.

l You will see a split screen with the reports available on the left side bar

l The side bar on the left of the Reports form contains a “tree” of all InEight Estimate
adjustable reports
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l On the right, when you select a report node on the left, note that it displays the Output
Settings on the right side of the form, from which the report settings can be adjusted and
the report can then be run

4. Each report has a Print tab, a Layout tab and a Header/ Footer tab specific to that report.
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l There are also Master Layout Settings and Master Header/Footer Settings located at the
bottom of the left-hand side bar tree. Here you can define settings that will apply to all
reports

9.1.3 Output Settings

This section provides a more detailed explanation of the output setting tabs.

9.1.3.1 Report Printing Options

The Print tab includes three options for printing output: Print to Printer, Export to File, and Preview.
Export file outputs include PDF, Excel, text, and more.

9.1.3.2 Report Layout Settings

Many of the InEight Estimate adjustable reports include formatting options for the general layout of
the report, located under the Layout tab of the report’s output settings. Settings for the report include:
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Orientation, Margins, Font, and Number Format.

9.1.3.3 Report Header/Footer Settings

Many of the InEight Estimate adjustable reports include the option to define and insert headers and
footers into the report. You can add information to the left, middle, or right of the header and footer
sections of the report.

1. Once you define headers and footers, you can save them for use on other reports.

2. You can add page, time, and date stamps as needed, as well as images (e.g., company logo).

3. You can also use brackets to have it “stamp” the report with the Job Code and Job Description.
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4. You can enter your own information as desired.

9.1.3.4 Report Detail Settings

Most reports have a Details tab with various options to configure what information is included on the
report.
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9.1.3.5 Save Output Settings

Once you’ve configured your settings for the report, you can save them as a custom version of that
report.
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The following steps walk you through configuring the settings and formatting for two different reports.
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Step by Step — Configure Report Output Settings (Report 1)

1. Open the Training Job and select Setup >Report>Resources.

2. Under Resources on the left side bar, select Resource Utilization.

3. On the Print tab there are three options. A best practice is to always set to Preview so you can
review before printing.

InEight Inc.  |  Release 19.2 Page 341 of 962

Estimate User Guide 9.1 Reports Menu



4. On the Layout tab you can make adjustments based on your preferences.
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5. Move to the Header / Footer tab. Remove the default Report Title from the first page Header
only and enter Resource Utilization in the center Report Header box as a title that will appear on
the first page only.
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6. Go to the Details tab, and you can see the details and options you can select to customize and
adjust the report.

7. For this navigation, you will not Filter by currency; leave the selection as No Filter.

8. Under Report Type, choose the first option, Resource Utilization Summary.
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l You can choose to select the Hide Zero quantity/cost Resources Employments Details box
if you prefer to have your printed report not show any resources that have a dollar value
of zero

l You can choose if you want the report at a summary level, or if you want it to reference
your cost items when you are looking at a resource

l If you choose Resource Utilization Summary with Employed Cost Items, it adds CBS
position to the structure of the report

l You would select this if you wanted to see cost items and resources by the cost item

The Details settings are “sticky” features, meaning they default to what was
selected the last time.

9. You can use grouping to group by different tags and user-defined fields. Most of them are
related to the Resource Rate Register, for example: Geographic Area, Organizational Category,
Wage Zone, etc. For this example, group by Resource Organizational Category.

10. Next, you can choose the resources you want to see. For this example, select the Labor and
Construction Equipment Resource Types.
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l For this example, you will not make any selections under Columns or Details

l This is just one of many ways to organize and adjust your report.

11. Click Run to run the report.

l This report can be helpful for seeing your utilization hours, broken down by regular time
and overtime hours

12. Click the red X to close this page and open the Construction Equipment page.

13. Click the red X to close the Construction Equipment report.

Step by Step — Configure Report Output Settings (Report 2)

1. Open the Training Job and select Setup >Reports, then expand the Cost Breakdown Structure
node.
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2. Under Cost Breakdown Structure on the left side bar, select Estimate Summary.
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3. Along with the Print, Details, Layout, and Header / Footer tabs, there is an additional tab called
Cost Item Selection. Select this tab.

4. The Cost Item Selection tab allows you to report on a selection of cost items:

l Print a contiguous range of cost items:  Allows you to print a series of cost items in a row.
In this case, print just items: select 4.1 in the From field and 4.3.2 in the To field.

l Select cost items to print from the register below:  Allows you to use column filters to
select the cost items to include in the report; leave this button unselected.

5. You can roll up your cost items to a certain CBS level for the report as well, depending on the
level of detail you need.

6. On the Details tab, select Days for Cost item production field 1, andMan-Hours / UM for Cost
item production field 2 (this report allows you to report on two production values).

7. Under Resource Types, uncheck all of the boxes except Labor, ConstructionEquipment, and
Installed Material.
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8. Leave the rest of the settings at their defaults, then select the Header / Footer tab.

9. In the center Page Footer field delete the existing text, then type Confidential –Internal Use
Only.

10. To save the settings you’ve configured, click on the Settings drop-down arrow above the output
setting tabs.
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11. Select the Save disk icon to save the new settings.

12. Type Estimate Summary – Manager.

13. Click OK.

l Notice that a custom version of the report now displays under Estimate Summary on the
Reports tree on the left

Page 350 of 962 InEight Inc.  |  Release 19.2

9.1 Reports Menu Estimate User Guide



9.1.4 Helpful Reports

9.1.4.6 PBS Summary

Under the Price Breakdown Structure Report node, the PBS Summary Report gives a good overview of
how your price breaks down by cost category. This provides a high-level overview that is cost category
driven, providing information based on the total value of the project.

When selecting your settings on the Details tab, a best practice is to select and include:

l Cost Categories

l Markup Rate

l Percentage of Cost

This allows you to see your costs and markup broken out by cost category.
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You can also select to show markup rate and what percentage the markup is of your cost.

9.1.5 Standard Proposal

Located under the Pay Item & Proposal report node, the Standard Proposal report can be used for
contractors required to submit a pricing proposal to a client. It lists all the pay items with the client
provided quantities and your final pricing. You can include subtotals (defined on the Pay Item &
Proposal Register), cover sheet information, and a signature block.
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9.1.6 CBS Details

Under the Cost Breakdown Structure report node, the CBS Details report can be a helpful report for bid
review. On the Details tab you can include or not include any of the information contained in the CBS
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Register, including cost items with production, costs by category, shift arrangements, resources, and
notes.

9.1.7 Audit

Under the Job Tracking node, the Audit Report is a very important report to run during estimate review
to make sure you didn’t leave anything out of the estimate. It checks for a number of potential errors
in the estimate, including:

l Zero Price Pay Items

l Zero-value cost items

l Pay items without Cost Items assigned

l Resources with a quantity of zero
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Exercise 9.1 — Run a System Report

You can adjust InEight Estimate system reports to report on the particular information you need.
Complete the following steps to configure and run the Pay Item Summary report, using the Training
Job:

1. From the Reports window, expand the Pay Item & Proposal report node.

2. On the Reports tree, select Pay Item Summary.

3. On the Details tab, select a Pay Item Range from 303 4263 – 800 0220.

4. Choose to Include Assigned Cost Items.

5. Show Costs As: Unit.

6. Include Profit Analysis columns and Include Pay Item Price columns

7. Run the report.

You should end up with the following results
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Congratulations, you have completed this exercise!
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9.2 REGISTER REPORTS

At any time, you can print a report of the data in the currently displayed register using the Print or
Preview option available from the Actions tab for the register you are in.

The data that prints is the data currently displayed on the register form. The report will print whatever
columns are displayed on the register; if you have customized the display in the register, the report
prints that data. In other words, register reports are entirely customizable.

By creating Saved Views, you can report the data on a register form in several different variations.

The following step by step example will walk you through creating a custom register report on resource
utilization and saving it as a Saved View.
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Step by Step — Create a Register Report

1. Open the Training Job and select Setup tab, then select the Resource Rates drop-down list.

2. From the drop-down list, select Labor.

3. From your Saved Views drop down menu on the Resource Rate Register, select the Print View
for Summary view.

Page 358 of 962 InEight Inc.  |  Release 19.2

9.2 Register Reports Estimate User Guide



4. Notice this view includes utilization hours

5. Right-click on a column header and select Column Chooser.
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6. From the Customization window, drag-and-drop theMinority Percent, Unique Sales Tax, (Scale
2), andMaint. Man-Hour Factor columns into the register.

7. Close the Customize window.

8. Sort the Utilization Count column by clicking on the column header twice so that you see the
bars descending.
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l This sorts your items so the most utilized resources are at the top

9. Click on the Saved Views drop-down menu and select the Save disc icon to save the view.

10. Name the view Labor Utilization View, and then click OK to save the customized view.

11. From the Actionsmenu, select Preview to review the report before printing.
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9.2.1 Register Report Output Settings

Within the Preview for a register report, there are several options to choose from to configure the
output of your report.

9.2.1.1 Page Setup

While in the Preview mode, selecting File > Page Setup provides setup options for the page format:

l Page Size (legal, letter, etc.)

l Paper Width & Height

l Orientation (portrait or landscape)

l Page Margins (left, right, top, bottom)

9.2.1.2 Exporting to Document

Using the Export function allows you to identify a Print range, Image quality, Password Security, and
more. Selecting File > Export Document prints an Adobe Acrobat (*.pdf) report.
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Exercise 9.2 — Create a Custom Register Report

You can configure the columns in your registers for reporting and run your own custom reports.
Complete the following steps to configure and run a report from the CBS Register, using the Training
Job:

1. Select Estimate>Cost Breakdown Structure (CBS).

2. Under Saved Views, Select CBS Simple View.

3. Hide the Optional Code column.

4. Add back in theMan-Hours (Total) andMan-Hours / UM columns.

5. Now add back in the Labor Total Cost, Owned Equipment Total Cost, and Materials
Total Cost categories for reviewing the estimate.

6. Save the View (create your own name for the view).

7. Select Preview to view the report.

You should end up with the following results

Congratulations, you have completed this exercise!
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Lesson 9 Review

1. The ___________ Report gives a good overview of how your price breakdowns by cost
category.

a. Estimate Summary

b. PBS Summary

c. Audit

2. The ___________ Report is a very important report to run during bid review to make sure
you didn’t leave anything out of the estimate.

a. CBS Details

b. Audit

c. Pay Item Summary

3. A best practice is to always set your Print output setting to Preview so you can review
before printing.

a. True

b. False

Lesson 9 Summary

As a result of this lesson, you can:

l Run reports from the Report menu

l Create and run reports from register forms
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LESSON 10 — DATA REPRODUCTION

Lesson Duration: 20 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Create a job from an existing job or template

l Create a template

l Reproduce estimate data using the Bid Wizard

l Reproduce estimate data using copy/paste

l Add cost items to a job using the CBS Bid Wizard

l Utilize the Snapshot function
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10.1 COPY AN EXISTING JOB

As you build an estimate, you may want to reuse pay items, cost items, or resources from a previous
estimate. When you plan to reuse the majority of content within a job, you can simply make a copy of
the existing job.

Using the Create a new Job from… Existing Job option on the Backstage View creates an exact replica
of the existing job, including the job’s properties, pay items, cost items, and resources.

The following Step by Step walks you through how to make a copy of an existing job.

Step by Step — Copy an Existing Job

1. Click the File tab on the Estimate landing page.

2. From the left side panel, select New, then select Existing Job.

3. The Job Register displays a list of your existing projects; select the Training Job and click OK.
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4. On the New Job dialog, in the Code field, type Infra Job Copy with your initials.

5. To copy the cost details from the existing job to the new job, verify that the Copy Cost Details
checkbox is selected

l If you wanted to copy just the cost item structure without cost details, you would uncheck
the box.

6. Uncheck the check for copying the PBS Changes Log.

7. Click OK to create the new job.

The new job opens with the Job Properties form active, so you can begin to modify the new job
as needed. If you look through the tabs on the Job Properties form, you will find that it looks
exactly like the job from which it was copied. Other forms, such as the Pay Item & Proposal
Register and the CBS Register, also look the same in both jobs until you make modifications in
one job or the other.

This is a very easy method for creating a new job, and it is a good choice if you want to copy an
entire job. However, if you want to pick and choose which parts of a job to duplicate, the Bid
Wizard is a better choice.

10.2 TEMPLATES

Job Templates provide you the ability to maintain a list of template jobs that can be used to create new
jobs. As your company grows and increases the number of projects, the need to standardize the
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estimating process increases to ensure consistency and reduce the chance of information being
overlooked.

In InEight Estimate you can create job folders and store them in a separate register as templates. This
allows you to store cost items in master templates separate from the jobs in your Job Register.

You can create templates from scratch or from existing job folders. The following steps walk you
through how to create a new template from an existing job folder.

Step by Step — Create a Template

1. Click the File tab on the Estimate landing page.

2. From the left side panel, select Templates.

3. Under Templates, select the Template Register.
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4. From the Actions tab, select Create Template from Job.

l The Job Register opens for you to select the source job for the template

l Assume that you want to make a template from your E101 Training Job

5. Select the E101 Training Job with your initials, then click OK.

You cannot create templates from jobs that are published to Job Tracking.
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l A prompt appears to give your new template a Job Code

6. In the Code field, type Small Project Template[your initials].

l Leave Copy Cost Details and Copy PBS Changes Log checked

7. Click OK.

l The new template is created and opens to the Job Properties form

l You can add the description in addition to the code for any new job you are creating from
a template. This description is later added to the Overview tab of the new job on the Job
Properties form

l Back in the Templates Register, you can see the new template created

InEight Inc.  |  Release 19.2 Page 371 of 962

Estimate User Guide 10.2 Templates



l Similar to copying an existing job, you can create a new job from a template from
the New menu in the Backstage View.

l You can also create a new job from a template from the New menu in the Bid
Wizard.

8. Select Add to existing job

9. From Select Source Job, click the dropdown arrow

10. Click Next

11. Select a job that is shown as having a Template

12. Click OK
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10.2.1 Archive and Restore Templates

The templates feature gives you the ability to archive and restore templates, enabling templates to
become portable. You can move templates between different environments. You can also backup the
templates similarly to the Jobs Archive and Restore function.

Step by Step — Archive and Restore a Template

1. Click File to open the Backstage View.

2. Select Archive / Restore.

l Several options appear for archiving and restoring your jobs, templates, and library

3. Select Archive Template.

l The Template Register appears

4. Select the Small Project Template [your initials] template you previously made, then click OK.

5. When prompted to include attachments, click Yes.

l The Save As window appears

6. Browse to where you want to save the job, then click Save.

7. Select Restore Template from the Archive / Restore page of the Backstage View to begin
restoring the template.

8. Browse to the archived template and select it.

9. Click Open.
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l If the template already exists, a prompt will appear asking if you want to overwrite it

l To overwrite it, select Yes

l If you select No, you will be prompted to save it under a new Template Code

10.3 BID WIZARD

InEight Estimate’s Bid Wizard is a powerful tool that can help automate the process of setting up
estimates by copying information that already exists in other InEight Estimate job folders. The Bid
Wizard can be used to create new projects, create a new job from an existing template, or to add to
projects that are already underway.

Rather than copying every part of an existing job, the Bid Wizard gives you more flexibility and control
over which parts of a job you want to duplicate, e.g., pay items or cost items or both.

In most cases you will be copying cost items, but if you have a project with pay items that are
commonly used, you can copy them into a new project. If you select pay items, you will be able to
select cost items as well.

The following Step by Step walks you through how you can use the Bid Wizard to create a new job by
importing pay items and their associated costs from an existing job.

Step by Step — Use the Bid Wizard

1. To open the Bid Wizard, click the File tab on the Estimate landing page.

2. From the left side panel, select New, then select Bid Wizard.
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l The Bid Wizard – Step 1 dialog displays

Notice that you can either create a new project or add to an existing project.

3. Type E101 Bid Wizard (with your initials) in the New Code field.

4. Type Bid Wizard Example in the Description field.

5. Click the Next button.

l The Bid Wizard – Step 2 dialog displays

6. Choose Select cost items and click Next.
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l The Bid Wizard – Step 3 of 4 dialog displays

l You use this step to indicate which source you want to pull your setup data from (the
library or your source job)

7. For all selections, select Copy from source job.

8. Check the Also copy all non-utilized resources checkbox.

9. Select Copy from source job under Unassigned Cost Items and Markup, and the Copy Markup
box is automatically selected.
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10. Click Next.

l The Bid Wizard – Step 4 of 4 dialog displays

11. Click the Source Job drop-down arrow.

InEight Inc.  |  Release 19.2 Page 377 of 962

Estimate User Guide 10.3 Bid Wizard



l The Job Register opens

12. Find and select Training Job.

13. Click OK.

l This screen displays the cost items of the source job (Training Job). All items are
automatically selected

14. Use the Toggle Include All button to exclude all selections.
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15. Select the checkboxes to includeMobilization, Clearing & Grubbing, and Unclassified
Excavation.

16. Notice that when selecting Unclassified Excavation, that cost item’s subordinates are
automatically selected
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17. Click Finish to add the new job.

l An Attention prompt appears asking, “Do you want to adjust Pay Rules and Shift
Arrangements of the copied cost items?”

l Typically, you will want to use the shifts and payment rules of your new destination job.

18. Select Adjust the pay rules and shift arrangements to match the destination.
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19. Click OK.

l A help bubble appears letting you know the job has been created, and that you can use
the ribbon tabs on the Estimate landing page to open any form

20. Close the help bubble by selecting the X in the upper right corner.

21. Open the Estimate > CBS to see the three cost items that were brought in.

InEight Inc.  |  Release 19.2 Page 381 of 962

Estimate User Guide 10.3 Bid Wizard



10.3.1 Bid Wizard Updates

While using the Bid Wizard, the Include option is left unchecked by default. A filter is applied to bring
in pay items when using the Bid Wizard. The Toggle Include All button only selects the filtered list of
items instead of all items.

When the filter criteria is modified, the selected items remain checked even if some of the items might
not be visible in the view. When the view is changed, the selected items remain checked.

Tags and UDF fields are included in the Bid Wizard Selection register for the cost items and Pay Item &
Proposal selection registers. This lets you filter the list of cost items based on a tag or UDF.

When you select the Toggle Select All button, only filtered items are included which allow you to
include scopes of work relevant to your estimate without having to manually select all items needed.
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10.4 COPY ESTIMATE DATA USING EDIT COMMANDS

While the Bid Wizard is an efficient way to copy cost history into new projects, you may prefer to use
edit commands such as copy and paste to bring cost history into your estimate.

To copy and paste cost history from one job to another, it is beneficial to see the jobs side by side. The
following steps walk you through the process.

Step by Step — Copy Estimate Data Using Edit Commands

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you just
created.

2. Open the Training Job (if you do not still have it open).
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3. Make sure the CBS is open for both jobs by going to the Estimate menu and selecting Cost
Breakdown Structure (CBS).

4. Since you have both jobs open and they are in their own application window, align them to be
side by side by using theminimize icons of each job or utilizing Windows align functionality.
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l Note that the window caption identifies the CBS Register for each job

5. On the CBS of the Training Job, click the row header on cost item 4 – Aggregate Base and press
Ctrl+C to copy the cost item.

When you copy a superior cost item, all of its subordinates are automatically
copied.

6. On the CBS of the E101 Bid Wizard job, click the row header on the first blank register row, and
press Ctrl+V to paste the cost item.

7. On the Attention dialog, select Adjust the pay rules and shift arrangements to match the
destination and click OK.
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l You can see in the destination job’s CBS that you’ve added the Aggregate Base cost item,
along with its subordinate cost items and all cost and productivity detail

You can also drag and drop cost items from one CBS to another instead of
copying and pasting.

Copied cost items are considered Job Overhead until they are assigned to a
pay item

8. To go back to your full screen view of the E101 Bid Wizard job, select the maximize icon.
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10.5 CBS BID WIZARD

You can also use the Bid Wizard to add cost items while you are in the CBS Register. The following
steps walk through using the CBS Bid Wizard.

Step by Step — Use the CBS Bid Wizard

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you created.

2. From the Estimate tab, select Cost Breakdown Structure (CBS).

3. Create a new cost item by typing New in the Description column on the bottom row of the CBS

4. Highlight the New row.

5. To open the CBS Bid Wizard, click the Bid Wizard icon on theMore Actions tab.

InEight Inc.  |  Release 19.2 Page 387 of 962

Estimate User Guide 10.5 CBS Bid Wizard



l The Bid Wizard window opens

6. Click in the Source Job column on the New cost item row.

7. From the Source Job drop-down list, select Training Job.

8. Scroll to the right of the Source Job column and click in the Source CBS Position Code column on
the New Cost item row.

l A source CBS Register window appears

9. Select CBS position code 5 – Asphalt Concrete Hot Mix Type A from the register.

10. Click OK.

11. Click Finish on the Bid Wizard.
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l An Attention prompt displays, asking if you want to make adjustments

l Keep the default options selected:Make Adjustments according to their quantity drivers
and cost drivers and Adjust the pay rules and shift arrangements to match the
destination

12. Click OK.

l You can see that cost item 5 and its subordinates are now imported into your existing job.

l You could choose a new name for the cost item, or name it Asphalt Concrete Hot Mix
Type A to match the original cost item

10.6 SNAPSHOTS

A job snapshot is a copy of an estimate that provides read-only access to the job as it existed at a
specific point in time. You can now filter the Snapshot register to jobs containing snapshots.

The Snapshot register has some additional columns as well. In addition to the Code, Description, Last
Saved, and Version column, the Snapshot register contains all fields that are present on the Jobs
register that provides you with an easier way to group, sort, filter, and find the jobs you need.

10.6.1 Snapshot Register

The Snapshot Register is where you will view individual snapshots for specific jobs.
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Step by Step — Snapshot Register

1. Click theFile tab to open the Backstage View. In the panel, select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.

3. To view individual snapshots for specific jobs, click the icon next to the desired job to display
the list of snapshots.
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10.6.2 Creating a New Job Snapshot

Step by Step — Create a New Job Snapshot

You can create a Job Snapshot from an existing Job.

1. From the Snapshots form, select the Create Snapshot tab.

2. If an existing job is open select Save, if you haven’t already done so.
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3. A New Job Snapshot [Job Code Here] dialog box appears. From there, you can add a Snapshot
comment.

l If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box, otherwise uncheck the box.

l If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button.

l If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

l If you want to Specify User Access restrictions for this Snapshot (default selection), select
this option

l Then use the Add and Remove buttons to specify user access using Active Directory.
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(Users with current access to the job default onto the list.)

4. Click OK to create the snapshot.

5. A pop-up indicates when the snapshot has been created.
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10.6.3 Editing a Job Snapshot

Step by Step — Edit a Job Snapshot

1. From the Snapshot Register, click the icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to edit and select Edit.

3. The same sort of dialog box opens up as when you created the Snapshot. In this case, from the
Edit Job Snapshot [Job Code Here] dialog box, modify the Snapshot Comment and the User
Access options as needed.

l If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box. Otherwise, uncheck the box

l If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button

l If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

l If you want to Specify User Access restrictions for this Snapshot (default selection), select
this option

l Then use the Add and Remove buttons to specify user access using Active Directory.
(Users with current access to the job default onto the list.)

4. Click OK to update the snapshot.
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10.6.4 Deleting a Job Snapshot

Step by Step — Delete a Job Snapshot

1. From the Snapshot Register, click the icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to delete snapshots from and select Delete.

3. Click OK

Alternatively, you can delete all Job Snapshots by clicking Delete All Job Snapshots from the
Actions tab.
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10.6.5 Loading a Job Snapshot

When you load an existing Snapshot, it loads into Estimate as any other job.

Step by Step — Load a Job Snapshot

1. Click the File tab to open the Backstage View, then select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.

3. On the Snapshot Register, click the icon next to the desired job to display the list of snapshots.

4. Right-click on the individual snapshot you want to load and select Load.
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To identify a snapshot in Estimate as a read-only snapshot:

l The job name is preceded by the label SNAPSHOT: centered on the top of the toolbar

l A red banner shows the specific snapshot information at the bottom of the screen

A snapshot can be modified, but it cannot be saved as it is read-only.
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Exercise 10.1 — Data Reproduction

Now that you have learned how to utilize the Bid Wizard, complete the following steps using the Bid
Wizard and Copy & Paste features.

1. Open the Bid Wizard by clicking the Bid Wizard icon from theMore Actions tab.

2. Choose the Create a new job radio button.

3. Type BW Exercise (with your initials) in the New Code field and type Exercise in the
Description field.

4. Choose Select cost items.

5. For all selections, choose Copy from source job.

6. Select the Also copy all non-utilized resources checkbox.

7. Select Copy from source job under Unassigned Cost Items and Markup, and the Copy
Markup box is automatically selected.

8. Find and select Training Job and click OK.

9. Use the Toggle Include All button to exclude all selections.

10. Select the checkboxes to include Cost Items 4-7.

11. Click Finish to add the new job.

12. Select Adjust the pay rules and shift arrangements to match the destination.

13. Open the CBS to see the cost items that were brought in.
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14. Open the Infra Job Copy with your initials that you created earlier in this lesson.

15. Copy Cost items 8 and 9 and paste them into the BW Exercise job.

You should end up with the following results

Congratulations, you have completed this exercise!
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Lesson 10 Review

1. From the New option on the Backstage View, which of the following options are available
for creating a new job? (Select all that apply)

a. Scratch

b. Template

c. Import

d. Existing Job

e. Historic

f. Bid Wizard

2. Which of the following job reproduction options lets you pick and choose which cost
items you want to import into your new job?

a. Template

b. Bid Wizard

c. Existing Job

d. Archive

3. Which of the following options allows you to add cost items from another project when
working in the CBS Register?

a. Bid Wizard

b. CBS Bid Wizard

c. Template

d. Existing Job

Lesson 10 Summary

As a result of this lesson, you can:

l Create a job from an existing job or template

l Create a template
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l Reproduce estimate data using the Bid Wizard

l Reproduce estimate data using copy/paste

l Add cost items to a job using the CBS Bid Wizard

l Utilize the Snapshot function
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LESSON 11 — EXCEL INTEGRATION

Lesson Duration: 20 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Export data from InEight Estimate to Excel

l Link a field in InEight Estimate to Excel

l Update a linked InEight Estimate field with Excel data

Lesson Topics

11.1 Linking to Excel 403
11.1.1 InEight Estimate Workbook 403
11.1.2 Linking to and from Excel 404
11.1.3 Update Links 408

Lesson 11 Review 410
Lesson 11 Summary 410

11.1 LINKING TO EXCEL

11.1.1 InEight Estimate Workbook

Every job has its own Excel workbook embedded within it for doing side calculations and take-offs. You
can link your calculations to fields in InEight Estimate to automatically update them into your estimate.
When you create a new job from scratch, the Library Master Workbook is copied to create a new
embedded Excel workbook for the job.



The workbook comes with some pre-defined take-off and analysis worksheets, or you can create your
own. Simply open the appropriate worksheet, plug in your values, and Excel will calculate your results.
To open your job’s workbook, select the Estimate tab, then click on the Workbook icon under the
Workbook section.

l The embedded Excel workbook for the job opens.

11.1.2 Linking to and from Excel

InEight Estimate's linking capabilities with Excel can be done in one of two ways. A field in InEight
Estimate can be populated with a value from Excel, or a cell in Excel can be populated with the data
from an InEight Estimate field. This two-way linking functionality allows you to make quick work of
complex chores to perform spreadsheet-based take-off or formula-driven analysis.
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The following example walks through how to link a simple take-off calculation into InEight Estimate
from Excel. It is a take-off to determine the size of a concrete foundation.

Step by Step — Link Estimate to Excel

1. Open the Training Job and from the Estimate tab, open the CBS Register.

2. For this example, create a new cost item in the blank row at the bottom of the CBS register and
name it Concrete Foundation.

3. Open the job’s Excel workbook from the Estimate tab, by selecting the Workbook icon.

4. In the workbook, create a new worksheet named Concrete Take-off and enter the following
fields:

5. Create a new row to calculate the total cubic yards by factoring the length, width, and height
quantities.
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l Your Volume Total should be 50 cubic yards

6. InEight Estimate will only link to named fields in Excel. Click in the field you want to name (B6),
then click in the Field Name window and type Volume.

7. Go back to the CBS Register and right click on the Concrete Foundation cost item Forecast (T/O)
Quantity field.

8. From the resulting right click menu, select Link this field to Excel.

l You can also link the field by selecting the field and then selecting Link Field from the
Actions tab
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9. On the Link to Excel dialog, select the Update InEight Estimate field from Excel radio button.

10. In the Field to link window, select Volume (you may need to click the Refresh button for the
field name to display).
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11. Click OK.

l The Forecast Quantity field for Concrete now is linked to the Volume field in Excel and
populates with the take-off quantity (50)

11.1.3 Update Links

When data in InEight Estimate or Excel changes, you can quickly update all links, in just the currently
active job or in all open jobs.  Simply select one of the following options from the Workbook drop-
down list on the Estimate tab.
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Lesson 11 Review

1. The Export to Excel feature is available on all register forms in the system and allows you
to export the data currently displayed on a register form to an Excel worksheet.

a. True

b. False

2. You can use the __________ tool to easily select a group of items to copy.

a. Customize

b. Workbook

c. Cell Select

d. Excel Select

3. In order to link an Excel field to InEight Estimate, the Excel field must be:

a. Named

b. Highlighted

c. Tagged

d. Selected

Lesson 11 Summary

As a result of this lesson, you can:

l Export data from InEight Estimate to Excel

l Link a field in InEight Estimate to Excel

l Update a linked InEight Estimate field with Excel data
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LESSON 12 — SCHEDULE INTEGRATION

Lesson Duration: 45 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Set up scheduling options

l Update schedule from InEight Estimate

l Update InEight Estimate from schedule

l Manage changes between estimate and schedule
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12.2.1 Set Up Scheduling Options 440
12.2.2 Schedule Cost Items 440
12.2.3 Update Microsoft Project from InEight Estimate 444
12.2.4 Update InEight Estimate from Microsoft Project 447
12.2.5 Manage Changes Between Estimate and Schedule 449

Lesson 12 Review 453



Lesson 12 Summary 453
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12.1 PRIMAVERA

12.1.1 Scheduling Options

Prior to sending information from InEight Estimate to Primavera, you need to make sure the proper
settings are in place.

12.1.1.1 Job Properties Schedule Tab

Primavera scheduling options are configured on the Setup > Job Properties > Schedule tab.

l At the top of the Schedule tab, the Integrated Schedule must be set to Primavera

l As a default, the Always use Plug Days when updating InEight Estimate from the schedule
checkbox is not selected (on a job by job basis, this box can be checked later for jobs in which an
estimator does not want updates from Primavera to change the duration and therefore the cost
of your cost items in InEight Estimate)

l On the Schedule tab, there are several sub-tabs that need to be set up correctly to produce
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correct data behavior and ensure the correct passing of data to Primavera

Step by Step — Login Options Tab

1. On the Schedule > Login Options tab of Job Properties, select the Use these login settings radio
button.

l If pre-defined login settings were required, the Use pre-defined login settings radio button
would be selected instead

l The Instance will remain set to -Default-

l Database selection will be pmdb during training.

2. Type your user name in the User Name field.

3. Type your password into the Password field.

l You will have your own login settings specific to your company
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12.1.1.2 Mapping Options Tab

The Mapping Options tab contains options critical to downstream applications. It will have the
following settings selected by default:

1. The CBS Position Code is selected as the field to populate the Primavera WBS Code and Activity
ID fields.

2. TheManage the Primavera WBS structure in InEight Estimate… radio button is selected for the
initial push from InEight Estimate to P6.

l This means the WBS structure in Primavera will be controlled by the structure of superior
and terminal cost items in InEight Estimate.

l Selecting the other option would cause the WBS structure to be controlled in Primavera.
Only terminal cost items would be sent from InEight Estimate to Primavera and all
hierarchal structure (WBS Elements) would be created in Primavera manually

l This option can be changed later, on a job-by-job basis.

3. The Update the Project’s Planned Start Date in Primavera from the Forecast Start Date option
is checked.

l This will automatically pull the Forecast Start Date from the Job Properties > Cover Sheet
tab to become the Planned Start Date in Primavera.

You should double-check to make sure the right Start Date is defined on the
Job Properties > Cover Sheet tab.

12.1.1.3 Resources Tab

The Resources tab dictates how resources are mapped between InEight Estimate and P6.
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Section Name

1
Update Primavera Resources
from Estimate

Provides options for sending InEight Estimate resources to
Primavera.

l Typically, you would select the Update scheduled
resources only option to send only resources that are
employed on cost items

l The Update all of this job’s resources option updates
Primavera with all of the resources in your project’s
Resource Rate Register

2 Map Resource Types to
Primavera

Specify whether your resources will import into Primavera as
Resources or Roles.

3
Update Primavera Budgeted
Units when using Plug Days

Allows you to specify how to handle Budgeted Units for items
that use Plug Days.

4 Update Primavera Cost
Accounts from Estimate
Account Codes

Checking this box causes assigned account codes to import into
Primavera as Cost Accounts.

5
Update Price/Unit on
Primavera Resource
Assignments

Checking the boxes in this section will cause the Charge Rate
costs of your resources to import into Primavera along with
your resources.

12.1.1.4 Overview – Resources Tab
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12.1.1.5 Expense Costs Tab

The Expense Costs tab is useful for bringing costs in from InEight Estimate that are not connected to
resources, for example, your plugged and/or quoted cost items. This tab is optional, and it is not
required to make selections here.

12.1.2 Schedule Cost Items

Before you can integrate with Primavera, your cost items need to be marked as Scheduled in InEight
Estimate. This is done on the Cost Breakdown Structure (CBS) Register. From your Saved Views drop-
down list in the CBS, the Schedule Setup View displays all of your schedule-related columns. There are
a couple to keep in mind when you schedule your items:

l Scheduled:  This column tells you which of your items are selected to be included in your
Primavera schedule

l Roll Up Schedule:  This column lets you check a box to roll up your estimate to the selected level
when it imports into Primavera

In the below example, notice that all of the cost items are scheduled, but the subordinates for
Unclassified Excavation will be rolled up to the superior level.
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The following steps walk you through scheduling your cost items.

Step by Step — Schedule a Cost Item in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. In the Saved Views drop-down list, select Schedule Setup View.

l In the Scheduled column, you can select the checkbox for each cost item that you want to
schedule

l If a cost item has subordinate cost items below it, you will only be able to check the
superior cost item, which will automatically schedule the subordinate cost items along
with it

3. Select theMobilization, Clearing & Grubbing, and Unclassified Excavation cost items, then
press Tab.
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Step by Step — Schedule a Group of Cost Items in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l To schedule multiple cost items, you can highlight the row for each cost item that you
want to schedule, using the Shift and Ctrl keys to select multiple rows.

3. Select additional cost items 4-Aggregate base, 5- Asphalt Concrete Hot Mix, and 6- 36-inch RCP
Culvert Class.

To schedule all cost items, highlight the JOB row.

4. Right click on the selected rows and select Schedule Selection.
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l On the Schedule Cost Items dialog, you can select whether or not you want to roll up the
selected cost items to a specific level of the CBS for scheduling purposes

5. Select Schedule selected cost items and their subordinates without rolling them up, then click
OK.
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l Your scheduled cost items will import into Primavera the next time you update Primavera
from InEight Estimate.

12.1.2.6 Roll Up Schedule

For cost item 3 – Unclassified Excavation, your scheduler does not need all of your estimate details and
wants to roll up your cost items to a higher level when they import into the Primavera schedule.

Follow the steps below to learn how to roll up your cost items for the schedule.

Step by Step — Roll Up Schedule

1. In the Training Job, from the Estimate tab select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l Review your cost items to decide which cost items need to be rolled up

3. Select the Roll Up Schedule checkbox on the Unclassified Excavation cost item.

12.1.3 Update Primavera from InEight Estimate

Now that you have set up your Primavera options in Job Properties and scheduled your cost items in
the CBS, you are ready to send your project information to Primavera.
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When you first update Primavera from InEight Estimate, Primavera will create a new project
automatically and load it with the following information from InEight Estimate:

Data Sent from InEight Estimate to Primavera

Data Type InEight Estimate Primavera

Project Data Job Code Project ID

Job Description Project Name

Activity Data CBS Position Code//Schedule ID WBS Code / Activity ID

Description WBS Element / Activity Name

Hours Planned Duration (Hours)

Shift and Rate Rules Activity Calendar

Cost Item Tags and UDFs Activity Codes or UDFs

Cost Category Total Cost Cost Category (custom text columns)

Resource Data Resource Code Resource ID

Resource Description Resource Name

Cost Data Resource Cost / Unit Resource Price / Unit

Cost Category Total Cost Expense Category Budgeted Cost

Tags, resource data, and cost data only update in Primavera if selected in the Job
Properties > Schedule settings.

The following steps walk you through updating Primavera from InEight Estimate to create a new
schedule.
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Step by Step — Update Primavera from InEight Estimate

1. From the Estimate tab, select Schedule>Update Primavera from InEight Estimate.

l The Update Primavera From Estimate dialog prompts you to indicate what data to update
to Primavera

2. Make sure Resources and Expenses are checked. Deselect Actuals (For Job Tracking purposes) if
auto selected, then click OK.
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l An Attention prompt appears, letting you know that the job has not been saved.

3. Click Yes to save the job before updating Primavera.

l A window appears that shows the progress of the data sync between InEight Estimate and
Primavera. Depending on the size of the job, this can take several minutes
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l When the window disappears, the update is complete

4. Open Primavera P6 (Project Management) client.

5. Log in to Primavera, using the same Username and Password that was entered on the Schedule >
Login Options tab in InEight Estimate Job Properties.
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6. In Primavera, open the project.
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7. In the Open Project dialog, expand the BID*BUILD folder.
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All projects created from InEight Estimate are created in the BID*BUILD folder by
default.

l Your available projects are sorted by their job names.

8. Select the Training Job (with your initials) so that it is highlighted, and then select Open.

l The WBS Layout displays for the project. You can see the breakdown structure imported
from InEight Estimate with durations, rolled up as specified by the Roll Up Schedule option
in InEight Estimate

l Initially, the start date for your activities is the start date defined on the Job Properties >
Cover Sheet tab (these will change as activity relationships are defined)

9. Select the Resources tab to see the resources that imported for each activity, with their
associated costs.
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12.1.4 Update InEight Estimate from Primavera

You can also bring information back from Primavera into InEight Estimate. When you update InEight
Estimate from Primavera, the following information updates:

Update InEight Estimate from Primavera

Data Type Primavera InEight Estimate

Activity Data Start Dates Start Dates

Finish Dates Finish Dates

Relationships Schedule Relationships

Hours Plugged Days
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Complete the following steps to practice updating InEight Estimate from Primavera. You will create a
scheduling relationship in Primavera, and then import the updated dates and relationships into InEight
Estimate.

Step by Step — Update InEight Estimate from Primavera

1. Open your version of the Training Job project in Primavera.

l In the real world, it is likely that you would have overlapping activities, or your activities
would occur out of order, however for this example you will link all activities from finish to
start

2. Highlight all of your activities from 1-Mobilization through 6.4-Backfill RCP Pipe.

3. Right click on one of the selected rows and select Link Selected Activities to create the Finish to
Start relationship.

l You may have to select the Relationship Lines button to show the linked activities in the
graph on the right side of the screen.

4. To schedule this new relationship, select the Schedule button (or press the F9 key).

5. On the Schedule Project window, keep the default settings and select the Schedule button.
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6. To update InEight Estimate with this change, go back to InEight Estimate and select Estimate tab.

7. Select Schedule>Update Estimate from Primavera.

8. On the Update InEight Estimate from Primavera prompt, keep the default Update the estimate
to stay in synch with the schedule selected, then click OK.
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9. On the Schedule Setup View, you can see the Start and Finish dates updated from Primavera.
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12.1.5 Manage Changes Between Estimate and Schedule

As changes to scope, resources, and costs come up in your estimate, and changes to relationships and
dates occur in the schedule, you can continue updating your estimate and schedule as needed.

12.1.5.7 Plug Days

The Schedule Plug Days option allows you to define the duration in the schedule separate from the
duration defined for your cost items on the Production tab.

For example, your 10” PVC Pipe activity may have extra days in the schedule due to the delivery date
of the pipe material, but you don’t want those extra days to drive the costs in your estimate, since your
crews won’t be working on the activity on those extra days.

All superior cost items are hard-coded to use Schedule Plug Days.

Step by Step — Schedule Plug Days

1. Look at the Days (Duration driven) column in the CBS where it shows 4.65 days for Excavate-
Install-Backfill Pipe.

2. Make sure the Schedule Plug Days checkbox is selected on the Excavate-Install-Backfill Pipe
cost item, then enter a Plug Days duration for the number of days the item will be scheduled in
Primavera (7 days).

l This allows you to maintain your duration of 4.65 days in the estimate and 7 days in the
schedule.

12.1.5.8 Update Primavera with InEight Estimate Changes

The following steps will walk you through updating the schedule with a scope change in your estimate.
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Step by Step — Update Primavera with InEight Estimate Changes

1. In the Training Job from the Estimate tab, select Cost Breakdown Structure.

l In this scenario, there is a scope change for your Excavation requiring you to change all of
your quantities

2. Change the quantity in the Forecast (T/O) Quantity field in the CBS as specified below:

Quantity Change for Cost Item

CBS Code Description Old Quantity New Quantity

5 Asphalt Concrete Hot Mix Type A 35,000 25,000

l As you make your changes, take note of how your duration changes in the Days (Duration
driven) column for these items

l If prompted about changing Total or Unit Cost, select Change TOTAL cost, so that your unit
costs stay intact, then click OK.

3. From the Estimate tab, select Schedule>Update Primaverafrom InEight Estimate to send the
changed hours to Primavera.
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l The Update Primavera From InEight Estimate dialog prompts you to indicate what data to
update to Primavera

4. Make sure Resources and Expenses are checked, then select OK.

l A window appears that shows the progress of the data sync between InEight Estimate and
Primavera. Depending on the size of the job, this can take a few minutes
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l When the window disappears, the update is complete

5. Open Primavera (P6 Web Client).

6. Open the Training Job project.

7. On the Activities screen, compare the Planned Duration to the Days (Duration driven) in InEight
Estimate for Excavate-Install-Backfill Pipe.

l The Primavera scheduled duration should have changed from 4.65 days to 7 days to match
the updated duration in InEight Estimate for Excavate-Install-Backfill Pipe

l You will also notice a change in days for Excavation after changing the T/O Quantity in
InEight Estimate
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8. To schedule this change in Primavera, select the Schedule button (or press the F9 key) and select
the Schedule button on the Schedule Project window.

9. Your start and finish dates are different now. In InEight Estimate, from the Estimate tab, select
Schedule>Update InEight Estimate from Primavera to update InEight Estimate with the new
dates.
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Exercise 12.1 — Manage Changes Between Estimate and Primavera

As changes occur during the estimating process, you can keep the estimate and schedule in sync
through schedule integration. In this exercise, you will practice making changes between the
estimate and schedule. Complete the following steps:

1. Open the Training Job and open the CBS Register.

2. Check the box in the Schedule Plug Days column for the Install RCP Pipe.

3. Change the Plug Days for Install RCP Pipe to 8 days.

4. Update Primavera from InEight Estimate.

5. Open the Training Job project in Primavera and confirm the Planned Duration (you may
need to change your view to see this column) changed to 8 days.

6. In Primavera, change the Planned Duration for Backfill RCP Pipe to 12 days.

7. Schedule the changes in Primavera (Schedule button or F9).

8. Update InEight Estimate from Primavera.

You should end up with the following results

Cost item 6.3 Install RCP Pipe is now showing 8 Plug days in Primavera.

Page 438 of 962 InEight Inc.  |  Release 19.2

Exercise 12.1 — Manage Changes Between Estimate and
Primavera

Estimate User Guide



Cost item 6.4 Backfill RCP Pipe should have 12 plug days in InEight Estimate.

Congratulations, you have completed this exercise!
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12.2 MICROSOFT PROJECT

12.2.1 Set Up Scheduling Options

Prior to sending information from InEight Estimate to Microsoft Project, you need to make sure the
proper settings are in place.

12.2.1.1 Job Properties Schedule Tab

Microsoft Project scheduling options are configured on the Schedule tab of the Job Properties form.

l At the top of the Schedule tab, the Integrated Schedule must be set toMicrosoft Project

l As a default, the Always use Plug Days when updating InEight Estimate from the schedule
checkbox is not selected (on a job by job basis, this box can be checked later for jobs in which an
estimator does not want updates from Microsoft Project to change the duration and therefore
the cost of your cost items in InEight Estimate)

12.2.2 Schedule Cost Items

Before you can integrate with Primavera, your cost items need to be marked as Scheduled in InEight
Estimate. This is done on the Cost Breakdown Structure (CBS) Register. From your Saved Views drop-
down list in the CBS, the Schedule Setup View displays all of your schedule-related columns. There are
a couple to keep in mind when you schedule your items:
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l Scheduled:  This column tells you which of your items are selected to be included in your
Primavera schedule

l Roll Up Schedule:  This column lets you check a box to roll up your estimate to the selected level
when it imports into Primavera

In the below example, notice that all of the cost items are scheduled, but the subordinates for
Unclassified Excavation will be rolled up to the superior level.

The following steps walk you through scheduling your cost items.

Step by Step — Schedule a Cost Item in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. In the Saved Views drop-down list, select Schedule Setup View.

l In the Scheduled column, you can select the checkbox for each cost item that you want to
schedule

l If a cost item has subordinate cost items below it, you will only be able to check the
superior cost item, which will automatically schedule the subordinate cost items along
with it
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3. Select theMobilization, Clearing & Grubbing, and Unclassified Excavation cost items, then
press Tab.

Step by Step — Schedule a Group of Cost Items in InEight Estimate

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l To schedule multiple cost items, you can highlight the row for each cost item that you
want to schedule, using the Shift and Ctrl keys to select multiple rows.

3. Select additional cost items 4-Aggregate base, 5- Asphalt Concrete Hot Mix, and 6- 36-inch RCP
Culvert Class.

To schedule all cost items, highlight the JOB row

Page 442 of 962 InEight Inc.  |  Release 19.2

12.2 Microsoft Project Estimate User Guide



4. Right click on the selected rows and select Schedule Selection.

l On the Schedule Cost Items dialog, you can select whether or not you want to roll up the
selected cost items to a specific level of the CBS for scheduling purposes

5. Select Schedule selected cost items and their subordinates without rolling them up, then click
OK.

l Your scheduled cost items will import into Primavera the next time you update Primavera
from InEight Estimate.
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12.2.2.2 Roll Up Schedule

For cost item 3 – Unclassified Excavation, your scheduler does not need all of your estimate details and
wants to roll up your cost items to a higher level when they import into the Primavera schedule.

Follow the steps below to learn how to roll up your cost items for the schedule.

Step by Step — Roll Up Schedule

1. In the Training Job, from the Estimate tab select Cost Breakdown Structure.

2. From the Saved Views drop-down list, select Schedule Setup View.

l Review your cost items to decide which cost items need to be rolled up

3. Select the Roll Up Schedule checkbox on the Unclassified Excavation cost item.

12.2.3 Update Microsoft Project from InEight Estimate

Now that you have set up your schedule to integrate with Microsoft Project in Job Properties and
scheduled your cost items in the CBS, you are ready to send your project information to Microsoft
Project.

When you first update Microsoft Project from InEight Estimate, Microsoft Project will create a new
project automatically and load it with the following information from InEight Estimate:
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Data Sent from InEight Estimate to Microsoft Project

Data Type InEight Estimate Microsoft Project

Project Data Job Code Project Name

Activity Data

CBS Position Code 01 – CBS Position Code

Description Description

Days (Duration Driven) Duration

Cost Data Cost Category Total Cost Cost Category (custom text columns)

The following steps walk you through updating Microsoft Project from InEight Estimate to create a new
schedule.
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Step by Step — Update MS Project from InEight Estimate

1. From the Estimate tab, select Schedule>Update Project from InEight Estimate.

l Your job automatically opens in Microsoft Project

l The Work Breakdown Structure Layout displays for the project

l You can see the breakdown structure imported from InEight Estimate with durations,
rolled up as specified by the Roll Up Schedule option in InEight Estimate

l Initially, the start date for your activities is the start date defined on the Job Properties >
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Cover Sheet tab (these will change as activity relationships are defined)

12.2.4 Update InEight Estimate from Microsoft Project

You can also bring information back from Microsoft Project into InEight Estimate. When you update
InEight Estimate from Microsoft Project, the following information updates:

Update InEight Estimate from Microsoft Project

Data Type Microsoft Project InEight Estimate

Activity Data Start Dates Start Dates

Finish Dates Finish Dates

Hours Hours

Walk through the following steps to practice updating InEight Estimate from Microsoft Project. You will
create a scheduling relationship in Microsoft Project and then import the updated dates and
relationships into InEight Estimate.
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Step by Step — Update InEight Estimate from MS Project

1. Open your version of the Training Job project in Microsoft Project.

l In the real world, it is likely that you would have overlapping activities or your activities
would be out of order, however for this example you will link all activities from finish to
start

2. Click on the Link Tasks icon to link all activities.

l Ensure the Auto Schedule button is selected

3. To update InEight Estimate with this change, go back to InEight Estimate and from the Estimate
tab, select Schedule>Update InEight Estimate from Project.
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l On the Schedule Setup View, you can see the Start and Finish dates updated from MS
Project.

12.2.5 Manage Changes Between Estimate and Schedule

As changes to scope, resources, and costs come up in your estimate, and changes to relationships and
dates occur in the schedule, you can continue updating your estimate and schedule as needed.

12.2.5.3 Plug Days

The Schedule Plug Days option allows you to define the duration in the schedule separate from the
duration defined for your cost items on the Production tab. For example, your 10” PVC Pipe activity
may have extra days in the schedule due to the delivery date of the pipe material, but you don’t want
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those extra days to drive the costs in your estimate, since your crews won’t be working on the activity
on those extra days.

All superior cost items are hard-coded to use Schedule Plug Days.

Step by Step — Schedule Plug Days

1. Look at the Days (Duration driven) column in the CBS where it shows 4.65 days for Excavate RCP
Trench.

2. Make sure the Schedule Plug Days checkbox is selected on the Excavate RCP Trench cost item,
and then enter a Plug Days duration for the number of days the item will be scheduled in
Primavera (7 days).

l This allows you to maintain your duration of 4.65 days in the estimate and 7 days in the
schedule.

Any duration changes made in Project will import into InEight Estimate as Plug Days
automatically so that they can be reviewed by the estimator before making any changes to
production in InEight Estimate.

12.2.5.4 Update Microsoft Project with InEight Estimate Changes

The following steps will walk you through updating the schedule with a scope change in your estimate.
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Step by Step — Update MS Project with InEight Estimate Changes

1. In the InEight Estimate Training Job, from the Estimate tab, select Cost Breakdown Structure.

l In this scenario, there is a scope change for your Excavation requiring you to change all of
your quantities

2. Change the quantity in the Forecast (T/O) Quantity field in the CBS as specified below.

Quantity Change for Cost Item

CBS Code Description Old Quantity New Quantity

5 Asphalt Concrete Hot Mix Type A 35,000 25,000

l As you make your changes, take note of how your duration changes in the Days (Duration
driven) column for these items.

l If prompted about changing Total or Unit Cost, select Change TOTAL cost, so that your unit
costs stay intact

3. From the Estimate tab, select Schedule>Update Projectfrom InEight Estimate to send the
changed hours to Microsoft Project.

4. Go back to the Training Job in Microsoft Project.
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l The Microsoft Project scheduled duration should have changed from 4.65 days to 7 days to
match the updated duration in InEight Estimate for Excavate RCP Trench

l You can also see that the days for Asphalt Concrete Hot Mix Type A and its subordinates
adjusted because you adjusted the Forecast T/O Quantity in InEight Estimate

5. Your Start and Finish dates are different now. In InEight Estimate, from the Estimate tab, select
Schedule >Update InEight Estimate from Project to update InEight Estimate with the new dates.
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Lesson 12 Review

1. Under the Job Properties > Schedule tab, which setting can be enabled to account for
plugged costs (e.g., for subcontractors)?

a. Resource price/unit

b. Expense Costs

c. Schedule ID

d. Actuals

2. For InEight Estimate schedule integration with Primavera, which of the following can be
sent from your estimate to the schedule? (Select all that apply)

a. Activity data

b. Cash Flow graphs

c. Resource data

d. Cost data

e. Price data

3. The Schedule Plug Days option allows you to define the duration in the schedule separate
from the duration defined for your cost items on the Production tab.

a. True

b. False

Lesson 12 Summary

As a result of this lesson, you can:

l Set up scheduling options

l Update Schedule from InEight Estimate

l Update InEight Estimate from Schedule

l Manage changes between estimate and schedule

InEight Inc.  |  Release 19.2 Page 453 of 962

Estimate User Guide Lesson 12 Review



Page 454 of 962 InEight Inc.  |  Release 19.2

This page intentionally left blank.

Lesson 12 Summary Estimate User Guide



InEight Inc.  |  Release 19.2 Page 455 of 962

LESSON 13 — CASH FLOW

Lesson Duration: 25 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Interpret cash flow and resource utilization on the Cash Flow graph

l Select Cash Flow Options

l Change Cash Flow Display Settings
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13.1 CASH FLOW

The Cash Flow form provides a graphical representation of the cash flow and resource utilization of
your project, so you can quickly assess financing and resource needs.

You can open the Cash Flow form by selecting the Estimate tab from the Estimate landing page, then
selecting Cash Flow from the Schedule section.

In order to generate a cash flow curve the estimate must be populated with schedule dates either
directly from integration with Primavera, Microsoft project, or input manually.

Overview – Cash Flow Form

Section Description

1
The graph displays the projected cash flow of your project, along with job financing
expense, individual cost category costs and resource utilization.

l The x-axis measures time
l The left y-axis measures amounts
l The right y-axis measures quantities (when resource utilization is displayed)
l All graphs depicted on the Cash Flow form can be displayed based on Pay Quantity

or Forecast (T/O) Quantity

2 Click on the Display Settings icon to indicate what to display on the graph.
l You can display total costs and price or specific cost categories
l You can also set the display settings to report on Resource Utilization

3
Click on the Cash Flow Options icon to specify revenue timing, cost timing, and cost of
money.

4 Click the Excel icon to export the numerical data represented on the graph into an Excel
spreadsheet where you can run additional analysis.

5 You can filter the Cash Flow graph by date range or by a range of cost items.

6 Click and drag over the graph to zoom in on a particular section. Click the Reset Zoom
button to restore the graph to its original state.
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13.2 CASH FLOW OPTIONS

The Cash Flow Options are used to define the cash flow rules (revenue timing, cost timing, cost of
money, and quantities) needed to calculate the finance expense and cash flow for your project.

Cash flow rules (revenue timing, cost timing, cost of money, and quantities) describe how cash flow
occurs between a contractor and a client, and between contractors or owners and
vendors/subcontractors. Cash flow is then calculated based on both the earning and payment terms
you specify, and the job's schedule and pay item prices.

To open the Cash Flow Options, click on the Cash Flow Options icon in the Tools section of the
Actions tab.

You can also access Cash Flow Options from the Setup > Job Properties > Cash Flow tab.
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1. Revenue timing:  Revenue is the amount of money actually paid to a contractor by the client for
the completion of project deliverables. This section contains options to specify when and how
often payment is recieved.

2. Cost Timing:  Cost is the amount of money expended to complete the scope of the project. This
section contains options to specify when and how often you pay contractors, subcontractors and
vendors.

To include any of your costs in your cash flow (including indirect costs), they need
to be scheduled

3. Cost of Money:  Represents the financing cost to fund the project. This section contains fields to
specify interest rates you pay for the money you borrow, and interest rates you earn for money
invested, to determine a total Finance Cost.

4. Quantities: Allows you to calculate cash flow based on pay quantities or forecast (T/O)
quantities.

5. Dates: By default, the scheduled Early Start and Early Finish dates of each cost item (and its
resource employments) as listed in the CBS Register, provide the timing of the expenses,
revenue, and costs that show up on the Cash Flow graph. You have the option to base cash flow
timing on Start/Finish dates or Late Start/Finish dates.
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13.2.0.1 Cash Flow Options Set Up

The following steps walk you defining settings on the Cash Flow Options form.

Step by Step — Cash Flow Options Setup

1. In the E101 – Training Job, from the Estimate tab, select Setup >Job Properties >Cash Flow.

l You will see the default options already there

l You will adjust a few of those options

2. Change your Revenue timing to Every month on the 10th.
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l The average calendar days from billing to collection should be set to 25 days

3. For Cost timing, bills are received from subcontractors and vendors Every month on the 25th.

l Average calendar days elapsed from receipt of invoice to payment should be set to 30 days

4. For Cost of money, enter 10% for the Average annual interest rate paid to borrow money (when
cost exceeds revenue) and 2% for Average annual interest rate earned (when revenue exceeds
cost).

5. Leave all remaining options as originally defaulted.
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13.3 CASH FLOW DISPLAY SETTINGS

13.3.1

13.3.2 Cost Items and Cost Categories

The Cash Flow Display Settings allow you to control what information displays on the Cash Flow graph.
To open the Display Settings click on the Actions > Display Settings icon in the Tools section.

Section Description

1 You can save your display settings for future use.

2 Select how the graph measures the timing of your cash flow. Options include:  Day,
Week, Month, Quarter, and Year.

3

Under the Cost Items section, you can select:
l Total Cost (Forecast):  The total cost of your scheduled cost items, based on when

your costs are accrued (when your cost items are scheduled). This is displayed as a
dashed line on the graph

l Total Price (current):  The total revenue of your pay items, based on when the
revenue is earned (when your cost items are scheduled). This is displayed as a
dashed line on the graph

l Total Cost (Forecast) – Cash:  The total cost of your scheduled cost items, reflecting
the cost timing you specify in the Cash Flow Options. This is displayed as a solid line
on the graph

l Total Price (current) – Cash:  The total revenue of the pay items, reflecting the
revenue timing you specify in the Cash Flow Options. This is displayed as a solid line
on the graph

l Cash Flow:  Displays the difference between your Total Cost – Cash and Total Price
– Cash values, so you can see if you are making or losing money

l Finance Cost:  Displays the Cost of Money amount calculated from the settings you
specify in the Cash Flow Options

4 You can check the Estimated box for any specific cost categories you need to display.
l The other check boxes are used for InEight Estimate Performance

Overview – Cash Flow Display Settings – Cost Items and Cost Categories
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13.3.2.1 Cash Flow Display Set Up

The following steps walk you through setting up your Cash Flow Display Settings.

Step by Step — Cash Flow Display Settings Set Up

1. In the E101 – Training Job, from the Estimate tab, select Cash Flow from the Schedule section.

2. On the Actions tab, select Display Settings to open the Display Settings window.

3. From the Period drop-down list, selectWeek.

4. Under the Cost Items section, make sure the following are selected:

l Total Cost (Forecast)

l Total Price (Forecast)

l Total Cost (Forecast) – Cash

l Total Price (Forecast) – Cash

l Cash Flow
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l Finance Cost

5. Under the Cost Categories section, check the Estimated checkbox for the Labor and Owned
Equipment categories.
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6. Click OK to close the Display Settings window.

l Your Total Cost (Forecast) displays as a dashed red line, indicating your accrued costs
based on when your cost items are scheduled and the assigned cost curves for each cost
item.

l Your Total Price (current) displays as a dashed green line, indicating the revenue you’ve
earned, based on the timing of your pay items

l Your Total Cost (Forecast) – Cash displays as a solid red line, indicating your costs, based
on when your cost items are scheduled and the cost timing defined in Cash Flow Options

l Your Total Price (current) – Cash displays as a solid green line, indicating your revenue,
based on the timing of your pay items and the revenue timing defined in Cash Flow
Options

l Your Cash Flow displays grey bars indicating when your cash flow is negative or positive
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l Your Finance Cost displays as a blue line on the graph

7. To filter your graph by date range, click on the Start drop-down arrow and select a start date of
your date range filter.

8. Click on the End drop-down arrow and select an end date of your date range filter.
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l Your graph now only includes your cost items that fall within the specified date range

9. To remove the filter, click in the Start field and press the Backspace key.

10. Do the same for the End field.

13.3.3 Resource Utilization

You can also use the Cash Flow graph to report on resource utilization. For example, you may want to
run a report that displays a work hours curve for a particular labor trade or to see the peak usage times
for a particular piece of heavy equipment.

You can run resource utilization graphs based off of any of the following:

l Resource Type

l Resource Code

l Description

l Organizational Category

l Tag 1, 2, and 3

l Quote Group

l Account Code and Cost Item Account Code

l Fuel Type

You set up your resource utilization settings from the same Display Settings window you use for setting
up Cash Flow, Display Settings in the Tools section of the Actions menu.
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13.3.3.2 Resource Utilization Display Set Up

The following steps walk you through setting up your Cash Flow graph to report on Resource
Utilization.

Step by Step — Resource Utilization Display Setup

1. In the E101 – Training Job, from the Estimate tab, select CashFlow from the Schedule section.

2. On the Actions tab, select Display Settings to open the Display Settings window.

3. Make sure the all checkboxes are unchecked under the Cost Items and Cost Categories sections.

4. Under the Resources section, check the Resource Utilization checkbox.

5. From the Summarize resources by drop-down list, select Description.
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6. From the resulting list of Values, select Laborer.

7. Click in the Qty field for the selected value and select a color of your choice.

l In this case the Qty represents the work hours for your Laborer resource

8. Click in the Cost field for the selected value and select a different color of your choice.

9. From the Quantity and Cost drop down lists, you can select how your quantities and costs will
display on the graph. In this case select the Quantity to display as a Bar and Cost to display as a
Line.
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10. Click OK to close the Display Settings window.

l The graph now displays the utilization of your Laborer resource, showing the work hours
and costs used over time

The graphs displayed on the Cash Flow form are based on the estimated cost of each cost
item and its resource employments (in the case of resource utilization).
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Lesson 13 Review

1. Under what cash flow form can you set up your revenue and cost timing?

a. Cash Flow Options

b. Display Settings

c. Worksheet

d. Page Setup

2. By default, the red dashed line on the Cash Flow graph represents the:

a. Total Cost (Forecast)

b. Total Price (current)

c. Total Cost (Forecast) – Cash

d. Total Price (current) - Cash

3. In the Cash Flow Display Settings, Resource Utilization allows you to view a graphical
summarization of your resources by which of the following? (Select all that apply)

a. Resource File Description

b. Resource Type

c. Resource Code

d. Description

e. Wage Zone

f. Organizational Category

Lesson 13 Summary

As a result of this lesson, you can:

l Interpret cash flow and resource utilization on the Cash Flow graph

l Select Cash Flow Options

l Change Cash Flow Display Settings
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CALCULATORS

Lesson Duration: 20 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Use the Haul Calculator

l Use the Trench Calculator

l Use the In-Field Calculator
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14.1 HAUL CALCULATOR

The Haul Calculator allows you to enter the specifics of up to three haul routes (distance, travel speed,
etc.). Once entered, you can either:

l Calculate the number of trucks required to complete the haul in a set amount of time, or

l Calculate how long it will take to complete the haul with a set number of trucks

The following activity walks step by step through using the Haul Calculator to calculate the number of
trucks needed for a cost item.

Step by Step — Haul Calculator – Calculate Quantity of Trucks

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Open cost item 4.1 – Furnish & Haul Base Material.

3. On the Cost Item Record, click the Detail tab.

4. Right click on the ETDT – Dump Truck row header and select Open Haul Calculator.
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5. On the Haul Calculator, select the Calculate quantity of ETDT required to complete haul in
duration entered below radio button. (ETDT is the resource code for the Dump Truck you
selected.)

6. For the Haul Distance, type 5.

7. Enter an Average Payload (Ton) of 30.

8. For Load Time (Minutes), type 3.

9. Enter a Travel Speed Full of 35Mile/Hour.
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10. For Dump Time (Minutes), type 2.

11. Enter a Travel Speed Empty of 45 Mile/Hour. Notice this calculates a cycle time of 20.24.

12. Enter aWork Efficiency of 90 percent.
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l The calculator shows a result of 1.56 concurrent haulers

13. Click OK.

14. Your cost item now shows a quantity of 1.56. Round up the Quantity to 2. Also, adjust the
Teamster Quantity to 2 (if needed).

Step by Step — Haul Calculator – Calculate Total Duration

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Open cost item 4.1 – Furnish & Haul Base Material.

3. On the Cost Item Record, click the Detail tab.

4. Change your Teamster and Dump Truck quantities back to 2 each.

5. Right click on the ETDT – Dump Truck row header and select Open Haul Calculator.

6. On the Haul Calculator, select the Calculate total duration of haul using quantity of ETDT
entered below radio button.

l With the previous information you entered still there, the calculator calculates a total
duration of 281.08 hours
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7. Click OK.

l The Hours field on the Production tab updated to 281.08

l Your ETDT Dump Truck quantity remains at 2

14.2 TRENCH CALCULATOR

The Trench Calculator allows you to quickly calculate trench, pipe, and bedding values. You can
perform pipe-related take-off by defining the details of the trench (e.g., length, depth, width, hinge
elevation, backslope, and swell factor), the pipe (diameter, elevation, and waste factor), and up to four
beddings.

With this information, the Trench Calculator can automatically calculate:

l Total excavation volume (neat-line)

l Total excavation volume (including swell/shrinkage)

Page 476 of 962 InEight Inc.  |  Release 19.2

14.2 Trench Calculator Estimate User Guide



l Total pipe to purchase

l Lift Volume (for up to four beddings)

l Lift Weight (for up to four beddings)

You can use these calculations to define certain cost item setup data:

l You can use the Total Excavation Volume that is calculated as the quantity of the cost item

l You can use the Total pipe to purchase calculation as the quantity of a resource (e.g., pipe) that
has been employed to the cost item

l You can use the Lift Volume or Lift Weight that is calculated as the quantity of a resource
employed to the cost item in either cubic yards or tons

l You can click the Toggle English / Metric button at the bottom of the dialog to switch between
the English and Metric systems for entering data

You can access the Trench Calculator from the Actions tab of a Cost Item Record

When copying cost items in a job or from job to job, the Trench Calculator variable data is
included with the data being copied. When a cost item is copied to the clipboard, Trench
Calculator variable data is also included.

14.2.1 Trench Calculator – Trench Tab

The following steps walk through using the Trench Calculator to take-off excavation volume.

Step by Step — Trench Calculator – Trench

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Create a new cost item from the bottom row of your CBS and call it 24” Pipe.

3. Add the following three subordinates and update their Units of Measure:

l Excavate Trench: CY

l Install Pipe: LF

l Backfill Trench: CY

4. Open the Excavate Trench Cost Item Record. Add the following resources:
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l LL2  Laborer – 1

l LO2  Operator Class 2 – 1

l EX245  Excavator 245 – 1

5. Adjust the Production to: 100 CY/Hour.

6. On the Cost Item Record’s Actions tab, select Trench Calculator.

7. For Trench Length, type 1000.00 feet.

8. For Trench Width (at the bottom) type 4.00 feet.

9. Enter a Trench Depth of 10.00 feet.

10. Enter a Hinge Elevation of 5.00 feet.
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11. Enter a Backslope of 45 degrees.

12. Define theMaterial Swell/Shrinkage Factor (fraction expressed as a decimal) at .10.

l You can select either a “neat-line” total volume or include swell/shrinkage

13. Select the “Total excavated volume (including swell/shrinkage)” checkbox.

14. Click Save Configuration to Library and save the Trench calculator as Trench Example with your
initials.

15. Click OK.

14.2.2 Trench Calculator – Pipe Tab

You can also use the Trench Calculator to take off how much piping and bedding you need for the
trench.
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Step by Step — Trench Calculator – Pipe

1. On the CBS Register, adjust the Forecast T/O Quantity for the Install Pipe cost item to 1000 LF.

l Assume this quantity is based off manual take-off calculations you already did

2. Open the Install Pipe Cost Item Record.

3. Add the Resource Assembly of CPIPE - Pipe Crew and adjust the production to 300 LF / Day.

4. On the Cost Item Record’s Actions tab, select Trench Calculator.

5. Select Load Configuration from Library.

6. Select Trench Example (with your initials).

7. Click OK.

8. On the Trench Calculator, select the Pipe tab.

9. Enter the following for the size and position of the pipe:

l Pipe exterior diameter:  26.00 inches

l Pipe center elevation (from bottom):  19.00 inches

l Waste factor: 10%

10. Click on the resource icon to pull up the Resource Rate Register.

11. Select the Installed Material tab.

12. SelectMPP24 Pipe 24” PVC SDR35, then click OK.

l The Pipe variables you entered should match the following image:
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13. Click Save Configuration to Library and save the Trench calculator as Trench Example with your
initials.

14. When prompted to overwrite the existing saved file, click Yes.

15. Click OK to close the Trench Calculator.

14.2.3 Trench Calculator – Beddings Tab

The following steps walk you using the Trench Calculator to calculate bedding take-offs.

Step by Step — Trench Calculator – Beddings

1. Back on the CBS Register, adjust the Forecast T/O Quantity for Backfill Trench to 2300 CY, based
on manual calculations.

2. Open the Backfill Trench Cost Item Record.
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3. Add the following resources:

l LL2 Laborer – 3

l LO2 Operator Class 2 – 1

l RPC Plate Compactor – 1 

l EL950 Loader 950 – 1

4. Adjust the Production to 160 CY/Day.

5. From the Cost Item Record’s Actions tab, select Trench Calculator.

6. Select Load Configuration from Library

7. Select Trench Example (with your initials), then click OK.

8. On the Trench Calculator, select the Beddings tab.

9. On the Beddings tab, you can define up to four beddings to backfill the trench

l The variables you enter will determine how much bedding you need

10. Enter the following variables for each bedding:

Bedding Lift 1 Bedding Lift 2 Bedding Lift 3

Elevation (from trench floor) 6.00 38.00 76.00

Additional material needed 5.00 5.00 5.00

Conversion factor 1.60 1.70 1.60

l Under Results, you can match each of the Bedding Lifts with a material resource, by
selecting the resource icon and selecting the resource you want to employ from the
Material tab

11. Selecting the resource from the Tons selection field, select the following materials for each
bedding:

Resource Code Resource Description

Bedding Lift 1 MASAND Sand

Bedding Lift 2 MAFA Fine Aggregate

Bedding Lift 3 MACA1-1/2 Coarse Aggregate
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12. Click OK.

l Note that the pipe and bedding materials are added to the cost item with their quantities
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Exercise 14.1 — Trench Calculator

In this exercise, you will practice using the Trench Calculator to take-off piping and bedding
materials. Complete the following steps:

1. In the Training Job, create a new cost item called Underground Pipe.

2. Give the cost item a quantity and unit of measure of 1640 Linear Feet.

3. Open the new cost item and open the Trench Calculator.

4. On the Trench tab, enter the variables for the trench:

Trench length 1000 feet

Trench width (at bottom) 4 feet

Trench depth 10 feet

Hinge elevation 5 feet

Backslope 45 degrees

Material swell/shrinkage factor 0.10 (decimal)

l Do NOT check the box to bring in volume shrinkage.

5. Select theMPR36material resource from the drop-down Results list.

6. On the Beddings tab, enter bedding variables.

Bedding lift 1

Elevation (from trench floor) 6 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.3
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Bedding lift 1

Bedding material resource (Tons) MASAND

Bedding lift 2

Elevation (from trench floor) 38 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.1

Bedding material resource (Tons) MAFA

Bedding lift 3

Elevation (from trench floor) 76 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.1

Bedding material resource (Tons) MACA1-1/2

7. Select OK and confirm that the pipe material and bedding materials populated the cost
item.

You should end up with the following results
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Congratulations, you have completed this exercise!
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14.3 IN-FIELD CALCULATOR

You can use the In-field Calculator to do simple mathematical calculations in any numeric field on
records, registers, and tree lists. You use this calculator much like an Excel workbook field, by inserting
the cursor in the field where you want to perform a calculation, then pressing the "=" key, followed by
a valid arithmetic expression. To display the calculated result, you press the tab key. The resulting
value is stored without the arithmetic expression used to calculate the value.

The following steps walk through using the In-field Calculator to calculate the area of how much
sandblasting is needed for painting the steel bridge structure specified in the Training Job.

The resulting field value is stored without the arithmetic expression used to calculate the
value.

Step by Step — In-Field Calculator

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

2. Scroll to find cost item 13.3 Sandblast.

3. Click in the Forecast (T/O) Quantity field.

4. Press the = key, then type 10*250.
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5. Press the Tab key and it calculates the result.
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Lesson 14 Review

1. The Haul calculator allows you to:

a. Calculate the number of trucks required to complete the haul in a set amount of
time

b. Calculate how long it will take to complete the haul with a set number of trucks

c. Neither

d. Both

2. The Trench Calculator allows you to quickly calculate ___________ values.

a. Trench

b. Pipe

c. Bedding

d. All of the above

3. For the in-field calculator, what symbol needs to be at the beginning of the math
equation for it to calculate?

a. +

b. –

c. =

d. (

Lesson 14 Summary

As a result of this lesson, you can:

l Use the Haul Calculator

l Use the Trench Calculator

l Use the In-Field Calculator
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LESSON 15 — COST ITEM ASSEMBLIES

Lesson Duration: 40 Minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Explain what a cost item assembly is and why it is used

l Create and edit a cost item assembly

l Employ a cost item assembly
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15.1 COST ITEM ASSEMBLY OVERVIEW

15.1.1 Overview

Cost Item Assemblies utilize predictive models to quickly and accurately estimate elements of a job
that can be repetitive in nature on a single job or from job to job. They use parameter driven
estimating to create cost items. They use created parameters and mathematical calculations to
incorporate quantity takeoffs and estimate quantification into cost items. A cost item assembly will
output fully populated cost items directly into the project CBS. The inputs are dimension values and
specification sections, while the output is cost items.

Cost Item Assemblies accomplish the following:

l Model a construction system or component that is quick and easy to employ

l Promote a consistent process of estimating among various users

l Enable less experienced users to more efficiently create an estimate

l Provide good visibility into the assumptions and calculations made to obtain the results

l Provide the flexibility to easily adjust model assumptions and account for varying project
requirements from estimate to estimate

All the following can be done with Cost Item Assemblies:

l Assembly employments can be re-opened to modify inputs

l Assemblies can be stored in the Library and imported like resources

l Assemblies can be copied and pasted between projects

l Assemblies can be created from existing project cost items

l Assemblies can be modified for project specific needs

l Assemblies can be modified and employments updated in the project

l Employed assemblies can become permanent cost items by deleting the link

l Assemblies can be created for either metrical or imperial units

15.1.2 Users

There are typically two types of users that work with Cost Item Assemblies:
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l The power user, someone like the lead estimator, creates the cost item assemblies

l The end user uses the created assemblies

User Function

Power User

This user can determine what questions need to be answered to
create a standard construction system, and how specifically to use
those answers in determining the systems quantities, cost and
resources to be applied in the estimate.
Many companies have spreadsheets that they have created for
estimators in the organization to use in estimating specific types of
work. If you are the person that often creates or enhances those
spreadsheets, you probably fall into the category of being a user that
will create Cost Item Assemblies.

End User This is sometimes a less experienced estimator that will benefit from
being provided a set of questions to answer because it can help the
estimator develop an understanding for the way the work is
estimated and provide them with guidance in gathering the right
information.
The use of Cost Item Assemblies is not exclusive to less experienced
estimators, however. They can be used by anyone involved in the
estimating process that wants to quickly create an estimate for a
scope of work in a consistent and repeatable way. Cost Item
Assemblies can be a great way to initialize an estimate and give the
estimator more time to focus on analyzing the job and considering
different ways of approaching the work.

User Types

15.1.3 Navigation / Data Blocks

The use of data blocks in the Cost Item Assembly Register allows you to set up a layout that works best
for you.

The data blocks in the Cost Item Assembly Record are:

l Cost Items

l Inputs

l Calculations
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l Notes

l Setup

l Tables

l Sub Assemblies

The Default Data Block view looks like the following:

15.1.4 Move Data Blocks

To move Calculations onto the screen, simply click on the name and drag it until the following options
appear:
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Next, choose where to place it on your screen:

The calculations data block now appears on the screen.
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15.1.5 Add and Remove Data Blocks

To look at Setup and Tables, click on the tabs to view them.

To get rid of the Notes screen, simply press the X, and to bring it back, click on Default Data Blocks in
the ribbon.
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15.2 COST ITEM ASSEMBLY CREATION

15.2.1 Create a Cost Item Assembly Record

Cost Item Assemblies allow you to create intelligent construction systems to automatically estimate
various scopes of work, based upon a user providing specification and dimension variables. You can
create multiple Cost Item Assemblies and maintain a library of construction systems that are used
throughout the estimating department. When creating an assembly, it’s helpful to have a solid
understanding of the various inputs that will be used and how those inputs will be used to influence
the resulting collection of cost items.

Cost Item Assemblies are created by entering a code and description for the assembly. Both fields can
be changed at any time.

Scenario

One scope of work that is part of the estimate is a ductbank. This ductbank work entails
excavating, laying the conduit, and then either backfilling it with concrete or soil depending on
the location, and all conduit runs consist of two conduits. You want to estimate the cost and
hours for this work using a cost item assembly.

Page 502 of 962 InEight Inc.  |  Release 19.2

15.2 Cost Item Assembly Creation Estimate User Guide



Step by Step — Create a Cost Item Assembly Record

1. From the Setup tab, click on Cost Item Assemblies.

2. From the Actions tab, click on New.

3. In the Code field, type TEST – Your Initials.

4. In the Description field, type Test Cost Item Assembly - Ductbank.

5. In the bottom right corner, click OK.
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l Notice that your Cost Item Assembly now shows up in the Cost Item Assembly Register

15.2.2 Workflow

There is a standard workflow for building cost item assemblies .

1. Define the desired output from an assembly (cost items).

2. Decide what questions the estimator will be required to answer (and what assumptions you
want to set).

3. Create input tables for user selections.

4. Create expressions to provide the required results to populate the cost items.

15.2.3 Build Cost Item Assembly Record

Once your Cost Item Assembly has been created, it is time to build the assembly. To begin, you first fill
out the setup information, then you use the remaining data blocks to build the assembly record.

The fields in the Setup tab can be filled with unique names, choice of pull-downs or left blank. The
fields on the Setup tab include:

l Assembly file

l Geographic Areas

l Wage Zone

l Org. Category
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l Last Changed By is updated when the definition of the assembly is modified, such as the inputs,
calculations, cost items, tables, notes, etc.

l Last Changed On is updated when the definition of the assembly is modified, such as the inputs,
calculations, cost items, tables, notes, etc.

l The Tag and User Defined field can be filled in by the user

The first four fields are used the same way resource attributes are used to filter which resources are
imported from the master library into a project. These will appear on the cost basis tab of job
properties as filters to determine which cost item assemblies you import into a new estimate.

Step by Step — Cost Item Assembly Set Up

1. Select your assembly from the list and click Open from the ribbon.

2. In the bottom right corner, click on the Setup tab.
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3. In the Assembly File drop-down, select Standard Cost Item Assembly File.
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4. Select a Geographic Area and Org. Category.

5. In the Tag 1 drop-down, select Concrete.
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6. In the Tag 2 drop-down, click the Add icon.

7. Enter the following, then click OK.
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15.2.4 Cost Items

The Cost Items data block is used to create cost item breakdown structure, where you can assign the
default values and resource employments and link the results of the calculated values to the
appropriate cost item and resource employment fields. This is where you build a framework of cost
items that you want as output from this assembly.

Cost Items for a Cost Item Assembly are created within the Cost Item Assembly Record, not in the CBS
Register.

There will be at least one cost item with the following default values which you can override.

l Default Description is equal to the Assembly Description

l Default Forecast (T/O) Qty = 1

l This is the top-level cost item in the assembly. Any additional cost items will need to be created
as subordinates to this cost item

After you complete the values in the Cost Items data block, the steps included in
the Calculations data block need to be completed prior to linking any values to the
cost items.
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This data block has the same functionality as the CBS register; double-clicking one
of the cost items or selecting one of the cost items and choosing Open from the
menu will open the Cost Item Record. To quickly perform this work, you can easily
copy cost items from the CBS Register and paste them into the Cost Items data
block of the Cost Item Assembly Record.

Step by Step — Create Cost Items in an Assembly

1. Click X on the pop up.

2. From the Cost Items data block, right click on your cost item and select Insert Subordinate.
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3. Insert 4 subordinates.
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4. Enter the descriptions and units of measure as follows:

15.2.5 Inputs and Tables

The Inputs data block is where you define the questions that will be asked of the user when they
employ a Cost Item Assembly. Inputs can be value-type or table-type inputs and validation rules can be
specified for value-type inputs such as minimum or maximum values that are acceptable, or default
values that appear when the Cost Item Assembly is employed. These Inputs will be the parameters
used in calculations to drive the Cost Item Assembly outputs.

Tables are used for reference data and can provide functionality similar to a lookup field in excel.
Tables may contain account codes, production rates, or other reference fields and can be imported
from the Library or copied from one assembly to another. Tables can be assembly specific, project level
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(Standard), or Enterprise (Library) level (Master Standard). You can populate tables from a project
specification list.

Step by Step — Create Input Values

1. Navigate to the Inputs data block. In the first empty field under Variable Name, type Length,
then press Tab.

The Variable Name is how the calculations will reference the input values.

l The Display Order field can be set to control the order in which you are prompted to
provide the input values

2. Select the Description field and type Ductbank Length (ft), then press Tab.
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3. In the Input Type field, select Value from the drop-down list. In the Default Value field, type 100.

4. Fill out additional fields as shown below:

15.2.5.1 Data Validation

The Data Validation field determines what type of data validation is enforced when the Cost Item
Assembly is employed. This field is enabled only when the Input Type is Value. The data validation
options are as follows:
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Selection Description

None No validation is enforced, and any numeric value is permissible.

Equal Permits the entry of a value that is equal to the value entered in the Value/Minimum
field.

Not Equal
Permits the entry of a value that is not equal to the value entered in the
Value/Minimum field.

Greater
Than

Permits the entry of a value that is greater than the value entered in the
Value/Minimum field.

Greater
Than or
Equal

Permits the entry of a value that is equal to or greater than the value entered in the
Value/Minimum field.

Less Than Permits the entry of a value that is less than the value entered in the Value/Minimum
field.

Less Than
or Equal

Permits the entry of a value that is less than or equal to the value entered in the
Value/Minimum field.

Between Permits the entry of a value that falls between the range of numbers defined by the
values entered in the Value/Minimum field and theMaximum field.

Not
Between

Permits the entry of a value that does not fall between the range of numbers defined by
the values entered in the Value/Minimum field and theMaximum field.

Step by Step — Create Input Values from a Table

1. In the bottom right corner of the Cost Item Assembly Record, click on Tables.

2. Right click in the Table Code field and select New.
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3. In the Code field, type CONC – Your Initials, and in the Description field, type Concrete Types.

4. In the Columns section, enter in the following column names and descriptions, choosing the Text
Type.
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5. Click OK in the bottom right corner.

6. In the Tables section, enter in the following data for the Concrete resource codes and types:
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7. Click OK in the bottom right corner.

8. Add the following input, selecting Table for the Input Value from the drop-down.

9. From the Table drop-down list, select your CONC table.
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15.2.5.2 Standard Tables

In the Setup tab, you can create standard tables for the project. These are created exactly like tables
within the Cost Item Assembly Record. All users in the project have access to the standard tables.
These tables can be copied and pasted into the Cost Item Assemblies’ tables. You can create, edit, or
delete standard tables from the Standard Table Register. You can copy Standard tables from the
library, to the library, and from another job.

15.2.6 Conditional Inputs

Conditional input expressions can include variables that reference other input values or ask simple
Yes/No questions. This allows the user to provide answers to inputs, which are then used to determine
if the user is asked to provide more answers for additional inputs. The variable Default Value is used in
the conditional input expression, so the input is always hidden when the Cost Item Assembly is initially
employed. Therefore, the Default Visibility checkbox is not selected, and when you create an estimate
and employ the Cost Item Assembly in the Cost Item Assembly Inputs view, the conditional input is
hidden.

You can then provide information and enter a dimension or a response to a question. Note that:

l If the value entered changes the expression result to True, the conditional input shows

l If you want to see all the inputs in a Cost Item Assembly even if their conditions are not currently
evaluating to True, you can click View in Cost Item Assembly Inputs, and then select Show
Hidden Inputs. This will display all the conditional inputs for the Cost Item Assembly

l To make it easier for users to select data from tables, you can hide unnecessary table columns in
the Table Row Selection Register

l In both Cost Item Assembly Register and Standard Tables Register, go to the Columns data block
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and clear the Default Visibility checkbox to hide columns in the table

More user tags and user defined fields are available on the Cost Item Assembly > Inputs data block
related to a group of variables or with other similarities. A Standard View also exists, so you can define
saved views to make use of the additional tags and fields.

Step by Step — Set Conditional Inputs

1. Create a new input as follows, choosing Table as the Input Type, and selecting Standard Table
from the drop-down.

2. Set the Default Value of the CONC variable as No, then click OK.
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3. In the Visibility Condition field for the CONC TYPE variable, click the fx button.

4. In the Formula Editor, and from the Fields section, double click [CONC.CODE].
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5. In the Operators field, double click on the ‘==’

6. In the Formula Editor, type ‘Yes’.

7. Click OK.
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l Notice that the Default Visibility field for CONC TYPE becomes unchecked

l This means that only when the answer to Is Concrete required is Yes, the CONC TYPE input
will become visible; otherwise, it will stay hidden

8. In the Tag 1 fields for CONC TYPE and CONC, select Concrete.
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9. In the Find field under Inputs, select Tag 1.

10. Begin typing in Concrete and notice that the CONC TYPE row becomes highlighted.
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15.2.7 Calculations

Calculations are values produced from expressions that utilize hard values, input values, and lookup
values. They can be numerical, Boolean, and/or character expressions. These calculations will provide
the method to produce values to use with the cost item output of the assembly. Variable names can
contain these special characters:

l A-Z

l 0-9

l _

l ? (Null)

15.2.7.3 Formulas

The Formula field enables you to create your own custom expressions. You can take assembly inputs
and calculate results. Calculation results may be used in other calculations or linked to an assembly’s
cost item register field values. Formulas can be created with numbers, math operators (e.g., + or – for
addition or subtraction), input variable values or other calculation results, table lookup values, or any
number of functions that are built into the Formula Editor.

The following formula shows an example of how to calculate the cubic foot volume of concrete in a 10’
wide by 15’ long by 6” thick slab on grade. The resulting answer is 75 cubic feet.

To calculate the same volume in cubic yards (there are 27 cubic feet in a cubic yard), the formula can
be rewritten as follows. The resulting answer is 2.78 cubic yards.
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15.2.7.4 Variables

Variables are placeholders for values that can be changed based upon user input or calculation results,
and they can be used to simplify a complex formula. Variables require a name that is unique within the
Cost Item Assembly, and the syntax for referencing a variable in a formula is to enclose the entire
variable name in [brackets]. Using the preceding example, a calculation named [VOL_CUFT] determines
the cubic foot volume of 75. The second formula then references the value stored in the variable [VOL_
CUFT] and divides it by 27 to calculate the cubic yard volume of 2.78.

Input variables are also used to store user inputs as described above. In the following example, three
inputs are created in the Inputs section of the Cost Item Assembly and employing this Cost Item
Assembly will prompt the user to provide the values for the width, length and thickness of the concrete
slab, those values are stored in the variables named [WIDTH], [LENGTH] and [THICK] respectively.

The [VOL_CUFT] calculation in the following example is the same as in the preceding example, but
replaces the 10 foot, 15 foot, and 6 inch values with the variable names, which you would provide
when the Cost Item Assembly is employed.

As in the preceding example, the [VOL_CY] calculation takes the result of the [VOL_CUFT] calculation
and divides by 27 to convert the volume from cubic feet to cubic yards.
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15.2.7.5 Functions

Functions can be used to expand the power of a formula by performing special types of operations on
the formula’s values. Functions are most commonly used by the name of the function, followed by the
values that the function will use to perform the special calculations.

As an example, the Ceiling() function can be used to take the result of a calculation and round it up to
the nearest whole number. In using the concrete slab example from above, the calculation [VOL_BUY]
will take the result of the [VOL_CY] calculation and round it up from 2.78 CY to 3.00 CY using the syntax
Ceiling([VOL_CY]), which represents the amount of concrete you would want to purchase for this work.

15.2.7.6 Null Value

Creating valid formulas can be challenging when calculations start to become more complex. Improper
referencing of variables, incorrect spelling of functions, or invalid mathematical operations are all
examples of ways in which a formula expression can be invalid. When a formula results in an invalid
expression it will return a NULL value. A NULL value is displayed using a ‘?’ character and will preclude
you from employing the Cost Item Assembly in the job. In the following example, a formula that divides
any number by zero generates a mathematically invalid result and is indicated by the ‘?’ character.

15.2.7.7 Formula Editor

The Formula Editor is a tool you can use to assist in the creation of validated formulas that correctly
reference variables and ensure the use of proper syntax. Select the fx button to open the Formula
Editor.
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Element Description

1
Expression
Box

Type your formula expression here or add expression elements by double
clicking items in the Expression Values section as described below.

2 Expression
Elements

Click on an element type to view its categories in the Expression Values list
(3).

3
Expression
Values

Double-click a value to add it to the Expression Box.
l If Functions is the selected Expression Element, a drop-down list of

various categories of functions will be displayed so the list can be
filtered making it easier to find the desired function.

4 Information
and Help

When an expression is selected from the Expression Values list (3), an
explanation of that expression and how it is used will appear in this window.

l If Fields is the selected Expression Element (2), the Expression Values
section will list all the available variables used in the Cost Item
Assembly, as well as displaying the variable type and the Description as
provided by the user in the Description Field of the indicated Input or
Calculation variable

l If Constants is the selected Expression Element (2), then choosing any
of the values in the Expression Values section will provide a brief
explanation of the constant

l If Operators is the selected Expression Element (2), then choosing a
mathematical operator in the Expression Values section will display a
brief description of what the operator does

l If Functions is the selected Expression Element (2), choosing a Function
in the Expression Values section will display the selected functions
syntax as well as a brief description of how the function is intended to
work

Overview - Formula Editor
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Within the Formula Editor, you can use tables to provide reference data for use in calculations. For
example, the following illustration shows a table that stores values for various Concrete Strengths
along with their associated resource code values.
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Step by Step — Create Calculations

1. Drag the Calculations data block into view.

2. In the Variable name field, type Volume, then press Tab.

The Variable Name field in the Calculations section will be the name that other
Calculations can refer or link to and this name must be unique within the context of
the Cost Item Assembly, and unique with respect to input variable names.

3. Enter the Description Ductbank Volume, then press Tab.
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4. In the Formula field, select the fx formula editor button.

5. Select the Field values and Operators as indicated below to create the displayed formula, then
click OK.

l Notice that the Default Result auto calculates using the calculation and input values
provided
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6. In the blank row under the Variable Name field, type Conduit and enter the Description Conduit
Length, then click the fx button to open the formula editor.

7. Select the Fields value and Operators as indicated below to create the displayed formula, then
click OK.

8. In the blank row under the Variable Name field, type Volume2 and enter the Description Conduit
Volume, then click on the fx button to open the formula editor.
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9. Enter the following formula, using the PI() function from the Functions > Math tab, the radius
and length from the Fields tab, and the available Operators tab, then click OK.

10. In the blank row under the Variable Name field, type Volume3 and enter the Description
Backfill/Concrete volume, then click on the fx button to open the formula editor.

11. Enter the following formula, selecting the already created calculations from the Fields section.
Click OK.
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12. In the blank row under the Variable Name field, type Concrete and enter the Description
Concrete type, then click on the fx button to open the formula editor.

13. Enter the following formula, selecting the table value from the Fields tab, then click OK.
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l A default result will not appear because a value from the table has not yet been chosen.

15.2.8 Notes

Notes can be utilized to provide guidance to you on how to use the Cost Item Assembly or provide
further clarification on what the various inputs are requiring or how the calculations are being
performed. This field supports rich text editing, meaning users can copy and paste from an editing tool
various graphics or formatted text such as bold text, bulleted or numbered text, hyperlinks to websites,
or various fonts. The Notes data block is displayed on the right side of the Cost Item Assembly Record
screen.
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Step by Step — Add to the Note Section

1. Click on the Notes tab in the bottom right corner.

2. In the Notes text box, type Ductbank Notes.

3. Right click within the notes section and select Hyperlink.
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4. Type in a link to your SharePoint or document sharing site, then click OK.

Page 538 of 962 InEight Inc.  |  Release 19.2

15.2 Cost Item Assembly Creation Estimate User Guide



l Note how the hyperlink appears in the notes section.

5. Still in Notes, copy a picture or drawing from your computer, then Paste it into the notes section.
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15.2.9 Linking Calculations to Cost Items

The results of calculations can be assigned to any number of different fields in the Cost Items data
block of the Cost Item Assembly record. It is common to link dimensional calculations to the Forecast
(T/O) Quantity fields of various cost items, but calculation results can be linked to many other fields
such as Productivity fields, Description fields, and even Resource Employment fields such as Quantity
or Code. You can link multiple cost item fields to a single calculation by holding the CTRL key. To link a
calculation to a cost item, you right click on the cost item field and then either select to link to the
calculation result from the context menu or from the ribbon.

Step by Step — Link Calculations to Cost Items

1. Expand your Cost Items window so that you can see all the cost items.

2. Right click on the Excavate Ductbank Forecast (T/O) Quantity field and select Link this field to
Calculation Result.
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You create calculations prior to linking the values field. The linking of calculation
results is similar to linking to Excel values except all linked values update
automatically.

3. Select VOLUME, then click OK.
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l Note how the Forecast (T/O) Quantity field is now populated with a linked quantity

4. Right click on the Install Ductbank Conduit Forecast (T/O) Quantity field and select Link this field
to Calculation Result.

5. Select CONDUIT, then click OK.
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6. Select the Forecast (T/O) Quantity field for Pour Concrete, hold down CTRL, and select the
Forecast (T/O) Quantity field for Backfill.

7. Right click and select Link this field to Calculation Result.

8. Select VOLUME3, then click OK.
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9. In the Inputs data block, select the Default Value field for the CONC TYPE input.

10. SelectMC2000, then click OK.

Page 544 of 962 InEight Inc.  |  Release 19.2

15.2 Cost Item Assembly Creation Estimate User Guide



l Notice that this value is now populated in the Default Value field.

11. Navigate to the Calculations data block.

l Note that the Default Result field is now populated

12. In the Cost Items data block, right click in the Optional Code field for the Pour Concrete cost
item, and select Link to Calculation Result

13. Select the CONCRETE calculation, then click OK.
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l Note how the optional code for Pour Concrete is now populated

15.3 COST ITEM ASSEMBLY EMPLOYMENT

When an estimator wants to estimate a scope of work, they can use any available Cost Item
Assemblies that have been included in the job. Cost Item Assemblies are employed in the CBS Register
in much the same way a resource is employed on a cost item. Cost Item Assemblies can be imported
into a project from the Library via the Setup > Job Properties > Cost Basis tab in the same way that
resources can be brought in.
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15.3.1 Employment

Employing cost item assemblies comes after they have been created by a lead estimator typically.
Employing an assembly means an estimator selects a specific assembly to insert into the CBS register
as if adding a new cost item. The estimator will be prompted to provide all the inputs or accept the
default assumptions required for that assembly.

15.3.2 Job Properties

Cost Item Assemblies can effectively be used as a starting point for various components of an estimate.
You can import job specific cost item assemblies by navigating to the Setup menu and selecting Setup >
Job Properties > Cost Basis > Cost Item Assembly.

You can also import cost item assemblies into the Library the same way as doing it from within a job.
You can access the Master Cost Item Assembly Register by navigating to the Library > Cost Item
Assembly Register.
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15.3.3 Insert Cost Item Assemblies

Once your Cost Item Assemblies are created, the cost items must be inserted into the CBS Register.
They can be inserted as a subordinate or new cost item anywhere in the CBS hierarchy. To do so, you
right click on the position code where you want to place the cost item assembly and select to either
insert the assembly as subordinate cost items or as new cost items.

Once the cost items are inserted into the CBS, you can hover over Forecast (T/O) Quantity to see the
associated calculation.
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Step by Step — Insert Cost Item Assemblies

1. Navigate to the CBS Register.

2. Right click on the first cost item in the hierarchy and select Insert Cost Item Assembly as
Subordinate.
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3. Select your Cost Item Assembly, then click OK.

4. Click OK again.

l Your Cost Item Assembly is added to the bottom of the CBS

15.3.4 Edit an Employed Cost Item Assembly

Employed Cost Item Assemblies are read-only cost items in the CBS register, but the inputs that were
provided by the user to create the cost items can be modified to update the resulting cost items. If you
change one variable in the cost item assembly, it will automatically update all associated cost items.

You can update the values of an Employed Cost Item Assembly in two ways:
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l From the CBS Register

l From the Cost Item Assembly Register

15.3.5 From the CBS Register

You can edit the entire Cost Item Assembly from within the CBS Register.

Step by Step — Edit an Employed Cost Item Assembly from the CBS Register

1. Right click on your Excavate Ductbank cost item and select Edit Cost Item Assembly Inputs.

2. Maximize your screen.
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3. Change the Length input value to 120.

4. Click OK.

l Notice how all the quantities for the cost items using the input Length change

15.3.6 From the Cost Item Assembly Register

You can navigate back to the Cost Item Assembly Register, select your Cost Item Record, and make any
changes there. Once the Cost Item Assemblies have been employed, to update the cost items with any
changes made in the Cost Item Assembly Register, you need to go back to the CBS Register to update
the cost items. You follow the same steps as above except you do not actually change anything in the
edit window, you just click OK to see the updated changes.
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15.3.7 Advanced Options

The following step by step demonstrates some advanced options within Cost Item Assemblies, such as
conditional inputs and functions.

Step by Step — Advanced Options

1. Navigate to your Cost Item Assembly Record.

2. In the Calculations data block, click on the formula editor for the “Volume” calculation.

3. Using the Functions tab, select the Round function and put your existing formula within its
parenthesis, then click OK.
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l You now see a rounded number in the Default Result field

4. You now see a rounded number in the Default Result field

5. Do the same for the Volume2 and Volume3 calculations.

6. Create a new calculation. In the Variable Name field, type Include_Conc, enter Include
Concrete? in the Description field, then click on the fx button to open the formula editor.

7. Using the Iif(, , ) function from the Functions tab, and the existing Volume3 calculations from the
Fields tab, enter in the following formula, then click OK.
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8. Navigate to the CBS Register.

9. Right click on one of your cost assembly items, and select Edit Cost Item Assembly Inputs.
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10. On the CONC input, select the ellipses next to the Default Value.
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11. Select Yes.

12. Click OK.
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l Note how the conditional input CONC TYPE is now displayed

13. Click OK.

14. Navigate back to your Cost Item Assembly Record.

15. In the Cost Items data block, right click on the Pour Concrete Forecast (T/O) Quantity field.

16. From the ribbon, click the Unlink from Calculation Result option.

17. Now click Link to Calculation result.
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18. Select the INCLUDE_CONC calculation, then click OK.

19. Right click on the Pour Concrete Optional Code field.

20. From the ribbon, click the Unlink from Calculation Result option.

21. Navigate to the CBS Register.

22. Right click on one of your cost assembly items, and select Edit Cost Item Assembly Inputs.

23. Click OK.

24. Right click on one of your cost assembly items, and select Edit Cost Item Assembly Inputs.
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25. Change the default value of CONC to No.

26. Click OK.

27. Click OK again.

l Notice that your Pour Concrete cost item now disappears

15.3.8 Breaking the Link to a Cost Item Assembly

To ensure that the logic used in the calculation of a Cost Item Assembly is retained, employed Cost
Item Assemblies are not directly editable in the CBS Register. To customize the results of an employed
Cost Item Assembly, you can disassociate it from the originating Cost Item Assembly logic as per the
following steps.
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Step by Step — Break the Link to a Cost Item Assembly

1. Right click your Excavate Ductbank cost item and select Break Cost Item Assembly Link.

2. On the resulting Attention prompt, click Yes.
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3. When prompted about changing the Quantity Driver to Superior CI, click Yes.

l Note that the hyperlinks disappear, and the link has been broken

InEight Inc.  |  Release 19.2 Page 563 of 962

Estimate User Guide 15.3 Cost Item Assembly Employment



Exercise 15.1 — Creating and Employing a Cost Item Assembly

Now that you have covered the key tasks related to cost item assemblies, you can practice creating
one on your own. You can use your own project (if available) or the training project used in this
lesson.

1. Create a cost item assembly with two cost items.

2. Create inputs and calculations and link them to the cost items in your assembly.

3. Employ the assembly in the CBS Register.

4. Break the cost item’s link to the assembly.

Congratulations, you have completed this exercise!
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15.4 COST ITEM SUB-ASSEMBLIES

With the Sub-Assemblies in the Cost Item Assemblies form, you can easily create and maintain cost
item assemblies that model construction systems and contain multiple complex calculations. Sub-
assemblies enable the Cost Item Assemblies feature to be more modular, allowing you to maintain
smaller, simpler versions of cost item assemblies and reuse them in multiple places.

15.4.1 Accessing the Cost Item Assembly Sub Assemblies

A sub-assembly can be created within a cost item assembly by simply inserting it as a subordinate cost
item.

To access a cost item assembly record, select Setup > Cost Item Assemblies. The Cost Assembly
register will open.

Select the cost item you want to open by double clicking or right click and select Open.
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15.4.2 Overview of the cost item assembly sub assembly

Under the Cost Items window you will see the cost item assemblies listed. On the right side of the
screen will be the sub assemblies relating to each cost item.
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When you expand the sub assemblies on the right, it lists all the elements which make up that sub
assembly.

On the Cost Item Assembly Record screen there are three windows. Below are their functions:
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Windows Description

1 Cost Items
These are the component cost items that will be inserted when the assembly is
employed. Fields on the cost items can be linked to Calculations, which are
driven by the Input values in window 2.

2 Inputs /
Calculations

Inputs: These are the inputs the user will specify during employment of the
assembly. These input values drive the Calculations which can be linked to the
cost items in window 1.
Calcutions: This is where Calculations are defined. Calculations can be based
on Input values and other Calculations, and the Calculation results can be
linked to fields on the assembly’s cost items and resource employments.

3
Sub
Assemblies

Four tabs appear: Notes, Setup, Tables, and Osub Assemblies.
l Notes are displayed when the assembly is employed
l Setup shows file and Tag information
l Tables link to individual Table Records by Table Code
l Sub Assemblies list all the elements which make up that sub assembly

Selecting the Default Data Blocks icon in the top left of the screen will change the view of the Cost
Item Assembly Record.
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The cost item assemblies input values can then be assigned to the sub-assembly input values for you to
answer a question only one time. For example, when providing the total square footage of a wall
system, the single input can be used by the cost item assembly and its sub-assemblies. Adjusting values
in the questions, will change the preview, as shown below.

From the Cost Item Assembly Record > Sub Assemblies tab, compare how changes affect the Cost
Breakdown Structure (CBS) Register:

Changing these values will…

adjust these totals.
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Sub-assembly input values can be sorted and shown conditionally based upon your inputs. Then you
can employ a cost item assembly which only views the questions that are relevant. For example, a
question in the cost item assembly could be, "Is insulation required?". If the answer to the question is
yes, then a sub-assembly that defines the cost of installing insulation gets included in the cost item
assembly. If the answer is no, then the sub-assembly is not included.

To view the formulas used to calculate the values of the cost items, in the Cost Breakdown Structure
(CBS) Register hover over the Forecast (T/O) Quantity line items. This will help you to understand how
these values were determined.

When your Input questions require answers as Yes/No, Unit of Measure, etc., select the field’s ellipse
to open the table screen. Here you can select the item(s) which relate to your initial selection. When
OK is selected, the line item will update with the new selection.
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Step by Step — Creating a Cost Item Assembly Sub Assembly

1. Navigate to Setup > Cost Item Assemblies.

2. Select a cost item assembly.

l The cost item assembly record will open
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3. With the addition of “Walls” as our example. select a blank line in the Cost Item Assembly and
give it a number and description.

4. Right click on the line item and select Insert Cost Item Assembly as Subordinate.
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l The Cost Item Assembly Register sub assembly opens

5. From this screen, select a sub assembly to add and click OK.
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l The window for the sub assembly will open with its details

l Complete any changes to the values

6. Click OK.

The cost item sub assembly has been added:
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Lesson 15 Review

1. Where do you create new cost items for the cost item assembly?

a. CBS Register

b. Cost Item Assembly Record

c. Job Properties

d. Cost Item Assembly Register

2. From where can you edit an employed cost item assembly?

a. CBS Register

b. Cost Item Assembly Record

c. Resource Rate Register

d. Both a & b

3. Match each function to its correct definition:

Term Definition

Iif Rounds the given value to the nearest integer

Round Returns the maximum value for the specified values

Pi Returns the value of Pi

Max Returns either TruePart or FalsePart depending on the Boolean expression

Lesson 15 Summary

As a result of this lesson, you can:

l Explain what a cost item assembly is and why it is used

l Create and edit a cost item assembly

l Employ a cost item assembly
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15.5 ADVANCED JOB SNAPSHOTS

A job Snapshot is a copy of an Estimate job that provides read only access to the job as it existed at a
specific point in time.

You can use a Job Snapshot to do the following

l Freeze your estimate at various points for audit purposes, such as after take-off is complete,
after bid review is complete, or after final subcontractor/supplier prices have been entered.

l Give access to users that need access to the information but are not permitted to modify the
data.

l Enable users to access a job while eliminating the concern that someone may inadvertently
change live data.

l Copy data from a snapshot version of a job and paste it back into the live job or any other
project.

l Create a new job from a snapshot version of a job.

Behind the scenes, the job is saved and maintained as an archive. When a snapshot is loaded, the
archive is restored as a local copy. A snapshot can be modified, but changes cannot be saved.
Snapshots are managed in the Snapshot Register.

15.5.1 Creating A New Job Snapshot

User access can be set for each snapshot as follows:

l Use job’s current User Access restrictions for the snapshot

l Remove all User Access restrictions for the snapshot

l Specify User Access restrictions for the snapshot

Step by Step — Creating a New Job Snapshot

1. Click on the File tab. From the Backstage View, select Snapshots from the left navigation pane.

2. Select Create Snapshot.

3. The job name and description display at the top of the dialog.
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4. In the Snapshot Comment area, enter a short description of the snapshot. This comment will be
used to identify the snapshot on the Snapshot Register form.

5. To include all attachments that have been stored in the job folder with this Snapshot, select the
check box.

6. Select the Specify User Access restrictions for this Snapshot option.
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7. Ensure that your name is selected, otherwise click the “Add” button and select yourself. Click OK.

15.5.2 To Create a New Job from a Snapshot

New jobs can be created from existing job snapshots using the following steps.
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Step by Step — Creating a New Job from a Snapshot

1. Click on the File tab. From the Backstage View, select New from the left navigation pane.

2. Select Create Snapshot.

3. Select Create a new Job from... Snapshot.

4. Select a snapshot from which to create the job. Click OK.

5. Enter in a unique code for the new job TEST – Your Initials. Check both boxes to copy cost details
and PBS changes log into the new job. Click OK.

6. Your job will pop up in a new window. Close out of your job and navigate back to the training
job.
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7. Click OK to save.

15.5.3 Load a Job Snapshot

When you load an existing Snapshot, it loads into Estimate like any other job. You can use it for
reference and copy data from it to other jobs. A snapshot can be modified, but changes cannot be
saved. To identify it in Estimate as a read-only snapshot:

l The job name is preceded by SNAPSHOT: in the job tab

l A red banner displays the specific snapshot information in the Current Job area at the bottom of
the screen.

Step by Step — Load a Job Snapshot

1. Click on the File tab. From the Backstage View, select Snapshots from the left navigation pane.

2. Select Snapshot Register.

3. Select the snapshot that you would like to load.
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4. From the Ribbon, select the Actions tab. Then under the Edit section, select Load.

5. Your snapshot opens as indicated by the top and bottom of the screen.

6. Close out of the snapshot. Close out of the Library.
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15.5.4 Compare Snapshots in Job Explorer

In Estimate Job Explorer, you are able to now compare a snapshot to another snapshot, or a snapshot
to a job by selecting them in the tree view.

Step by Step — Compare Snapshots in Job Explorer

1. Click on the File tab. From the Backstage View, select Job from the left navigation pane.

2. Select Compare Jobs.

3. Select a job and a snapshot from the Estimate Job Explorer.

4. Click Set Item Matching Criteria.

5. From the Item Matching Criteria window, select Account Code. Then click OK.
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6. On the Estimate Job Explorer, click Show Column Comparison View. Once done, click OK.
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7. You can now compare the snapshot and the job column by column. Close out of the Library
when done.

15.5.5 Delete a Job Snapshot

If you decide that you no longer need a snapshot or if you want to delete it for any other reason, you
can do so following this step by step.

Step by Step — Delete a Job Snapshot

1. Click on the File tab. From the Backstage View, select Snapshots from the left navigation pane.

2. Select Snapshot Register.

3. Select the snapshot you want to delete.
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4. From the Ribbon, select the Actions tab. Under the Edit section, select Delete.

5. Click OK to complete the deletion of the snapshot.

15.5.6 Upgrade Snapshot Version

When a snapshot is selected in the Snapshot Register that is not the same as the Estimate system
version, a prompt opens for the user to upgrade the snapshot. The snapshot must be upgraded to be
viewed. The snapshot opens automatically after the upgrade is completed, which shows the updated
version in the status bar.
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15.6 VALIDATED TAGS

Tags are used to identify or mark records for filtering, sorting and reporting purposes. Think of them as
you would any paper tag that you attach to an object to better identify it or find it when you need it.

Tags can be created and made available to all Tags fields throughout the system or can be created for
specific Tags fields on specific forms. When created for a specific Tags field on a specific form, the list
of available Tags for that field will be limited to those Tags assigned to that field and form. Tags that
have not been assigned to a specific field and form will be available to all Tags fields on all forms. After
data is tagged, it can be filtered, sorted, and grouped using the filtering and grouping features on the
register containing the data.

15.6.1 Validate Field Examples

Examples Description

Area Assign construction area to cost items

Phase Assign construction phase to cost items

Work Type Assign construction work types to cost items

Estimator Assign an estimator’s name to a cost item for
responsibility/tracking

Estimate Scope
Cost item tagging for secondary reporting scope
needs

Issues Issues to discuss during estimate reviews

Risk Level
Assign risk level to cost items for estimate
reviews

Division/District/Region
Tags

Division/District/Region tags

Review Status Sections of the estimate that have been reviewed

Contract Type Contract types

Bid Review Date Date organization reviewed the bid

Bid Award Date Date the bid was awarded

Page 586 of 962 InEight Inc.  |  Release 19.2

15.6 Validated Tags Estimate User Guide



Examples Description

Bid Place
Track how the bid placed against competitors if
not won

Quantity Verification Cost item takeoff validation complete

Users can take advantage of validated and non-validate tags in every register within estimate. It will be
up to the organization on how they want to best leverage tags in each register.
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15.6.1.1 Register Examples
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15.6.2 Master Foundation Setup Data – Validated Tags

A master set of Tags is created and stored in theMaster Foundation Setup Data - Tags tab of the
Library. When you create a new folder, the master set is automatically copied from the Library to the
new folder. If you feel the current job requires new or different Tags to adequately categorize its cost
items and resources, you can change, create, or delete them any time you want.

Step by Step — Validated Register Tags

1. From the Backstage View, select Library from the left pane navigation.

2. From the Ribbon, select the Setup tab.

3. Under the section Master Initialization, select the Foundation Setup Data button. The
Foundation Setup Data Register opens.

4. From the Foundation Setup Data Register, select the Tags tab.

5. Click in the first blank cell in the Code column. Then enter the code that defines the tag.
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6. In the Description field, enter a description for the tag.

7. In the Register field, define the type of item to associate with this tag.

8. In the Field column, define the tag field to associate with this tag.

9. Repeat the previous steps to add additional tags.

15.6.3 Creating Validate Tags in the Record

The following steps walk you through how to create validated tags within a User Tag Record.

Step by Step — Validated Record Tags

1. From the Backstage View, select Library from the left pane navigation.

2. From the Ribbon, select the Setup tab.

3. Under the section Master Initialization, select the Foundation Setup Data button. The
Foundation Setup Data Register opens.

4. From the Foundation Setup Data Register, select the Tags tab.
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5. Select the Actions tab.

6. Under the Edit section, select New. A new User Tag Record opens.
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7. In the Code column, enter the code that defines the tag.

8. In the Description field, enter a description for the tag.

9. In the Register drop down, define the type of item to associate with this tag.

10. In the Field drop down, define the tag field to associate with this tag.

11. When you are finished, click OK to close this record and return to the register.
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12. Repeat the previous steps to add additional tags.

13. To edit pre-existing tags, select the tag you want to edit. Then, in the Actions tab, click Open.
The User Tag Record opens.

15.6.4 Assigning Validate Tags to Cost Items

The following steps walk you through how to assign validated tags to cost items.

Step by Step — Assigning Validate Tags to Cost Items

1. From the Ribbon, select the Estimate tab.

2. Then select Cost Breakdown Structure (CBS).
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3. Double-click the row that you want to assign tags. The Cost Item Record for that row opens.

l e.g., Direct Cost Add-On, Indirect Cost Escalation, etc.

4. Select the Cost Item Setup default data block in the lower right portion of the record.

5. Select a tag to add to the Tag 1 field drop down.

6. Select the Cost Item Setup default data block in the lower right portion of the record.
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If the tag that you want to assign does not display in the drop-down list, you have
the ability to add a new tag by clicking on the green plus button that shows to the
left of the validation button and adding the new tag to your job's foundation data

7. Repeat the previous steps to add additional tags.

15.6.5 Assigning Validated Tags to an Employed Resource

The following steps walk you through how to assign validated tags to an employed resource.

Estimate provides you with the ability to assign specific tags on a resource-by-resource basis for each
employed resource on a cost item.

Tags are master codes and descriptions that are used, generally, for sorting and filtering purposes and
allow you to group like data for reporting and review purposes.

Step by Step — Assigning Validate Tags to Employed Resources

1. From the Ribbon, select the Estimate tab.

2. Then select Cost Breakdown Structure (CBS).

3. Double-click the row that you want to assign tags. The Cost Item Record for that row opens.
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l e.g., Direct Cost Add-On, Indirect Cost Escalation, etc.

4. In the Cost Item Record, select the Detail tab.

5. Select a resource row in the Detail tab and then select the Employment Setup default data block
in the lower right portion of the record.

6. Select a tag for the Tag 1 field using the drop down list.

If the tag that you want to assign does not display in the drop-down list, you have
the ability to add a new tag by clicking on the green plus button that shows to the
left of the validation button and adding the new tag to your job's foundation data.

7. Repeat the previous steps to add additional tags.

15.6.6 Assigning Validated Tags to Pay Items

Tags are master codes and descriptions that are generally used for sorting and filtering purposes, and
they allow you to group like data for reporting and review purposes.

Step by Step — Assigning Validate Tags in Pay Item Register

1. From the Ribbon, select the Price tab.

2. Under the Pay Items section, select Pay Item & Proposal. The Pay Item & Proposal Register
opens.

3. In the register, select the pay item that you want to assign a tag.

4. Find and click into the Tag 1 field. Then select a tag from the drop down list.

If the tag that you want to assign does not display in the drop-down list, you have
the ability to add a new tag by clicking on the green plus button that shows to the
left of the validation button and adding the new tag to your job's foundation data.

5. Repeat the previous steps to add additional tags.
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15.6.6.2 Assign Tags on the Pay Item Record

Step by Step — Assigning Validate Tags in Pay Item Record

1. From the Ribbon, select the Price tab.

2. Under the Pay Items section, select Pay Item & Proposal. The Pay Item & Proposal Register
opens.

3. In the register, select the pay item that you want to assign a tag.

4. On the Actions tab, click Open to open the Pay Item Record.

5. From the Pay Item Record, select the Tags / User Defined Fields tab.

6. Click the Tag 1 field. Then select a tag from the drop down list.

If the tag that you want to assign does not display in the drop-down list, you have
the ability to add a new tag by clicking on the green plus button that shows to the
left of the validation button and adding the new tag to your job's foundation data.

7. Repeat the previous steps to add additional tags. Once done, click OK.

15.6.7 Assigning Validated Tags to Price % Add-On

Step by Step — Assigning Validated Tags to Price % Add-On

1. From the Ribbon, select the Estimate tab.

2. Under the Breakdown Structure section, select Cost Breakdown Structure (CBS).

3. Double-click on the PRICE % ADD-ON row.

4. Under the Cost Item Setup default data block, click in the Tag 1 field. Then, select an account
code using the drop down list.

If the tag that you want to assign does not display in the drop-down list, you have
the ability to add a new tag by clicking on the green plus button that shows to the
left of the validation button and adding the new tag to your job's foundation data.

5. Repeat the previous steps to add additional tags. Once done, click OK.
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15.6.8 Assigning Validated Tags to a Quote Record

Tags are master codes and descriptions that are generally used for sorting and filtering purposes, and
they allow you to group like data for reporting and review purposes.

Step by Step — Assigning Validated Tags to Quote Record

1. From the Ribbon, select the Quote tab.

2. Under the Quote Management section, select Quotes.

3. Open the preferred Request for Quote Record by highlighting it on the Quote Register.

4. Then select the Actions tab. Under the Edit section, select Open. The Quote Record opens.
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5. Under the Setup default data block, click in the Tag 1 field. Then, select a tag using the drop
down list.

If the tag that you want to assign does not display in the drop-down list, you have
the ability to add a new tag by clicking on the green plus button that shows to the
left of the validation button and adding the new tag to your job's foundation data.

6. Repeat the previous steps to add additional tags. Once done, click OK.

15.7 NON-VALIDATED TAGS

Tags are used to identify or mark records for filtering, sorting, and reporting purposes.

Tags can be created and made available to all Tags fields throughout the system or can be created for
specific Tags fields on specific forms. When created for a specific Tags field on a specific form, the list

Page 600 of 962 InEight Inc.  |  Release 19.2

15.7 Non-Validated Tags Estimate User Guide



of available Tags for that field will be limited to those Tags assigned to that field and form. Tags that
have not been assigned to a specific field and form will be available to all Tags fields on all forms. After
data is tagged, it can be filtered, sorted, and grouped using the filtering and grouping features on the
register containing the data.

15.7.1 Non-Validate Field Examples

Examples Description

Risk description Identify specific risks against cost items

Superintendent Identifies responsible person for operations and
forecasting

Commodities
Grouping cost items for roll-up and review for
specific commodities

Client Tagging Specific cost item tagging for client

External System Flag External flags for integration

AWP Planning Assign a cost item to a Work Plan for operations

Users can take advantage of validated and non-validate tags in every register within estimate. It will be
up to the organization on how they want to best leverage tags in each register.
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15.7.1.1 Register Examples
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15.7.2 Creating Non-Validate Tags

The following steps walk you through how to create non-validate tags within a Cost Item Record.

Step by Step — Non-Validate Tags in Cost Item Record

1. From the Ribbon, select the Estimate tab.

2. Then select Cost Breakdown Structure (CBS).

3. Double-click the row that you want to assign tags. The Cost Item Record for that row opens.

l e.g., Direct Cost Add-On, Indirect Cost Escalation, etc.

4. Select the User Defined default data block in the lower right portion of the record.

5. Click into the User Defined 1 field and type in the value needed for the cost item.

The following steps walk you through how to create non-validate tags within the register.

Cell select and fill down shortcuts can expedite the assigning process.
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Step by Step — Non-Validate Tags in Register

1. From the Ribbon, select the Estimate tab.

2. Then select Cost Breakdown Structure (CBS).

3. Go to the cost item that you want to add tags and scroll to the User Defined 1 field.

4. Type in the value needed for the cost item.

5. Changing the caption can also assist in notating how the field is to be used.
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15.8 ADVANCED JOB SNAPSHOTS

A job Snapshot is a copy of an Estimate job that provides read only access to the job as it existed at a
specific point in time.

You can use a Job Snapshot to do the following

l Freeze your estimate at various points for audit purposes, such as after take-off is complete,
after bid review is complete, or after final subcontractor/supplier prices have been entered.

l Give access to users that need access to the information but are not permitted to modify the
data.

l Enable users to access a job while eliminating the concern that someone may inadvertently
change live data.

l Copy data from a snapshot version of a job and paste it back into the live job or any other
project.

l Create a new job from a snapshot version of a job.

Behind the scenes, the job is saved and maintained as an archive. When a snapshot is loaded, the
archive is restored as a local copy. A snapshot can be modified, but changes cannot be saved.
Snapshots are managed in the Snapshot Register.
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15.8.1 Creating A New Job Snapshot

User access can be set for each snapshot as follows:

l Use job’s current User Access restrictions for the snapshot

l Remove all User Access restrictions for the snapshot

l Specify User Access restrictions for the snapshot

Step by Step — Creating a New Job Snapshot

1. Click on the File tab. From the Backstage View, select Snapshots from the left navigation pane.

2. Select Create Snapshot.

3. The job name and description display at the top of the dialog.

4. In the Snapshot Comment area, enter a short description of the snapshot. This comment will be
used to identify the snapshot on the Snapshot Register form.

5. To include all attachments that have been stored in the job folder with this Snapshot, select the
check box.

InEight Inc.  |  Release 19.2 Page 607 of 962

Estimate User Guide 15.8 Advanced Job Snapshots



6. Select the Specify User Access restrictions for this Snapshot option.

7. Ensure that your name is selected, otherwise click the “Add” button and select yourself. Click OK.
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15.8.2 To Create a New Job from a Snapshot

New jobs can be created from existing job snapshots using the following steps.

Step by Step — Creating a New Job from a Snapshot

1. Click on the File tab. From the Backstage View, select New from the left navigation pane.

2. Select Create Snapshot.

3. Select Create a new Job from... Snapshot.

4. Select a snapshot from which to create the job. Click OK.
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5. Enter in a unique code for the new job TEST – Your Initials. Check both boxes to copy cost details
and PBS changes log into the new job. Click OK.

6. Your job will pop up in a new window. Close out of your job and navigate back to the training
job.

7. Click OK to save.

15.8.3 Load a Job Snapshot

When you load an existing Snapshot, it loads into Estimate like any other job. You can use it for
reference and copy data from it to other jobs. A snapshot can be modified, but changes cannot be
saved. To identify it in Estimate as a read-only snapshot:

l The job name is preceded by SNAPSHOT: in the job tab

l A red banner displays the specific snapshot information in the Current Job area at the bottom of
the screen.
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Step by Step — Load a Job Snapshot

1. Click on the File tab. From the Backstage View, select Snapshots from the left navigation pane.

2. Select Snapshot Register.

3. Select the snapshot that you would like to load.

4. From the Ribbon, select the Actions tab. Then under the Edit section, select Load.

5. Your snapshot opens as indicated by the top and bottom of the screen.
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6. Close out of the snapshot. Close out of the Library.

15.8.4 Compare Snapshots in Job Explorer

In Estimate Job Explorer, you are able to now compare a snapshot to another snapshot, or a snapshot
to a job by selecting them in the tree view.

Step by Step — Compare Snapshots in Job Explorer

1. Click on the File tab. From the Backstage View, select Job from the left navigation pane.

2. Select Compare Jobs.

3. Select a job and a snapshot from the Estimate Job Explorer.

4. Click Set Item Matching Criteria.
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5. From the Item Matching Criteria window, select Account Code. Then click OK.

6. On the Estimate Job Explorer, click Show Column Comparison View. Once done, click OK.
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7. You can now compare the snapshot and the job column by column. Close out of the Library
when done.

15.8.5 Delete a Job Snapshot

If you decide that you no longer need a snapshot or if you want to delete it for any other reason, you
can do so following this step by step.

Step by Step — Delete a Job Snapshot

1. Click on the File tab. From the Backstage View, select Snapshots from the left navigation pane.

2. Select Snapshot Register.

3. Select the snapshot you want to delete.
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4. From the Ribbon, select the Actions tab. Under the Edit section, select Delete.

5. Click OK to complete the deletion of the snapshot.

15.8.6 Upgrade Snapshot Version

When a snapshot is selected in the Snapshot Register that is not the same as the Estimate system
version, a prompt opens for the user to upgrade the snapshot. The snapshot must be upgraded to be
viewed. The snapshot opens automatically after the upgrade is completed, which shows the updated
version in the status bar.
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15.9 ARCHIVE AND RESTORE JOBS

One of the most useful features within Estimate is the ability to archive job folders. This feature is used
to store job folders that you create in Estimate in a compressed format. This feature is particularly
useful when you want to create a backup copy of one or many jobs.

By archiving Estimate job data you are not only creating a copy for safekeeping but you are also
allowing yourself the ability to free up additional hard drive space by subsequently deleting the data
that you have backed up. Archiving jobs can also be useful for moving a job from one environment to
another, such as sending a job file to another Estimate user in a different office or a different company.

Once you have backed up Estimate job data you always have the ability to restore that data at any time
by using the Restore feature.

Step by Step — Archiving a Job

1. Click on the File tab. From the Backstage View, select Archive/Restore from the left navigation
pane.

2. Select Archive Job.

3. From the Job Register, select a job to archive. Click OK.

4. An Include Attachments warning appears. Click Yes to continue.
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5. Save this job on your desktop. Click Save. Then click OK.

15.9.1 Restore Job Archive

Once you have archived an Estimate job, you always have the ability to restore that data at any time by
using the Restore Job Archive feature. This feature de-compresses a specified archive file and provides
you with the ability to overwrite an existing job or specify a new job code where you want to restore
your job data.

Step by Step — Restore Job Archive

1. Click on the File tab. From the Backstage View, select Archive/Restore from the left navigation
pane.

2. Select Restore Job Archive.

3. Select the archive that you previously saved to your desktop. Click Open. Then when prompted,
select No.

InEight Inc.  |  Release 19.2 Page 617 of 962

Estimate User Guide 15.9 Archive and Restore Jobs



4. Enter a code TEST RESTORE – Your Initials. Check both boxes to copy cost details and PBS
changes log into the new job. Click OK.

5. Your restored job will open in a new window. Close out of the restored job.
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15.9.2 Merge Job with Archive

Once you have archived a job, you have the ability to merge that data with existing job data at any
time by using theMerge Job Archive feature.

When merging job data, the system looks at your existing job data for matching codes or descriptions.
If the system finds a match, the existing data is overwritten (updated) to reflect the data in the archive
file. If the system does not find a match, the data is added to the job.

The Merge Job Archive feature does not merge all of the data in the job. The data that is
included/merged is as follows:

l Foundation Setup Data

l Resource Rates

l Resource Assemblies

Step by Step — Merge Job with Archive

1. Click on the File tab. From the Backstage View, select Archive/Restore from the left navigation
pane.

2. SelectMerge Job with Archive.

3. When prompted, select Yes to continue.
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4. Select your test job, then click OK.

5. Select the archive saved to your desktop, then click Open.

6. Click on the File tab. From the Backstage View, select Start from the left navigation pane.

7. Select your test job from the Open a recent Job section.
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8. From the Ribbon, select the Setup tab. Then select Job Properties.

9. You can now see that your archive and test job have merged data by viewing Resource Rates,
Resource Assemblies, and Foundation Setup Data.

15.10 WORK BREAKDOWN STRUCTURES

15.10.1 WBS Overview

The Work Breakdown Structure (WBS) feature lets you create a job in one format and present in a
multitude of other formats depending on the need. This can be beneficial when the estimating team or
the proposal team needs to present the estimate in a preferred format to a design firm, engineering
company, client or any other stakeholders. WBS retains the same relationship between items as in the
original estimate and only changes the view and how items are arranged in the hierarchy.

15.10.2 Format Creation

The Work Breakdown Structure provides flexibility to create other formats, such as Construction
Specific Institute (CSI) MasterFormat or UniFormat. Use WBS formats when you need to have multiple
variations and summary reports of an estimate. This is useful in cases where you want to show
different estimates in one particular way, perhaps for a repeat client or designer.

Once you have your general information entered and set up for a format, you can build your hierarchy.
This lets you organize and define the information in a format that works best for you. You have the
ability to build your hierarchy from scratch or you can use a template. The default Quantity (1.00) &
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Unit of Measure (Each) are populated in the WBS hierarchies. You are able to change these two items
as needed. After a WBS item has been created, it is listed in the Foundation Setup Data Register.

Step by Step — Create a WBS Item

1. From the Ribbon, select the Setup tab.

2. Select Foundation Setup Data drop down and then selectWork Breakdown Structure.

3. From the Work Breakdown Structure, select the Actions tab.

4. Under the Edit section, select New. A new Work Breakdown Structure Record opens.
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5. Enter a Code and Description for the WBS item.

6. From the Setup data block, enter a Period in the Hierarchy Separator field.

The Hierarchy Separator is used to separate the parent cost items from the
subordinate and terminal cost items.

7. Select the Tag 1 drop down arrow and select Concrete.

8. In the Details data block, build your hierarchy by entering items into the Code and Description
fields.

9. In the Details data block, leave the Quantity as the default. Enter in a Unit of Measure for each
item.
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10. Once done, click OK.

15.10.3 Assign WBS to CBS

The Cost Breakdown Structure (CBS) Register shows you the WBS Code and Description fields. From
here, you can assign your WBS items to any of your CBS items.

Step by Step — Assign WBS item to CBS item

1. From the Ribbon, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS). The Cost Breakdown Structure (CBS) Register opens.

3. Right click on any column header and select Column Chooser.
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4. In the Customize window, scroll down until you findWBS: Test WBS.

InEight Inc.  |  Release 19.2 Page 625 of 962

Estimate User Guide 15.10 Work Breakdown Structures



5. Drag and drop both columns into the CBS column headers.
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6. Select a cost item and then click into the empty field from the WBS column you dragged and
dropped into the CBS. Click the arrow icon that appears to the right of that field. TheWork
Breakdown Structure Detail Register opens.
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7. Select the WBS item to assign to the cost item. Once done, click OK.

8. The WBS selected in the previous step is now populated in that cost item’s WBS field.

Page 628 of 962 InEight Inc.  |  Release 19.2

15.10 Work Breakdown Structures Estimate User Guide



15.10.4 View WBS Items

In the Work Breakdown Structure View Register you can:

l Select from the list of WBS formats that you want to view your estimate. You can easily change
to a different format as needed.

l See the total cost roll up of assigned cost items and subordinate detailed items.

l Select from the hierarchy structure and show utilized cost items and associated resources in a
separate panel

l Change quantities of a WBS item.

Only the unit cost is affected when the quantity has been changed.

When you are creating multiple WBS items, you are able to group the data and view the Work
Breakdown Structure Hierarchy.
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Step by Step — View WBS Items

1. From the Ribbon, select the Estimate tab.

2. In the Breakdown Structure section, selectWork Breakdown Structure. The Work Breakdown
Structure View Register opens.

3. From the WBS tree, click the WBS drop down arrow and select your WBS item.

4. In the Cost Items data block, you can view which cost items utilized by a WBS item that you
select. You can also view the total cost roll up of assigned cost items

5. Expand your utilized cost item by clicking the + icon in the CBS Position Code. You can now view
the associated resources to your cost item and WBS item.
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15.11 COPY JOB RESOURCES TO LIBRARY

Resources are created in the Resource Rate Register. This register is the location where you build out
the structure of those resources.

Use of this lesson will draw from other sections of InEight Estimating Manual. Basic
understanding of the resources is required.

The following procedure is going to guide you through copying resources from a project back to your
library in InEight Estimate.

Step by Step — Copying Job Resources to Library

1. From the Backstage View, select Open from the left pane navigation.

2. From the Job Register, select the job that you want to copy resources.

3. Select the Estimate tab.

4. Under the Resources section, select Resource Rates. The Resource Rate Register opens.
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5. Select the Actions tab.

6. Under the Tools section, select the option Copy Job Resources to Library.

7. A new window appears prompting you to make a few choices on what is to be updated into the
library.
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8. The system is grouped by status letting you know what has been modified from the
library resources.

9. In the main grid, you can select which resources to bring to the library. The bottom of the
window has a toggle that allows you to include all the modified or new resources that you wish
to bring into the library. If preferred, select Toggle Include All located in the New or Modified
Resources data block.

10. The quoted values allows a user to update the resource rates based on the pricing that came
back to be the new value in the library during quotation. If preferred, select the Use quoted
values for awarded resources check box in the Quoted Values data box.

11. Once done, click OK.

12. A pop-up will appear asking Overwrite existing Resources?. To confirm the changes, select Yes.
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15.12 COPY JOB RESOURCES TO LIBRARY

Resources are created in the Resource Rate Register. This register is the location where you build out
the structure of those resources.

Use of this lesson will draw from other sections of InEight Estimating Manual. Basic
understanding of the resources is required.

The following procedure is going to guide you through copying resources from a project back to your
library in InEight Estimate.

Step by Step — Copying Job Resources to Library

1. From the Backstage View, select Open from the left pane navigation.

2. From the Job Register, select the job that you want to copy resources.

3. Select the Estimate tab.

4. Under the Resources section, select Resource Rates. The Resource Rate Register opens.

5. Select the Actions tab.

6. Under the Tools section, select the option Copy Job Resources to Library.
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7. A new window appears prompting you to make a few choices on what is to be updated into the
library.
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8. The system is grouped by status letting you know what has been modified from the
library resources.

9. In the main grid, you can select which resources to bring to the library. The bottom of the
window has a toggle that allows you to include all the modified or new resources that you wish
to bring into the library. If preferred, select Toggle Include All located in the New or Modified
Resources data block.

10. The quoted values allows a user to update the resource rates based on the pricing that came
back to be the new value in the library during quotation. If preferred, select the Use quoted
values for awarded resources check box in the Quoted Values data box.

11. Once done, click OK.

12. A pop-up will appear asking Overwrite existing Resources?. To confirm the changes, select Yes.
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15.13 MULTI-EDIT OF RESOURCES

The following procedure is going to guide you through editing multiple resources at one time in InEight
Estimate.

Use of this lesson will draw from other sections of InEight Estimating Manual. Basic
understanding of the resources is required.

Step by Step — Mutli-Edit Resources

1. From the Backstage View, select Open from the left pane navigation.

2. From the Job Register, select the job that you want to copy resources.

3. Select the Estimate tab.

4. Under the Resources section, select Resource Rates. The Resource Rate Register opens.

5. Select resources to edit.

l Use CTRL + Click to select many specific individual resources.

l Use CTRL + SHIFT + Click to select multiple resources above or below your first selection.

6. In the Ribbon, select the Actions tab.

7. Under the Edits section, select Open.
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8. Many of the fields show with the title VARIES. This is caused by different values
being present in the same fields.

9. You can edit your chosen resources to be associated with a specific quote group if that option is
available in the record. You can update records in bulk for other fields within the InEight
Estimate resources. To updated the quote group, select the Setup tab in the record.

10. Select the Quote Group Tag drop down. Then select the specific Quote Group Tag to associate to
your chosen resources.
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11. Once done, click OK. Your chosen resources are now associated to the specified quote group.
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15.14 IMPORTING RESOURCES

The following procedures inform you how to setup resources in InEight Estimate from an excel sheet.

Use of this lesson will draw from other sections of InEight Estimating Manual. Basic
understanding of the Sort, Group, Filter, Excel integration functionality in InEight Estimate
is required.

15.14.1 Open Resource Rate Register

You can create resources within the Resource Rate Register. This is the location to build out the
structure of those resources.

Step by Step — Opening the Labor tab

1. Open the Job Folder or Library that you’re going to be working in.

2. From the Ribbon, select the Setup tab.

3. Under the Resources section, select Resource Rates. The Resource Rate Register opens.

4. Select the tab you want to add resources to.
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The layout of this register and excel file is up to the organization and the decisions that are made
during the detail design phase. A basic excel file will be provided to your organization as a starting
point to work from. If that can’t be located, you can easily build one utilizing the views within InEight
Estimate.

15.14.1.1 Creating A Labor Saved View - Resource Rate Register

You can create a view to mirror both the register and excel sheets to easily bring information back and
forth from the two applications.

Example of columns:

l User Defined 1

l Resource Code

l Description

l Resource File Description - Validated field

l Geographic Area - Validated field

l Wage Zone - Validated field

l Organizational Category - Validated field

l Tag 1 - Validated field

l Tag 2 - Validated field

l Currency - Validated field
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l Default Quantity

l Use Base Wage Factors - Scale Factors

l Scale Factor 2 - Scale Factors

l Scale Factor 3 - Scale Factors

For more information on Validated Tags field, see Validated Tags topic. Scale Factors
aren’t required if you are manually applying rates to each cost category scale.

The view should appear as shown below with User Defined 1 in the first column. This field is used for
sorting and arranging data accurately moving between Estimate and Excel. You are not limited to UDF
1 and can choose to utilize a field of their choice for sorting.

15.14.2 Setting up the excel file

Go to the Excel sheet and make sure the information in the columns shown in the screenshot are filled
out. Basic concepts to keep in mind regarding the excel file:

Sort Code - This column needs to have a high sequential number such as 10000. This is very important
to assign as it will help us authenticate all the labor rates.

Resource Code - A unique Naming convention to be assigned to every labor resource. In this example
we have all labor resource starting with a L followed by the letters that represent the resource
description.

Labor Base - The base wage of the labor resource is entered here. Estimate does not allow $ sign to be
pasted, which is why the cells for the Base column are formatted to Number.
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15.14.2.2 Creating the resource

Follow this procedure once you have information filled out in excel.

Step by Step — Creating the Resource

1. Open the excel file.

2. Sort the sheet by sequential number in the Sort Code field.

3. Highlight the cells you want to bring into the estimate.

4. Copy the cells using right click and selecting Copy from the context menu.

5. Open Estimate to the Resource Rate Register.

6. Select the User Defined 1 column in the Labor tab of the Resource Rate Register.

InEight Inc.  |  Release 19.2 Page 643 of 962

Estimate User Guide 15.14 Importing Resources



7. Right click the empty cell and select Paste from the context menu. A pop up will appear asking
Are you sure you want to insert the selected values?

8. Select Yes to confirm inserting the selected values.

9. The cells you copied from the excel sheet are now copied into the Resource Rate Register. The
Sort code data is pasted in the User defined 1 column. Resource Code & Resource description
data is pasted as well.

Page 644 of 962 InEight Inc.  |  Release 19.2

15.14 Importing Resources Estimate User Guide



10. For Make sure the sorting is on User Defined 1 column. This allows us to see the
information being sorted similar to our data in excel file. Base Wage Factors need
to be flagged to turn on with the check box. Your first copy and paste should have
activated them. You need to copy and paste again in order to apply the factors.

15.14.2.3 Resource Cost Details

Labor resources are now in the system a user can apply rates to those resources.

Step by Step — Resource Cost Detail

1. From the Ribbon, select the Actions tab.

2. Under the View section, select the Resource Cost Details option. The Resource Cost Details
Register opens.

3. Create a view to mirror the accompanying excel sheet or create one to bring in the
associated resource cost in the details register.

4. From the Saved views drop down, select the Labor view to filter down to only labor resources.
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5. Right click a column header and select Column Chooser.

6. Drag and drop the columns into the view identified below.

Example of columns – The level of detail and utilization of specific cost categories is a decision for each
organization:

l User Defined 1 - Non editable fields from resource rates register

l Resource Code - Non editable fields from resource rates register

l Description - Non editable fields from resource rates register

l Resource File Description - Non editable fields from resource rates register

l Geographic Area - Non editable fields from resource rates register

l Wage Zone - Non editable fields from resource rates register

l Organizational Category - Non editable fields from resource rates register

l Scale - Non editable fields from resource rates register

l Labor Base

l Travel

l Premium

l Holiday

l Savings

l Pension

l Vacation

l Subsistence
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l Health & Welfare

l Apprenticeship

l Undefined Fringe 1

l Undefined Fringe 2

l Undefined Labor Fringes

l Bodily Injury & Property Damage

l Workers Compensation

l Undefined Insurance1

l Undefined Insurance2

l Undefined Labor Insurance

l FICA

l FUTA

l SUTA

l Undefined Tax1

l Undefined Labor Taxes

l Undefined Labor Burden

l Undefined Labor

l Construction Supplies

l Undefined Materials

l Undefined

l Billing Rate

l Billing Rate Markup

l Billing Rate Markup %

15.14.3 Filter/Sort/Paste - Resource Cost Details Register

The Labor upload view brings in the columns required to enter Labor base, burdens etc. Every Labor
resource has three rows created with Scales 1,2,3. The Scale Column is used to setup Straight time,
Over time, Double time.
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Step by Step — Filter Resource Cost Detail Register

1. From the Scale column header, click the filter icon..

2. Set the From and To values to 1.

3. Back on the excel spreadsheet, highlight the base rates to bring in.

4. Right click and select Copy in the context menu.
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5. Go to Estimate. Right click and select Paste from the context menu.

6. You will be prompted with a Are you sure you want to insert these values?message as before.
Select Yes to continue.

15.14.4 Manual Set-Up of Scales 2 & 3 – Optional

If the organization wants to have more in-depth cost details for each scale rather than using scale
factors the same procedure will be utilized to copy Labor burden, fringes, and other add-ons to setup
Scale 2 & Scale 3.

For Base Wage Factor Columns will not be active if your organization is using method 2.
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15.14.4.4 Resource Rate Register

15.14.4.5 Resource Cost Details Register

Step by Step — Manual Setup of Scales

1. From the Scale column header, click the filter icon..

2. Set the From and To values to 2.

Page 650 of 962 InEight Inc.  |  Release 19.2

15.14 Importing Resources Estimate User Guide



3. Back on the excel spreadsheet, highlight the base rates to bring in.

4. Right click and select Copy in the context menu.

5. Go to Estimate. Right click and select Paste from the context menu.

6. You will be prompted with a Are you sure you want to insert these values?message as before.
Select Yes to continue.

7. Follow the same procedure for scale 3.

15.14.4.6 Non Labor Resource Setup

The same principles can be applied for the other resource types within InEight Estimate. This
procedure covers installed material, but can also be used for the other six resource types.

15.14.5 Creating A Materials Saved View - Resource Rate Register

Create a view to mirror both the register and excel sheets to easily bring information back and forth
from the two applications.

Example of columns
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l User Defined 1

l Resource Code

l Description

l Resource File Description - Validated Tag field

l Geographic Area - Validated Tag field

l Wage Zone - Validated Tag field

l Organizational Category - Validated Tag field

l Tag 1 - Validated Tag field

l Tag 2 - Validated Tag field

l Currency - Validated Tag field

l Apply Standard Tax - Validated Tag field

l Unique Sales Tax

l Unit of Measure - Validated Tag field

15.14.6 Creating A Material Resource

Follow the step by step once you have information filled out in excel.

Step by Step — Creating the Resource

1. Open the excel file.

2. Sort the sheet by sequential number in the Sort Code field.

3. Highlight the cells you want to bring into the estimate.

4. Copy the cells using right click and selecting Copy from the context menu.
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5. Open Estimate to the Resource Rate Register.

6. Select the User Defined 1 column in the Installed Material tab of the Resource Rate Register.

7. Right click the empty cell and select Paste from the context menu. A pop up will appear asking
Are you sure you want to insert the selected values?
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8. You will be prompted with a Are you sure you want to insert these values?message. Click Yes
to continue.

15.14.7 Create A Material Saved View - Resource Cost Details Register

Installed Material Resources are now in the system. You can apply rates to those resources. Create a
view to mirror the accompanying excel sheet or create one to bring in the associated resource cost in
the details register.

Step by Step — Material Saved View

1. From the Ribbon, select the Actions tab.

2. Under the View section, select the Resource Cost Details option. The Resource Cost Details
Register opens.

3. Create a view to mirror the accompanying excel sheet or create one to bring in the
associated resource cost in the details register.

4. From the Saved views drop down, select the Installed material view to filter down to only
material resources.

5. Right click a column header and select Column Chooser.

6. Drag and drop the columns into the view identified below.
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Example of columns – The level of detail and utilization of specific cost categories is a decision for each
organization:

l User Defined 1 - Non editable fields from resource rates register

l Resource Code - Non editable fields from resource rates register

l Description - Non editable fields from resource rates register

l Resource File Description - Non editable fields from resource rates register

l Geographic Area - Non editable fields from resource rates register

l Wage Zone - Non editable fields from resource rates register

l Organizational Category - Non editable fields from resource rates register

l Unit of Measure - Non editable fields from resource rates register

l Currency - Non editable fields from resource rates register

l Total - Non editable fields from resource rates register

l Installed Materials

l Undefined Materials

l Sales Taxes

l Undefined Fees

l Undefined

l Billing Rate

l Billing Rate Markup

l Billing Rate Markup %

15.15 QUANTITY CHECKING

The Quantity Checking feature allows you to compare the quantity of a superior cost item to the sum
of its relevant subordinate cost item quantities. This setting enables the use of the Quantity Check and
Quantity Warning columns in the Cost Breakdown Structure. The use of these columns can assist in
confirming whether or not your quantities are correct.

The subordinate cost item quantities need to have the same unit of measure as the
superior cost item before you are able to choose the Quantity Check column.

In the example below, break a concrete pour cost item into four subordinate parts. The Forecast (T/O)
Quantity of the superior item will be 156875.00 tons of concrete. Start by dividing each of the four
parts into 35000.00 tons each. Once you have broken out this concrete pour, determine if you need a
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fifth pour or if you should distribute the remaining quantity to the four pours. The factors you keep in
mind are the trips and time involved in the extra pour vs capacity of equipment.

Step by Step — Quantity Checking

1. From the Ribbon, select the Setup tab.

2. Under the section Initialize, select Job Properties. Then select the Cost Basis tab.

Quantity checking starts by turning the feature on in the Job Properties. If you want
to have quantity checking turned on for all jobs in Estimate, then this setting needs
to be turned on in theMaster Job Properties. The Master Job Properties is located
in the Library.

3. From the Rules data box, select the Activate Quantity Checking check box.

4. Next bring a couple of columns into your view on the Cost Breakdown Structure (CBS) Register.
Right click on the column header and choose Go To Column.

5. The Go To Column dialog box appears. Have the Include columns that are not currently in the
view check box selected.
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6. Click OK when you have selected your preferred columns.

Next, toggle the check box for the Quantity Check column.

7. As you check Quantity Check for the four batches of Concrete, the superior cost
item Quantity Warning turns yellow. This is indicating a quantity warning. Hover
your mouse over the superior cost item Quantity Warning column. Then, an
overlay message appears showing the quantity discrepancy. Apply this discrepancy
to the Subordinate cost items. That way, the superior cost item with be the sum of
the parts.

8. The remaining quantity is 16875.00 tons which does not warrant a fifth pour.

15.16 COST ESCALATION OVERVIEW

Escalation is the provision in a cost estimate for increases in the cost of labor, equipment, material due
to continuing price changes over time. Escalation is used to estimate the future cost of a project or to
bring historical costs to the present. Most cost estimating is done in current dollars and then escalated
to the time when the project will be accomplished. A good example could be the employment of union
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labor over the duration of broader time scope. Often union labor will increase from one year to the
next. Another could be weather changes, from summer to winter conditions.

Cost Escalation is based on a schedule and can be applied to any direct cost category by date range.
Date range escalation is calculated based on each cost item's scheduled earliest start and finish dates.
In this way, escalation changes when the job schedule changes, which means that if you change the
schedule at any time and shift any escalated cost items and their costs from one date range to another,
the value of escalation and the effective rate changes.

As a user, you have complete control over the subject cost that you would like Direct Cost Escalation to
be calculated. In essence, you can override the default settings and choose any of the cost items on the
CBS, or define a rule (filter) that uses all cost items matching that rule as your subject cost. For
example, you can specify that the subject cost used in the calculation of Direct Cost Escalation will be
all cost items in the CBS that are assigned to a pay item and whose unit of measure is cubic yards. Hand
picking cost items or defining rules on which subject cost are defined is done on the Dependency tab of
the Direct Cost Escalation Record.

The escalation layers represent, in the Price Breakdown Structure (PBS), cost changes that accrue over
time across a cost category, based upon when the costs are scheduled to occur using the Schedule
module. For example, it represents forecast wage increases that occur midway through construction,
or the cost of installed material price inflation in the economy.

You can escalate a job's direct cost two ways:

1. Specify a fixed amount to any one or all of the cost categories.

Page 658 of 962 InEight Inc.  |  Release 19.2

15.16 Cost Escalation Overview Estimate User Guide



2. Specify a fixed rate to any one or all of the cost categories.
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When you specify a fixed rate, the amount varies with the cost total that it is applied. When you
specify a fixed amount, the amount remains the same and the rate changes as cost totals change. The
last input you make designates which method you prefer. For example, if you last input a figure in the
rate field of a cost category, then it is understood that the rate is to be fixed. The specified method is
indicated on the form with an arrow symbol.

To open a Direct Cost Escalation Record, follow the step by step below.

Step by Step — Direct Cost Escalation Record

1. From the Ribbon, select the Estimate tab.

2. Under the Breakdown Structures section, select Cost Breakdown Structure (CBS).

3. Double-click the Direct Cost Add-On row. The Dependent Cost Item Record opens.

4. Under Saved Views, select the Date Range View.

5. Setup the escalation by giving the description a time period name (Quarters for this example).
Use the FromDate and ToDate field for each escalation period.

15.17 COST ESCALATION OVERVIEW

Escalation is the provision in a cost estimate for increases in the cost of labor, equipment, material due
to continuing price changes over time. Escalation is used to estimate the future cost of a project or to
bring historical costs to the present. Most cost estimating is done in current dollars and then escalated
to the time when the project will be accomplished. A good example could be the employment of union

Page 660 of 962 InEight Inc.  |  Release 19.2

15.17 Cost Escalation Overview Estimate User Guide



labor over the duration of broader time scope. Often union labor will increase from one year to the
next. Another could be weather changes, from summer to winter conditions.

Cost Escalation is based on a schedule and can be applied to any direct cost category by date range.
Date range escalation is calculated based on each cost item's scheduled earliest start and finish dates.
In this way, escalation changes when the job schedule changes, which means that if you change the
schedule at any time and shift any escalated cost items and their costs from one date range to another,
the value of escalation and the effective rate changes.

As a user, you have complete control over the subject cost that you would like Direct Cost Escalation to
be calculated. In essence, you can override the default settings and choose any of the cost items on the
CBS, or define a rule (filter) that uses all cost items matching that rule as your subject cost. For
example, you can specify that the subject cost used in the calculation of Direct Cost Escalation will be
all cost items in the CBS that are assigned to a pay item and whose unit of measure is cubic yards. Hand
picking cost items or defining rules on which subject cost are defined is done on the Dependency tab of
the Direct Cost Escalation Record.

The escalation layers represent, in the Price Breakdown Structure (PBS), cost changes that accrue over
time across a cost category, based upon when the costs are scheduled to occur using the Schedule
module. For example, it represents forecast wage increases that occur midway through construction,
or the cost of installed material price inflation in the economy.

You can escalate a job's direct cost two ways:

1. Specify a fixed amount to any one or all of the cost categories.
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2. Specify a fixed rate to any one or all of the cost categories.
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When you specify a fixed rate, the amount varies with the cost total that it is applied. When you
specify a fixed amount, the amount remains the same and the rate changes as cost totals change. The
last input you make designates which method you prefer. For example, if you last input a figure in the
rate field of a cost category, then it is understood that the rate is to be fixed. The specified method is
indicated on the form with an arrow symbol.

To open a Direct Cost Escalation Record, follow the step by step below.

Step by Step — Direct Cost Escalation Record

1. From the Ribbon, select the Estimate tab.

2. Under the Breakdown Structures section, select Cost Breakdown Structure (CBS).

3. Double-click the Direct Cost Add-On row. The Dependent Cost Item Record opens.

4. Under Saved Views, select the Date Range View.

5. Setup the escalation by giving the description a time period name (Quarters for this example).
Use the FromDate and ToDate field for each escalation period.

15.18 DEPENDENT COST ITEMS

Like the default dependent cost items you can add your own.

If you need to use additional dependent cost items, you can create your own, but you
must delete all the existing default dependent cost items first.
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The following steps walk you through deleting your existing default indirect costs so you can create
your own.

Step by Step — Deleting Existing Default Indirect Costs

1. From the Ribbon, select the Estimate tab.

2. Under the Breakdown Structure section, select Cost Breakdown Structure (CBS).

3. Select the Prime Bond indirect cost item by clicking on its row header.

4. Then press and hold the Shift key while selecting the Job Financing indirect cost item. All your
dependent indirect cost items are now selected.

5. Right click on the selection and select Delete.

6. Select Yes to confirm you want to delete the selected Cost Items. Your indirect cost items are
now deleted.

You can also control which default dependent cost items are copied into new jobs from scratch. You do
this in the Library from the Master CBS.

The following steps walk you through toggling the inclusion of default dependent cost items in new
jobs from scratch.
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Step by Step — Toggling Default Dependent Cost Items

1. From the Ribbon, select the File tab.

2. Select Library from the left pane navigation.

3. From the Library's Ribbon, select the Estimate tab.

4. Under the Master Breakdown Structures section, select Cost Breakdown Structure (CBS).

5. Use Column Chooser or Go To Column to bring the Auto-Include column into your view.

6. A check mark in the Auto-Include column indicates that those cost items in the Master CBS will
be included in new jobs from scratch.

15.18.1 Define a Contingency Add-On based on Man Hours

The following steps walk you through adding ad defining contigency based on man hours for the job.
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Step by Step — Define a Contingency Add-On

1. From the Ribbon, select the Estimate tab.

2. Under the Master Breakdown Structures section, select Cost Breakdown Structure (CBS).

3. From the Cost Breakdown Structure (CBS) Register, right click on the row header for any cost
item and select Insert Dependent Cost Item.

4. On the resulting Attention prompt, select Based on CBS Man Hours.

5. Once you are done with the Attention dialog box, Click OK.

6. Double click on the CBS Man Hour Add-On description to highlight the description title.

Page 666 of 962 InEight Inc.  |  Release 19.2

15.18 Dependent Cost Items Estimate User Guide



7. You can customize the visibility by changing the description to Contingency.

8. Double click on the newly named Contingency row header to open the CBS Man Hour Add-On
Record.

9. From the Description tab, add a description to the Man Hour Add-On Detail.
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10. The description allows the total Man-Hours for the job to display.

11. From the record, select the Dependency tab to see what contributes to your subject to cost.

You can also refine how you build your contingency. It can be based on costs where man hours is
over 10 hours. You can do this by setting a filter on the Hours (Duration driven) column and
choosing Define Subject Cost using column filtering.

11. Define the Contingency Add-On by designating Add-On Cost/Man-Hour column.
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15.18.2 Defining a Price % Add-On

The following steps walk you through adding and defining Price % Add-On for the job.

Step by Step — Defining Price Add-On

1. From the Cost Breakdown Structure (CBS) Register, right click on the row header for any cost
item and select Insert Dependent Cost Item.

2. On the resulting Attention prompt, select Based on Job’s Price.
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3. Once you are done with the Attention prompt, click OK.

4. Double click on the Price % Add On row header to open the record.

5. The Price % Add-on Record opens to the Description tab. Type Office Overhead in the
Description field and type a rate of 4.

l Office Overhead is now defined with a rate of 4% of the job’s price.
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6. Once done, click OK to close the record.

15.18.3 Defining a Direct Cost Add-On

The following steps walk you through creating a Direct Cost Add-On dependent cost item.

Step by Step — Define a Direct Cost Add-On

1. From the Ribbon, select the Estimate tab.

2. Under the Master Breakdown Structures section, select Cost Breakdown Structure (CBS).

3. From the Cost Breakdown Structure (CBS) Register, right click on the row header for any cost
item and select Insert Dependent Cost Item.

4. On the resulting Attention prompt, select Based on Direct Costs.

5. Once you are done with the Attention dialog box, Click OK.

6. Double click on the Direct Cost Add-On row header to open the record.

7. On the Description tab, type Small Tools in the blank row under the Description column.
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8. You can define additional rows for other add-on costs as needed.

l The Dependency Cost Breakdown appears on the right.

l The Subject Cost is the cost that the cost item depends on, based on what is defined on
the cost item’s Dependency tab.
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9. Click on the Dependency tab to see what contributes to your subject cost.
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l There are a couple of options at the bottom to control how dependency items are
selected. By default, the bottom radio button is selected.

l The bottom radio button allows you to use column filtering to control what items
are included.

l The top button allows you to manually select the cost items you would like to
include.

10. For this activity, leave the default (lower) button selected.
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11. Select the Description tab. You can define an add-on Rate (percentage) or Cost at any of the cost
category levels in the Dependency Cost Breakdown on the right side of the record.

l You can also add a rate at the Total level to have it apply to all your cost categories.

12. Type 10 in the Rate field at the Labor cost category level, then press Tab.

13. Once you are done, click OK to close the record.

15.19 SPLIT COST ITEMS

You have miles of trench work that you need to break up into phases. You have already defined this
trench cost item and entered the details defining the total cost to perform the work. You can split this
cost item into 4 phases of work by using the Split feature.
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The Split feature changes your Cost Breakdown Structure. Before performing these steps,
be sure you have the correct cost item selected for splitting and whether or not the
change is needed.

Step by Step — Split Cost Items

1. From the CBS Register, select the cost item you want to split.

2. From the Ribbon, select the Actions tab.

3. Under the Edit section, select the option.

4. When the Split Cost Item data box appears, enter in the number of parts that you want to split
the selected cost item into.

5. Select OK to copy the previously selected cost item into 4 subordinate cost items with the same
description.
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If there are subordinate cost items in the split cost item, those subordinate cost
items are then copied into each of the 4 new cost items. The cost item Total
Forecast (T/O) Quantity is divided into 4 even quantities. This subsequently divides
the cost into 4 even amounts. Add the incremental Phase title to the description of
the 4 new subordinate Cost Items to identify them later.

15.20 SWAP RESOURCES

Any resource assembly on the Cost Breakdown Structure (CBS) Register or the Master Cost Breakdown
Structure (CBS) Register can be swapped for any other resource. In practice, this feature is useful for
making universal adjustments to the cost details. For example, you can swap a Laborer Class 1 for an
Operator Class 1 or Corrugated Metal Pipe for Reinforced Concrete Pipe.

You have a great deal of control over the instances (cost items) in which you want to swap one
resource for another. You can:

l Swap all instances of one resource for another on all cost items where that resource is
employed, whether or not the resource employment is designated as unique.
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l Swap one resource for another on all cost items where that resource is not designated as a
unique resource employment.

l Swap instances of one resource for another on a select set of cost items where that resource is
employed, whether or not the resource employment is designated as unique.

l Swap one resource for another on a select set of cost items where that resource is not
designated as a unique resource employment.

In the original estimate, you had employed Dozer D8 for all of the Excavation work. A month after first
draft of the estimate, you want to replace all of your employed Dozer D8 resources with the less
expensive Dozer D6. To make this resource swap in InEight Estimate, you need to use the Resource
Swap tool.

Making changes in the Cost Breakdown Structure (CBS) Register can cause unexpected
results. It is good practice to perform an Archive of the Job or confirming the changes
being committed prior to swapping resources.

Step by Step — Swapping Resources

1. From the Ribbon, select the Actions tab.

2. Under the View section, select the Filter drop down. Then select the Filter by Resource option.
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3. When the Filter by Resource window opens, select the Dozer D8 Resource Code.

InEight Inc.  |  Release 19.2 Page 679 of 962

Estimate User Guide 15.20 Swap Resources



4. Once you have this filter applied, you can see all cost items that have the Dozer D8 employed.
From the CBS Register, select theMore Actions tab.

5. From the Batch Operations section, select the Swap drop down. Then select Swap Resource.
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6. From the Swap Resource window, select the icon in the Currently employed resource section.
Then choose the Dozer D8 resource code.

InEight Inc.  |  Release 19.2 Page 681 of 962

Estimate User Guide 15.20 Swap Resources



7. Next Choose the Dozer D6 resource code for the New resource to replace currently employed
entry.

8. The radio buttons in the Swap Resource window determines if you want to replace unique
resources or not. For this example, select Replace only resources that are NOT unique.

Unique is referring to resources that have defaults overridden from what was
originally designated in the Resource Rate Register. If you choose Replace only
resources that are NOT unique, then the unique Dozers D8 resource in the cost
structure will not be replaced. If you choose Replace ALL resources (including
unique resources), then all of the Dozers D8 resources are replaced.

9. In the next step, choose which cost items to perform the swap of Dozer D8 for Dozer D6.
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10. For this example, choose all three cost items which have the Dozer D8 employed.

11. Click OK to continue.

Because it can be difficult to revert any changes in the CBS Register you are
prompted one more time as a review of the Cost Items which will be affected by
the swap.
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12. Select OK to continue. The CBS Register can appear blank. Remember that you have the filter
applied to only show Cost Items that have the Dozer D8 employed. Remove the filter.

13. The Dozer D6 now shows in place of the D8 Dozer.
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15.20.1 Employment Details in Swapped Resources

When swapping resources, you have the option to select the Use Default Employment Resources check
box. When selected, this check box updates the employment setup values with the defaults from the
new resource. This feature lets you use the default employment set up while swapping the resources.
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15.20.2 CBS Hierarchy View for Resource/Resource Assembly Swap

Toggle Hierarchy is added to the Swap Resource and Swap Resource Assembly selection registers.
When selected, it allows you to view the superior cost items of your selections in the context of the
CBS Register Hierarchy. This enhancement makes it easier for you to determine when the cost items
you intended to select are the correct cost items.

15.21 COST ALLOCATION

The Cost Item Record - Allocation tab lets you to spread costs from a single Cost Item Record to one or
more other cost items in the Cost Breakdown Structure (CBS) Register.

l Allocation Item - The cost item to be allocated, where you define the quantities, resource
employments and the logic that determines how to allocate the item throughout the bid.
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l Allocation Target - A cost item to be the recipient of allocated cost, as defined within the
Allocation Item. There may be one or many Allocation Targets for one Allocation Item.

l Distribution - A read-only cost item in the CBS representing an Allocation Target's proportional
share of the Allocation Item.

You can choose from several methods to determine specifically where and how much cost to spread:

l Quantity - Specify the amount of the Allocation Item to be spread to each Allocation Target.

l Proportionately based on another field - Allocate proportionately by one of many available cost
item values, usually based on time or cost.

l Percentage - Specify the percentage of the Allocation Item to spread to each Allocation Target.

l Unit Cost - Use the unit cost from the Allocation Item and the quantity of each Allocation Target
to drive the Forecast (T/O) Quantity of the Allocation Item.

Cost Item Allocation is a good means of spreading costs throughout a bid for the purpose of
determining appropriate bid prices. You can then compare unit price in Quote Comparison & Award.

Only Level 1 cost items can be allocated, including Add-On and Escalation dependent cost
items. A subordinate cost item cannot be allocated, and a cost item that is assigned to a
pay item cannot be allocated.

15.21.1 Cost Allocation

With Cost Item Allocation, you can track the cost of one broad cost item by distributing the cost of that
item to other cost items, so that the cost can be tracked on a more detailed level. This gives better
visibility into the cost that makes up an item. For example, you can spread ST&S from one cost item to
multiple cost items that will use ST&S.

Imagine that a large portion of your scope of work for the job you are bidding has concrete. You face
the options of batching your own raw materials or purchasing the materials from a supplier. You can
use cost allocation to create the cost of a batch plant and allocate it to different items, and then
compare this unit cost to the unit cost of purchasing the materials from a supplier.

The Allocation tab allows you to spread costs from an Allocation Item to one or more Allocation Target
(s).

In the Allocation Target list, the [Unit of Measure] Quantity column caption displays the
Unit of Measure of the Allocation Item. For instance, if the Allocation Item's Unit of
Measure is Cubic Yards (CY), then the caption displayed for this column is CY Quantity.

A Distribution cost item is created as a read-only subordinate cost item under each Allocation Target. It
is copied proportionally with the quantity/cost defined to each different item in CBS.
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15.21.2 View Filter Excludes Cost Item Allocation Details

A View Filter option is added to show only the level 1 cost item distribution in the allocation
destinations to provide you with a clear and comprehensive view of the CBS register, especially when
there are many allocations. When you are allocating cost items, the allocations are created in the
destination cost item by creating a copy of the entire allocated cost items structure. This filter allows
you to simplify the view by displaying only the parent level allocation cost item.
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Step by Step — Cost Allocation

1. From the Ribbon, select the Estimate tab.

2. Under the Breakdown Structures section, select Cost Breakdown Structure (CBS). The Cost
Breakdown Structure Register opens.

3. Select the Concrete Batch Plant cost item.

4. From the Ribbon, select the Actions tab. Under the Edit section, select Open. The Cost Item
Record opens.

5. Select the Allocation tab.

6. Check the box for Allocate this Item’s Cost. Keep the By Quantity option selected.

7. Check the Include box for the cost item Box Culvert Footing to allocate cost to it.
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Take note of the Allocation Percentage and Total Cost to be Allocated columns.
This shows the percent of the total allocation qty allocated to that cost item and
the total cost to be allocated to that item (notice that is the total cost of the
Concrete Batch Plant).

8. The Box Culvert Footing item just gained all of the Concrete Batch Plant’s distribution cost items
(highlighted in purple). Navigate back to the CBS Register.
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9. Find the Box Culvert Footing cost item. The distribution cost items are added as its subordinates.

10. In the Cost Item Record, check the Include box for the cost items, Box Culvert Walls and Box
Culvert Deck.

11. In the Account Code column, click on the Filter icon. Filter to account code 13 for all of the
concrete items. Once done, click OK.
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12. Select the Erect and Strip Deck code, hold <Shift>, and select the Footer code to muli-select all
of the codes in between. Then, tight click and select Toggle Included.

13. Check the Include box in the Include column for the cost item Column, round. The CY Quantity is
now highlighted yellow. This is because this cost item’s UoM is Each and not CY.

14. Right click on the Account Code column, and select Clear Filter from the context menu.

15. Under the cost item Column, round, the subordinate cost item Place Column Concrete has a
UoM of CY. Manually enter that cost item’s Forecast (T/O) Quantity into the Column, round’s CY
Quantity field.

16. Select the Account Code filter and reselect the option 13.

17. In the Include column, check the Include box for all of the remaining cost items with this filter.
Then, remove the Account Code filter.
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18. Fix the CY quantity for the other Column, round cost item.

19. Fix the CY quantity for the Drilled Shaft Foundation (60”) cost item.
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20. 20. Fix the CY quantity for the Drilled Shaft Foundation (72”) cost item.

21. Notice in the Allocation Details section, that we have over-allocated this cost item. The Concrete
Batch Plant quantity is 1,000 CY, whereas we have allocated 1,172.59 CY.
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15.21.3 Cost Allocation to By Unit Cost

Having an under allocation or over allocation is ok, but it can be fixed by updating the Forecast (T/O)
Quantity of the Concrete Batch Plant. To do this, change the cost allocation to by Unit Cost.

Step by Step — Cost Allocation by Unit Cost

1. Change the cost allocation to by Unit Cost. When the Attention dialog box appears, click Yes to
continue.

2. Now the Allocation Details warning states the quantities are fully allocated.
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3. Notice also that the Forecast (T/O) Quantity of the Concrete Batch Plant has updated to
1,172.59 CY to match the allocated quantity, and the Total Cost has updated to $96,030.20 to
keep the unit cost at the original $81.90/CY.

4. Return to the CBS Register. The distributed cost items all have a unit cost of $81.90.
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5. The original “Concrete Batch Plant” cost item has a total cost of $96,030.20.

6. Navigate to the CBS Register. Double click the Project Indirect Costs cost item to open it.

7. Select the Allocation tab. Check the box for Allocate this Item’s Cost.
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8. Select the proportionately based on radio button. From the drop down, select Shifts (Total).

9. Filter the Account Code column to 13. Once done, click OK.
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10. Select all of the cost items. Then, right click on the selected cost items and select Toggle
included. Ensure that all of the Included boxes are checked.

11. On the CBS Register, verify that all of the items have cost items distributed proportionately by
shifts.
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15.22 COST ALLOCATION

The Cost Item Record - Allocation tab lets you to spread costs from a single Cost Item Record to one or
more other cost items in the Cost Breakdown Structure (CBS) Register.

l Allocation Item - The cost item to be allocated, where you define the quantities, resource
employments and the logic that determines how to allocate the item throughout the bid.

l Allocation Target - A cost item to be the recipient of allocated cost, as defined within the
Allocation Item. There may be one or many Allocation Targets for one Allocation Item.
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l Distribution - A read-only cost item in the CBS representing an Allocation Target's proportional
share of the Allocation Item.

You can choose from several methods to determine specifically where and how much cost to spread:

l Quantity - Specify the amount of the Allocation Item to be spread to each Allocation Target.

l Proportionately based on another field - Allocate proportionately by one of many available cost
item values, usually based on time or cost.

l Percentage - Specify the percentage of the Allocation Item to spread to each Allocation Target.

l Unit Cost - Use the unit cost from the Allocation Item and the quantity of each Allocation Target
to drive the Forecast (T/O) Quantity of the Allocation Item.

Cost Item Allocation is a good means of spreading costs throughout a bid for the purpose of
determining appropriate bid prices. You can then compare unit price in Quote Comparison & Award.

Only Level 1 cost items can be allocated, including Add-On and Escalation dependent cost
items. A subordinate cost item cannot be allocated, and a cost item that is assigned to a
pay item cannot be allocated.

15.22.1 Cost Allocation

With Cost Item Allocation, you can track the cost of one broad cost item by distributing the cost of that
item to other cost items, so that the cost can be tracked on a more detailed level. This gives better
visibility into the cost that makes up an item. For example, you can spread ST&S from one cost item to
multiple cost items that will use ST&S.

Imagine that a large portion of your scope of work for the job you are bidding has concrete. You face
the options of batching your own raw materials or purchasing the materials from a supplier. You can
use cost allocation to create the cost of a batch plant and allocate it to different items, and then
compare this unit cost to the unit cost of purchasing the materials from a supplier.

The Allocation tab allows you to spread costs from an Allocation Item to one or more Allocation Target
(s).

In the Allocation Target list, the [Unit of Measure] Quantity column caption displays the
Unit of Measure of the Allocation Item. For instance, if the Allocation Item's Unit of
Measure is Cubic Yards (CY), then the caption displayed for this column is CY Quantity.

A Distribution cost item is created as a read-only subordinate cost item under each Allocation Target. It
is copied proportionally with the quantity/cost defined to each different item in CBS.

InEight Inc.  |  Release 19.2 Page 703 of 962

Estimate User Guide 15.22 Cost Allocation



15.22.2 View Filter Excludes Cost Item Allocation Details

A View Filter option is added to show only the level 1 cost item distribution in the allocation
destinations to provide you with a clear and comprehensive view of the CBS register, especially when
there are many allocations. When you are allocating cost items, the allocations are created in the
destination cost item by creating a copy of the entire allocated cost items structure. This filter allows
you to simplify the view by displaying only the parent level allocation cost item.
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Step by Step — Cost Allocation

1. From the Ribbon, select the Estimate tab.

2. Under the Breakdown Structures section, select Cost Breakdown Structure (CBS). The Cost
Breakdown Structure Register opens.

3. Select the Concrete Batch Plant cost item.

4. From the Ribbon, select the Actions tab. Under the Edit section, select Open. The Cost Item
Record opens.

5. Select the Allocation tab.

6. Check the box for Allocate this Item’s Cost. Keep the By Quantity option selected.

7. Check the Include box for the cost item Box Culvert Footing to allocate cost to it.
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Take note of the Allocation Percentage and Total Cost to be Allocated columns.
This shows the percent of the total allocation qty allocated to that cost item and
the total cost to be allocated to that item (notice that is the total cost of the
Concrete Batch Plant).

8. The Box Culvert Footing item just gained all of the Concrete Batch Plant’s distribution cost items
(highlighted in purple). Navigate back to the CBS Register.
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9. Find the Box Culvert Footing cost item. The distribution cost items are added as its subordinates.

10. In the Cost Item Record, check the Include box for the cost items, Box Culvert Walls and Box
Culvert Deck.

11. In the Account Code column, click on the Filter icon. Filter to account code 13 for all of the
concrete items. Once done, click OK.
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12. Select the Erect and Strip Deck code, hold <Shift>, and select the Footer code to muli-select all
of the codes in between. Then, tight click and select Toggle Included.

13. Check the Include box in the Include column for the cost item Column, round. The CY Quantity is
now highlighted yellow. This is because this cost item’s UoM is Each and not CY.

14. Right click on the Account Code column, and select Clear Filter from the context menu.

15. Under the cost item Column, round, the subordinate cost item Place Column Concrete has a
UoM of CY. Manually enter that cost item’s Forecast (T/O) Quantity into the Column, round’s CY
Quantity field.

16. Select the Account Code filter and reselect the option 13.

17. In the Include column, check the Include box for all of the remaining cost items with this filter.
Then, remove the Account Code filter.
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18. Fix the CY quantity for the other Column, round cost item.

19. Fix the CY quantity for the Drilled Shaft Foundation (60”) cost item.
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20. 20. Fix the CY quantity for the Drilled Shaft Foundation (72”) cost item.

21. Notice in the Allocation Details section, that we have over-allocated this cost item. The Concrete
Batch Plant quantity is 1,000 CY, whereas we have allocated 1,172.59 CY.
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15.22.3 Cost Allocation to By Unit Cost

Having an under allocation or over allocation is ok, but it can be fixed by updating the Forecast (T/O)
Quantity of the Concrete Batch Plant. To do this, change the cost allocation to by Unit Cost.

Step by Step — Cost Allocation by Unit Cost

1. Change the cost allocation to by Unit Cost. When the Attention dialog box appears, click Yes to
continue.

2. Now the Allocation Details warning states the quantities are fully allocated.
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3. Notice also that the Forecast (T/O) Quantity of the Concrete Batch Plant has updated to
1,172.59 CY to match the allocated quantity, and the Total Cost has updated to $96,030.20 to
keep the unit cost at the original $81.90/CY.

4. Return to the CBS Register. The distributed cost items all have a unit cost of $81.90.
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5. The original “Concrete Batch Plant” cost item has a total cost of $96,030.20.

6. Navigate to the CBS Register. Double click the Project Indirect Costs cost item to open it.

7. Select the Allocation tab. Check the box for Allocate this Item’s Cost.
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8. Select the proportionately based on radio button. From the drop down, select Shifts (Total).

9. Filter the Account Code column to 13. Once done, click OK.
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10. Select all of the cost items. Then, right click on the selected cost items and select Toggle
included. Ensure that all of the Included boxes are checked.

11. On the CBS Register, verify that all of the items have cost items distributed proportionately by
shifts.
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15.23 DEPENDENT COST ITEM ALLOCATION

Step by Step — Dependent Cost Item Allocation

1. From the CBS Register, right click on the first cost item and select Insert Dependent Cost Item
from the context menu.

2. When the Attention dialog box shows, select Based on Direct Costs. Once done, click OK.
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3. Find your new cost item. Then double click to open the cost item record.

4. In the CBS Position Code Description, enter the description Small Tools & Supplies.

5. Enter in the cost item, “ST&S”.
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6. In the Cost Breakdown default data block, set the labor rate as 5%.

7. In the Cost Item Record, select the Cost Categorization tab.

8. Under the Cost Categorization Method, select the Use Custom Categorization radio button.

9. Find the Supplies Cost Category and check the box next to Supplies.

10. Select the Allocation tab. Then, check the box for Allocate this Item’s Cost.

11. Select the proportionately based on radio button. From the drop down, select Labor Total Cost.
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12. In the Cost Item Record, filter the Account Code column to 13. Once you are done selecting the
filter, click OK.

InEight Inc.  |  Release 19.2 Page 721 of 962

Estimate User Guide 15.23 Dependent Cost Item Allocation



13. In the Cost Item Record, check the Include box in the Include column for every cost item.

14. Return to the CBS Register. The ST&S is distributed to all of the selected cost items.
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15.23.1 Turning Off Cost Allocation

If you determine that you no longer want to spread the cost of an Allocation Item, you can turn off cost
allocation for that cost item. The logic that you created to spread the costs are retained, so you can
easily turn it back on later.
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Distributions cannot exist in the CBS when a job is published for Job Tracking. To remove
Distributions, either break the Cost Allocation link or uncheck the Allocate this Item’s
Cost check box on the Cost Item Record - Allocation tab.

Step by Step — Turning Off Cost Allocation

1. From the CBS Register, select the Concrete Batch Plant Cost Item Record.

2. From the Ribbon, select the Actions tab. Under the Edit section, select Open. The Cost Item
Record opens.

3. Select the Allocation tab. Uncheck the box for Allocate this Item’s Cost.

4. Once done, click OK to return to the CBS Register.

5. All of the distribution cost items are gone, but the quantity and the total cost of the Concrete
Batch Plant has not changed.
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15.23.2 Breaking a Cost Allocation Link

To make a Distribution a permanent part of the CBS, and permit its costs and quantities to be directly
editable under the cost item(s) to which it has been distributed, break the Cost Allocation link.

Step by Step — Breaking a Cost Allocation Link

1. From the CBS Register, select the Project Indirect Costs Cost Item Record.

2. From the Ribbon, select the Actions tab. Under the Edit section, select Open. The Cost Item
Record opens.

3. Select the Allocation tab. Then go to the CBS Register in the record.

4. Select the cost item with a Cost Allocation Link. Then from the Ribbon, select the Actions tab.

5. Under Tools, select Break Cost Allocation Link.

6. When the Attention dialog box shows, click Yes to continue.
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7. The original cost item still exists and is now becomes editable. All the distribution cost items are
now editable as well. They are now permanent items and are no longer highlighted in purple
either.
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15.23.3 Pay Item Assignment for Allocation Distribution in an Unlocked
Job

In the Cost Item Record - Allocation tab, the check box Allocation distributions inherit target Pay
Item Assignment was added. When the check box is selected in an unlocked job, the system uses the
same allocation distribution for the cost item’s costs anytime the cost item is copied and added to a
job. For a locked job, this is the normal system behavior. This option is always selected and cannot be
edited.
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15.24 ALARM LIMITS

The Alarm Limits lets you establish limits to specific pay items to make sure the pricing is within certain
limits, i.e. percentage or unit price. The Alarm Limits do not do any calculations. It informs you if either
of the limit types are outside the range. If outside the limits, the row is then colored red.

For example, when pricing Mobilization, there can be limits as to the amount that can be entered and
how soon to receive payment. In the screen shot below, you can enter up to 10% of the contract price
and receive that amount when 5 or 10% of the work is completed.

Pay Item and Proposal register:
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In this case, the limits are between 8 and 10%. The row is colored red to indicate that the Unit Price is
not within the percentage limits.

The screen shot below is the record view for Mobilization.

The following is an example for Steel Reinforcement as a Unit Price range.
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Based on the screen shots, the Unit Price is not within the $1.00 to $1.50 range. It is $1.60.

The record view is now shown.
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15.25 ALARM LIMITS

The Alarm Limits lets you establish limits to specific pay items to make sure the pricing is within certain
limits, i.e. percentage or unit price. The Alarm Limits do not do any calculations. It informs you if either
of the limit types are outside the range. If outside the limits, the row is then colored red.

For example, when pricing Mobilization, there can be limits as to the amount that can be entered and
how soon to receive payment. In the screen shot below, you can enter up to 10% of the contract price
and receive that amount when 5 or 10% of the work is completed.

Pay Item and Proposal register:

In this case, the limits are between 8 and 10%. The row is colored red to indicate that the Unit Price is
not within the percentage limits.

The screen shot below is the record view for Mobilization.
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The following is an example for Steel Reinforcement as a Unit Price range.

Based on the screen shots, the Unit Price is not within the $1.00 to $1.50 range. It is $1.60.

The record view is now shown.
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15.26 SUBTOTALS

The subtotal feature is for situations where the Owner wanted subtotals on the proposal form of pay
item groups.

The following screen shot is using the supplied Subtotal register view:
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From the Subtotal column, the last item in the subtotal group is where the box is checked. Once the
box is checked, then a description may be entered. After the box is checked, the Subtotal Amount and
Running Subtotal Amounts are then displayed in a bold font.

In our standard Proposal Report, there is an option to printout the subtotals.
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15.26.1 Earnings Rules:

The Earnings Rules let you decide how much can be paid where certain work is completed. The cost
items assigned to the pay items are where you can decide when to ask for payment.

The application is used in the Job Tracking form. The Earnings Rules also determine how the Cash Flow
curve is generated.

In the following screen shot, the record for 36 inch RCP Culvert Class III from the Training Job is open.
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By default, the cost items in the Earnings % column are calculated based on the cost distribution. In
this case where all the Materials are furnished and completed the Excavation, you have earned $49.58
and $12.12 for a total of 61.7% revenue.

There may be times when you can only receive revenue when you have only completed the Backfill of
the Pipe. In that case I can uncheck the Use Default Earnings Rules box, as seen in the previous screen
shot, and enter 100%. You can then decide when to account for the revenue by changing the Earnings
Timing.

The following screen shot show this option.
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Another example is when you can get full payment for material on hand, such as Precast Girders. Then
you can choose the start for the Earnings Timing. This way, the Cash Flow shows costs and revenue
occurring at the start of the item.

15.27 ROUNDING PRECISION

Rounding Precision lets you change the decimal position of the Unit Prices instead of manually entering
the values.

You can preset the Unit Price decimals, then using this feature, round up or down the decimals. The
job’s default Unit Price decimal is set to 2.

There are two decimal selections to understand. In the Settings form from the Backstage View,
Decimal Precision lets you to calculate how many decimals to display.

In the Cost Basis form from Job Properties, lets the Unit Price decimal to calculate the Total Price.
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In the following screen shot, the Rounding Precision column is set to 2 for each pay item with the
exception of Mobilization, which was changed to -2. The -2means to the nearest $100.
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Change the 2 and 3 pay item row's Rounding Precision to 0 and 1. The Unit Price changed accordingly.
In doing so, you are moving the decimal to show tenth, zero, ten dollars, or in the Mobilizations case to
the nearest $100.
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15.28 PAYMENT METHODS

There are three different Payment Methods:

l Unit Price

l Fixed Final Pay

l Time and Expense
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The Unit Price is the default Payment Method. This option multiplies the Unit Price to the Pay Quantity
to calculate the Total Price.

The Fixed Final Pay method has two applications:

l display contingency type pay items.

l accurately calculate the over/under run pay items that are paid as if they were lump sum items.

Contingency type pay items is where the owner provided the pay item and entered their own value.
This becomes part of the proposal where it may or may not be used. To identify this type of pay item,
select the Fixed Final Paymethod, as displayed in the following screen shot. Then, enter $10,000 for
example.
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If this were a real pay item, lock the $10,000 because it must be part of the proposal. However, then
the issue is how to account for any costs, overhead, or profit to this Pay Item. Assuming you did not
want to add any overhead and profit dollars to the $10,000, enter a plug source of $10,000 in the CBS.
This offsets the Price of $10,000 but charges the $10,000 to a Cost Category that won't be used in any
overhead of profit dollars. Now, the $10,000 is not markup.

The second application the Fixed Final Pay method has is to accurately calculate the over/under run
pay items that are paid as if they were lump sum items. An issue occurs where a pay item is provided
with a quantity, such as a Superstructure Bridge of 10,000 CY, and you must enter a Unit Price against
the 10,000 CY.

However, the fine print says that this Pay Item can not be measured and can be paid as if it was a Lump
Sum item, but your quantity takeoff convinced you that you use more or less than the 10,000 CY. Say
your takeoff came to 12,000 CY and you entered the Forecast (TO) Quantity with the 12,000 CY.

Now the CBS is calculated on the 12,000 CY. Now normally in an over/run quantity, InEight Estimate
can help you decide how best to price out these items. In this case, you cannot take advantage of this
situation. The system converts that total cost based on the 12,000 CY. However, you divide by the
10,000 CY to give a different Unit Cost in the Pay Item and Proposal form. This way, when you get paid,
you get the cost as developed in the CBS.

The following screen shot shows the situation where you have an overrun normally. In this example,
you developed the CBS direct cost as $4.00 times 12000 CY for $48,000. (the system shows more
accuracy). Notice the direct costs of $40,000 and the balanced unit of $5.51. This is the normal
calculation if this was a true overrun pay item.
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When you change the Payment Method to Fixed Final Pay, the CBS cost of $48,000 is now shown.
Then when you price out the pay item, you get your $48,000 return.

Now for the Time and Expense payment method. This option is used with the Job Tracking form. Each
resource type can enter a Billing rate. For Force Account/Time and Material/Time and Expense work,
by changing the pay item to this method, the actual costs are entered in the Job Tracking form. Then
there is an Excel report that lists the actual costs using the Billing rates, plus the profit entered in the
Job Tracking tab in the Job Properties form.

15.29 UNBALANCED PRICING

The pay items are provided along with the Pay Quantities. If the pay items are to be measured and
paid on the final measured quantity, then we can provide information to price the pay items to
maximize the return. Some specifications are written that if an over/under pay item runs a certain
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percent, then the Unit Price is negotiated. Now, understanding this,you can forecast the final revenue
result.

The following screen shot shows a typical over and under run situation. The overrun quantities are
shown in green and the underrun is shown in red. I have balanced priced the job where all pay items
are using their Balanced Unit Price. In the Variance box, the Profit row, there is an ADD of $4153
dollars.

This means that if your Forecast Quantities become the final measure amount, I lose the $4153 dollars.
This is the difference between the Target Profit and the Forecast Profit. The issue is the underrun
quantity is priced at its Balanced Price, meaning there is 3000 Ton that I will not be paid for if my
35000 Ton is what I am expecting.

Now, I will use the system’s Unbalanced feature to price all the pay items. See the following screen
shot.
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What the Unbalanced Autoprice did was to price out the underrun with it’s Direct Cost only. The
overhead and profit share of the underrun was spread proportionately to the overrun items. The
underrun was priced lower than normal and the Overrun items were price higher than normal.

Now look at the Variance block and see the Profit row where it now says CUT, meaning if my forecast
quantities in up being the final measured quantities, I will pick up an additional $61,723 dollars in
profit.

The CUT simple allows you to decide if you want to keep the final Proposal price as shown, or to CUT
the $61,000 OR ANY PORTION of it from the final Proposal amount to get the job believing your
Forecast Quantities is the final measured quantities. Of course you can enter any preferred Unit Price.

15.30 ALTERNATE SCENARIOS

The Alternate scenarios feature allows a contractor to effectively evaluate multiple approaches to an
estimate, and quickly identify the most cost efficient way of performing the proposed work. Both
owners and contractors need more visibility to see the impact of changes made to the assumption
made on the cost model.

For example, a contractor might want to estimate the cost of hauling excavation material using a
scraper hauling machine(s). Alternatively, a contractor may want to compare the cost of loading and
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hauling that same excavation material with a loader truck(s). You should be able to estimate both
approaches quickly and switch between various scenarios.

Owners are increasingly requiring contractors to provide alternative items within the bid proposal.
Contractors should consider the cost impact of alternative estimate approaches, while also
contemplating how to effectively price their work.

The primary purpose for using Alternate Scenarios is to create ‘What If’ type of scenarios to gain a
better view of estimating ‘like’ situations. By defining Alternates, you have the ability to compare
multiple scenarios within an estimate, in which you can suspend or unsuspend various records.

Manually suspending and unsuspending items can be time consuming and error prone,
and can require maintenance of several versions of the estimate. Creating Alternate
Scenarios is a solution to this problem.

15.30.1 Base Alternate

Base Alternate refers to your base or anchor estimate and is part of the estimate’s cost.
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15.30.2 Alternates Records

Alternate records are used to define alternate scenarios so that you can assess the impact of those
scenarios.

To access the Alternates form select the Estimate tab. Under the Alternates section, select Alternates.

This action opens up the Alternate Record Details form.

Names Description

1. Code Code of Alternate Scenario.

2. Description Description of Alternate Scenario.

3. Active
Determines if Alternate Scenario is active within
CBS or not.

4. Total Cost (Added) When Alternate is set to active, it will not be
suspended, and its CBS Total Cost will be added
to the estimate’s Total Cost Forecast. Below
example shows the full $84,000 will be included
in the estimate.

5. Total Cost
(Suspended)

When Alternate is set to active, Total Cost
Suspended will be $0 because alternate is active
part of bid.

6. Total Cost (Net
Change)

Difference between Total Cost Added and Total
Cost Suspended.
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15.30.3 Alternates Record Details

Drill down into an Alternate Record to view and edit its attributes. The Alternate Record details form
provides you with a way to setup rules for auto suspending and unsuspending groups of cost items.
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Names Description

1. Assigned to
Alternate

Code of Alternate Scenario.

2. Suspended by
Alternate

Description of Alternate Scenario.

Step by Step — Create Alternate Scenario in CBS

1. From the Ribbon, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS). The Cost Breakdown Structure (CBS) Register opens.

3. Using the Unclassified Excavation cost item, type in Rock Excavation as a new subordinate.

4. Then type in 3000 in the Forecast T/O Quantity column.

5. Under the Unit of Measure column, select Cubic Yard.
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6. Double click the Rock Excavation cost item to open the cost item's record.

7. Select the Plug tab. Under the Subcontract section click into the Unit Cost field for the
Subcontract Price.

8. Type $28.00 in the Plug Unit Cost column for the Subcontract Price. Once done, click OK.

9. On the CBS Register, change your Saved Views to Alternates View.

10. Select the Rock Excavation cost item. Under the Alternate column, select the drop down arrow,
and then select the Add icon. This will open up a new form to create a new Alternate record.
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11. Type ROCK1 in the Code field, and type Rock Excavation in the Description field. Once done, click
OK.

12. An Attention message will appear alerting you the item will be suspended once you move off the
field.

13. Select Yes. You see the Rock Excavation item is now in suspended status.
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Suspended status is the default status for alternate items.

14. In order to activate this alternate item, select the Estimate tab in the Ribbon and go the
Alternate Scenario drop down in the Alternates section.

15. Then select the ROCK1 scenario. Once done, click OK. The Suspend check box fields is no longer
checked for Rock Excavation.

Alternate Scenario’s BASE and ROCK1 are now both included in the Total Cost
Forecast in your estimate. This is also known as additive type of alternate, meaning
that when it’s active it will be added to the estimate. When Alternate Scenario Base
+ ROCK1 are both checked, the cost item assigned to the ROCK1 alternate is
included in the Total Cost (Forecast).
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16. When only the Base Alternate Scenario is checked, the cost item assigned to the ROCK1
alternate is NOT included in the Total Cost (Forecast). Only base alternates are including the
estimate’s cost.

When a cost item is assigned to an alternate, it’s then considered an alternate item
in the estimate and does not contribute to the job’s cost until the alternate is
‘activated’.

15.30.4 Assigning multiple cost items to one alternate

Any number of cost items can be assigned to a single alternate item. The alternate feature can be used
to quickly suspend and unsuspend groups of items. Another manner in which alternates can be used
would be to consider two different approaches to completing the same scope of work. In this case the
activation of an alternate would replace the preselected cost items.
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Imagine you are a contractor and want to assign an Alternate Scenario to your 3.2 Excavation Trucks
cost item, and at the same time automatically suspend your 3.1 Excavation Scrapers cost item. You
need an Alternate Scenario view showing what would happen when you suspend Excavation Scrapers,
but want to keep your Excavation Trucks active. You’d like to evaluate this pricing scenario, especially
your Total Cost Forecast.

Step by Step — Multiple Cost Items to an Alternate

1. From the Ribbon, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS). The Cost Breakdown Structure (CBS) Register opens.

3. Create a copy of cost item Excavation and rename it Excavation, scrapers.

4. Rename the original Excavation cost item to Excavation, trucks.

5. Under the Unit of Measure column, select Cubic Yard.

6. Double click to open the cost item Excavation, trucks.

7. Add a new Construction Equipment Resource: code ETDT Dump Truck, then select OK.

8. Add a new Construction Equipment Resource: code EL950 Loader 950, select OK.

9. Change the quantity of ETDT Dump Truck to 5.

10. Add a new Labor Resource: code LT1 Teamster, then select OK.

11. Change the quantity for LT1 Teamster to 5.

12. Remove resources ES621 Scraper 621, ES623 Scraper 623, L01 Operator Class 1.

13. Change the quantity for L02 Operator Class to 5.

14. Change the Cubic Yard/Day to 2800 on the Production tab.
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15. Your results should look like this:

16. The Unit and Total Cost are now recalculated. Once you are done with all your changes, click OK
to return to the CBS register.

17. Your Excavation, truck cost item is now worth $3.59 a Cubic Yard, while your Excavation, scraper
cost item is worth $3.00 a Cubic Yard.
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In order to make these two cost items mutually exclusive, meaning that you want
one or the other in the bid, you can set this up via an alternate item. You can set
this up so that one is automatically suspended, while the other is active

18. For Excavation, truck, add a new Alternate by click on the Alternate field and selecting the new
icon.

19. Type ROCK2 in the Code.

20. Type in Trucking Excavation for the description.

21. Click on the Cost Items tab. In the CBS Position Code field, select the Excavation, scrapers.
Excavation, scrapers will now be suspended when Alternate Excavation, trucks is active.
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22. An Attention message will appear alerting you the item will be suspended once you move off the
field. Select Yes to continue. On the CBS Register, you now see that Excavation, trucks is
suspended while Excavation, scrapers is activated.

23. In order to activate this alternate item, select the Estimate tab in the Ribbon and go the
Alternate Scenario drop down in the Alternates section.

24. Then select the ROCK2 scenario. Once done, click OK.
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25. The trucks cost item is now active and scrapers has automatically been suspended. Now the
Suspended by Alternate column is checked for cost item Excavation, trucks.

15.31 ALTERNATE SCENARIOS

The Alternate scenarios feature allows a contractor to effectively evaluate multiple approaches to an
estimate, and quickly identify the most cost efficient way of performing the proposed work. Both
owners and contractors need more visibility to see the impact of changes made to the assumption
made on the cost model.
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For example, a contractor might want to estimate the cost of hauling excavation material using a
scraper hauling machine(s). Alternatively, a contractor may want to compare the cost of loading and
hauling that same excavation material with a loader truck(s). You should be able to estimate both
approaches quickly and switch between various scenarios.

Owners are increasingly requiring contractors to provide alternative items within the bid proposal.
Contractors should consider the cost impact of alternative estimate approaches, while also
contemplating how to effectively price their work.

The primary purpose for using Alternate Scenarios is to create ‘What If’ type of scenarios to gain a
better view of estimating ‘like’ situations. By defining Alternates, you have the ability to compare
multiple scenarios within an estimate, in which you can suspend or unsuspend various records.

Manually suspending and unsuspending items can be time consuming and error prone,
and can require maintenance of several versions of the estimate. Creating Alternate
Scenarios is a solution to this problem.

15.31.1 Base Alternate

Base Alternate refers to your base or anchor estimate and is part of the estimate’s cost.
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15.31.2 Alternates Records

Alternate records are used to define alternate scenarios so that you can assess the impact of those
scenarios.

To access the Alternates form select the Estimate tab. Under the Alternates section, select Alternates.

This action opens up the Alternate Record Details form.

Names Description

1. Code Code of Alternate Scenario.

2. Description Description of Alternate Scenario.

3. Active
Determines if Alternate Scenario is active within
CBS or not.

4. Total Cost (Added) When Alternate is set to active, it will not be
suspended, and its CBS Total Cost will be added
to the estimate’s Total Cost Forecast. Below
example shows the full $84,000 will be included
in the estimate.

5. Total Cost
(Suspended)

When Alternate is set to active, Total Cost
Suspended will be $0 because alternate is active
part of bid.

6. Total Cost (Net
Change)

Difference between Total Cost Added and Total
Cost Suspended.
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15.31.3 Alternates Record Details

Drill down into an Alternate Record to view and edit its attributes. The Alternate Record details form
provides you with a way to setup rules for auto suspending and unsuspending groups of cost items.
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Names Description

1. Assigned to
Alternate

Code of Alternate Scenario.

2. Suspended by
Alternate

Description of Alternate Scenario.

Step by Step — Create Alternate Scenario in CBS

1. From the Ribbon, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS). The Cost Breakdown Structure (CBS) Register opens.

3. Using the Unclassified Excavation cost item, type in Rock Excavation as a new subordinate.

4. Then type in 3000 in the Forecast T/O Quantity column.

5. Under the Unit of Measure column, select Cubic Yard.
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6. Double click the Rock Excavation cost item to open the cost item's record.

7. Select the Plug tab. Under the Subcontract section click into the Unit Cost field for the
Subcontract Price.

8. Type $28.00 in the Plug Unit Cost column for the Subcontract Price. Once done, click OK.

9. On the CBS Register, change your Saved Views to Alternates View.

10. Select the Rock Excavation cost item. Under the Alternate column, select the drop down arrow,
and then select the Add icon. This will open up a new form to create a new Alternate record.
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11. Type ROCK1 in the Code field, and type Rock Excavation in the Description field. Once done, click
OK.

12. An Attention message will appear alerting you the item will be suspended once you move off the
field.

13. Select Yes. You see the Rock Excavation item is now in suspended status.

Page 764 of 962 InEight Inc.  |  Release 19.2

15.31 Alternate Scenarios Estimate User Guide



Suspended status is the default status for alternate items.

14. In order to activate this alternate item, select the Estimate tab in the Ribbon and go the
Alternate Scenario drop down in the Alternates section.

15. Then select the ROCK1 scenario. Once done, click OK. The Suspend check box fields is no longer
checked for Rock Excavation.

Alternate Scenario’s BASE and ROCK1 are now both included in the Total Cost
Forecast in your estimate. This is also known as additive type of alternate, meaning
that when it’s active it will be added to the estimate. When Alternate Scenario Base
+ ROCK1 are both checked, the cost item assigned to the ROCK1 alternate is
included in the Total Cost (Forecast).
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16. When only the Base Alternate Scenario is checked, the cost item assigned to the ROCK1
alternate is NOT included in the Total Cost (Forecast). Only base alternates are including the
estimate’s cost.

When a cost item is assigned to an alternate, it’s then considered an alternate item
in the estimate and does not contribute to the job’s cost until the alternate is
‘activated’.

15.31.4 Assigning multiple cost items to one alternate

Any number of cost items can be assigned to a single alternate item. The alternate feature can be used
to quickly suspend and unsuspend groups of items. Another manner in which alternates can be used
would be to consider two different approaches to completing the same scope of work. In this case the
activation of an alternate would replace the preselected cost items.
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Imagine you are a contractor and want to assign an Alternate Scenario to your 3.2 Excavation Trucks
cost item, and at the same time automatically suspend your 3.1 Excavation Scrapers cost item. You
need an Alternate Scenario view showing what would happen when you suspend Excavation Scrapers,
but want to keep your Excavation Trucks active. You’d like to evaluate this pricing scenario, especially
your Total Cost Forecast.

Step by Step — Multiple Cost Items to an Alternate

1. From the Ribbon, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS). The Cost Breakdown Structure (CBS) Register opens.

3. Create a copy of cost item Excavation and rename it Excavation, scrapers.

4. Rename the original Excavation cost item to Excavation, trucks.

5. Under the Unit of Measure column, select Cubic Yard.

6. Double click to open the cost item Excavation, trucks.

7. Add a new Construction Equipment Resource: code ETDT Dump Truck, then select OK.

8. Add a new Construction Equipment Resource: code EL950 Loader 950, select OK.

9. Change the quantity of ETDT Dump Truck to 5.

10. Add a new Labor Resource: code LT1 Teamster, then select OK.

11. Change the quantity for LT1 Teamster to 5.

12. Remove resources ES621 Scraper 621, ES623 Scraper 623, L01 Operator Class 1.

13. Change the quantity for L02 Operator Class to 5.

14. Change the Cubic Yard/Day to 2800 on the Production tab.

15. Your results should look like this:
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16. The Unit and Total Cost are now recalculated. Once you are done with all your changes, click OK
to return to the CBS register.

17. Your Excavation, truck cost item is now worth $3.59 a Cubic Yard, while your Excavation, scraper
cost item is worth $3.00 a Cubic Yard.
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In order to make these two cost items mutually exclusive, meaning that you want
one or the other in the bid, you can set this up via an alternate item. You can set
this up so that one is automatically suspended, while the other is active

18. For Excavation, truck, add a new Alternate by click on the Alternate field and selecting the new
icon.

19. Type ROCK2 in the Code.

20. Type in Trucking Excavation for the description.

21. Click on the Cost Items tab. In the CBS Position Code field, select the Excavation, scrapers.
Excavation, scrapers will now be suspended when Alternate Excavation, trucks is active.
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22. An Attention message will appear alerting you the item will be suspended once you move off the
field. Select Yes to continue. On the CBS Register, you now see that Excavation, trucks is
suspended while Excavation, scrapers is activated.

23. In order to activate this alternate item, select the Estimate tab in the Ribbon and go the
Alternate Scenario drop down in the Alternates section.

24. Then select the ROCK2 scenario. Once done, click OK.
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25. The trucks cost item is now active and scrapers has automatically been suspended. Now the
Suspended by Alternate column is checked for cost item Excavation, trucks.

15.32 PAY ITEM ALTERNATES

An Alternate Scenario is a set of active Alternates that can also be used with Pay Items. It’s reasonable
for the owner to include pay items as alternates within a job. The owner will most likely base the bid
selection criteria primarily on the base bid items, but may also include alternate items in addition.
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The contractor will want to understand the cost impact of an alternate if it is awarded. Contractors
may not know ahead of time which combination of alternates an owner may choose to award. This
feature will help the contactor understand how to spread markup to various bid item prices using
different scenarios. This permits easy comparisons between different scenarios.

Imagine you are a contractor and bidding a job where the owner has included a security guard booth
pay item as an alternate item in the job. The owner bases the base bid selection criteria on the base
bid items, however, the owner elects to include alternate items in the award of the contract too. You
as the contractor need to add the new security guard toll booth pay item to analyze the cost impact of
adding this alternate, among other scenarios.

Suspending an item is the same as ‘Deducting’ an item.

The owner’s bid could look like this below, where the first eight pay items are base pay items. The last
Toll Booth pay item is the owner’s Alternate. All items the owner is requesting to see in the
contractor’s bid.

The one Alternate Construction item below represents a bid item the owner would like to have as part
of the bid as well. However, this one alternate is more of a ‘would like to have’. The Alternate item(s)
help to give the owner the option to accept the Alternates if it still falls within the owner’s budget.
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Step by Step — Create Pay Item and Proposal Alternate Scenario

1. From the Ribbon, select the Price tab.

2. Under the Pay Items section, select Pay Item & Proposal. The Pay Item & Proposal Register
opens.

3. Select the Saved Views drop down arrow and select Alternates View.

4. At the bottom of the register, create a new pay item labeled as Security Guard Booth in the
Description field. Then in the Pay Item Number field, type in SG1.
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5. Now create a new Alternate for the Security Guard Booth pay item using the same steps for your
new cost item.

6. Click in the Alternates field for the Security Guard Booth Alternate. Select the add icon. An
Alternate Record opens.

7. In the Code field, type in code ALT3.

8. In the Description field type in Security Guard Booth Alternate.

9. Go into the CBS and copy all of the subordinate cost items for the existing Toll Booth cost item.
(We will assume the same Toll Booth resources are needed for a Security Guard Booth).
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10. Paste the copied cost items into the new Security Guard Booth cost item you just created in the
PIP.

11. The cost items have all been automatically suspended in the CBS. This is because the Security
Guard Booth pay item is suspended as well
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12. In the Pay Item & Proposal Register, activate alternate pay item Security Guard Booth by
selecting Alternate Scenario Base + ALT3 at that top of the form.

13. The Security Guard Booth is now activated. You can now see that all of the pay items have been
priced including the Security Guard Booth Alternate pay item.

You may need to establish your pay item price first if a price does not yet exist

14. From the register, select the Actions tab. Then under the Auto Price section, select the Balance
Bid drop down.
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15. Select the option Hit Target Goal in order to auto price the job. Now all of the pay items have
been priced, including the Security Guard Booth Alternate pay item.

15.32.1 Compare Alternate Scenarios

You can price and analyze the impact of each Alternate Scenario to the estimate’s Total Price on the
Pay Item & Proposal Register. This is after the Alternate Scenarios have been defined, assigned, and
activated.

Each Alternate and combination of Alternates represents a different scenario, and prices need to be
established for every scenario that you want to compare.

For example, if you have defined Alternate Scenarios 1, 2 and 3, you may wish to price each of them
separately, and price any combination of them, and/or you may wish to price the combination of all
three.

Be sure to establish bid prices for every alternate or combination of alternates.
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Step by Step — Compare Alternate Scenarios

1. From the Ribbon, select the Price tab.

2. Under the Pay Items section, select Pay Item & Proposal. The Pay Item & Proposal Register
opens.

3. On the Pay Item & Proposal Register, select the Actions tab. Under the View section, select
Compare Alternative Scenarios. This action performs a comparison among the various
Alternative Scenarios you’ve priced so far.

4. After selecting Compare Alternative Scenarios, new columns appear on the pay item form. These
columns show a comparison of the base bid, plus Alternate Scenarios that have been priced so
far.
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5. The current scenario base price Total Price is $6,307,253.15, however the Alternate Price
scenario for the additional Security Guard Booth is $6,337,826.19

15.33 BENCHMARKING

Benchmarking is used to validate an estimate's cost and productivity values by comparing them to
relevant historical data, specifically as-built and as-estimated information captured from past jobs in
Estimate. Unit cost and unit man-hour benchmark data points are displayed graphically in relation to
the current estimate.

Using the Benchmarking feature requires the installation of the Data Warehouse. For
additional information, see the Data Warehouse topic.
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15.33.1 Benchmarking Master Job Properties Form

TheMaster Job Properties - Benchmarking form is used to establish the historical data to be used for
benchmarking the current job, and to define the default benchmark graph display and calculations.

TheMaster Job Properties - Benchmarking form includes:

l Historical Data Source - Select As-Estimated and As-Built data from the Data Warehouse.

l Default Cost Item Matching Criteria, Default Account Code Matching Criteria and Default Jobs
Filter - Define which cost items, account codes and jobs should be included.

l Benchmark Graph display Options - Define the data to be represented on both the X-Axis and
the Y-Axis of the graph.

l Calculate "Average" as- Define the calculation method as either Average orWeighted Avg
(weighted by current Qty).

l Benchmark - Select a benchmark value of Cost per Unit,Man-Hours / Unit, or Units / Man-
Hour.

l Flag an item's variance relative to the benchmark data when - Define the breakpoints for low,
medium and high variance ranges.

l Don't benchmark items with fewer than <number> historical data points - Designate the
minimum number of data points needed to benchmark an item.

The data in the Master Job Properties - Benchmarking form is automatically copied to any
newly created jobs. If all of the jobs that you create in Estimate will use the same rules,
defining the data in the Master Job Properties form will save time when you create new
job folders in Estimate.

In addition to the primary Forecast (T/O) Quantity and Unit of Measure on each cost item, Secondary
Quantity and Secondary Unit fields in the Cost Item Record can be used to capture a meaningful,
alternative quantity and unit on which to analyze As-estimated data.

You can establish the historical data to be used for benchmarking the current job, define the default
benchmark graph display, and define high, low and medium variance ranges on the Job Properties -
Benchmarking form.
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Step by Step — Benchmarking Master Job Properties Form

1. From the Backstage View, select Library from the left pane navigation.

2. From the Ribbon, select the Setup tab. Under the section Master Initialization, select Job
Properties. The Job Properties register opens.

3. On the Job Properties form, select the Benchmarking tab.

4. The Historical Data Source defaults to Data Warehouse. Select the historical data to use: As-
Estimated, As-Built, or both.

5. To define Default Cost Item Matching Criteria, click the Edit button and define your criteria for
matching cost items. You can select one or many fields and relate them using AND/OR logic.

6. To define Default Account Code Matching Criteria, click the Edit button and define your criteria
for matching cost items. You can select one or many fields and relate them using AND/OR logic.

A matching benchmark data point will be excluded if its unit of measure type (e.g.,
area, length, etc.) is different than the unit of measure type of the matching item in
the current estimate.

7. To filter the jobs to include, click the Edit button on the Default Jobs Filter and define your job
filtering criteria.

8. Choose your Benchmark Graph Display Options:

l Select the data to be represented on the X-Axis:
o Date
o Item Quantity (Primary)
o Item Quantity (Secondary)
o Ratio (Primary / Secondary)
o Ratio (Secondary / Primary)

l Select the data to be represented on the Y-Axis:
o $ / Primary Unit
o Man-Hrs / Primary Unit
o Primary Units / Man-hr
o $ / Secondary Unit
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o Man-Hrs / Secondary Unit
o Secondary Units / Man-hr

9. Define your average calculation method as either Average orWeighted Avg (weighted by
current Qty).

10. Define the Benchmark values that will be calculated from the historical data set by selecting Cost
per Unit,Man-Hours / Unit and Units / Man-Hour.

11. Define the variance ranges to be used for flagging an item relative to the benchmark data:

l To flag an item's variance from the average, select Its % variance from the average
exceeds and choose the Low,Medium, and High percentages to flag (values are
incremented by 1%).

l To flag an item's standard deviations from the norm, select Its standard deviations from
the norm (using SSTDEVP method) exceeds and choose the Low,Medium and High values
to flag (values are incremented by .1).

12. To customize the display colors for the Low,Medium and High ranges, click on a color block and
choose a different color.

13. To set a minimum number of benchmark data points required for an item to be benchmarked,
select a number in the Don't benchmark items with fewer than historical data points field.

NOTE: The data in the Master Job Properties form is automatically copied to any
newly created jobs. If all of the jobs that you create in Estimate will use the same
data, descriptive information and rules, defining the data in the Master Job
Properties form will save time when you create new job folders in Estimate.
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15.33.2 Benchmarking Job Properties Form

The Job Properties - Benchmarking form is used to establish the historical data to be used for
benchmarking the job, and to define the default benchmark graph display and calculations.

The Job Properties - Benchmarking form includes:
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l Historical Data Source - Select As-Estimated and As-Built data from the Data Warehouse.

l Default Cost Item Matching Criteria, Default Account Code Matching Criteria and Default Jobs
Filter - Define which cost items and which jobs should be included.

l Benchmark Graph display Options - Define the data to be represented on both the X-Axis and the
Y-Axis of the graph.

l Calculate "Average" as- Define the calculation method as either Average or Weighted Avg
(weighted by current Qty).

l Benchmark - Select a benchmark value of Cost per Unit, Man-Hours / Unit, or Units / Man-Hour.

l Flag an item's variance relative to the benchmark data when - Define the breakpoints for low,
medium and high variance ranges.

l Don't benchmark items with fewer than <number> historical data points - Designate the
minimum number of data points needed to benchmark an item.

How to Open this Form:

1. On the Estimate ribbon, select the Setup tab.

2. Under the Initialize section, select Job Properties drop down arrow.

3. On the drop down list, select Benchmarking.

Step by Step — Opening the Job Properties Form

1. On the Ribbon, select the Setup tab.

2. Under the Initialize section, select the Job Properties drop down arrow.

3. On the drop down list, select Benchmarking.
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15.33.3 Benchmarking Graph

The defaults for the benchmarking graph are defined on the Job Properties - Benchmarking form, but
on the Cost Item Record - Benchmarking form you have the ability to override the default criteria in
order to expand or contract the amount of historical data being used to calculate benchmark values for
a specific cost item. This way, you can filter the historical data sources to only the past jobs that are
relevant to that cost item.
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Before starting this procedure, make sure to set up your default benchmarking options, as outlined in
the Benchmarking Options topic.

Step by Step — Benchmarking Graph

1. From the Ribbon, select the Estimate tab. Under Breakdown Structures, select Cost Breakdown
Structure (CBS).

2. On the Cost Breakdown Structure (CBS) Register, select theMore Actions tab. Under the Tools
section, select Refresh Benchmarks.

3. The Refresh Benchmarks dialog shows the Last refresh date and the number of Jobs matching
filter criteria.

l If the number of matching jobs is too large or too small, return to step 1 and expand or
contract your filtering options.

l If the number of matching jobs is acceptable, click Refresh Now to proceed.

4. Open the Cost Item Record of any preferred cost item.

5. Click on the Benchmarking default data block located in the lower right portion of the Cost Item
Record.

6. The benchmarking graph shows the historical benchmark values for this cost item, along with the
Current value, the Average value, and the variance ranges represented by each color. This
information is calculated and displayed as specified on the Job Properties - Benchmarking form.
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7. To refine the values that contribute to this cost item's graph, click the Settings button to display
the Settings dialog:

l To override the job filter for this cost item, click the Edit button in the Override Jobs Filter
field and define the filter to use for benchmarking this cost item.

l To override the Display Options for this cost item, select the desired values from the X-Axis
and Y-Axis drop-down boxes.
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l To override the list of jobs that contribute to the Included Historical Data for this cost item,
use the Auto include all matching data points toggle to include all or exclude all, and select
the individual Include check boxes for the jobs you want to include.

l When you have completed your customizations for this cost item's benchmarking, click OK
to save your changes and return to the Cost Item Record - Benchmarking form.

8. To zoom in on a portion of the graph, click and drag across the portion of the graph that you
want to enlarge. To view the entire graph again, click Reset Zoom.
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9. To print a Benchmark Report, click the Print button, change any options as necessary on the
Benchmark Report dialog, and click Run.
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15.33.4 Account Code Utilization Register

The Account Code Utilization Register is used to roll estimate line items into an account code
hierarchy, with the ability to control which cost items contribute quantity to their parent, in order to
benchmark against historical projects in a way that is consistent across projects.

The Account Code Utilization Register is similar to the Cost Breakdown Structure (CBS) and theMaster
Cost Breakdown Structure (CBS), with the following exceptions:

l The rows in the Account Code Utilization Register represent Account Codes rather than
individual Cost Items, so the tree structure reflects the Account Code hierarchy rather than the
CBS hierarchy.

l The detail rows in the Account Code Utilization Register reflect a terminal Account Code's
assigned Cost Items.
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l The terminal rows in the Account Code Utilization Register represent each utilized Account Code
in the CBS.

l If the Account Code’s Auto-Quantity setting is set to Yes, then the Quantity of the terminal row
is equal to the Quantity (Primary or Secondary) of all the cost items in the CBS with that assigned
Account Code, and the cost items in the CBS employing resources with that assigned Account
Code, provided that they have the same Unit of Measure type as the Account Code.

l Detail rows for each terminal row represent the cost items assigned to the terminal Account
Code, including cost items employing resources that are assigned to the terminal Account Code.

l The Account Code Utilization Register can be filtered to display only terminal items by clicking
the drop down arrow on the Is Terminal column and selecting Checked.

l When a Fuel Account Code is assigned to an employed resource, the resource's Fuel Total Cost is
removed from the Account Code associated with the cost item and placed instead in the Fuel
Account Code.

The parent-child hierarchy for Account Codes is based on the Account Code Hierarchy Separator,
which is located from the Backstage View Settings under the Options drop down labeled as Account
Code Settings. The Hierarchy Separator defines the parent-child relationship within the Account Code
structure.

The Account Code Utilization Register is used primarily for analysis, and most of the columns are read-
only. Most of these columns originate on the Account Codes tab in the Foundation Setup Data
Register and theMaster Foundation Setup Data Register. Modifying an editable column on this form
has the same effect as modifying the same field on the Account Codes tab of the Foundation Setup
Data Register or on the Account Record. For further information, see Creating Account Codes.

The Benchmarking portion of the form is similar to the Benchmarking data block on the Cost Item
Record, with the following exceptions:

l The Item Matching criteria is always Account Code.

l Parent account codes will include all matching data points for their child account codes, based
on the Hierarchy Separator.

l Account Code rows can be benchmarked at the terminal row level or at any superior row level in
the Account Code Utilization Register, meaning that both current estimate values and
benchmark values can be compared at any level since both include the values rolled up from
their children.
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15.33.4.1 Opening the Account Code Utilization Register

Step by Step — Opening the Account Code Utilization Register

1. From the Backstage View, select Library from the left pane navigation.

2. From the Ribbon, select the Estimate tab.

3. Under the section Master Breakdown Structures, select Account Code Utilization. The Account
Code Utilization Register opens.
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15.34 BENCHMARKING

Benchmarking is used to validate an estimate's cost and productivity values by comparing them to
relevant historical data, specifically as-built and as-estimated information captured from past jobs in
Estimate. Unit cost and unit man-hour benchmark data points are displayed graphically in relation to
the current estimate.
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Using the Benchmarking feature requires the installation of the Data Warehouse. For
additional information, see the Data Warehouse topic.

15.34.1 Benchmarking Master Job Properties Form

TheMaster Job Properties - Benchmarking form is used to establish the historical data to be used for
benchmarking the current job, and to define the default benchmark graph display and calculations.

TheMaster Job Properties - Benchmarking form includes:

l Historical Data Source - Select As-Estimated and As-Built data from the Data Warehouse.

l Default Cost Item Matching Criteria, Default Account Code Matching Criteria and Default Jobs
Filter - Define which cost items, account codes and jobs should be included.

l Benchmark Graph display Options - Define the data to be represented on both the X-Axis and
the Y-Axis of the graph.

l Calculate "Average" as- Define the calculation method as either Average orWeighted Avg
(weighted by current Qty).

l Benchmark - Select a benchmark value of Cost per Unit,Man-Hours / Unit, or Units / Man-
Hour.

l Flag an item's variance relative to the benchmark data when - Define the breakpoints for low,
medium and high variance ranges.

l Don't benchmark items with fewer than <number> historical data points - Designate the
minimum number of data points needed to benchmark an item.

The data in the Master Job Properties - Benchmarking form is automatically copied to any
newly created jobs. If all of the jobs that you create in Estimate will use the same rules,
defining the data in the Master Job Properties form will save time when you create new
job folders in Estimate.

In addition to the primary Forecast (T/O) Quantity and Unit of Measure on each cost item, Secondary
Quantity and Secondary Unit fields in the Cost Item Record can be used to capture a meaningful,
alternative quantity and unit on which to analyze As-estimated data.

You can establish the historical data to be used for benchmarking the current job, define the default
benchmark graph display, and define high, low and medium variance ranges on the Job Properties -
Benchmarking form.
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Step by Step — Benchmarking Master Job Properties Form

1. From the Backstage View, select Library from the left pane navigation.

2. From the Ribbon, select the Setup tab. Under the section Master Initialization, select Job
Properties. The Job Properties register opens.

3. On the Job Properties form, select the Benchmarking tab.

4. The Historical Data Source defaults to Data Warehouse. Select the historical data to use: As-
Estimated, As-Built, or both.

5. To define Default Cost Item Matching Criteria, click the Edit button and define your criteria for
matching cost items. You can select one or many fields and relate them using AND/OR logic.

6. To define Default Account Code Matching Criteria, click the Edit button and define your criteria
for matching cost items. You can select one or many fields and relate them using AND/OR logic.

A matching benchmark data point will be excluded if its unit of measure type (e.g.,
area, length, etc.) is different than the unit of measure type of the matching item in
the current estimate.

7. To filter the jobs to include, click the Edit button on the Default Jobs Filter and define your job
filtering criteria.

8. Choose your Benchmark Graph Display Options:

l Select the data to be represented on the X-Axis:
o Date
o Item Quantity (Primary)
o Item Quantity (Secondary)
o Ratio (Primary / Secondary)
o Ratio (Secondary / Primary)

l Select the data to be represented on the Y-Axis:
o $ / Primary Unit
o Man-Hrs / Primary Unit
o Primary Units / Man-hr
o $ / Secondary Unit
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o Man-Hrs / Secondary Unit
o Secondary Units / Man-hr

9. Define your average calculation method as either Average orWeighted Avg (weighted by
current Qty).

10. Define the Benchmark values that will be calculated from the historical data set by selecting Cost
per Unit,Man-Hours / Unit and Units / Man-Hour.

11. Define the variance ranges to be used for flagging an item relative to the benchmark data:

l To flag an item's variance from the average, select Its % variance from the average
exceeds and choose the Low,Medium, and High percentages to flag (values are
incremented by 1%).

l To flag an item's standard deviations from the norm, select Its standard deviations from
the norm (using SSTDEVP method) exceeds and choose the Low,Medium and High values
to flag (values are incremented by .1).

12. To customize the display colors for the Low,Medium and High ranges, click on a color block and
choose a different color.

13. To set a minimum number of benchmark data points required for an item to be benchmarked,
select a number in the Don't benchmark items with fewer than historical data points field.

NOTE: The data in the Master Job Properties form is automatically copied to any
newly created jobs. If all of the jobs that you create in Estimate will use the same
data, descriptive information and rules, defining the data in the Master Job
Properties form will save time when you create new job folders in Estimate.
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15.34.2 Benchmarking Job Properties Form

The Job Properties - Benchmarking form is used to establish the historical data to be used for
benchmarking the job, and to define the default benchmark graph display and calculations.

The Job Properties - Benchmarking form includes:
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l Historical Data Source - Select As-Estimated and As-Built data from the Data Warehouse.

l Default Cost Item Matching Criteria, Default Account Code Matching Criteria and Default Jobs
Filter - Define which cost items and which jobs should be included.

l Benchmark Graph display Options - Define the data to be represented on both the X-Axis and the
Y-Axis of the graph.

l Calculate "Average" as- Define the calculation method as either Average or Weighted Avg
(weighted by current Qty).

l Benchmark - Select a benchmark value of Cost per Unit, Man-Hours / Unit, or Units / Man-Hour.

l Flag an item's variance relative to the benchmark data when - Define the breakpoints for low,
medium and high variance ranges.

l Don't benchmark items with fewer than <number> historical data points - Designate the
minimum number of data points needed to benchmark an item.

How to Open this Form:

1. On the Estimate ribbon, select the Setup tab.

2. Under the Initialize section, select Job Properties drop down arrow.

3. On the drop down list, select Benchmarking.

Step by Step — Opening the Job Properties Form

1. On the Ribbon, select the Setup tab.

2. Under the Initialize section, select the Job Properties drop down arrow.

3. On the drop down list, select Benchmarking.
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15.34.3 Benchmarking Graph

The defaults for the benchmarking graph are defined on the Job Properties - Benchmarking form, but
on the Cost Item Record - Benchmarking form you have the ability to override the default criteria in
order to expand or contract the amount of historical data being used to calculate benchmark values for
a specific cost item. This way, you can filter the historical data sources to only the past jobs that are
relevant to that cost item.
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Before starting this procedure, make sure to set up your default benchmarking options, as outlined in
the Benchmarking Options topic.

Step by Step — Benchmarking Graph

1. From the Ribbon, select the Estimate tab. Under Breakdown Structures, select Cost Breakdown
Structure (CBS).

2. On the Cost Breakdown Structure (CBS) Register, select theMore Actions tab. Under the Tools
section, select Refresh Benchmarks.

3. The Refresh Benchmarks dialog shows the Last refresh date and the number of Jobs matching
filter criteria.

l If the number of matching jobs is too large or too small, return to step 1 and expand or
contract your filtering options.

l If the number of matching jobs is acceptable, click Refresh Now to proceed.

4. Open the Cost Item Record of any preferred cost item.

5. Click on the Benchmarking default data block located in the lower right portion of the Cost Item
Record.

6. The benchmarking graph shows the historical benchmark values for this cost item, along with the
Current value, the Average value, and the variance ranges represented by each color. This
information is calculated and displayed as specified on the Job Properties - Benchmarking form.
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7. To refine the values that contribute to this cost item's graph, click the Settings button to display
the Settings dialog:

l To override the job filter for this cost item, click the Edit button in the Override Jobs Filter
field and define the filter to use for benchmarking this cost item.

l To override the Display Options for this cost item, select the desired values from the X-Axis
and Y-Axis drop-down boxes.
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l To override the list of jobs that contribute to the Included Historical Data for this cost item,
use the Auto include all matching data points toggle to include all or exclude all, and select
the individual Include check boxes for the jobs you want to include.

l When you have completed your customizations for this cost item's benchmarking, click OK
to save your changes and return to the Cost Item Record - Benchmarking form.

8. To zoom in on a portion of the graph, click and drag across the portion of the graph that you
want to enlarge. To view the entire graph again, click Reset Zoom.
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9. To print a Benchmark Report, click the Print button, change any options as necessary on the
Benchmark Report dialog, and click Run.
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15.34.4 Account Code Utilization Register

The Account Code Utilization Register is used to roll estimate line items into an account code
hierarchy, with the ability to control which cost items contribute quantity to their parent, in order to
benchmark against historical projects in a way that is consistent across projects.

The Account Code Utilization Register is similar to the Cost Breakdown Structure (CBS) and theMaster
Cost Breakdown Structure (CBS), with the following exceptions:

l The rows in the Account Code Utilization Register represent Account Codes rather than
individual Cost Items, so the tree structure reflects the Account Code hierarchy rather than the
CBS hierarchy.
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l The detail rows in the Account Code Utilization Register reflect a terminal Account Code's
assigned Cost Items.

l The terminal rows in the Account Code Utilization Register represent each utilized Account Code
in the CBS.

l If the Account Code’s Auto-Quantity setting is set to Yes, then the Quantity of the terminal row
is equal to the Quantity (Primary or Secondary) of all the cost items in the CBS with that assigned
Account Code, and the cost items in the CBS employing resources with that assigned Account
Code, provided that they have the same Unit of Measure type as the Account Code.

l Detail rows for each terminal row represent the cost items assigned to the terminal Account
Code, including cost items employing resources that are assigned to the terminal Account Code.

l The Account Code Utilization Register can be filtered to display only terminal items by clicking
the drop down arrow on the Is Terminal column and selecting Checked.

l When a Fuel Account Code is assigned to an employed resource, the resource's Fuel Total Cost is
removed from the Account Code associated with the cost item and placed instead in the Fuel
Account Code.

The parent-child hierarchy for Account Codes is based on the Account Code Hierarchy Separator,
which is located from the Backstage View Settings under the Options drop down labeled as Account
Code Settings. The Hierarchy Separator defines the parent-child relationship within the Account Code
structure.

The Account Code Utilization Register is used primarily for analysis, and most of the columns are read-
only. Most of these columns originate on the Account Codes tab in the Foundation Setup Data
Register and theMaster Foundation Setup Data Register. Modifying an editable column on this form
has the same effect as modifying the same field on the Account Codes tab of the Foundation Setup
Data Register or on the Account Record. For further information, see Creating Account Codes.

The Benchmarking portion of the form is similar to the Benchmarking data block on the Cost Item
Record, with the following exceptions:

l The Item Matching criteria is always Account Code.

l Parent account codes will include all matching data points for their child account codes, based
on the Hierarchy Separator.

l Account Code rows can be benchmarked at the terminal row level or at any superior row level in
the Account Code Utilization Register, meaning that both current estimate values and
benchmark values can be compared at any level since both include the values rolled up from
their children.
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15.34.4.1 Opening the Account Code Utilization Register

Step by Step — Opening the Account Code Utilization Register

1. From the Backstage View, select Library from the left pane navigation.

2. From the Ribbon, select the Estimate tab.

3. Under the section Master Breakdown Structures, select Account Code Utilization. The Account
Code Utilization Register opens.
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15.35 DATA WAREHOUSE

The Data Warehouse combines data from individual jobs into a single data warehouse. The Data
Warehouse allows you to combine data from multiple, individual job databases into a single database
for reporting purposes. You select which jobs to include, and Estimate takes care of populating the
consolidated database with all the data from each job.

InEight Inc.  |  Release 19.2 Page 809 of 962

Estimate User Guide 15.35 Data Warehouse



You can choose to update the Data Warehouse automatically when any of the included jobs are saved,
or manually at your discretion. With the data consolidated into the Data Warehouse, you can then use
Crystal Reports, Microsoft Access, or any other SQL-compatible reporting tool to create user-defined
reports that span across jobs. You can also use this consolidated data for benchmarking purposes.

The amount of time that it will take to update the Data Warehouse database is highly
dependent on the number of jobs included, the amount of data in those jobs, and the
number of users updating the database at any given time.

The Data Warehouse requires the installation of additional components. For information
contact support.ineight.com.

15.35.1 Changing the Update Method for Jobs in the Data Warehouse

The Data Warehouse allows you to select which of your jobs you want to include in the consolidated
Data Warehouse. After you have used the Data Warehouse Register to select the jobs you want to
update, you can define the method you prefer to use to update the database when job and library data
is saved.

l Update - This method indicates that you will decide when you want to update the Data
Warehouse database. This method requires that you manually execute the Update command
from the Data Warehouse Register register each time you want to update the Data Warehouse
database.

Jobs set to use the manual update method are designated by a check mark in the
Included column and the absence of a check mark in the Auto Update column.

l Auto-Update - This method indicates that the Data Warehouse database will automatically be
updated each time you save an included job or library. No manual intervention is required.

Jobs set to use the Auto-Update method are designated by a check mark in the
Included column and a check mark in the Auto Update column.

In order for an update of the Data Warehouse to be successful, the server containing the Job
Consolidation Server application must be available and the BID-BUILD Job Consolidation service must
be running.

The amount of time that it takes to update the Data Warehouse database is highly
dependent on the number of jobs included, the amount of data in those jobs, and the
number of users updating the database at any given time.
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Regardless of the method you chose when you initially defined which of your jobs you wanted to
include in the Data Warehouse database, you can change that method at any time.

15.35.1.1 Update method include as a manual update:

Step by Step — Benchmarking Updating Method

1. Select File to open the Backstage View. Select Jobs from the left navigation pane.

2. Under Jobs, select Data Warehouse.

3. On the Data Warehouse register, select the job that is currently set to Auto-Update.

4. Select the Actions tab.

5. Under Tools, select Update. This include the job as a manual run with a specific date identified in
the last update column. Notice the data status column to assist with identifying changes.
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15.35.1.2 Update method from manual update to auto-update

When defining jobs to Auto Update, the Data Warehouse database is updated any time
the included job or library is saved.

Step by Step — Benchmarking Manual to Auto Update

1. Select File to open the Backstage View. Select Jobs from the left navigation pane.

2. Under Jobs, select Data Warehouse.

3. On the Data Warehouse register, select the job that is currently set to Auto-Update.
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4. Select the Actions tab.

5. Under Tools, select Auto-Update. This enables the Auto-Update selection while also leaving a
check mark in the Included column.

15.35.2 Printing a Data Warehouse Database Field List

The Data Warehouse requires an Enterprise License and installation of additional
components. For information contact support.ineight.com.

With the data consolidated into the Data Warehouse, you can then use Crystal Reports, Microsoft
Access, or any other SQL-compatible reporting tool to create user-defined reports that span across
jobs. Whenever you use a third party application to extract data from a database for reporting, it is
helpful to know what tables are included in the database, the column names, and the data that
populates each of these columns.
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To assist you with this, you can generate a Data Warehouse Field List that defines each of the tables,
columns, and data in the Data Warehouse database.

Step by Step — Printing Data Warehouse Database Field List

1. Select File to open the Backstage View. Select Jobs from the left navigation pane.

2. Under Jobs, select Data Warehouse.

3. On the Data Warehouse register, select the job that you want to generate a report for.

4. Select the Actions tab.

5. Under Tools, select the Data Warehouse Field List.

6. On the Save Data Warehouse Field List dialog, browse to the destination folder on your
computer where you want to save the report and click Save. The report will display after saving.
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15.35.3 Canceling an Update of the Data Warehouse

The Data Warehouse requires an Enterprise license and installation of additional
components. For information contact support.ineight.com.

Regardless of the update method you have chosen, you can cancel a job update that is in queue or is
set to Auto-Update when job or library data is saved. When an update of the Data Warehouse is in
queue, or is set to Auto-Update when job or library data is saved, the Data Status column shows the
current status.

The Cancel Update command applies to jobs with a status of In Queue or jobs that are set to Auto-
Update. These jobs are removed from the queue, and jobs set to Auto-Update are set to manual
update.
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l Updating - Indicates that an update of the data warehouse is in progress for the subject job. Jobs
with a status of Updating cannot be canceled.

l In Queue - Indicates that an update of the data warehouse is waiting to be processed for the
subject job.

l Current - Indicates that the data warehouse update for that job is complete as of the last update.

When canceling an update for a job that is set to Auto-Update, the result is that the job's update
method is set to manual even if the current Reporting Status is Current.

Step by Step — Cancelling an Update of the Data Warehouse

1. Select File to open the Backstage View. Select Jobs from the left navigation pane.

2. Under Jobs, select Data Warehouse.

3. On the Data Warehouse register, select the jobs you want to cancel updates for and then select
the Actions tab.

4. Under the Tools section, select the Cancel Update button to cancel the preferred job update.
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15.35.4 Removing Jobs from the Data Warehouse

The Data Warehouse requires an Enterprise license and installation of additional
components. For information contact support.ineight.com.

The Data Warehouse allows you to select which of your jobs you want to include in the consolidated
data warehouse. You do not have to include all of your jobs. In the event that you want to remove a
currently included job, you can do so on the Data Warehouse Register.

Jobs currently included for updating the Data Warehouse are designated as such by the presence of a
check mark in the Included column on the Data Warehouse Register.

The Remove command applies to jobs with a status of In Queue, Updating, Current, or Out of Date.
The result of executing this command is that currently included jobs are removed.

InEight Inc.  |  Release 19.2 Page 817 of 962

Estimate User Guide 15.35 Data Warehouse



Step by Step — Removing Jobs from the Data Warehouse

1. Select File to open the Backstage View. Select Jobs from the left navigation pane.

2. Under Jobs, select Data Warehouse.

3. On the Data Warehouse register, select the job you want to remove and then select the Actions
tab.

4. Under Tools, select Remove to remove the job from the Data Warehouse database.
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15.36 ACCOUNT CODE MANAGEMENT

The make-up of account codes is dictated by the specifications of your cost accounting system. Each
code represents one cost account. Account codes are used for cross-referencing Cost Breakdown
Structure (CBS) cost items and the budget line items of your accounting system. Multiple CBS cost
items can be coded to the same account code if they fall under the same category.

Once an account code has been assigned to each cost item in a job's Cost Breakdown Structure (CBS),
the software can automatically or manually summarize all like assignments into one budget line (for
each account). Budgets can be captured for both primary and secondary quantities.

Account codes are often used to summarize cost items into standardized categories for use in
benchmarking and estimating applications.

They are useful for large company that use multiple levels of accounting-related cost codes for their
budget. They are extremely useful for benchmarking purposes. Account Codes provide a common
language (set of codes) that you can use across systems.

Account codes can be used to track: quantity, budget, account code tags, unit cost.

15.36.1 Account Code Setup

Account Codes can be setup for a project from the Foundation Setup Data Registerunder the Account
Codes tab. The columns for populating account code information are as follows:

Column Description

Utilized
This is a checkbox denoting whether or not the
account code is assigned to a cost item in the
project.

Account Code The alpha numeric sequence assigned as the
code.

Description Description detailing the account code’s scope.

Unit of Measure The primary unit of measure for the account
code.

Secondary Unit of
Measure

The secondary unit of measure for the account
code.

Currency The currency assigned to the account code.
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Column Description

Auto-Quantity
(Primary)

Automatically roll up cost item quantities if the
cost items and this account code have the same
primary UoMs. It can also be set on a project
specific basis.

Quantity The default quantity for the account code.

Auto-Quantity
(Secondary)

Automatically roll up cost item quantities if the
cost items and this account code have the same
secondary UoMs. It can also be set on a project
specific basis.

Secondary Quantity The secondary quantity for the account code.

Tag 1-20
Tags that can be associated to account codes to
enable them to be categorized.

User Defined Field 1-
10

Optional open-text fields you can use to add
information related to the account code.

15.36.1.1 Create an Account Code

Account Codes can be created for the project level within a project or for multiple projects within the
Library. Account Codes should be as detailed as possible to most accurately benchmark work. Only
lead estimators or estimators with a lot of experience should create new account codes.

The master set of Account Codes is created and stored in the Library on theMaster Foundation Setup
Data under the Account Codes tab. When a new folder is created, the master set is automatically
copied from the Library to the new folder.

If you feel the current job requires new or different Account Codes to adequately organize the job's
budget, you can change, create, or delete them any time you wish. Account Codes can also be created
on-the-fly in the folder.

Step by Step — Create an Account Code

1. From the Setup tab, select the Foundation Setup Data drop down and then Account Codes.

2. From the Actions tab, under the Edit section, select New.
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3. Enter a unique account code TEST – Your Initials. Enter the description Test Account Code.
Select a Unit of Measure. Enter a quantity.

4. When you are done, click OK.

5. Your account code is added to the bottom of the register. The Utilized column is unchecked
because your account code has not yet been utilized.
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15.36.2 Edit an Account Code

Editing an account code is also done through the Foundation Setup Data tab and selecting Account
Codes.

Step by Step — Edit an Account Code

1. Select your account code.

2. From the Actions tab, under the Edit section, select Open.

3. Select the Auto-Quantity Primary check box. Notice that your quantity goes to 0.

4. Enter some notes in the Notes field.

5. Click on the Tags/User Defined Fields tab. From the Tag 1 drop down arrow, select Concrete.
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6. Enter in test in the User Defined 1 field. Once done, click OK.

15.36.3 Quantity Contribution

At the project level, you can manage account codes under the Account Code Utilization Register or in
Foundation Setup Data. In the Account Code Utilization Register, you can see the account codes
assigned to your cost items, along with account code details and quantity contributors.

Other budget information is automatically pulled into the Account Code Utilization Register including,
Total Cost, Unit Cost, Unit Rates, Primary and Secondary Quantity Ratios, Man Hours, and Account
Code Tags. To access this information, scroll through all of the columns in the Account Code Utilization
Register.

15.36.4 Account Code Quantity

There are two methods for defining primary and secondary quantities for your account codes:

l Manual entry in the Primary Qty and Secondary Qty fields

l Using the auto-quantity feature to have them automatically inherit the quantities of any cost
items that have the same unit of measure as the assigned account code
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15.36.5 Quantity Contributors

Within your project, you can specify how primary and secondary quantities contribute to your account
codes. Specifically, you can indicate how:

l Cost item primary and secondary quantities contribute to assigned account code primary and
secondary quantities

l Child account code primary and secondary quantities contribute to parent account code primary
and secondary quantities

For both cost item and account code contributions you can have quantities roll up:

l Primary quantity to primary quantity

l Primary quantity to secondary quantity

l Secondary quantity to secondary quantity
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Account codes will only automatically inherit quantities from cost items/account codes
using the same unit of measure.

15.36.6 Contribution Options – Cost Item to Account Code

From the Account Code Utilization Register, you can specify how cost item quantities roll up to the
account code that is assigned to it, by selecting the appropriate checkbox. The total of the contributing
cost item(s)’s quantities will roll up to become the account code quantity.
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15.36.7 Account Code Utilization Register

The Account Code Utilization Register keeps track of how the account codes are used for the project.
It displays the mapping between CBS items and Account Codes.

The Account Code Utilization Register is accessed through the Estimate tab from either within the
project (for project specific account codes and cost items) or the Library (for Master account codes and
cost items).

Account code hierarchy rolls up based on your assignments (just like in the CBS). Quantity contributors
(discussed above) can be employed from within the Account Code Utilization Register.

The Account Code Utilization Register is used to roll estimate line items into an account code
hierarchy, with the ability to control which cost items contribute quantity to their parent, in order to
benchmark against historical projects in a way that is consistent across projects.

The Account Code Utilization Register is similar to the Cost Breakdown Structure (CBS) and theMaster
Cost Breakdown Structure (CBS), with the following exceptions:

l The rows in the Account Code Utilization Register represent Account Codes rather than
individual Cost Items, so the tree structure reflects the Account Code hierarchy rather than the
CBS hierarchy.

l The Utilizing Items data block in the Account Code Utilization Register reflect a terminal Account
Code’s assigned Cost Items.

l The terminal rows in the Account Code Utilization Register represent each utilized Account Code
in the CBS.
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l If the Account Code’s Auto-Quantity setting is checked, then the Quantity of the terminal row is
equal to the Quantity (Primary or Secondary) of all the cost items in the CBS with that assigned
Account Code, and the cost items in the CBS employing resources with that assigned Account
Code, provided that they have the same Unit of Measure type as the Account Code.
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l The Account Code Utilization Register can be filtered to display only terminal items by clicking
the filter icon on the “Is Terminal” column and selecting “Checked”.
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l The parent-child hierarchy for Account Code is based on the Account Code Hierarchy Separator.
The Hierarchy Separator defines the parent-child relationship within the Account Code structure.

l The Account Code Utilization Register is used primarily for analysis, and most of the columns are
read-only. Most of these columns originate on the Account Codes tab in the Foundation Setup
Data Register and theMaster Foundation Setup Data Register. Modifying an editable column
on this form has the same effect as modifying the same field on the Account Codes tab of the
Foundation Setup Data Register or on the Account Record.
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Step by Step — Account Code Utililzation Register

1. From the Estimate tab under the Breakdown Structures section, select Account Code Utilization.

2. Select an account code. You can see the cost items that are using the account code below in the
Utilizing Items data block.
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3. Scroll to the right and find theMan Hours (w/ Maintenance) column. This shows the total
number of manhours contributing to that account code.

4. Click the ellipses next to the Find bar. Select Unit of Measure.
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5. In the Find field, type in Each. Then press <Enter>.

6. The first account code that matches that Unit of Measure is highlighted.

7. Press <F3> to move to the next account code that matches that UoM.

8. 8. You can change the quantity contribution of the cost items by checking and unchecking the
boxes of the cost items.
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15.36.8 Benchmarking

Benchmarking is a way for companies to track their productivity on all of their different projects. Since
projects have various cost items and pay items, a way to benchmark and track all of these job
uniformly is using account codes. When an account code is assigned to a cost item, the account code
tracks all benchmarking data such as total manhours, MH/unit, and quantities.

In the Account Code Utilization Register, you can scroll through the columns to find benchmarking data
on each account code.

Another way projects can benchmark is by using account code tag fields. All of the account codes with
the same tags can be benchmarked together.

Also in the Account Code Utilization Register, you can use the Benchmarking Data block to view
benchmarked data. The Benchmarking portion of the form is similar to the Benchmarking data block
on the Cost Item Record, with the following exceptions:

l The Item matching criteria is always Account Code.

l "Parent" account codes will include all matching data points for their "child" account codes,
based on the Hierarchy Separator.

l Account Code rows can be benchmarked at the terminal row level or at any superior row level in
the Account Code Utilization Register, meaning that both current estimate values and
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benchmark values can be compared at any level since both include the values rolled up from
their "children".

In the Setup tab, under Job Properties - Benchmarking tab, you can select where this project will get
its historical data. You can set criteria and filters to just pull in certain account codes, certain project
data, and certain cost items. You can also configure the Benchmark graph here.

15.36.9 Account Code Assignment

An Account Code can be mapped to multiple CBS items, but a CBS item can only be mapped to one
Account Code. Assigning Account Code to cost items is done for benchmarking purposes. It is best
practice to assign account codes to cost items in the estimate phase rather than after the project is
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awarded and work begins. This is beneficial for tracking account codes over the life of the project (from
estimate to completion).

Typically every cost item should be assigned an account code whether it is a terminal cost item or
parent cost item.

Account Codes can be assigned directly on the individual cost item, job overhead, or pay item forms.

Step by Step — Assign an Account Code to a Cost Item

1. From the Ribbon, select the Estimate tab. Then select Cost Breakdown Structure (CBS).

2. Change the Saved Views to Account Code View.

3. Double click on a cost item that has not been assigned an account code.

4. In the Employment Setup section, click on the Cost Item Setup icon, and find Default Properties.
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5. Click the icon next to the Account Code field. From the Account Codes Register, select your
account code. Click OK. Once done, click OK.
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6. Find that cost item in the CBS. Notice that the Account Code field is now populated.

Estimate provides you with the ability to assign specific account codes to each pay item on the Pay
Item & Proposal Register.

Step by Step — Account Code Utililzation Register

1. From the Price tab, select Pay Item & Proposal.

2. From the Pay Item & Proposal Register, select a pay item.

3. Find the Account Code field for that item.
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4. Click the icon in the Account Code field.

5. Select an account code that you wish to assign to that pay item. Once done, click OK.
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6. Notice how the account code you selected is now populated in that pay item’s account code
field.
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15.37 SCOPE SHEETS

A scope sheet is a table of default values pertaining to different scope items within a quote group. It is
used to more easily compare quotes.

InEight Inc.  |  Release 19.2 Page 841 of 962

Estimate User Guide 15.37 Scope Sheets



Scope sheets can be created from the Foundation Setup Data Register - Quote Group Tag Record. You
can optionally define a default Amount or % of Total for each scope item.

This is the amount or percentage of total cost to be applied to the total quote if that Scope Item is not
included in the scope of a subcontractor/supplier quote. This amount or percentage can also be
entered or modified on each Quote Record.

Step by Step — Create a Scope Sheet

1. From the Ribbon, select the Setup tab. Under the Initialize section, select the Foundation Setup
Data drop down, and select Quote Group Tags.
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2. From the Quote Group Tags register, select Pipe Materials.

3. Select the Actions tab from the Ribbon. Then, under the Edit section, select Open.

4. Under Row Number, enter 1 in the first blank row.

5. Under Scope Item, enter 5” pipe.
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6. Under the Amount section, enter 1000.

7. Fill out the next row as row 2, 6” pipe, and 25 as the % of Total. Once done, click OK.

15.37.1 Scope Sheet Uses

On the Quote Record - Special Terms & Conditions tab, you can exclude any scope item that is not
included in the scope of a subcontractor/supplier quote. Any default amounts or percentages entered
in the Quote Group Tag Record default into this tab. You can enter or modify the Amount or % of
Total to be applied to the total quote due to the exclusion of the scope item.
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Step by Step — Exclude Scope

1. From the Ribbon, select the Quote tab. Under the Quote Management section, select Quotes.
The Quote Register opens.

2. From the Actions tab, under the Edit section, select New.

3. When the Attention dialog box shows, select Create Quote from Quote Group Tag(s). In the
Description, check the box next to Pipe Materials. Once done, click OK.
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4. Select the Special Terms & Conditions tab. Uncheck the Inclusions box for the 6” pipe.
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5. Enter the Amount for the 6” pipe as 1000.

6. Notice that the total quote price has adjusted.

7.
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15.38 SCOPE SHEETS

A scope sheet is a table of default values pertaining to different scope items within a quote group. It is
used to more easily compare quotes.

Scope sheets can be created from the Foundation Setup Data Register - Quote Group Tag Record. You
can optionally define a default Amount or % of Total for each scope item.

This is the amount or percentage of total cost to be applied to the total quote if that Scope Item is not
included in the scope of a subcontractor/supplier quote. This amount or percentage can also be
entered or modified on each Quote Record.

Step by Step — Create a Scope Sheet

1. From the Ribbon, select the Setup tab. Under the Initialize section, select the Foundation Setup
Data drop down, and select Quote Group Tags.

Page 848 of 962 InEight Inc.  |  Release 19.2

15.38 Scope Sheets Estimate User Guide



2. From the Quote Group Tags register, select Pipe Materials.

3. Select the Actions tab from the Ribbon. Then, under the Edit section, select Open.

4. Under Row Number, enter 1 in the first blank row.

5. Under Scope Item, enter 5” pipe.
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6. Under the Amount section, enter 1000.

7. Fill out the next row as row 2, 6” pipe, and 25 as the % of Total. Once done, click OK.

15.38.1 Scope Sheet Uses

On the Quote Record - Special Terms & Conditions tab, you can exclude any scope item that is not
included in the scope of a subcontractor/supplier quote. Any default amounts or percentages entered
in the Quote Group Tag Record default into this tab. You can enter or modify the Amount or % of
Total to be applied to the total quote due to the exclusion of the scope item.
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Step by Step — Exclude Scope

1. From the Ribbon, select the Quote tab. Under the Quote Management section, select Quotes.
The Quote Register opens.

2. From the Actions tab, under the Edit section, select New.

3. When the Attention dialog box shows, select Create Quote from Quote Group Tag(s). In the
Description, check the box next to Pipe Materials. Once done, click OK.
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4. Select the Special Terms & Conditions tab. Uncheck the Inclusions box for the 6” pipe.
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5. Enter the Amount for the 6” pipe as 1000.

6. Notice that the total quote price has adjusted.

7.
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15.39 QUOTE COMPARISON AND AWARD REPORTS

On the Quote Comparison & Award form, you can see the inclusions and exclusions related to all cost
items in the job that have quote groups assigned to them, as described in the Special Terms &
Conditions.

15.39.1 Reports

Scope sheets can be seen in two reports:

l Quote Record report

l Compare & Award report

Step by Step — Reports

1. From the Ribbon, click on the Quote tab. Select the Reports option. The Quote Record Report
window appears.

2. Under the Quotes drop down, select Quote Record. Select the Details tab. Check the box next to
Include Terms and Conditions. Once you are done, click Run.
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3. Notice how the scope sheet is shown in the report.
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4. Under the Quotes report drop down, select Compare and Award. Select the Details tab. Check
the box next to Include Scope Sheet. Once you are done, click Run.

5. Notice how the scope sheet is shown in the report.
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15.39.2 Minority Setup Types

Imagine you are a lead estimator and the job up for bid requires 15% minority participation or good
faith efforts. You will want to track this within the estimate to ensure that you are meeting this
requirement before executing the bid.

Minority Setup Types can be customized under the System tab and clicking on Customize.
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You can then select Minority setup under Titles and customize the minority names.
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You can select Minority setup under Colors and customized various minority types to help identify
them easily.

This enables you to recognize the Minority type of a vendor in registers such as Quote Comparison and
Award just by sight.
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You can select a Minority Business Enterprise to assign to the seller from the General Terms &
Conditions within the Quote Record.
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You can run a Minority Participation report to easily see the progress towards meeting the minority
participation goals for a project.
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15.39.3 Quote Comparison and Award Substitute Rankings

To compare quotes from different vendors where not all items are quoted, you can substitute values
using the lowest Awarded Splittable Quote for items rather than the un-awarded plug value. This
offers a more accurate comparison.
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15.40 BILLING RATES

In Estimate, the Billing Rate is defined as how much the Contractor is charging your client to utilize one
of your resources within the Resource Rate Register. The billing rate can also be viewed as how much
money that your client is expected to pay for utilizing one of the resources for a specified amount of
time. It’s important for you as a contractor to have a way to more quickly see your charge rate to
compare against what you will ultimately bill your client, also known as your Billing Rate.

Page 864 of 962 InEight Inc.  |  Release 19.2

15.40 Billing Rates Estimate User Guide



Contractors need a reliable way to price projects utilizing various markup strategies with clear visibility
into various costs that drive the markup amounts. It’s important for contractors to be able to:

l Apply various costs that drive markups

l Apply billing rate gains (difference between contractor’s cost vs billing rates/client cost)

l Have clear visibility into the true margin based on both cost and billing rates

l Compare the cost and billing rates within the CBS

As a result of properly pricing projects, contractors can now create and view various Billing Rate
Reports showing:

l A summary of billing rates in lieu of the cost rates for a client to see, Estimate Summary reports

l Cost item breakdown that shows associated cost categories, billing unit rates, and total billing
amounts, Billing Rate Summary

l An analysis of reources and their margins, utilization counts and billing amounts,Margin
Analysis report

15.40.1 Charge Rate

The Charge Rate is the contractor’s cost for a resource. These costs include actual labor, any types of
fringes, labor taxes plus insurances, and more. These costs are all tracked within the Charge Rate’s Cost
Category Breakdown in a resource rate. The charge rate is not a cost to the client and does not include
any profit, markup or overhead. Charge Rates can be setup for a resource by going to the Setup tab
and selecting Resource Rates. Then opening a resource rate record, and selecting the Charge Rate tab.
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15.40.2 Billing Rates Setup

Billing Rates have 3 scales where you can determine the appropriate billing and markups rates.

l Scale 1 – regular time

l Scale 2 – overtime

l Scale 3 – double time

You can enter a billing rate markup as a dollar amount in the Billing Rate Markup field or as a
percentage in the Billing Rate Markup % field. After double clicking a resource rate, you will see the
resource record.

The Billing Rate tab includes the following fields.

Name Description

1. Charge Rate
The amount of money it costs a contractor to
occupy a resource. Also known as the
contractor’s cost.
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Name Description

2. Billing Rate The amount a contractor charges a client to
utilize a resource rate. The billing rate can also
be viewed as how much money the client is
expected to pay for utilizing one of those
resources for a specified amount of time.

3. Billing Rate
Markup

The dollar value amount of profit added to the
charge rate that a contractor generally
determines. This can include certain contractor
fees that the contractor has deemed to include.

4. Billing Rate
Markup %

The percent dollar value amount of profit added
to the charge rate that a contractor generally
determines. This can include certain contractor
fees that the contractor has deemed to include.

The below example shows a contractor’s Charge Rate of $27.48 in Scale 1. The Billing Rate Markup is
45% of the $27.48 Charge Rate, which is a $12.37 Billing Rate Markup. The total Billing Rate is $39.84,
which is the price the contactor would charge a client.
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Step by Step — Billing Rate Setup

1. Use the Training Job for this example. From the Ribbon, select the Setup tab.

2. Under the Resources tab, select the Resource Rates drop down arrow. Then select Labor. The
Resource Rate Register opens to the Labor tab.

3. Select the LW WELDERDWelder Resource Code from the list. Then select the Actions tab. Under
the Edit section, select Open.

4. After the Labor Rate Record opens, select the Billing Rate tab.

5. Change the Billing Rate Markup % to 15 for Scale 1, then tab out of the field.
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l The system automatically calculates the Billing Rate Markup field to $6.38.

l This represents 15% of the Charge Rate.

l The Billing Rate is now equal to the Charge Rate plus 15%.

6. Change the Billing Rate Markup to $14.68 for Scale 2.

l The Billing Rate Markup % is now 23% and the Billing Rate is now $78.51.

l Scale 1 Charge Rate of $42.56 plus (half of $42.56) $21.28 equals a Scale 2 rate of $63.83.

l Scale 2 rate of $63.83 plus 23% equals a billing rate of $78.51
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15.40.3 Cost vs. Billing View

The Detail tab in a Cost Item record lets you compare the Unit Cost (charge rate) against the client’s
Billing Unit Rate.

To view the Cost vs. Billing View within a Cost Item record, select a cost item record, click on the Detail
tab, then select the Billing Rates View.

The Detail tab includes the following fields.

Name Description

1. Unit Cost
This is the contractor’s cost for this resource rate,
also known as the Charge Rate.

2. Billing Unit Rate The amount a contractor charges a client to
utilize a resource rate, also known as the Billing
Rate.

3. Total Cost
(Forecast)

This is the Unit Cost multiplied by the number of
hours utilized.

4. Total Billing
Amount

This is the Billing Unit Rate multiplied by the
number of hours utilized.

l Below is an example of how to view the Cost vs. Billing View when the Production Days are equal
to 1.

l The Unit Cost (Charge Rate) and the Billing Unit Rate values both values derive from your
Resource Rate.
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Step by Step — CBS Cost vs. Billing View

1. From the Ribbon, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS). The Cost Breakdown Structure (CBS) Register opens.

3. Create a cost item called Fabrication Work. Double click on the new cost item to open it.

4. Select the Detail tab. Then select LWD Welder from the Code field.

5. Go to the Production default data block. In the Days field, enter in 1.
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6. You are now able to compare your Total Cost against the Billing Rate. Your Total Cost is $226.96
for 8 hours, while you Total Billing rate to the client is $317.74.

15.40.4 Billing Rate Reports

There are several reports you can run to view resource costs, billing rates, and mark-ups. Some of
these reports you may choose to provide to your customer. Other reports, you may choose to use only
as a way to view your markup margins prior to submitting to your customer.

To locate these reports, select the Setup tab. Then select Reports. From the Reports window, select
Billing Rate Reports.

15.40.4.1 Billing Rate Summary report

The Billing Rate Summary report shows cost items including cost category details.
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The end of the report shows you a total of your Direct and Indirect cost markups, and also includes a
Total Billing Amount at the bottom far right.

15.40.4.2 Estimate Details with Billing Rate report

The Estimate Details with Billing Rate report shows a selection of resources with associated billing rates
and utilization counts.
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15.40.4.3 Margin Analysis report

The Margin Analysis report is beneficial for displaying both mark-up and margin values for selected
resource rates.

15.41 BILLING RATES

In Estimate, the Billing Rate is defined as how much the Contractor is charging your client to utilize one
of your resources within the Resource Rate Register. The billing rate can also be viewed as how much
money that your client is expected to pay for utilizing one of the resources for a specified amount of
time. It’s important for you as a contractor to have a way to more quickly see your charge rate to
compare against what you will ultimately bill your client, also known as your Billing Rate.

Contractors need a reliable way to price projects utilizing various markup strategies with clear visibility
into various costs that drive the markup amounts. It’s important for contractors to be able to:

l Apply various costs that drive markups

l Apply billing rate gains (difference between contractor’s cost vs billing rates/client cost)

l Have clear visibility into the true margin based on both cost and billing rates

l Compare the cost and billing rates within the CBS

As a result of properly pricing projects, contractors can now create and view various Billing Rate
Reports showing:

l A summary of billing rates in lieu of the cost rates for a client to see, Estimate Summary reports

l Cost item breakdown that shows associated cost categories, billing unit rates, and total billing
amounts, Billing Rate Summary

l An analysis of reources and their margins, utilization counts and billing amounts,Margin
Analysis report
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15.41.1 Charge Rate

The Charge Rate is the contractor’s cost for a resource. These costs include actual labor, any types of
fringes, labor taxes plus insurances, and more. These costs are all tracked within the Charge Rate’s Cost
Category Breakdown in a resource rate. The charge rate is not a cost to the client and does not include
any profit, markup or overhead. Charge Rates can be setup for a resource by going to the Setup tab
and selecting Resource Rates. Then opening a resource rate record, and selecting the Charge Rate tab.

15.41.2 Billing Rates Setup

Billing Rates have 3 scales where you can determine the appropriate billing and markups rates.

l Scale 1 – regular time

l Scale 2 – overtime

l Scale 3 – double time

You can enter a billing rate markup as a dollar amount in the Billing Rate Markup field or as a
percentage in the Billing Rate Markup % field. After double clicking a resource rate, you will see the
resource record.
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The Billing Rate tab includes the following fields.

Name Description

1. Charge Rate
The amount of money it costs a contractor to
occupy a resource. Also known as the
contractor’s cost.

2. Billing Rate The amount a contractor charges a client to
utilize a resource rate. The billing rate can also
be viewed as how much money the client is
expected to pay for utilizing one of those
resources for a specified amount of time.

3. Billing Rate
Markup

The dollar value amount of profit added to the
charge rate that a contractor generally
determines. This can include certain contractor
fees that the contractor has deemed to include.

4. Billing Rate
Markup %

The percent dollar value amount of profit added
to the charge rate that a contractor generally
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Name Description

determines. This can include certain contractor
fees that the contractor has deemed to include.

The below example shows a contractor’s Charge Rate of $27.48 in Scale 1. The Billing Rate Markup is
45% of the $27.48 Charge Rate, which is a $12.37 Billing Rate Markup. The total Billing Rate is $39.84,
which is the price the contactor would charge a client.

Step by Step — Billing Rate Setup

1. Use the Training Job for this example. From the Ribbon, select the Setup tab.

2. Under the Resources tab, select the Resource Rates drop down arrow. Then select Labor. The
Resource Rate Register opens to the Labor tab.
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3. Select the LW WELDERDWelder Resource Code from the list. Then select the Actions tab. Under
the Edit section, select Open.

4. After the Labor Rate Record opens, select the Billing Rate tab.

5. Change the Billing Rate Markup % to 15 for Scale 1, then tab out of the field.

l The system automatically calculates the Billing Rate Markup field to $6.38.

l This represents 15% of the Charge Rate.

l The Billing Rate is now equal to the Charge Rate plus 15%.
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6. Change the Billing Rate Markup to $14.68 for Scale 2.

l The Billing Rate Markup % is now 23% and the Billing Rate is now $78.51.

l Scale 1 Charge Rate of $42.56 plus (half of $42.56) $21.28 equals a Scale 2 rate of $63.83.

l Scale 2 rate of $63.83 plus 23% equals a billing rate of $78.51

15.41.3 Cost vs. Billing View

The Detail tab in a Cost Item record lets you compare the Unit Cost (charge rate) against the client’s
Billing Unit Rate.
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To view the Cost vs. Billing View within a Cost Item record, select a cost item record, click on the Detail
tab, then select the Billing Rates View.

The Detail tab includes the following fields.

Name Description

1. Unit Cost
This is the contractor’s cost for this resource rate,
also known as the Charge Rate.

2. Billing Unit Rate The amount a contractor charges a client to
utilize a resource rate, also known as the Billing
Rate.

3. Total Cost
(Forecast)

This is the Unit Cost multiplied by the number of
hours utilized.

4. Total Billing
Amount

This is the Billing Unit Rate multiplied by the
number of hours utilized.

l Below is an example of how to view the Cost vs. Billing View when the Production Days are equal
to 1.

l The Unit Cost (Charge Rate) and the Billing Unit Rate values both values derive from your
Resource Rate.
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Step by Step — CBS Cost vs. Billing View

1. From the Ribbon, select the Estimate tab.

2. Select Cost Breakdown Structure (CBS). The Cost Breakdown Structure (CBS) Register opens.

3. Create a cost item called Fabrication Work. Double click on the new cost item to open it.

4. Select the Detail tab. Then select LWD Welder from the Code field.

5. Go to the Production default data block. In the Days field, enter in 1.

6. You are now able to compare your Total Cost against the Billing Rate. Your Total Cost is $226.96
for 8 hours, while you Total Billing rate to the client is $317.74.
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15.41.4 Billing Rate Reports

There are several reports you can run to view resource costs, billing rates, and mark-ups. Some of
these reports you may choose to provide to your customer. Other reports, you may choose to use only
as a way to view your markup margins prior to submitting to your customer.

To locate these reports, select the Setup tab. Then select Reports. From the Reports window, select
Billing Rate Reports.

15.41.4.1 Billing Rate Summary report

The Billing Rate Summary report shows cost items including cost category details.

The end of the report shows you a total of your Direct and Indirect cost markups, and also includes a
Total Billing Amount at the bottom far right.
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15.41.4.2 Estimate Details with Billing Rate report

The Estimate Details with Billing Rate report shows a selection of resources with associated billing rates
and utilization counts.

15.41.4.3 Margin Analysis report

The Margin Analysis report is beneficial for displaying both mark-up and margin values for selected
resource rates.
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15.42 BILLING RATES REPORTS OVERVIEW

15.42.1 Cost Item Summary

The Cost Item Summary tab in a Cost Item Record, allows the estimator to add additional costs to the
Resource Billing rates by a percentage or amount. For example, there may have been extra work that a
percentage would apply that the owner approves. The Billing reports then lists these for the owner.

The following screen shot shows cost item 3.1 with the adjustment. To see the adjustment, select the
Actions tab and under the View section, use the Display Billing Rate toggle to display the Billing Rate
columns.

Review the two columns Total Billing Amount and Unadjusted Total Billing Amount.
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The following screen shot is the estimate details with Billing Rates report for the 3.1 cost item.
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15.42.2 Dependent Cost Items

You can use dependent cost items with billing work. For example, the Contractor may have an
agreement with the Owner to add additional overhead costs as a percentage of the work or the Owner
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allows a contingency for unknown work.

The following screen shot is an example of using a dependent cost item with billing work.

The following screen shot is a sample report that includes the dependent cost item with billing work.
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15.42.3 Additional Markup in the PBS form

Depending how the Resource Billing Rates are determined, to accommodate the Owner, a fee can be
applied using the PBS form.

The screen shot is a sample markup for Direct Costs in the PBS form.
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The following screen shot is of a sample report that includes that fee total of the additional markup.
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15.43 ESTIMATE SOFTWARE PREREQUISITES

15.44 ESTIMATE SOFTWARE COMPATIBILITY

This document is subject to change at any time. This document only covers software
directly compatible with InEight Estimate. InEight does not assume the responsibility to
verify or guarantee whether any third-party software is compatible with any other third-
party software (e.g. MS SQL Server 2005 compatibility with Windows Server 2012R2).

Qualified = Supported: You can get support for both Qualified and Compatible platforms from InEight.

Qualified platform : The platforms listed in the qualified category have been systematically tested
by InEight as part of the release covered by the InEight Estimate Compatibility document.

Compatible platform : The platforms listed in the compatible category have not been systematically
tested by InEight, in this release, but based on testing in previous releases, and knowledge of the
platform, InEight expects that the functionality will work and will fully support these platforms.

Unsupported : The platform listed is not supported.
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Before installing/upgrading the Server/Network version of Estimate, please check with
your IT or Administrator to confirm the version of Estimate your company is currently
running and the version your company will upgrade to. The Server version of Estimate
MUST match the client versions on the workstations.

15.44.1 Compatibility Matrix
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15.44.2 Legend Index

These numbers are outlined in blue in the Matrix.

1 – Microsoft has ended support for this OS. It is no longer supported by InEight.

2 – Not all versions of Windows 10 are tested. Only versions supported by Microsoft are supported by
InEight.

3 – InEight Estimate has not been tested against newer versions of .NET.

4 – The installed version of Office 365 has not been tested but is compatible.

5 – InEight Estimate does not support Home editions of Microsoft Windows.
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15.45 MINIMUM SYSTEM REQUIREMENTS

Estimate uses specific versions of SQL, Windows, and other third party software such as Microsoft
Excel for basic functionality. To install the latest version of Estimate, you will first need to confirm the
minimum requirements needed to run Estimate on your machine.

Before installing/upgrading the Server/Network version of Estimate, please check with
your IT or Administrator to confirm the version of Estimate your company is currently
running and the version your company will upgrade to. The Server version of Estimate
MUST match the client versions on the workstations.

15.45.1 Application (Estimate Server)

Minimum Recommended
CPU- Dual-Core Processor w/ 2.0 GHz (x86/x64) Quad-Core Processor w/ 3.0 GHz (x86/x64)
Storage - 100 GB hard-disk space ₁  N/A
Memory - 4 GB RAM ₁  8 GB RAM ₁ 
Display - 1024x768 32-Bit Color 1920x1080 32-Bit Color
Software - Windows 2012 Server with latest service pack,
Windows 2012 R2 Server with latest service pack,
Windows 2016 Server with latest service pack, or
Windows 2019 Server with latest service pack
.NET Framework 4.76 ₄

N/A

15.45.1.1 Workstation (Estimate Server)

Minimum Recommended

CPU- Dual-Core Processor w/ 2.0 GHz (x86/x64)
Quad-Core Processor w/ 3.0 GHz
(x86/x64)

Storage - 50 GB hard-disk space ₁  N/A
Memory - 4 GB RAM ₁  16 GB RAM ₁ 
Display - 1024x768 32-Bit Color 1920x1080 32-Bit Color
Other - Network/internet connectivity
Internet connection required for web- based modules and/or
synchronization

N/A

Software - Windows 8.1 Professional, Ultimate, or Enterprise (32- N/A
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bit and 64-bit₂) Windows 10 Professional or Enterprise (32- bit and
64-bit₂) .NET Framework 4.7

15.45.1.2 Database (SQL Server)

Minimum Recommended
CPU- Dual-Core Processor w/ 2.0 GHz (x86/x64) N/A
Storage -250 GB hard-disk space ₁  N/A
Memory - 4 GB RAM ₁  N/A
Display - 1024x768 32-Bit Color N/A
Software - Windows 2012 – 2019 Server with latest service pack,
and
SQL Server 2012 Standard & Enterprise, or Express (32-bit and 64-
bit), or
SQL Server 2014 Standard & Enterprise, or Express₃ (32-bit and 64-
bit), or
SQL Server 2016 Standard & Enterprise, or Express₃, or
SQL Server 2017 Standard & Enterprise, or Express₃, or
SQL Server 2019 Standard & Enterprise, or Express₃

N/A

15.45.1.3 Web

Minimum Recommended
CPU- Dual-Core Processor w/ 2.0 GHz (x86/x64) N/A
Storage -25 GB hard-disk space ₁  N/A
Memory - 4 GB RAM ₁  N/A
Display - 1024x768 32-Bit Color N/A
Software - Windows 2012 - 2019 Server with latest service pack, and
IIS (Internet Information Services) 7.0, or 7.5
.NET Framework 4.7

N/A

1. Additional RAM, and/or hard disk space may be required based on load and amount of data
2. Beginning with HD PCM version 10.0, support is provided for 64-bit operating systems
3. Additional web servers, processors, RAM, and/or hard disk space may be required based on load
and amount of data.
4. Additional processors, RAM, and/or hard disk space may be required based on load and amount of
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data.
5. SQL Server 2014 requires Windows 7 or later.
6. .NET 4.7 Requires Windows 8.1 Professional/Ultimate/Enterprise, Windows 10
Professional/Enterprise w/ Anniversary Update

IA64 operating systems are not currently supported.

15.45.1.4

LESSON 15 — INSTALLING ESTIMATE

15.1 Upgrade an existing Estimate Standalone Client 896
15.2 Upgrade an existing Estimate Server 898
15.3 Upgrade an existing HDExecute Database 899
15.4 Migrating Estimate to a Different Server 900

15.4.1 Detach Estimate Databases on old server 900
15.4.2 Attach Estimate Databases on new server 900
15.4.3 Manually Attach the HDLibrary and BidMaster Databases 902

15.5 Estimate System Requirements 902
15.5.1 Verifying the new Estimate Version 902
15.5.2 Planning the Estimate Installation 903
15.5.3 Installation Requirements 905

15.6 Installing the Estimate Server 906
15.7 Share Attachment Folder with Network Users 907
15.8 Install Estimate License Server 908
15.9 Install Estimate Standalone Client 909

15.1 UPGRADE AN EXISTING ESTIMATE STANDALONE
CLIENT

An upgrade install of an existing Estimate Standalone client application must be performed on all client
workstations where the current Estimate application is installed.
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If you have multiple Estimate client applications installed on the same workstation, all applications can
be upgraded at the same time.

When upgrading an existing Estimate installation, security permissions for the InEight
Estimate folder in the installation path C:\Program Files\InEight\InEight Estimate are
automatically set to grant full control to all authenticated users.

Use the following step-by-step at the workstation where the Estimate Standalone client application is
installed.

Step by Step — Upgrade existing Standalone Client

1. Start Windows as you normally would and exit out of any programs that are currently running.

2. Launch the Estimate installer downloaded from the InEight website.

3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make
changes to your computer.

4. On the Installation Package screen, click Install to continue.

5. Click Install Estimate to continue.

6. At the License Agreement screen, select the I Accept the Agreement check box. Then, click
Continue.

7. At the Upgrade or Install screen, select the Upgrade or Repair radio button. Then click Next to
continue.

8. Click Next to start the upgrade process.

9. At the Ready to Install screen, click Install to continue.

10. Follow the prompts to upgrade all installed applications.

11. At the Installation Summary screen, click Next to continue.

12. Click Finish to complete the installation, and then exit the setup program.

Repeat these steps as needed on all client workstations that has the Estimate Standalone client
application installed.
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15.2 UPGRADE AN EXISTING ESTIMATE SERVER

Use the following instructions to upgrade your existing Estimate server application. If you have
multiple Estimate server applications installed on the same server, all applications can be upgraded at
the same time.

All existing installations of the Estimate server applications must be upgraded.

Use the following step-by-step at the server console where the Estimate server application is installed.

Before installing/upgrading the Server/Network version of Estimate, please check with
your IT or Administrator to confirm the version of Estimate your company is currently
running and the version your company will upgrade to. The Server version of Estimate
MUST match the client versions on the workstations.

Step by Step — Upgrade existing Server

1. Start Windows as you normally would and exit out of any programs that are currently running.

2. Launch the Estimate installer downloaded from the InEight website.

3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make
changes to your computer.

4. On the Installation Package screen, click Install to continue.

5. Click Install Estimate to continue.

6. At the License Agreement screen, select the I Accept the Agreement check box. Then click
Continue.

7. At the Upgrade or Install screen, select the Upgrade or Repair radio button. Then click Next to
continue.

8. At the Components screen, you a list of all client applications currently installed on the server
appears. Click Next to start the upgrade process.

9. Follow the prompts to upgrade all currently installed applications.

10. At the Select Additional Tasks dialog under Additional Shortcuts, select Desktop/Quick Launch
shortcut. Select Next to continue.

11. Follow the prompts to upgrade all currently installed applications.
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12. At the Installation Summary screen, click Next to continue.

13. Click Finish to complete the installation, then exit the setup program.

Repeat these steps as needed on all servers that have the Estimate server applications installed.

15.3 UPGRADE AN EXISTING HDEXECUTE DATABASE

Use the following instructions to update your existing HDExecute database.

All existing installations of the HDExecute database must be upgraded. Any Estimate
server applications must be upgraded prior to upgrading the HDExecute database. In
addition, the Estimate client and all library data must be upgraded prior to upgrading the
HDExecute database.

Use the following step-by-step at the database server console where the HDExecute database is
installed.

Step by Step — Upgrade existing HDExecute Database

1. Start Windows as you normally would and exit out of any programs that are currently running.

2. Launch the Estimate installer downloaded from the InEight website.

3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make
changes to your computer.

4. On the Installation Package screen, click Install to continue.

5. Click Install Databases to continue.

6. At the License Agreement screen, select the I Accept the Agreement check box. Then click
Continue.

7. At the Install Databases screen, define the Database Selection by selecting the radio button of
the preferred database.

8. On the Install Databases screen, define the SQL Server Instance a by selecting it from the drop
down list.

9. Determine the SQL Authentication login and password. The default for both the login and
password is bidbuilduser.
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10. On the Install Databases screen, define the Jobs/Databases Folder Path by selecting the Browse
button.

11. Select Create to continue.

12. At the Confirm Connection Settings screen, select Yes to continue.

13. At the Create Database Results screen, select OK to complete the upgrade and exit the setup.

15.4 MIGRATING ESTIMATE TO A DIFFERENT SERVER

SQL Management Studio needs to be installed on the new server.

15.4.1 Detach Estimate Databases on old server

Use the following step-by-step at the old server to detach Estimate Databases.

Step by Step — Detach Estimate Databases

1. On the old server, open the Services Manager by going to Control Panel and selecting
Administrative Tools.

2. Select Services. Stop the InEight Estimate Server service.

3. Go to C:\Program Files\InEight\InEight Estimate and run the Detach Utility to detach any existing
Estimate databases.

l If any Estimate databases are attached, select the check box next to the databases. Then
select Detach Selected Databases.

l The status then changes to Detached.

4. Select Exit to close the Detach Utility.

If you have databases for other products installed on the same SQL database
instance as Estimate, DO NOT use the Detach Utility to detach these databases.
Consult with a Database Administrator or the other products' vendors for guidance.

15.4.2 Attach Estimate Databases on new server

Use the following step-by-step at the old server to attach Estimate Databases.
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Step by Step — Attach Estimate Databases

1. On the new server, install InEight Estimate Server.

If you are installing Estimate version 15.0 or later, SQL Express 2014 is included.
You have the option to install the database engine when installing Estimate. If you
did not choose to install the database engine while installing Estimate, then install
SQL.

2. Open the Services Manager by going to Control Panel and selecting Administrative Tools.

3. Select Services. Stop the InEight Estimate Server service.

4. Go to C:\Program Files\InEight\InEight Estimate and run the Detach Utility to confirm no existing
Estimate databases are attached.

l If any Estimate databases are attached, select the check box next to the databases. Then
select Detach Selected Databases.

l The status then changes to Detached.

5. Select Exit to close the Detach Utility.

6. Go to C:\Program Files\InEight\InEight Estimate and rename the Jobs folder to Jobs.old.

7. Copy the Jobs folder from the old server to the new server into the following folder path
C:\Program Files\InEight\InEight Estimate.

You should now have two Job folders appear in the InEight Estimate folder on the new server.
The new Jobs folder labeled Jobs, and the second labeled Jobs.old. The Jobs folder should have
all of your Estimate data in it.

8. Delete the BidMaster_Log.ldf file from the following path, C:\Program Files\InEight\InEight
Estimate\Jobs.

9. Delete the HDLibrary_Log.ldf file from the following path, C:\Program Files\InEight\InEight
Estimate\Jobs\HDLibrary.

10. Open the Estimate Configuration Tool.

11. Go to the Control Panel and select Administrative Tools.

12. Select Services. Start the InEight Estimate Server service.

13. Open InEight Estimate and when prompted, click OK to upgrade your existing job(s) and Library
data.
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15.4.3 Manually Attach the HDLibrary and BidMaster Databases

Use the following step-by-step if the InEight Estimate Server service does not start.

Step by Step — Manually Attach the HDLibrary and BidMaster Databases

1. Start the SQL Management Studio.

2. Connect to the instance name used for Estimate.

3. Right-click the database folder and select Attach.

4. Go to the Jobs folder, C:\Program Files\InEight\InEight Estimate\Jobs.

5. From the root of the InEight Estimate\Jobs folder, select BidMaster_Data.mdf and attach it.

6. Go to the HDLibrary folder, C:\Program Files\InEight\InEight Estimate\Jobs\HDLibrary.

7. From the Estimate\Jobs\HDLibrary sub-folder, select HDLibrary_Data.mdf and attach it.

8. In Services, select InEight Estimate Server.

9. Select Restart to restart the InEight Estimate service.

15.5 ESTIMATE SYSTEM REQUIREMENTS

Listed on our website are the Compatibility and Minimum System Requirements topics. Any software
versions not listed on those articles are to be assumed incompatible with Estimate unless explicitly
stated elsewhere in the InEight software documentation.

Estimate will not function on any Home Editions of MS Windows, nor any version of
Apple Mac OS.

15.5.1 Verifying the new Estimate Version

Before you install the latest version of Estimate, you need to confirm you are installing your company’s
recommended version of Estimate.
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Step by Step — Verifying Estimate version

1. Select the System tab.

2. Select the About Estimate option under the Help section.

15.5.2 Planning the Estimate Installation

To install Estimate, you must determine the client and server components necessary. You will also
need to determine where the components will reside on the servers and workstations. Standalone
installations reside on a single workstation. Smaller network installations typically employ one or a few
servers along with a collection of workstations, each supporting one client. Large Enterprise
installations require numerous, dedicated servers determined by CPU, network, database and storage
needs. Most server components must be installed on systems that reside on a single, protected
network. A few server components interact with workstations located across LAN/WAN boundaries.
Installation of these components requires extra diligence considering system and network traffic
exposure.

Administrative credentials are required to install, repair or upgrade any Estimate component.

Product licensing controls how modules operate but does not limit installation. Activation or changes
to licensing may require administrative elevation. It is recommended that one obtain suitable licensing
prior to starting the installation process.

15.5.2.1 Client Applications

Estimate Standalone Client - An isolated client whose executables and data reside on a single
workstation. Standalone installation includes an option that may be used to install SQL Server Express
Edition. While a more capable installation of SQL Server may be substituted, it is typically not
necessary. Standalone clients do not interact with network-based Estimate services. A minimum
standalone installation consists of 1) the Standalone Client and 2) Microsoft SQL Server Express. One
host running Windows Professional is required.

Administrators should understand that the Standalone and Network Client installations are just two
modes of operation. Differences lie in where user data is located and how that data may be shared. In
the case of Standalone operation, all data and licensing must be constrained to the system where the
client is installed. No user data is shared or synchronized.
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Diligence must be exercised when transitioning a workstation between Network and
Standalone modes of operation. The SQL Server instances involved inherently differ. User
data that resides on one SQL Server instance must be manually taken offline, moved and
later returned by a system administrator. Estimate makes no provisions for synchronizing
user data during such changes. Incorrect actions taken may lead to a loss or overwrite of
critical data. There is no magic undo pill, but Estimate does offer backup and archival
functionality that one should always use before venturing down this path.

One or both of the following are required for multi-user, Estimate implementations:

l Network Client is a full installation on each user’s workstation, interacting via one
EstimateServer.

l Remote Client fetches and dynamically installs Network client executables from one or
moreEstimate Servers upon Remote client launch. If multiple servers are employed, they may
bedifferent versions of InEight Estimate.

Estimate Network Client - A full, client whose purpose is to interact with Estimate Server and License
Server, accessing advanced functionality and sharing data with other clients. Network Client
installations do not need SQL Server locally installed on the client workstation. As such, no option to
install SQL Server Express is provided when installing the Network Client.

User data resides with the Estimate Server or on a dedicated SQL Server accessed by Estimate Server.
The Network Client never directly interacts with SQL Server.

Network Clients authenticate with the Estimate License Server (a Windows Service) upon launch. A
minimum network installation consists of 1) the Network Client, 2) Estimate Server, 3) Estimate License
Server and 4) Microsoft SQL Server. Two to four hosts (or more) running Windows Professional or
Server are required.

15.5.2.2 Server Applications

Estimate Server - Facilitates collaborative use of Estimate clients. Interacts with SQL Server and
exposes Estimate clients to advanced functionality in a network environment. Network traffic to and
from Estimate Server is not encrypted nor has Estimate Server been hardened to support WAN-based
operation. It must be installed on a host that resides entirely within a protected LAN.

License Server - Facilitates management and distribution of Estimate module licenses when running
the Estimate application in a network environment. Network traffic to and from Estimate License
Server is not encrypted nor has Estimate License Server been hardened to support WAN-based
operation. It must be installed on a host that resides entirely within a protected LAN.
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It is recommended that the Estimate Server and License Server be installed on a
dedicated host to achieve optimal performance.

15.5.3 Installation Requirements

In addition to the Estimate installation package, what you’ll need depends upon the nature of your
license, whether you’ll be installing in a Standalone, Small Network or Enterprise network
environment. Enterprise installations can be quite complex and are not discussed in this document.

The Estimate Server is also required for Primavera Integration, Mobile Timesheets, and
the Data Warehouse.

When installing the Estimate Server, you will have the option to install SQL Server 2014 Express Edition
as the database for Estimate. You also have the option to not install SQL Server 2014 if you intend to
use an installation of the full SQL Server for Estimate. It is recommended that the Estimate Application
Server be a dedicated server for the Estimate application to achieve optimal performance.

Your client workstations and servers must meet or exceed the minimum system requirements. To view
the minimum system requirements, visit the support site and review theMinimum System
Requirements document.

Standalone Installation:

l Estimate Client (Standalone)

Small Network Installation:

l Estimate Server

l License Server

l Estimate Client (Network)

Enterprise Installation:

• Estimate Server

• License Server

• Estimate Client (Network or Remote)

InEight Inc.  |  Release 19.2 Page 905 of 962

Estimate User Guide 15.5 Estimate System Requirements



15.6 INSTALLING THE ESTIMATE SERVER

When installing the server application, security permissions for the INEIGHT ESTIMATE
folder in the installation path C:\Program Files\InEight\InEight Estimate are automatically
set to grant full control to all authenticated users.

Use the following step-by-step to install the Estimate Server.

Step by Step — Installing Estimate

1. Launch the Estimate installer downloaded from the InEight website.

2. At the User Account Control screen, click Yes to allow the InEight Estimate application to make
changes to your computer.

3. On the Installation Package screen, click Install to continue.

4. Click Install Estimate to continue.

5. At the License Agreement screen, select I Accept the Agreement. Then click Continue.

6. If other Estimate client or server applications have already been installed on the server, select
Install on the Upgrade or Install dialog and click Next to continue.

7. At the Components screen under User Workstation Components, select the Estimate Client
check box, then select the Network radio button.

8. On the Components screen under Enterprise Server Components, select the Estimate Server
check box.

9. If you intend to use SQL Server 2014 Express Edition as the database for Estimate, select Install
SQL Express Edition with HDBID instance.

10. If you choose not to use SQL Server 2014 Express Edition because you are using a different
edition or version of SQL Server instead, deselect the Install SQL Express Edition with HDBID
instance. If you don’t select this option, another version of SQL Server must be installed
manually.

11. Click Next to continue.

12. On the Select Destination Location screen, define the installation folder for the Estimate
Framework. To accept the default installation folder, you do not need to do anything. To define a
different installation folder, click on the Browse button and navigate to the desired folder.
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13. Click Next to continue.

14. On the Ready to Install screen, click Install to continue.

15. On the Installation Summary screen, click Next to continue.

16. Click Finish to complete the Estimate Server installation and Exit the setup program.

15.7 SHARE ATTACHMENT FOLDER WITH NETWORK
USERS

When running Estimate in network mode, if you want the ability to make a copy of attachment files
inside the Job Folder you will be required to set the appropriate Sharing and Security permissions for
the Attachments folder on the Estimate server C:\Program Files\InEight\InEight Estimate\Attachments.

You have the ability to define an attachments path other than the default path
C:\Program Files\InEight\InEight Estimate\Attachments.

Use the following step-by-step to share the attachment folder with other network users.

Step by Step — Sharing the Attachment folder

1. Using Windows Explorer, browse to the Attachments folder on the Estimate server machine
C:\Program Files\InEight\InEight Estimate\Attachments.

2. Right-click on the Attachments folder C:\Program Files\InEight\InEight Estimate\Attachments
and select Properties.

3. Select the Sharing tab.

4. Click Permissions, and then select Advanced Sharing.

5. Select the check box for Share this folder. Under Settings, you can change the default share
name, add comments, or limit the number of simultaneous users to a specific number of people.

6. Select Permissions under the Comments section. Select the Group or user names you would like
to share the Attachments folder with.

7. For the group or user names to which you want to provide access, select Full Control in the
Allow column under the Permissions for Everyone section.

8. On the Permissions for Attachments dialog, click Apply.
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9. On the Permissions for Attachments dialog, click OK.

10. Click on the Security tab.

11. For each group or user name make sure that Full Control is selected in the Allow column.

12. On the Attachments Properties dialog, click Apply.

13. On the Attachments Properties dialog, click OK.

15.8 INSTALL ESTIMATE LICENSE SERVER

The Estimate License Server can be installed on any machine connected to the network to which all
Estimate users have access. It can be, but does not need to be, installed on the same server that
contains the Estimate Server application. The Estimate License Server and the associated server service
must be running in order for users to access the licenses to the modules that you have purchased.

Use the following step-by-step at the computer or server console where the Estimate License Server
will be installed.

Step by Step — Installing Estimate License server

1. Start Windows as you normally would, then exit out of any programs that are currently running.

2. Launch the Estimate installer downloaded from the InEight website.

3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make
changes to your computer.

4. On the Installation Package screen, click Install to continue.

5. Click Install Estimate to continue.

6. At the License Agreement screen, select I Accept the Agreement. Then click Continue.

7. If other Estimate client or server applications have already been installed on the server, select
Install on the Upgrade or Install dialog. Then click Next to continue.

8. At the Components screen under Enterprise Server Components, select the Estimate License
Server check box. Click Next to continue.

9. At the Ready to Install screen, click Install to install the Estimate License Server.

10. After the Installation Summary screen appears, click Next to continue.
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11. At the Installation Summary screen, click Next to continue.

12. Click Finish to complete the Estimate License Server installation and exit the setup program.

To complete the Estimate License Server installation, you will be required to
activate your license. You can activate your license over the Internet or by
importing a license file. For additional instructions on activation, see the document
Activating the Estimate License.

15.9 INSTALL ESTIMATE STANDALONE CLIENT

The Estimate Standalone Client installation is installed when the primary purpose of the user is to work
with the Estimate client application, including web-based applications. A Standalone Client installation
includes the installation of a database engine (SQL Server 2014 Express Edition) which allows the client
to work in both a disconnected mode (not connected to a network) or connected mode.

When installing the standalone client application, security permissions for the INEIGHT
ESTIMATE folder in the installation path C:\Program Files\InEight\InEight Estimate are
automatically set to grant full control to all authenticated users.

Use the following step-by-step at each client workstation where the Estimate Standalone Client will be
installed.

Step by Step — Installing Estimate Standalone Client

1. Start Windows as you normally would, then exit out of any programs that are currently running.

2. Launch the Estimate installer downloaded from the InEight website.

3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make
changes to your computer.

4. On the Installation Package screen, click Install to continue.

5. Click Install Estimate to continue.

6. At the License Agreement screen, select I Accept the Agreement. Then click Continue.

7. If other Estimate client or server applications have already been installed on the server, select
Install on the Upgrade or Install dialog. Then, click Next to continue.
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8. At the Components screen under User Workstation Components, select the Estimate Client
check box, then select the Standalone radio button. Click Next to continue.

9. On the Select Destination Location screen, define the installation folder. To accept the default
installation folder, you do not need to do anything. To define a different installation folder, click
on the Browse button and navigate to the desired folder.

10. On the Ready to Install screen, click Install to continue.

11. On the Select Additional Tasks screen, select the additional shortcuts you would like to install
you’re your machine. Click Next to continue.

12. On the Installation Summary screen, click Next to continue.

13. Click Finish to complete the installation and exit the setup program.

LESSON 15 — INSTALLING SOFTWARE
COMPONENTS

LESSON 15 — DATA WAREHOUSE

15.1 Data Warehouse Prerequisites 910
15.1.1 Preparing for Installation of the Data Warehouse 911
15.1.2 Backup Considerations 911

15.2 Data Warehouse Security Considerations 912
15.2.1 Job Consolidation Settings Considerations 912

15.3 Installing the Job Consolidation Server 914

15.1 DATA WAREHOUSE PREREQUISITES

The Data Warehouse allows you to combine data from multiple, individual job databases into a single
database for reporting purposes. You select which jobs to include and whether you want to update the
Data Warehouse automatically when any of the selected jobs are saved, or manually at your discretion.
With the data consolidated into the Data Warehouse, you can then use Crystal Reports, Microsoft
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Access, or any other SQL-compatible reporting tool to create user-defined reports that span across
jobs.

The Data Warehouse requires three additional components to an existing Estimate network
environment:

l Database – On the database server, an additional database named HDWarehouse is created.
This database can become very large, and is a heavy consumer of system memory and disk I/O.
For optimal performance, the HDWarehouse database should reside on a SQL Server computer
separate from the SQL Server computer where Estimate jobs and the HDExecute database are
stored.

l Job Consolidation Server – On an application server, run the Job Consolidation Server installer to
set up the Job Consolidation Server.

l Job Consolidation – Runs as a service, connects as a client to the InEight Estimate Server, just as
Estimate users do when they run the main application. You can use the Data Warehouse feature
within the Estimate client application to select which jobs should be consolidated into the Data
Warehouse.

For optimal performance, the Job Consolidation Server should be installed on a dedicated server. It can
also be installed on the same application server where other Estimate services run. For example, the
License Server, the Timesheet Integration Server, or the InEight Estimate Server.

15.1.1 Preparing for Installation of the Data Warehouse

The Data Warehouse database should be installed after the main Estimate client/server application has
been installed. The installation and setup instructions that follow needs a functioning environment that
includes:

l An installation of the Estimate Server running the InEight Estimate Server service.

l An Estimate Database Server running full SQL Server 2005 – SQL Server 2017.

l An installation of the License Server running InEight Estimate License Server service.

A full SQL Server instance on a dedicated database server is required for the Data
Warehouse.

15.1.2 Backup Considerations

The Estimate client/server application has user initiated System Backup and Restore features. These
features are not appropriate for Estimate Enterprise implementations, where job and library databases
reside on a separate SQL Server, and additional databases exist for modules such as Mobile Timesheets
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and the Data Warehouse. After you install the Data Warehouse, you will need to rely on external
Backup/Restore software to back up Estimate database files.

15.2 DATA WAREHOUSE SECURITY CONSIDERATIONS

Estimate installations may span across multiple servers which must be able to communicate with one
other. For example:

l Services and Web applications require read & write access to databases.

l Services that attach and detach database files require the SQL Server sysadmin role.

l Services that start and stop SQL Server require the SQL Server sysadmin role.

l Services and Web applications require read access to folders where application files reside.

Every service and Web application is assigned an identity under which it runs.

l For a Service – the identity is defined on the Log On tab in the service’s Properties dialog box.

l For a Web Application – the identity is defined by assigning the application to an application
pool, and then defining the application pool’s identity in the pool’s Advanced Settings.

By default, services use identities that only have access to the local machine, such as the local System
account. Local accounts cannot access resources on other computers. Since Estimate components
must access resources (e.g., folders, files or service commands) on other computers, the default
identities for all Estimate services must be changed.

It is recommended that you create a single network account for Estimate in Active Directory, and use it
for all Estimate services. Give the account Log on as a service rights. On the Estimate SQL Server, add
this account as a SQL Login and grant it the sysadmin role.

For Estimate Web applications, use the ASP.NET v4.0 application pool or create a new one just like it,
and let that application pool use its own Application Pool Identity. Define credentials for accessing SQL
Server in the application’s web.config file.

15.2.1 Job Consolidation Settings Considerations

Consider these questions as a planning worksheet prior to installing the Data Warehouse.

Section Description

RW. 1
What is the name of the Estimate application server where the Job Consolidation service
will be installed?
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Section Description

RW. 2 What is the name of the computer where the InEight Estimate Server service runs?

RW. 3

What is the name of the database server computer where HDWarehouse will be stored?
This database can become very large, and is a heavy consumer of system memory and
disk I/O. For optimal performance, the HDWarehouse database should reside on a SQL
Server computer separate from the SQL Server computer where Estimate jobs and the
HDExecute database are stored.

RW. 4 What is the SQL Server instance name?

RW. 5

Do you want to allow the Job Consolidation service to attach the HDWarehouse database
if it becomes detached?
This requires sharing the data folder on the SQL Server, and giving access to the Job
Consolidation login identity. It also requires granting the sysadmin role, in SQL Server, to
this login identity.

RW. 5.1 If yes, share the data folder in advance, and document the share name. Permit the
Estimate network login Full Control.

RW. 5.2
If no, be aware that the Job Consolidation service will fail to start whenever
HDWarehouse is not attached. An error will appear in the JobConsolidationServer.log file.

RW. 6 Where will your Data Warehouse data be stored?
Create a folder to contain database data and log files. You will most likely want to select a
different location than the default application folder, because Estimate applications are
not likely to be installed on the database server.

RW. 6.1
What is the path to this data folder, from the database server’s perspective?
For example, if the files on the SQL Server are at C:\HD Data, then from the SQL Server’s
perspective, the path is exactly that: C:\HD Data.

RW. 6.2 What is the path to this data folder, from the application server’s perspective?
For example, if the files on the SQL Server are at C:\Estimate Data, and that folder is
shared as EstimateData, then from the application server’s perspective the file path is
\\<dbserver>\estimatedata.

RW. 7

How many jobs should the Job Consolidation server be allowed to update in the Data
Warehouse, at one time?
By default, Job Consolidation will update two jobs in one time. Other jobs wait in queue.
Larger jobs require more memory, so this setting can be adjusted according to the typical
size of your Estimate jobs, and according to how much memory is available on your Job
Consolidation server. The default is 2 (minimum 1, maximum 10).
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15.3 INSTALLING THE JOB CONSOLIDATION SERVER

The Job Consolidation Server is required for the Estimate Benchmarking feature and the Data
Warehouse database. The Job Consolidation Server can be installed on a dedicated server or on a
server that contains other Estimate applications.

When Job Consolidation is used to update the Data Warehouse, installing Job Consolidation on its own
server computer is strongly recommended.

Step by Step — Installing Job Consolidation Server

1. Start Windows as you normally would, and then exit out of any programs that are currently
running.

2. Launch the Estimate installer downloaded from the InEight website.

3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make
changes to your computer.

4. On the Installation Package screen, click Install to continue.

5. Click Install Estimate to continue.

6. At the License Agreement screen, select I Accept the Agreement. Then click Continue to
continue.

7. If other Estimate client/server applications have already been installed on the server, select
Install on the Upgrade or Install dialog box. Then click Next to continue.

8. At the Components screen under Enterprise Server Components, select the Job Consolidation
Server check box. Then click Next to continue.

9. If you are installing the Job Consolidation Server on a server where no other Estimate
applications are installed, at the Select Destination Location screen, define the installation folder
for the Job Consolidation Server.

To accept the default installation folder, you do not need to do anything. To define a different
installation folder, click the Browse button and navigate to the desired folder. Click Next to
continue.

10. Click Install to start the installation.

If you are installing the Job Consolidation Server on a dedicated server, the
Estimate Framework will also be installed.
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11. On the Configuration Tool dialog box, select the Network tab.

12. In the Server IP Address or DNS Name field, enter the name of the computer where the InEight
Estimate Server service runs.

Reference Job Consolidation Settings Considerations topic line RW.2.

13. Select the Job Consolidation tab.

14. Select the Enable Data Warehouse check box.

15. In the Maximum Concurrent Jobs field, choose the number of jobs that can be updated
concurrently in the Data Warehouse.

Reference Job Consolidation Settings Considerations topic line RW.7.

16. If applicable, check the box to Use Separate Database Server.

17. If applicable, in the Server Host Name field, enter the name of the database server computer
where the HDWarehouse database will be stored.

Reference Job Consolidation Settings Considerations topic line RW.3.

18. If applicable, in the Instance name field, enter the SQL Server instance name.

Reference Job Consolidation Settings Considerations topic line RW.4.

19. If preferable, in the Database Security data block. If you want the Job Consolidation Server
service to connect to the database using its runtime identity, select Use Window
Authentication.

Reference Job Consolidation Settings Considerations topic line RW.5.1 for the runtime identity.

20. If you prefer, go to the Database Security data block. If you want the Job Consolidation Server
service to connect to the database using SQL Server Authentication, un-check Use Window
Authentication and enter the database User Name and database User Password.

Reference Job Consolidation Settings Considerations topic line RW.5.2.

21. In the Data Warehouse Paths data block, enter the Server Data file path from a database server
perspective.

Reference Job Consolidation Settings Considerations topic line RW.6.1.

22. In the Data Warehouse Paths data block, enter the Local Data file path from a Job Consolidation
Server perspective.

Reference Job Consolidation Settings Considerations topic line RW.6.2.

23. Click OK to continue.
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24. At the Installation Summary screen, click Next to continue.

25. Click Finish to complete the installation and exit the setup program.

LESSON 15 — PRIMAVERA INTEGRATION

15.1 Setting up Primavera Integration 916
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15.5.1 Set Up a Named User for the Primavera Integration API (Primavera v6.x or P6 v7) 922
15.5.2 Set Up a Named User for the Primavera Integration API (P6 v8 – P6 v15.1) 922

15.6 Installing the Primavera Integration Server 923

15.1 SETTING UP PRIMAVERA INTEGRATION

Primavera integration with Estimate is supported with Primavera v6.x, P6 v7, and P6 v8 -
P6 v15.1. When installing and configuring Primavera, it is necessary that all Primavera
applications installed on your environment are the same version. This includes the
database server, client application, and Integration API.

Primavera integration with Estimate requires that you have an existing implementation of Primavera
v6.x or P6 in your network environment. This includes but is not limited to the following:

l A Microsoft SQL Server or Oracle Database for Primavera (Primavera Database Server).

l A named user license for the Primavera Integration API. (Contact Primavera to obtain this
license).

Prior to installing the Estimate Primavera Integration Server, you will be required to install additional
applications and define configuration settings to complete the integration with Estimate.
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15.1.1 Server Configuration and Setup

While all server components can be installed on the same physical server, they can also be installed on
separate servers. There can be three different servers when setting up the Primavera integration with
Estimate:

l Primavera Database Server – This server runs the Microsoft SQL Server or Oracle database
service and holds the Primavera Project Management (PM) database.

l Estimate Primavera Integration Server – This server contains the Java Developer’s Kit (JDK), the
Java Runtime Environment (JRE), Primavera Integration API, InEight Estimate Primavera
Integration Server service, Java .NET Bridge components, and the JNBridge license file.

l Estimate Server – This server contains the Microsoft SQL Server database instance for Estimate
(HDBID), and as a result, the Microsoft SQL Server HDBID service and the InEight Estimate Server
service.

The screenshot below shows how the Primavera Integration with Estimate would look if the
deployment method chosen were to occur on three separate servers.
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15.2 DETERMINE THE TCP/IP PORT NUMBER OF THE
PRIMAVERA DATABASE

The Estimate Primavera Integration connects to the Primavera database using a host name and port
number. You will need to know what port number to use in a later setup step.

Use the following step-by-step to view the Primavera TCP/IP Port Number.
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Step by Step — Find the TCP/IP Primavera Port Number

1. From the main Primavera client menu, choose Help.

2. Then select About.

3. Select the System tab.

4. Locate the Bre Database line.

Primavera v6.x and P6 v7 require Java Runtime Environment (JRE) version 1.4 or
above. P6 v8 - P6 v8.4 require the i586 version of the Java Developer’s Kit (JDK)
version 1.6.0_23 or above. The Primavera integration with Estimate will not
function correctly with older versions of Java.

5. The port number displays after the server (host) name and before the database instance name.

l In the following example, the port number for the Microsoft SQL Server Primavera
Database Server is 49251:

l BRE Database: com.microsoft.sqlserver.jdbc.SQLServerDriver,

jdbc:sqlserver://server1:49251;database=pmdb; 8.0, INTERNAL_PLUGINS)

l In this example, the port number for the Oracle Database Server is 1521:

l BRE Database: oracle.jdbc.driver.OracleDriver,

jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=Server2)

(PORT=1521))(CONNECT_DATA=(SERVER=DEDICATED)(SERVICE_NAME=XE))) (, 7.0,
INTERNAL_PLUGINS)

6. Take note of the port number. Then select Close to exit the About Primavera dialog box.

The integration of Primavera v6.x or P6 v7 with Estimate requires the Java Runtime
Environment (JRE) to be installed on the Primavera Integration Server machine. The
integration of P6 v8 - P6 v8.4 with Estimate requires the Java Developer’s Kit (JDK) to be
installed on the Primavera Integration Server machine. If you are running 64-bit
Windows, a 64-bit JDK is required. Install these files after following the previous step-by-
step.
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15.3 INSTALLING THE PRIMAVERA INTEGRATION API

The version of the Primavera Integration API application that is required for Primavera to interact with
Estimate depends on the version of the Primavera database server that you have installed. You must
install the same version of all Primavera components. For example, if you installed version 8.1 of the
P6 EPPM database server, you are required to install version 8.1 of the P6 EPPM Integration API.

The installation files for this application can be found on your Primavera installation
media.

Use the following step-by-step at the server console where the Estimate Primavera Integration Server
will be installed.

Step by Step — Install the Primavera Integration

1. Locate and start the setup.exe file on your installation media for the Primavera Integration API.

If you get the Media Pack from the Oracle e-delivery website, you will find the
Integration API in the Web Services download.

2. On the Welcome to the Primavera Integration API Installer screen, click Next to continue.

3. If prompted on the Software License screen, select I Agree. Click Next to continue.

4. On the Installation Type screen, select Local Mode Packages Only. Click Next to continue.

5. Browse to the location of where you want to install the Primavera Integration API.

6. On the Select Components screen, select both Demo Applications and Integration API Javadoc.

7. If prompted, specify the location of the JRE or JDK file that you installed. Click Next to continue.

l Example JRE Java.exe file location: C:\Program Files\Java\jre6\bin\java.exe

l Example JDK folder location: C:\Program Files\Java\jdk1.6.0_23

8. Click Next and then Install to continue the installation.

9. On the Database Configuration screen, select either Oracle orMicrosoft SQL as appropriate.
Click Next to continue.

10. In the User Name field, enter the Primavera database user name pubuser.

11. In the Password field, enter the Primavera database password pubuser.
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12. In the Database Name field, enter the Primavera database name pmdb or pmdb$primavera.

13. For Oracle, enter the SID name XE.

14. In the Database Host Address field, enter the IP address or DNS name of the server where the
Primavera database resides.

15. In the Database Port field, enter the port number you documented in the TCP IP Port Number
topic.

16. Click Next to continue.

17. If you have an existing Primavera database configuration, you can select the existing
configuration or create a new one. Click Next to continue.

18. Click Exit to complete the Primavera Integration API installation.

15.4 TIMEOUT SETTING AND EXPIRATION CHECK RATE

Use the following step-by-step at the server console where the Estimate Primavera Integration Server
will be installed.

Step by Step — Set the Timeout Setting

1. Browse to the Primavera Integration API [version No.] folder. Then select Primavera
Administrator.

2. Enter your privileged user name privuser for the Primavera database.

3. Enter your password privuser for the Primavera database and click OK.

4. On the Primavera Administrator form, select the Configuration tab.

5. Click the + icon to expand the Primavera P6 Configuration folder.

6. Click the + icon to expand the Services folder.

7. Clicking on the + icon to expand the License Service or Module Access Service.

8. Triple-click Epiration checkrate to edit it. Change the value to 30s.

9. Select another folder in the tree list to exit the field.

10. Further down the tree list, click the + icon to expand the Integration API Server folder and RMI
folder.
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11. Triple-click Session Timeout to edit it. Change the value to 24d.

12. Select another folder in the tree list to exit the field.

13. Click Save Changes located to the lower right of the form.

14. Click OK on the dialog box.

15. Click on the x in the upper right to close the Primavera Administrator.

15.5 CREATE A NAMED USER FOR PRIMAVERA
INTEGRATION API

15.5.1 Set Up a Named User for the Primavera Integration API
(Primavera v6.x or P6 v7)

Use the following step-by-step at the server console where the Estimate Primavera Integration Server
will be installed.

Step by Step — Set a Named User (P6 version 6.x or 7)

1. Launch Primavera Project Management. From the Primavera menu, select Admin, and then
Users to open the Users dialog box.

2. Highlight the Admin login name in the list of users.

You can also choose a special user designated for use by the Estimate Primavera integration. This
is the user that is specified in Job Properties for every job configured to send updates to
Primavera. You can avoid permission problems by making this user an Admin Super User. The
special user does not need access to any module besides the Integration API.

3. In the bottom portion of the dialog, select the Licensing tab.

4. Select the Named User check box in the Integration API row.

5. Click Close to exit the dialog box.

15.5.2 Set Up a Named User for the Primavera Integration API (P6 v8 –
P6 v15.1)

Use the following step-by-step in a web browser.

Page 922 of 962 InEight Inc.  |  Release 19.2

15.5 Create a named user for Primavera Integration API Estimate User Guide



Step by Step — Set a Named User (P6 v8 – v15.1)

1. Launch the Primavera P6 Web Application. At the top of the screen, choose Administer. Then
select User Access.

2. Highlight the Admin login name in the list of users.

You can also choose a special user designated for use by Estimate Primavera integration. This is
the user that will be specified in Job Properties for every job configured to send updates to
Primavera. You can avoid permission problems by making this user an Admin Super User. The
special user does not need access to any module besides the Integration API.

3. In the lower portion of the dialog box, view theModule Access tab.

4. Double-click the Access check box in the Integration API row.

5. Click Save.

15.6 INSTALLING THE PRIMAVERA INTEGRATION
SERVER

The Primavera Integration Server network component is required to allow for the dynamic integration
of Primavera with Estimate. The Primavera Integration Server can be installed on a dedicated server or
on a server that contains other Estimate applications.

Estimate supports manual configuration of the Primavera Integration API using admin.cmd to connect
to multiple Primavera databases. This advanced configuration allows a single Primavera Integration
Server to sync with more than one Primavera database.

Do not connect more than one Primavera Integration Server instance to the same
Primavera database.

If your enterprise uses multiple Primavera databases in locations distant from each other, it is better to
install multiple Primavera Integration Server services. Each must be installed on a different computer,
and you must give them unique instance names.

Java and the Primavera Integration API applications must be installed on each Primavera
Integration Server.

Use the following step-by-step at the server console where the Estimate Primavera Integration Server
will be installed.
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Step by Step — Install Primavera Integration Server

1. Start Windows as you normally would, and then exit out of any programs that are currently
running.

2. Launch the Estimate installer downloaded from the InEight website.

3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make
changes to your computer.

4. On the Installation Package screen, click the Install button to continue.

5. Click Install Estimate to continue.

6. At the License Agreement screen, select I Accept the Agreement. Then click Continue to
continue.

7. If other Estimate client or server applications have already been installed on the server, select
Install on the Upgrade or Install dialog. Then click Next to continue.

8. At the Components screen under Third Party Integration Components, select the Primavera
Integration Server check box, and then click Next to continue.

9. If you are installing the Primavera Integration Server on a server where no other Estimate
applications are installed, at the Select Destination Location screen, define the installation
folder where the Primavera Integration Server application will be installed.

l To accept the default installation folder, you do not need to do anything.

l To define a different installation folder, click on the Browse button and navigate to the
desired folder.

l Click Next to continue.

10. At the Ready to Install dialog, click Install to continue.

If you are installing the Primavera Integration Server network component on a
dedicated server, the Estimate Framework will also be installed.

11. On the Estimate Configuration dialog, select the Primavera Integration tab.

12. In the Paths data block:

l If you are using 32-bit Windows: Click the Find Paths button. Define the paths to the Java
Virtual Machine DLL file and the Primavera Integration API Folder.
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In the event that either of the paths is not defined after clicking on the Find
Paths button, you can click on the browse button next to each path field to
browse to the appropriate location.

l If you are using 64-bit Windows: Click on the Find Paths button. Define the path to the
Primavera Integration API Folder. Then define your path for the Java Virtual Machine DLL
by browsing to the jvm.dll file.

Your path for the Java Virtual Machine DLL will be similar to C:\Program
Files\Java\jre6\bin\server\jvm.dll. With the Java JDK installed, your path for
the Java Virtual Machine DLL will be similar to C:\Program
Files\Java\jdk1.7.0_45\jre\bin\server\jvm.dll.

13. In the Java data block, define the maximum memory setting from the Predefined Value drop
down list. The Java memory setting defines how much you want to allow Java to use for the
Primavera integration with Estimate. The default value is 512.

If you have not yet installed Java and/or the Primavera Integration API, click OK to
continue the installation of the Primavera Integration Server. Once you have
completed the installation of Java and/or the Primavera Integration API, you can
use the Estimate Configuration Tool to open this dialog again and define the paths
and Java memory settings.

14. In the Instance data block, specify the Instance Name if more than one Primavera Integration
Server connects to the same Estimate Server.

If you have only one Primavera database, this field may be left blank.

15. Click OK to continue.

16. On the Attention dialog, click OK to continue.

17. At the Update Registry and Finalize screen, click Next to continue.

18. Click Finish to complete the Primavera Integration Server installation and exit the setup program.
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15.13.5 SQL Server Utility 946
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15.1 MOBILE TIMESHEETS MODULE PREREQUISITES

TheMobile Timesheetsmodule enables you to collect employee, machine and period quantity data on
the spot at the jobsite and instantly transmit that information back to the home office.

The Timesheet Collector Client application can track employee and machine hours and charge them to
specific job’s cost items or cost accounts instantaneously.

The Timesheet Collector application includes synchronization capability that loads the master data
from Estimate projects, such as standard codes for cost items, accounts, employees and machines (for
example, employee codes, payroll types and resource rate codes) and tags. You never have to
memorize the codes and can easily enter data from the display's lists.
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The Timesheet Collector application allows you to enter timesheet data using a disconnected laptop,
then synchronize the data to the home office once a connection to either the Internet or the company
network is available. For example, a foreman can enter timesheet data while at the jobsite, and then
synchronize with the home office at the end of the day. This can be done either by initiating a wireless
Internet connection, connecting to the Internet from home, or returning to the office and connecting
to the company network.

The Timesheet Collector Client allows timesheets to be recorded electronically, off-line, and requires
only a minimal, temporary connection to the Internet or the company network to synchronize with the
home office and transmit timesheet data. Once synchronized into the Timesheet Warehouse, the
timesheet data is immediately available for approval and analysis by other Estimate users on the
network.

TheMobile Timesheetsmodule requires three additional components to an existing Estimate network
environment:
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l Database – On the database server, running the Databases installer creates an additional
database named HDExecute. The HDExecute database must reside in the same SQL Server
instance used by the main Estimate application to hold jobs and the library. Physical database
files must reside in the same folder where jobs are stored.

l Timesheet Integration Server – On an application server, running the Timesheet Integration
Server installer sets up the Timesheet Integration Server.

l Timesheet Synch Handler – On the Web server, running the Timesheet Synch Handler installer
sets up a web application under your default website. By default, the application is named
HDTime, but it can be renamed during installation if you choose. The Timesheet Synch Handler
application is accessible only to authenticated network users. The site can be made accessible
outside the firewall or can be limited to access by users with an internal network connection.

15.1.1 Preparing for Installation of Mobile Timesheets

The Mobile Timesheets module should be installed after the main Estimate client/server application
has been installed. The installation and setup instructions that follow require a functioning
environment that includes:

l An installation of the Estimate server running the InEight Estimate Server service.

l An installation of SQL Server 2014 Express Edition which can be installed when installing the
Estimate server application or an Estimate Database Server running full SQL Server 2005 – 2014.

If you will also be installing the Data Warehouse modules, you will be required to
have a dedicated database server running full SQL Server 2005 – 2014. This
database server will also be used for the Mobile Timesheets module.

l An installation of the License Server running the InEight Estimate License Server service.

If you are currently using a local Express Edition HDBID instance and will be moving to a full SQL Server
instance on a dedicated database server, you will be required to migrate all job and library databases
from the Express Edition instance to the full SQL Server instance on the dedicated database server.

Once you have migrated the jobs and library databases to the dedicated SQL Server database server,
verify that you can still run the Estimate application on client computers, and work with jobs and
library data now residing on the dedicated database server.

15.1.2 Pre-Configured Web Server

The Mobile Timesheets module requires a Web server running IIS. The installation instructions assume
you have a Windows Server with IIS already installed. The server must have network connectivity with
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the Estimate Database Server or the Estimate Server if you are using SQL Server 2014 Express Edition.

15.1.3 Backup Considerations

The Estimate client/server application has user initiated System Backup and Restore features. If you
are using a full SQL Server instance and a dedicated database server for the Mobile Timesheets module
rather than SQL Server Express Edition, these features are not appropriate when job and library
databases are installed on a separate SQL Server.

If you are using a full SQL Server instance and a dedicated database server for the Mobile Timesheets
module rather than SQL Server Express Edition, after you install the Mobile Timesheets module, you
will need to rely on external Backup/Restore software to back up Estimate database files.

15.2 MOBILE TIMESHEETS MODULE SECURITY
CONSIDERATIONS

Estimate installations may span across multiple servers which must be able to communicate with one
other. For example:

l Services and Web applications require read and write access to databases.

l Services that attach and detach database files require the SQL Server sysadmin role.

l Services that start and stop SQL Server require the SQL Server sysadmin role.

l Services and Web applications require read access to folders where application files reside.

Every service and Web application is assigned an identity under which it runs.

l For a Service – the identity is defined on the Log On tab in the service’s Properties dialog box.

l For a Web Application – the identity is defined by assigning the application to an application
pool, and then defining the application pool’s identity in the pool’s Advanced Settings.

By default, services use identities that only have access to the local machine, such as the local System
account. Local accounts cannot access resources on other computers. Since Estimate components
must access resources (e.g., folders, files or service commands) on other computers, the default
identities for all Estimate services must be changed.

It is recommended that you create a single network account for Estimate in Active Directory, and use it
for all Estimate services. Give the account Log on as a service rights. On the Estimate SQL Server, add
this account as a SQL Login and grant it the sysadmin role.
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For Estimate Web applications, use the ASP.NET v4.0 application pool or create a new one just like it,
and let that application pool use its own Application Pool Identity. Define credentials for accessing SQL
Server in the application’s web.config file.

15.2.1 Timesheet Synchronization Web User Authentication Method

The Timesheet Synchronization web application is designed to use Integrated Windows Authentication
to allow user access. To access the site, a user who is not already logged on to the network (or the web
server itself) will have to provide a user name and password.

15.2.2 Database Connections Planning Considerations

Consider these questions as a planning worksheet prior to installing the Mobile Timesheets Module.

Section Description

DB. 1 What is the name of your Estimate database server computer?

DB. 2 What is the SQL Server instance name?

DB. 3

Where will your data be stored?
Your database and log files must reside in the same folder where your Estimate jobs and
library data reside. The default location is C:\Program Files\InEight\ InEight Estimate\Jobs
on the database server.

DB. 4 What SQL Server login will your Mobile Timesheets Web server use to connect to the SQL
Server?
Create this SQL Server login in advance. Make note of the user name and password.

15.2.3 Mobile Timesheets Application Settings Considerations

Section Description

W.1 What is the name of your Estimate Web server computer?

W.2 Under what website will you create the Mobile Timesheets application?
By default, the Default Web Site will be used, but you can specify a different site during
installation.

W.3 What will you name the Mobile Timesheets application? (The default name is HDTime).
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Section Description

W.4 What application pool will the application be assigned to?

W.5
Where will you place the Mobile Timesheets home directory?
The default location is C:\inetpub\wwwroot\Hard Dollar\TimesheetSyncHandler.

W.6 What is the name of the computer where the InEight Estimate License Server runs?
By default, the License Server uses port 8010.

15.3 INSTALLING THE TIMESHEET INTEGRATION
SERVER

The Timesheet Integration Server is required for the Mobile Timesheets module. The Timesheet
Integration Server can be installed on a dedicated server or on a server that contains other Estimate
applications.

Use the following step-by-step at the server console where the Estimate Timesheet Integration Server
will be installed.

Step by Step — Install Estimate Timesheet Integration Server

1. Start Windows as you normally would, and then exit out of any programs that are currently
running.

2. Launch the Estimate installer downloaded from the InEight website.

3. At the User Account Control screen, click Yes to allow the InEight Estimate application to
makechanges to your computer.

4. On the Installation Package screen, click Install to continue.

5. Click Install Estimate to continue.

6. At the License Agreement screen, select I Accept the Agreement. Then, click Continue to
continue.

7. If other Estimate client or server applications have already been installed on the server, select
Install on the Upgrade or Install dialog. Then, click Next to continue.
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8. At the Components screen under Third Party Integration Components, select the Timesheet
Integration Server check box. Then, click Next to continue.

9. If you are installing the Timesheet Integration Server on a server where no other Estimate
applications are installed, at the Select Destination Location screen, define the installation folder
for the Timesheet Integration Server.

To accept the default installation folder, you do not need to do anything. To define a different
installation folder, click the Browse button and navigate to the desired folder. Click Next to
continue.

10. Click Install to start the installation.

11. At the Ready to Install dialog box, click Install to continue.

12. At the Update Registry and Finalize screen, click Next to continue.

13. Click Finish to complete the Timesheet Integration Server installation and exit the setup
program.

15.4 INSTALLING THE HDEXECUTE DATABASE

Where indicated, refer to your planning considerations.

The Estimate HDLibrary database must be attached in order for the new HDExecute
database to install successfully. Normally, if the InEight Estimate Server service is started,
HDLibrary will be attached. Use SQL Server Enterprise Manager or SQL Server
Management Studio, depending on the version of SQL Server that you are using, to verify
HDLibrary is attached.

Use the following step-by-step to install the HDExecute database.

Step by Step — Install Estimate HDExecute Database

1. Log on to the database server as the machine administrator.

2. Launch the Estimate installer downloaded from the InEight website.

3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make
changes to your computer.

4. On the Installation Package screen, click Install to continue.
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5. Click the Install Databases button.

6. At the License Agreement screen, select I Accept the Agreement and click Next to continue.

7. At the Install Databases screen under the Database Selections section, select the HDExecute
database check box.

8. Under the Connection Information section, enter the SQL Server Host Name, and the SQL Server
Instance.

Refer to Database Connections Planning Considerations topic with line items DB.1 and DB.2.

9. At the Jobs/Databases folder path screen, enter the location for the HDExecute database files.
Then, click Next to continue

Refer to Database Connections Planning Considerations topic with line items DB.3.

10. At the Components screen, verify that Timesheet Collection Data is enabled and selected. Then,
click Next to continue.

11. Select Install. Setup installs the HDExecute database and runs scripts to create stored procedures
and initialize tables.

12. When the installation has completed successfully, click Finish. Then exit to leave the setup
program.

15.5 INSTALLING THE TIMESHEET SYNCH HANDLER

The Timesheet Synch Handler is required for the Mobile Timesheets module. The Timesheet Synch
Handler should not be installed on any Estimate server system. It can be installed on a dedicated Web
server or on a Web server that contains other Estimate Web applications.

IIS must be installed and present on the client machines first for Estimate to allow you to
install the Timesheet Synch Handler. To install IIS, go to your Windows Start Menu search
bar, search for Turn Windows Features On or Off. Scroll down to the section Internet
Information Services. Select the + sign to the left of the IIS section. Then select all items
within the drop down. Windows will then install IIS.

Use the following step-by-step to install the Timesheet Synch Handler.
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Step by Step — Install Timesheet Synch Handler

1. Start Windows as you normally would, then exit out of any programs that are currently running.

2. Launch the Estimate installer downloaded from the InEight website.

3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make
changes to your computer.

4. On the Installation Package screen, click Install to continue.

5. Click Install Estimate to continue.

6. At the License Agreement screen, select I Accept the Agreement. Then, click Continue to
continue.

7. If other Estimate client or server applications have already been installed on the server, select
Install on the Upgrade or Install dialog and click Next to continue.

8. At the Components screen under Timesheet Collector Components, select the Timesheet Synch
Handler check box, and click Next to continue.

9. At the Select Destination Location screen, define the installation folder where the Timesheet
Synch Handler application will be installed.

To accept the default installation folder, you do not need to do anything. To define a different
installation folder, click on the Browse button and navigate to the desired folder.

10. At the Ready to Install dialog box, click Install to continue.

11. At the Timesheet Sync Handler / IIS Preparation screen, configure theWeb Site, Protocol, Port,
and Application settings.

12. Select Next to continue with the install.

13. At the Start Web Site? dialog box, you can choose to either:

Confirm the configuration of the Default Web Site by overriding the recommendation and
starting the site now by selecting Yes. This will complete the Timesheet Synch Handler installer
and Launch the IIS Management Console.

14. View Advanced Settings for the HDTime application. Set the Application Pool according to your
planning worksheet line W.4.

15. Open the Authentication feature for the HDTime application. Verify that Anonymous
Authentication is disabled andWindows Authentication is enabled.
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16. In the menu on the right, under Actions, click Explore. This opens the
C:\inetpub\wwwroot\HardDollar\TimesheetSyncHandler folder.

17. Edit the web.config file. Near the bottom is a section that points to your HDExecute database:

<appSettings>

<add key="HDExecuteConnectionString" value="SERVER=(local)\HDBid;User
ID=bidbuilduser;Password=bidbuilduser;DATABASE=HDExecute"/>

<add key="DeviceDataQueryTimeout" value="300"/>

<add key="TimesheetServiceHost" value="localhost"/>

<add key="TimesheetServicePort" value="8020"/>

</appSettings>

18. Edit the HDExecuteConnectionString values to point to your SQL Server instance using your
database login, as specified in DB.1, DB.2 and DB.4 in the Mobile Timesheets Module Security
Considerations topic.

19. Close the IIS Management Console.

20. Launch Internet Explorer. Enter http://<webserver name>/hdtime in the Address bar and click
Go. Verify that the HDTime landing page displays.

IIS performs Just-in-time (JIT) compiling of Web applications whenever they are initially
launched, when IIS is restarted, or when IIS detects changes in the application path that
trigger a re-compile. The first user that accesses the site when re-compiling will
experience a delay.

15.6 INSTALLING THE TIMESHEET COLLECTOR CLIENT

The Estimate Timesheet Collector Client needs to be installed when the primary purpose of the user is
to download master data from the main Estimate Server, create timesheets, and synchronize the
timesheets up to the Timesheet Warehouse. A Timesheet Collector Client installation includes the
installation of SQL Server 2014 Express Edition.

The Estimate Timesheet Collector Client application can be installed by accessing the
Internet and downloading the Estimate software and then selecting the Timesheet
Collector Client installation files.
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Prior to installing the Estimate Timesheet Collector, you must install the following applications to allow
for synchronization with the main Estimate system:

l Estimate Server

l Estimate License Server

l Timesheet Integration Server

l Timesheet Synchronization Server

15.6.1 Installing the Timesheet Collector Client from the Estimate
Installation

Use the following step-by-step at each client workstation where the Timesheet Collector Client will be
installed.

Step by Step — Install the Timesheet Collector Client

1. Start Windows as you normally would, then exit out of any programs that are currently running.

2. Launch the Estimate installer downloaded from the InEight website.

3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make
changes to your computer.

4. On the Installation Package screen, click Install to continue.

5. Click Install Estimate to continue.

6. At the License Agreement screen, select I Accept the Agreement. Then click Continue to
continue.

7. If other Estimate client or server applications have already been installed on the server, select
Install on the Upgrade or Install dialog box. Then, click Next to continue.

8. At the Components screen under User Workstation Components, select the Estimate Client
check box.

9. Scroll down to the Timesheet Collector Components and select the Timesheet Collector check
box.

10. Click Next to continue.

11. At the Select Destination Location screen, define the installation folder where the Timesheet
Collector Client application will be installed.
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To accept the default installation folder, you do not need to do anything. To define a different
installation folder, click on the Browse button and navigate to the desired folder.

12. At the Ready to Install screen, click Install to continue.

13. Click Next to continue.

14. At the Select Additional Task screen, click Next to have the setup program automatically create a
desktop and quick launch icon for the Timesheet Collector Client.

If you do not want the setup program to install these shortcuts, un-check the appropriate check
box. Then, click Next to continue.

15. At the Installation Summary screen, click Next to continue.

16. Click Finish to complete the installation and exit the setup program.

15.7 USING MICROSOFT PROJECT AS THE INTEGRATED
SCHEDULE

Using Microsoft Project as the integrated schedule in Estimate provides you with a powerful and
flexible project management tool that you can use to control simple or complex projects. It helps you
schedule and track all your cost items, so you can stay on top of their progress.

15.7.1 Define Microsoft Project as the Integrated Schedule

Step by Step — Set Microsoft Project as the Integrated Schedule

1. From the Setup tab under the Initialize sub-section, select Job Properties.

2. Select the Schedule tab.

3. Select the Integrated Schedule drop down arrow and chooseMicrosoft Project.

4. If preferred, check the box for Always want to use Plug Days when updating Estimate from the
schedule.

5. Click OK to close the Job Properties form.
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To make Microsoft Project the default integrated schedule for all projects, in Estimate go
to File > Library > Setup > Job Properties. Then, select Microsoft Project in the Integrated
Schedule field on the Schedule tab. Complete the additional associated fields. Every time
you create a new project in Estimate, Microsoft Project will automatically be defined as
the integrated schedule.

15.7.2 Defining Cost Item Roll Up Rules

Your Estimate project may contain more cost items than you want to schedule. You may want to
create a schedule for the project at a high level, rather than scheduling all the job's cost items. You
determine that this can be accomplished by rolling up the cost breakdown structure to a certain level.
For example, level 3.

When you do this, you can only see the cost items from the Cost Breakdown Structure in the schedule
at the rolled up level. For example, level 3. You can then proceed to schedule these items using the
tools in Microsoft Project.

Once all the rolled up level cost items have been scheduled and you update Estimate, the scheduled
start and finish dates from Microsoft Project will be brought back into the Cost Breakdown Structure.
As a result, all cost items lower than the rolled up level, for example level 3, in the CBS now inherit the
start and finish dates of their superiors at the rolled up level.

If you decide that a specific section in the Cost Breakdown Structure needs to be scheduled with more
detail, you have the ability to schedule specifically at a level lower that the rolled up level previously
defined. This can be done by navigating to that cost item in that section and activating the Schedule
check box.

Step by Step — Set Cost Item Roll Up Rules

1. From the Setup tab, select Job Properties.

Superior cost items are always scheduled using Plug Days.

2. Select the Schedule tab. Then, select the Cost Item Roll Up tab.

3. On the Cost Item Roll Up tab, Select the Automatically calculate Plug Days when rolling up cost
items for scheduling purposes check box.

4. If you want the superior level cost item to use the longest number of scheduled days from the
subordinates as the duration, select the radio button Longest scheduled days among all rolled
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up cost items.

5. If you want the superior level cost item to use the total scheduled days of all subordinates as the
duration, select the radio button Total scheduled days for all rolled up cost items.

When rolling up cost items for scheduling purposes, the Plug Days of the superior
cost item will be recalculated when a change is made to the scheduled days of a
subordinate.

6. To force an immediate recalculation of Plug Days for superior cost items, click the Recalculate
Plug Days button.

15.8 INSTALLING THE ESTIMATE ONCENTER
INTEGRATION

If you are installing the integration on a server, the InEight Estimate Server service will
restart at the end of the installation process.

Use the following step-by-step to install the Estimate OnCenter Integration module.

Step by Step — Install Estimate OnCenter Integration

1. Start Windows as you normally would, then exit out of any programs that are currently running.

2. Launch the Estimate installer downloaded from the InEight website.

3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make
changes to your computer.

4. On the Installation Package screen, click Install to continue.

5. Click Install Estimate to continue.

6. At the License Agreement screen, select I Accept the Agreement. Then, click Continue to
continue.

7. If other Estimate client/server applications have already been installed on the server, select
Install on the Upgrade or Install dialog box. Then click Next to continue.
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8. On the Components screen under Third Party Integration Components, select the OnCenter
check box. Then, click Next.

9. At the Select Destination Location screen, define the installation folder for the OnCenter
integration.

To accept the default installation folder, you do not need to do anything. To define a different
installation folder, click the Browse button and navigate to the desired folder. Then, click Next to
continue. Click Install to start the installation.

10. On the Ready to Install dialog box, click Install to continue.

11. At the Installation Summary screen, click Next to continue.

12. Click Finish to complete the installation and exit the setup program.

15.9 INSTALLING THE ESTIMATE INFOMINE
INTEGRATION

Use the following step-by-step to install the Estimate InfoMine Integration module.

Step by Step — Install Estimate InfoMine Integration

1. Start Windows as you normally would, then exit out of any programs that are currently running.

2. Launch the Estimate installer downloaded from the InEight website.

3. At the User Account Control screen, click Yes to allow the InEight Estimate application to make
changes to your computer.

4. On the Installation Package screen, click Install to continue.

5. Click Install Estimate to continue.

6. At the License Agreement screen, select I Accept the Agreement. Then, click Continue to
continue.

7. On the Components screen under Third Party Integration Components, select the InfoMine
check box and click Next.

8. At the Select Destination Location screen, define the installation folder for the InfoMine
integration.
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To accept the default installation folder, you do not need to do anything. To define a different
installation folder, click the Browse button and navigate to the desired folder. Click Next to
continue. Click Install to start the installation.

9. On the Ready to Install dialog box, click Install to continue.

10. At the Installation Summary screen, click Next to continue.

11. Click Finish to complete the installation and exit the setup program.

15.10 SOFTWARE UTILITIES

15.11 UNINSTALL TOOL

The Uninstall Tool lets you select which Estimate client and server applications to uninstall. You also
have the option to uninstall all Estimate client and server applications that are currently installed on
the client workstation or server.

The Uninstall Tool can be accessed by going to C:\Program Files\InEight\InEight Estimate\Uninstallers.

The Main Uninstaller can also be found using the same folder path: C:\Program
Files\InEight\InEight Estimate\Uninstallers.

Step by Step — Using the Uninstall Tool

1. At the Components screen, select the components that you want to uninstall. Then click Next to
continue.

2. At the Ready to Uninstall screen, click Uninstall to continue.

3. At the Update Registry and Finalize screen, click Next to continue.

4. Click Finish to complete the uninstall and exit the setup program.

The Uninstall Tool does not uninstall the SQL Server (HDBID) instance. If you want to
uninstall the SQL Server (HDBID) instance, use Add/Remove Programs in Control Panel to
uninstall.
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15.12 CONFIGURATION TOOL

The Configuration Tool lets you specify the computer names where server applications run and the
location of database files.

Security Roles and Active Directory Groups for Estimate are created with the Configuration Tool. The
Configuration Tool can be accessed by going to C:\Program Files\InEight\InEight Estimate. Then scroll
down the page and select ConfigurationTool.

The Configuration Tool can also be found using the following folder path C:\Program
Files\InEight\InEight Estimate License Server.

The Configuration Tool has three main tabs

l Network tab

l Database tab

l Attachments tab

When you install additional integrations, additional tabs appear in the Configuration Tool such as the
Primavera and Job Consolidation tabs.

15.12.1 Network Tab

The Network tab defines the server path for the Estimate Server and License Server. You can also
define the security roles within this tab.

On the Network tab, the first section you see is the Estimate Server. This section sets the Server IP
address or Host Name of the Estimate Server on the client machine. When setting up the server, the
default host name is localhost.

Below the IP address is the Port Number. Set the port number to match the port of the Estimate
Server. The default port number is 8004.

The next section is the License Server. In the Server IP Address or Host Name text field, enter in the
name of the server the License Server module has been installed on. If the License Server is installed on
same machine as Estimate Server, leave this section blank.

The port number below the License Server IP address section should match the port of the License
Server. The default port number is 8010.
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15.12.1.1 Setting Security Roles

The Security Roles section has the option to enforce role-based security policies. You can assign Active
Directory Groups to specific users in Estimate by selecting the Enforce role-based security check box.

Use the following step-by-step to set security rules.

Step by Step — Set Security Rules

1. After selecting the Enforce role-based security check box the Users, Security Administrators, and
Job Deleters sections become active. Select the browse button on the right.

2. When the Select Groups dialog box appears, select the object type you need to search your user
for. The two object types you can select are Built-in security principals and Groups.

3. Select OK to close the Object Types window.

4. In the From the location section, define the location of the user for the Active Directory Group by
selecting Locations.

5. In the text field for Object Names, enter in the full email of the user you are adding to the Active
Directory Group. Select Check Names to confirm this user is available in the location you have
searched for them.

The last section on the Network tab is Automatic Save. This section sets the amount of time per
minute Estimate automatically saves any opens jobs.

15.12.2 Database Tab

The Database tab defines the server path for the SQL Server, sets up the Security login, identifies the
Job Databases path, and Job Database Logs path.

On the Database tab, the first section you see is Server. Under Server IP Address or Host Name, enter
the Host/DNS name or IP address of the SQL Server that contains the Estimate SQL Instance.

In the Instance Name section, enter in the name of the Database Instance where the Project Databases
are held.

The Security section has two options. The first is a check box that, when checked, sets the security to
Use Windows Authentication. Enable this feature if you want a Windows user to connect to SQL rather
than a Local SQL User Account.
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The second option is to create your own local SQL user account using the Account and Password fields.
The default Account and Password both use the name bidbuilduser.

Both the Job Databases path and the Job Database Logs path navigate to the same pathway
C:\Program Files\InEight\InEight Estimate\Jobs\. These paths point to the location of your MDF and
LDF Files. The first two paths map your MDF data files and the following two paths map your LDF log
files.

15.12.3 Attachments Tab

The Attachments tab lets you to choose how to enable attachments in Estimate. This tab has only two
optional radio buttons to choose.

l Enable Linked Attachments Only - When choosing this option, it requires no additional
configuration. These attachments are not saved within Estimate Jobs. Files that are referenced
should be on a Network Share or they will not be accessible by other users.

l Enable Linked Attachments and Job Folder Attachments - The attachments folder located under
C:\Program Files\InEight\InEight Estimate\Attachments needs to be shared.

If using option 2 and the indicated folder is not shared, the Estimate Configuration
Window will not close.

If you installed the Primavera integration from the Estimate installation, click on the Primavera
Integration tab in the Configuration Tool. The Primavera Integration tab define the paths to the Java
Virtual Machine DLL and Java Memory settings.

This is required for users with the integration of Primavera with Estimate.

Use the Job Consolidation tab to define Performance settings, Database Server settings, Database
Security, and Report Warehouse Data File paths.

This is required for users with the Enterprise Data Warehouse module.

15.13 ADDITIONAL SOFTWARE UTILITIES

15.13.1 License Server Activator

The License Server Activator utility lets you to activate or re-activate your Estimate license on the
Estimate License Server.
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The License Server Activator can be accessed by going to C:\Program Files\InEight\InEight Estimate
License Server.

Then scroll down and select LicenseServerActivator.

15.13.2 Timesheet Integration License Utility

Each user who synchronizes a Timesheet Collector claims a license. The Timesheet Integration License
Utility lets you release a Timesheet Collector user licenses. Then the license can be claimed by a
different user.

The Timesheet Integration License Utility can be accessed by going to C:\Program Files\InEight\InEight
Estimate. Then, scroll down and select TimesheetIntegrationLicenseUtility.

15.13.3 Detach Utility

The Detach Utility lets you select which databases to detach. Use this utility when archiving the
BidMaster and Library and during migrations.

The Detach Utility can be accessed by going to C:\Program Files\InEight\InEight Estimate. Then, scroll
down and select DetachUtility.

15.13.4 Detach All Silent Utility

The Detach Utility lets you detach all databases without the option to select which databases to keep
attached. Use this utility during migrations.

The Detach Utility can be accessed by going to C:\Program Files\InEight\InEight Estimate. Then, scroll
down the page and select DetachAllSilent.

15.13.5 SQL Server Utility

The SQL Server Utility has a multitude of purposes. This utility can set trace flags which allows file
permissions to remain the same and not reset when detaching databases. You can also create the
BidBuildUser login if it does not already exist. To create a new login,Mixed Mode needs to be enabled.
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15.14 SQL SERVER REQUIREMENTS

Before you begin to install the SQL server, you must first set up some preliminary software. When
installing the SQL server, you must be a System Administrator.

We strongly recommend that a separate SQL instance be used for InEight Estimate.
Preferably called HDBID.

A folder must be created on the SQL Server to where the databases files (MDF) and Log files (LDF) are
going to be stored. This folder must be shared. This document will assist in the creation of this folder.

A Service Account must be created to operate InEight Estimate. The Service Account created for InEight
Estimate must be added to SQL through the SQL Management Studio.

The Service Account must be added to the local Administrators group in Windows. The Service Account
must be given Full Access (Admin Rights) to the shared folder. This document assists in the creation of
these requirements.

15.15 INSTALLING SQL SERVER 2014

The most common version of SQL is SQL Express. SQL Express is packaged with the InEight Estimate
installer.

Use the following step-by-step to install the SQL Server.

Step by Step — Install the SQL Server

1. Launch the Estimate installer downloaded from the InEight website.

2. At the User Account Control screen, click Yes to allow the InEight Estimate application to make
changes to your computer.

3. On the Installation Package screen, click Install to continue.

4. Click Install Estimate to continue.

5. At the License Agreement screen, select I Accept the Agreement. Then click Continue.

6. If other Estimate client or server applications have already been installed on the server, select
Install on the Upgrade or Install dialog box.

7. Click Next to continue.
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8. At the Components screen under User Workstation Components, select the Estimate Client
check box Then select the Network radio button.

9. On the Components screen under Enterprise Server Components, select the Estimate Server
check box.

10. If you intend to use SQL Server 2014 Express Edition as the database for Estimate, select Install
SQL Express Edition with HDBID instance.

11. If you choose not to use SQL Server 2014 Express Edition because you are using a different
version of SQL Server, deselect the Install SQL Express Edition with HDBID instance.

l If you don’t select this option, another version of SQL Server must be installed manually.

12. Click Next to continue

13. The installation was successful, click Close.

15.16 INSTALLING SQL EXPRESS 2014

Use the following step-by-step to install SQL Express.

Step by Step — Install SQL Express

1. Launch the Estimate installer downloaded from the InEight website.

2. At the User Account Control screen, click Yes to let the InEight Estimate application to make
changes to your computer.

3. On the Installation Package screen, click Install to continue.

4. SelectMicrosoft Installers. This open the Microsoft Installers window.

5. Browse to the Install folder for SQL Express 64 and then launch the SQLEXPR_x64_ENU installer.

6. At the Choose Directory for Extracted Files screen, choose the directory where you want to
extract the SQL installation. Then click OK.

7. When the SQL Server Installation Center window appears, choose how you want to install SQL.

8. If you are installing SQL for the first time, select New SQL Server stand-alone installation or add
features to an existing installation.
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9. On the SQL Server 2014 Setup screen, under the License Terms section, check the box I accept
the license terms. Then select Next.

10. Under the Microsoft Update section, select Next.

11. On the Feature Selection section, under Instance Features, select all three check boxes if they
are not already checked. Then select Next.

12. Under the Instance Configuration section, select the Named Instance radio button. Change the
name in the text field to HDBID.

l Notice the Instance ID field changed automatically to HDBID.

l Select Next to continue.

13. Under the Server Configuration section, select the Service Accounts tab.

l Set the Account Name for the SQL Server Database Engine to NT AUTHORITY\SYSTEM.

l Then select Next to continue.

14. Under the Database Engine Configuration section, select the Server Configuration tab.

l Set the Authentication Mode toMixed Mode.

l For the SA Account, enter the password: Hard$123abc.

l Then select Next to continue.

15. The installation was successful, click Close.

15.17 SQL SERVER CONFIGURATION MANAGER

Use the following step-by-step to setup the SQL Server Configuration.

Step by Step — Setup SQL Server Configuration

1. On the Start menu, search for SQL Server 2014 Configuration Manager. You can also find this
application by going to C:\ProgramData\Microsoft\Windows\Start
Menu\Programs\MicrosoftSQL Server 2014\Configuration Tools.

2. On the SQL Server Configuration Manager, expand the SQL Server Network Configuration drop
down in the left pane.

3. Select Protocols for HDBID.
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4. To enable Shared Memory, right-click the Shared Memory protocol name, and select Enable.

5. To enable TCP/IP, if it is not already enabled, right-click the TCP/IP protocol name and select
Enable.

6. When you click Enable on step 4 and 5, a dialog box appeared. This warning informs you changes
made will be saved but not applied until the services are stopped and restarted. Select OK to
close it.

7. Before restarting the services mentioned in the dialog box above, change the SQL Server (HDBID)
Service.

l On the left column, select SQL Server Services. On the right, right-click on SQL Server
(HDBID) and click Properties.

8. On the SQL Server Properties window, select the Startup Parameters tab.

l In the Specify a startup parameter text box, add -T1802 as a parameter .

l Then select Apply.

9. Click OK to exit out of the SQL Server Properties window.

10. The changes that were made to the HDBID Protocols require the SQL Server Service to be
restarted. In the left pane, select SQL Server Services.

11. On the right, right-click on SQL Server (HDBID). Then select Restart.

12. After the configuration is complete, close the SQL Server Configuration Manager.

15.18 ADDING A SERVICE ACCOUNT TO SQL

For InEight Estimate and SQL to communicate, a service account must be created to use for the InEight
Estimate software.

When SQL and InEight Estimate Sever are installed on the same computer, this is not
required.

If InEight Estimate is installed in a Domain environment, create an Active directory user for use by
Estimate.

If Estimate is installed in a Workgroup environment, on each computer where an InEight Estimate
server application or SQL will be installed, create a local user for use by InEight Estimate (this does not
apply to the InEight Estimate Client).

This user must be giving the following permissions:
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l This user must be added to the local Administrators group on the SQL server.

l This user must be given the Sysadmin role in the SQL instance that will be used for the InEight
Estimate software.

l This user must be given full control in the security tab for the SQL Data directory.

Users should not normally log on using this account. The account password should never
change or expire.

Use the following step-by-step to add a service account to SQL.

Step by Step — Add a Service Account to SQL

1. Launch SQL Management Studio.

2. At the Connect to Server screen, log in to the InEight Estimate Instance with a user that has
Admin rights. Then select Connect.

3. After you are connected, select the Security drop down in the left pane. Then select Logins.

4. Right click Logins and select New Login.

5. Select theWindows Authentication radio button.

6. In the Login Name, type in the URL path to the Active Directory Service Account or select the
Search button to search Active Directory users and groups and select the service user.

7. After you have selected the Service Account, select Server Roles from the left side of the screen.

8. Check the box for Sysadmin and click OK. You now added a Service Account to SQL.

15.19 SET ESTIMATE SERVICES TO LOG ON

Use the following step-by-step to set Estimate Services to Log On.

Step by Step — Set Services to Log On

1. To open Services, search for Administrative Tools. Then select Services.

2. Locate the InEight Estimate Server Service. Right-click and select Properties.

3. On the Properties window, select the Log On tab. Select the This account radio button.
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4. In the field marked This account, input the name of the service user account. Then enter the
password for the Service Account.

l Click OK to close the window.

l A dialog box appears informing you the service user account you selected has been
granted permissions to Log On as a Service.

5. Right-click on the Estimate Server service and select Start.

15.20 SHARE ATTACHMENT FOLDER WITH NETWORK
USERS

InEight Estimate requires access to the SQL Data folder through the File System. To accomplish this the
Data Folder must be shared.

Use the following step-by-step to share attachment folder with other Network users.

Step by Step — Sharing Attachment Folder

1. Open Windows Explorer and navigate to the Data folder.

2. Right-click the Data folder and select Properties.

3. Select the Sharing tab.

4. Select Advanced Sharing. Then check the box to Share this folder.

5. Click OK to exit out of the Advanced Sharing window.

6. Select the Security tab.

7. Click Edit and then select add the Service User.

8. Set the Permissions to Full Control.

9. Confirm that the Administrators have Full Control as well.

10. Click Apply and Close.
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15.21 COPYING AND ATTACHING ESTIMATE
DATABASES TO SQL SERVER

Use the following step-by-step to copy Estimate Databases.

Step by Step — Copy Estimate Database folder

1. Log in to the InEight Estimate Server as an Administrator that hasWrite permissions on the
following path \\(SQL Server)\Jobs Folder.

2. Open Windows Explorer and navigate to C:\Program Files\InEight\InEight Estimate\Jobs.

3. Copy the following databases to the SQL Server path \\(SQL Server)\Jobs Folder:

l BidMaster_data.mdf

l HDLibrary

l Training Job folder

Use the following step-by-step to attach Estimate Databases to SQL Server.

Step by Step — Attach Estimate Database folder to SQL Server

1. Go to the SQL Server and open SQL Management Studio.

2. Login as an Administrator.

3. Right-click on Databases and select Attach.

4. Click Add.

5. Go to the shared drive where you copied the database files to and select BidMaster_Data.mdf.

6. Click OK to continue.

7. Click OK again to continue.

8. A dialog box appears asking if you are certain that you have added all the necessary full-text
catalogs, click OK.

9. There are two more databases that need to be attached:
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l HDLibrary_data.mdf

l Training Job.mdf.

Repeat the previous steps to attach those two databases.

15.22 LICENSE ACTIVATION

LESSON 15 — ACTIVATE NETWORK
LICENSES

15.1 Activate Server License Over Internet 954
15.1.1 Network license 954

15.2 Activate Network Client License Over Internet 955
15.3 Activate Network License File 956

15.1 ACTIVATE SERVER LICENSE OVER INTERNET

For many reasons, you may need to activate or reactivate your InEight Estimate license. Some of these
reasons may include:

l You have renewed your license for another year

l You have purchased additional Estimate modules

l You have been using a Standalone license and you have now switched to a network license

l You recently received your first copy of Estimate and need to activate your license

At any time, Estimate allows you to reactivate your license for the reasons above and any other
reasons not mentioned.

15.1.1 Network license

Please ensure that there are no users logged into the InEight Estimate application when
you restart the license server service, as this could result in loss of work.
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Before you begin the activation of the Estimate license, ensure that you have a network connection.

Use the following step-by-step at the server console that contains the Estimate license server.

Step by Step — Activate Server License Over Internet

1. Go to the following path C:\Program Files\InEight\InEight Estimate License Server.

2. Scroll down and select the file LicenseServerActivator. The Activate InEight Estimate dialog box
appears.

3. At the Let's Activate screen, select Activate via the Internet.

4. Click Next to continue.

5. At the Activate via the Internet screen, enter the 16-digit serial number that was provided to you
by InEight Estimate. Click Finish to continue.

Your 16-digit serial number should have been saved from the initial activation. In
the event that it was not saved or if you are activating a new license, you must
manually enter your company’s 16-digit serial number for Estimate to complete the
activation process.

6. At the Activation Successful dialog box, click OK.

7. At the Start Service dialog box, click Yes to start the InEight Estimate License Server service.

8. At the Success dialog box, click OK to complete and exit out of the License Server Activator.

15.2 ACTIVATE NETWORK CLIENT LICENSE OVER
INTERNET

Double check the spelling of the IP address or DNS name for the license server. You will
need the license server DNS or IP address name for later.

Before you begin the activation of the Estimate license, ensure that you have a network connection.

Use the following step-by-step at the workstation that contains the Estimate network client.
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Step by Step — Activate Network License Over Internet

1. From the Backstage View, select Settings from the left navigation pane.

2. At the Settings dialog box under the Network section of the left navigation pane, select Licenses.

3. In the lower center portion of the Licenses dialog box, select Reactivate.

4. On the Update License dialog box, click Yes to continue.

5. At the Activate InEight Estimate dialog box under the Locate License section, choose Network
License.

6. Click Next to continue.

7. At the Activate with a License Server section, enter the IP address or DNS name of the license
server.

8. Click Finish.

9. At the Activation Successful dialog box, click OK.

10. Close and restart Estimate for your license activation or reactivation to take effect.

15.3 ACTIVATE NETWORK LICENSE FILE

Use this option if your company’s server is not connected to the internet. The Estimate
license file can be provided to you by InEight support.

Use the following step-by-step at the server console that contains the Estimate license server.

Step by Step — Activate Network License File

1. Go to the following path C:\Program Files\InEight\InEight Estimate License Server.

2. Scroll down and select the file LicenseServerActivator. The Activate InEight Estimate dialog box
appears.

3. At the Let's Activate screen, choose Import a license file provided by InEight.

4. At the Import a license File screen, browse to the location of the license file that was provided to
you by InEight.

5. Select Open to add the location of the license file to the Import a License File screen.
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6. Click Finish to continue.

7. At the Activation Successful dialog box, click OK.

8. At the Start Service dialog box, click Yes to start the InEight Estimate License Server service.

9. At the Success dialog box, click OK to complete and exit out of the License Server Activator.

LESSON 15 — ACTIVATING STANDALONE
LICENSES

15.1 Activate Standalone License Over the Internet 957
15.2 Activate Standalone license File 958

15.1 ACTIVATE STANDALONE LICENSE OVER THE
INTERNET

The Estimate Standalone license is intended for only one person to use. If you have
multiple Standalone licenses to activate, each 16-digit serial number is different per
workstation.

Use the following step-by-step at the workstation that contains the Estimate Standalone license.

Step by Step — Activate Standalone License Over Internet

1. From the Backstage View, select Settings from the left navigation pane.

2. Under the Network section of the left navigation pane, select Licenses.

3. In the lower center portion of the Licenses dialog box, select Reactivate.

4. On the Update License dialog box, click Yes to continue.

5. At the Activate InEight Estimate dialog box under the Locate License section, choose Individual
License.

6. Click Next to continue.
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7. At the Let's Activate screen, choose Activate via the Internet.

8. Click Next to continue.

9. At the Activate via the Internet screen, enter the 16-digit serial number that was provided to you
by InEight. Click Finish to continue.

Your 16-digit serial number should have been saved from the initial activation. In
the event that it was not saved or if you are activating a new license, you must
manually enter the workstation’s 16-digit serial number for Estimate to complete
the activation process.

10. At the Activation Successful dialog box, click OK.

11. Close and restart Estimate for your license activation or reactivation to take effect.

15.2 ACTIVATE STANDALONE LICENSE FILE

Use this option if the workstation is not connected to the internet. The Estimate license
file can be provided to you by InEight Support.

Use the following step-by-step at the workstation that contains the Estimate Standalone license.

Step by Step — Activate Standalone License File

1. From the Backstage View, select Settings from the left navigation pane.

2. At the Settings dialog box under the Network section of the left navigation pane, select Licenses.

3. In the lower center portion of the Licenses dialog box, select the Reactivate button.

4. On the Update License dialog box, click Yes to continue.

5. At the Activate InEight Estimate dialog box under the Locate License section, choose Individual
License.

6. Click Next to continue.

7. At the Let's Activate screen, choose Import a license file provided by InEight.

8. At the Import a license File screen, browse to the location of the license file that was provided to
you by InEight.
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9. Select Open to add the location of the license file to the Import a License File screen.

10. Click Finish to continue.

11. At the Activation Successful dialog box, click OK.

LESSON 15 — BORROWING NETWORK
LICENSES

15.1 Borrowing License Overview 959
15.1.1 Purpose 959
15.1.2 Summary 959
15.1.3 Individual (Standalone) License 960
15.1.4 Network License 960

15.2 Borrowing Network License Modules 960
15.2.1 Network Licensing Modules Overview 960

15.3 Returning Borrowed License Modules 961

15.1 BORROWING LICENSE OVERVIEW

15.1.1 Purpose

The purpose of this topic is to show you how Estimate licensing works and how to borrow a license
from a network environment to switch to a standalone deployment to work offline from the network.

15.1.2 Summary

Not only does Estimate's software licensing solution make it easier for you as the end user, it also gives
additional flexibility and control to your technology staff in the customization and management of your
licenses from one central location.

Like hardware based licensing solutions, Estimate's software licensing solution provides both individual
(standalone) licenses and network licenses. In addition, unlike hardware based licensing solutions,
Estimate also provides a feature that lets you borrow network licenses that can be used for a specified
amount of time while you are disconnected from the network.

InEight Inc.  |  Release 19.2 Page 959 of 962

Estimate User Guide 15.1 Borrowing License Overview



Estimate's network license borrowing feature lets you use your existing network licenses on a
computer that is disconnected from the network. For example, you can use the license on a laptop
computer that you can take out of the office to the field, bid openings, or at home.

15.1.3 Individual (Standalone) License

An Individual (Standalone) license is one that is locked to an individual personal computer. An
Individual (Standalone) license is not transportable to another computer.

15.1.4 Network License

A Network license is one that provides many module licenses in one central location that are shared
amongst all Estimate users connected to the network. Network module licenses are transportable.
Network module licenses lets you borrow one of the module licenses for a specified period of time.
After that period of time expires, the license is then returned to the module license central location on
the network for other users on the same network to access.

A Network license requires the installation of the Estimate License Server application
which manages the central location of module licenses.

15.2 BORROWING NETWORK LICENSE MODULES

15.2.1 Network Licensing Modules Overview

Estimate lets you borrow network licenses from the Estimate License Server. This is useful when you
generally use Estimate while connected to network but want to work in Estimate while not connected
to the network (in the field or at home).

For example, you can connect to the Estimate License Server on your network, borrow licenses for the
modules that you need, disconnect from the network or license server, and still run Estimate. By
borrowing licenses, you can take your laptop out to the field, or work at home without being
connected to your company's Estimate License Server.

The following step by step shows you how to borrow a network licensing module.
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Step by Step — Borrowing Network License Modules

1. While connected to the Estimate License Server, go to the Estimate Backstage View.

2. Select Settings.

3. Under the Network drop-down, select Deployment Mode.

4. Select the Standalone radio button. Then select OK.

5. When the Restart Estimate dialog box appears, select Yes to close the Estimate Client.

6. After you have restarted the Estimate Client, go to the Estimate Backstage View.

7. Select Settings.

8. Under the Network drop-down, select Licenses.

9. From the All Licenses column, select the modules that you need to borrow.

10. Select the Borrow button.

11. Click the Borrow button to move the selected modules to the Currently Borrowed Modules
column.

12. Choose how long you want to borrow the license for using the Borrow for __ days up and down
arrows in the center column.

You can only borrow a license for a maximum of 30 days.

13. Disconnect from the network.

15.3 RETURNING BORROWED LICENSE MODULES

In order for borrowed licenses to be made available to other network users, you must return the
borrowed licenses to the Estimate License Server prior to the expiration date.

In the event that you do not return the borrowed license before the expiration date, the
borrowed modules will be automatically be returned to the Estimate License Server.

The following step by step shows you how to return the borrowed network licensing module.
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Step by Step — Returning Borrowed Network License Modules

1. While connected to the Estimate License Server, go to the Estimate Backstage View.

2. Select Settings.

3. Under the Network drop-down, select Licenses.

4. Select the modules you need to return from the Currently Borrowed Licenses column.

5. Select the Return button in the center column to move the borrowed modules from the
Currently Borrowed License column to the All Licenses column.

6. Click OK to close the Settings dialog box
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